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1.1

1.2

1.3

1. Navigation

This document provides an overview of the basic template, navigation, common operations
that can be performed, and keyboard short cuts available in Oracle Financial Services
Lending and Leasing. Since this section details the general options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing.

The document is organized into below topics:
e Logging In
e Template and Navigation

e Common Operations
e Hot Keys

Note

The application can be best viewed in 1280 x 1024 screen resolution.

Audience

This document is intended to all Prospective Users who would be working on the application.

Conventions Used

Term Refers to

The system/application Oracle Financial Services Lending and Leasing

Mnemonic The underlined character of the tab or button

Logqging In

The pre-requisites to log into the system are a valid user ID and a password, defined by the
system administrator in Administration > User screen.

You can login to the system using a valid user ID and a password defined by the system

administrator, in Administration > User screen. A User ID is disabled automatically by the
system if it is inactive for a specified number of days.
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1.4

1.4.1

When you invoke the application, the Sign In screen is displayed.
ORACLE: B O

Financial Services Lending and Leasing

sign In

Please enter userid and password

e User ID — Specify a valid User ID.
e Password — Specify a valid password for the specified User ID.

The system accepts the User ID and password in upper case only. After specifying valid
credentials, click Sign In to sign into the application.

Template and Navigation

This section provides a brief input on the template and navigation of the system. Details are
grouped into two categories to enable easy understanding. These include:

e Home screen
e Screens

Home Screen

Once you login to the application with valid credentials, the system authenticates the details
and displays the Home screen.

The Home screen consists of the following components:

e Header
o Left Pane
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e Right Pane/Work Area

ORACLE"
Financial Services Lending and Leasing

ovn - SIS O

DashBoard
4 Dashgoard
DashBoard
Users Productivity
System Monitor
Producer Analysis
Process Files

> Origination
> Servicing
> Collections
> WP

> Tools

> Setup

You can view the application version details and copyright information by clicking About link
at the right corner of the screen.

About

Orade Financal Services Lending and Leasing 14.3.1.0.0
Buld OFSLL_14.3.1.0.0_B253.

Copyright © 1885,2017, Oracie andior fs afflstes. Al ights reserved.

Oracle and Java are registered trademarks of Oracke andlor s af flates. Other names may be trademarks of ther respective owners.

property laws. Except as expressly permited in your lense agreement or albowed by law, you may not use, copy, reprodce, ranslate, broadcast, modify, license,
transmi, distribute, exhibd, perform, publish or display any part in any form, o by any means. Reverse engineering, disassembly, or decomplation of tis software,
unless required by law for nteroperabilty,is prohibted.

The information is subject

If you find any errors, please report them o us in wriing.

that US. Government or behalf of the U S. Govemment, the following notice s
appicable:

U.S. GOVERNMENT END USERS: g tem, any hardware, andior
documentation, delivered o U.S. - Jation and agency-
‘specific supplemental reguiations. As Such, use, duplication, disclosure, modificaton, and adaptation of the programs, including any operating system, inegrated
Software, any programs installed on the hardware, andior documentation, shal be Subjecto icense terms and icense restrictons applicabe to the programs. o
other rights are granted to the U.S. Government

This software or hardware is developed for general use n 3 variety r use in any nherently
dangerous applications, including create 5 risk o pe jury. f you use this soft hardware in dangerous applications, then you shal
be responsibe to take all appropriate falsafe, backup, redundancy, use.

liabitty for any damages caused by use of this Software or hardware in dangerous applicafions.

may informaton on content, products and services from third parties. Oracle Corporation and ts
y respect o third-party content, products, and services. Oracle Corporation and
s affilates wil not be responsile for any loss, costs, or damages incurred due {0 your access to or use of tird-party conten, products, or Services.

| Qo |

Header
In the Header, system displays the following:

e User ID that you have currently logged/Signed in. Click the adjoining drop-down arrow,
the system displays the following options:

AIDYA ~

* Welcome, i Sign Out[QA]
Change Password

m  User Info i

— Change Password — Click to change the current password.
L (7, I— - R

-
ek

Ir

s
e
-
-
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Specify the current password in the Current Password field and a valid password,
you wish to maintain as a new password, in the New Password field. Re-enter the
password in Confirm Password field and click Submit to change the password.

User Info — Click to view the current user info.

Oracle Financial Services Lending and Leasing ®
User Info
Organization DMC Time Zone  JSER TIME ZONE v
Division US01 Level
First Name VARSHA User Time Zone UNDEFINED
Last Name VAIDYA Company US/CENTRAL (CENTRAL STANDARD
) st Branch Time TIME)
Responsibility SUPERUSER e
GL Post Date 02/10/2016 Server Time ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)
Session Language DEFAULT v Skin Family Skyros (Default) v

Debug Enabled Ind

|_—|3 Submit | 3E Close

In this screen, apart from viewing the user info, you can also set Session Language,
enable error log, and specify the time zone preference.

Session Language — Select a language that you need to set for the session, from
the drop-down list.

Debug Enabled Ind — Check this box to enable the debug indicator.

On selection, system records all the debugs into logs files depending on the
following two types of system parameters:

System Parameter Condition to record debug data

CMN_DEBUG_METHOD If parameter value is 1, then debug data is
recorded into a file in Database Server.

If parameter value is 4, then debug data is
recorded into the table LOG_FILES HEADER.

CMN_DEBUG_LEVEL If parameter value is greater than 0, only then the
debug data is recorded.

The debug data can be viewed from Dashboard > System Monitor > Database
Server Log Files.
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You can click on := List Files button to view the list of logged files.

ORACLE’ PRAKRRAD o
Financial Services Lending and Leasing

DashBoard 3 System Monitor [3] Close
BatchJobs  Jobs | Services Database ServerLog Files | Parked Transactions | Users a
Database Server Log Files
View v Format~ Freeze i Detach Wrap W) :=Svstries [ Download File
File Name File Type File Size File Time
JSVPRC_EN_000_01 DB12C_2084400 lob 5706 D2/18/2016 06: 1% 11 AD »
ALERT lob 395 02/22/2016 03:59:16 AN |
CSYPRC_EN_100_01 DB12C_3794335 lob 6390 02/22(2016 04:53:00 AP =
CSVPRC_EN_100_01 DB12C_3854338 lob 116750 02{22/2016 05:356:42 A}
JSVPRC_EN_000_01_DB12C_2004362 lob 5706 02/18/2016 10:57:09 AP =
gy . ] r
r
File Content
View * Format = Freeze DDetach ol Wrap B ©Begnnng@End #oflines 50 [E] show File
Text
0
o cmnsyp_cl_000_D1.get_syp parameter value value: weblogic
o

: 45:FLL:1v_use BI::¥ [

get_syp parameter value value: http://ofss2221142.in.oracle.com:.
get_syp parameter value walue: http://ofss2221142.in.oracle.com:

.get sSyp parameter value parameter: J5V_EI_USER

1.get_syp parameter value Daramecer

y o 00 oo

.get_syp_parameter value value: /scratch/work area/DEV/QA143REL/r. |

get_syp_parameter_valus parameter:

Click on & Show File button to view the selected file contents in the ‘File Content’
section. You can also click & Download File button to extract a copy of debug
details.

Time Zone Level - Select the time zone preference as User/Company Branch/
Application Server Time Zone from the adjoining options list.

For more details on time zone selection, refer to Time Zone Preference section of
this user manual.

Click Submit to save the changes or Close to close the screen without changes.
e Accessibility — Click the link to view accessibility features of the system.
Refer accessibility document for further details.
e Sign Out — Click the link to sign off from the application. You can also click on
icon to sign off from the application.
Left Window

In the left pane, system lists and provides drop-down links for various modules available in
the product. Click > to expand the Module Master Tabs and < to collapse them.

> DashBoard
> Origination
Servicing
Eles 5
Customer Service Il
Securitization
Transaction Authorization
Post Date Checks
Escrow Transactions

m

Account Documents d
Collateral Management |
Reparts
Producers
vendors g
Batch Transactions
Interfaces
AP Transactions
GL Transactions -
> Collections
> WFP
» Tools

> Setup
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To open a screen, navigate to Module Master Tab to which the screen belongs, expand the
tabs, and click the screen link you wish to open.

Menu Search in Left Window

In the left window you can make use of the search option to directly search and open the
screen that you are familiar with, and avoid multiple steps of navigation from the LHS menu.

The Search box in the LHS facilitates for an intuitive search of required screens in Oracle
Financial Services Lending and Leasing. For example, on typing the first letter of the screen,
the search box displays a list of all available screens starting with the letter entered in
alphabetical order. You can click on the required screen and press ‘Enter’. The screen is
displayed in the main window/work area.

ORACLE’
Financial Services Lending and Leasing

- e FEs
Application Retrieval(Criginatior) Data  Sceen | Reports || Correspondence | Transaction
Application Documents(Crigination)
Asset Types(Setup Products) Access Grid add | AEdt | Fven || o Audit
Account Documents(Servicing) el Freeze [ Detach we | @
AR - Organization Division Company Branch Alowed
et | | m— m i :

f DMC NLO2 ALL ALL Y
Audit Tables(Setup System) e B AL AL ¥
Advanees(Servicng Batch Transactions) DMC P04 AL AL Y

> Origination
> Servicing
> Collections
> WEP

» Tools

> Setup

When there are multiple matches with same screen name, you can filter the results through
the module from which the screen is accessed which is indicated in angular brackets. For
example typing 'VEN' displays the following options for selection - Vendors(Collections),
Vendors(Origination), Vendors(Servicing), Vendors(Setup System). For subsequent search,
you need to clear the data in the search field.

Right Window

The Right Window can also be termed as work area. When you click the screen link on left
pane, system displays the corresponding screen in the right pane.

RACLE
Financial Services Lending and Leasing

& Welcome, VAVAIDYA + [=}

Sales ead x Close
> DashBoard IS L.

/'Le;aknl’l’v Follow-up | Maintenance
% Fresze

Applicant Information

= ]
Tipe

L-oooos002 12/1772015 uso1 BoD s rore
Lovooz002 12/12/2015 uso1 usiia PIANINDRA ciiooa ot
Loooo200+ 127127201 uso1 usiia DoREN oncRT iote ¢
Loooocoo2 0210272016 uso1 usio i s0511 CONSULTATION  OFTLINC APPLICA.. 1iOME ADD1 A
Lovoo1001 127102015 uso1 usko ANDRES hanTinez 0c/0¢/19e0 CONGULTATION  weS ENTrY HolE LeA ey 2
L oooosoo2 1272372015 uso1 usko <Al san 11/13/1991 HotE UNITEDSTATES 123 ronce

ke | Reauests

Ao || Zeit || Elven || o it
...... £ Detadt @

Te
CAR/HOBILE PHONE

Phone Current
(0015323123 ¥
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You can open a maximum of 15 screens at a go. Once the maximum limit is reached, the
system displays an error message.

ORACLE"
Financial Services Lending and Leasing
ok

Each active screen is displayed as a tab at the top of right pane, across its width. To view a
screen, click the screen tab. You can identify the active screen with its white background.
Also, operation on any of the screen will not affect the data in other screens.

You can also open multiple Applications at the same time as separate tabs in the right
window, provided your system administrator has enabled the option 'Mac_Multi_tab_Ind'="Y’
in MENU_ACCESS table.

Having this option enabled you can view and update a maximum of 15 Applications in parallel
tabs and Oracle Financial Services Lending and Leasing renders dynamic data across all the
opened tabs.

However, this option is restricted only to the following screens in Origination Module Master
Tab. In the Left Menu of Origination Module Master Tab, you can open multiple applications
by clicking on the following links. Each successive click, opens a new Origination tab.

e Simple Application Entry
e Application Entry

e Underwriting

e Funding

ORACLE’
Financial Services Lending and Leasing

ASSHERAR ~ 1 Signout O

a‘| Origination x || Origination x | Grignation x | Ofigination x (36 Close
Search/Task  Funding: 0000001010 | Review Requests (Pendng: 0) £
> DashBoard
Origination Application: 0000001010: MILLEN JOHN Elvew | o Audt
- - Fresze i Detach Vi v Wam v
p— View = Format 53 i P W overide ok jarning OK MANUAL Contract
ot A= Sub Unit Status nanasen SE8E  produce tame mrd‘::fr COMBEL o geting Customer  Dupicate Appication Cantact 3
imple Application Entry
07/25/2036 0000001030 UNDEFINED APPROVED - FUND... FUNDED MN-00004: SOUT.. (612)451-2211 N ¥
Application Entry = & .
Underwriting
Funding
Application Retrieval
oy Ansys Summary | Appicant | Request | Decision | Contract | Colateral | Comments || Trackng | Document | Verification | Correspondence | Tools
Application Documents
Image Mantenance At
Reports
Producers Applicant
s “« Relation Type First Name Last Name Brth Dt Oun fRented
2| PRIMARY JOHN MILLEN 07/17/1991 UNDEFINED
Ratios
Ratios
Grade Score What IfPmt Amt. Assets Amt Lisbilties (3 Net-Worth Amt
» 0 0.00 0.00 0.00 0.00
Bureau
> Servicing
> Collections Bureau
> WEP Buresu Report Name FICO Score Tradelines Auto Tradelines ¢ P BI® Notices (FE)  Type ot
> Tools [ » [0 CREDITREPORT .. JONATHAN JENKINS 536 ¥ 1 [ 0 MANUAL 07/26)
> Setup bl . -
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Few screens in Origination are identical and are linked. Hence, when multi tab option is not
enabled, you can open only one screen at a time from the group. A sample of the grouping
structure is given below, based on stages of the screens:

Origination:
e Simple Application Entry
e Application Entry
e Underwriting
e Funding

As per the above listing, you will be able to open only one screen in the corresponding list and
need to close the same to open any other screen.

Right Splitter/Action Window

The Right Splitter/Action Window has quick access to search and other options to avoid
switching between tabs or navigating into sub tabs periodically. You can access the Right
Splitter/Action Window while working on an Application or Customer Service screens. You
can click ﬂ and |: to toggle the view of Right Splitter/Action Window.

Origination Screens

In Origination > Application screens, you can use the Right Splitter/Action Window to do the
following:

ORACLE" # Welcome, VavAIDYA - OGN O
Financial Services Lending and Leasing

Close.
> DashBoard Origination x —

origination Search/Tosk | Funding: 0000000378 | Review Requests (Pending: 0)

Application: 0000000378: TIFFANY RUSSEL / GRACE (B view || o auit
Vieww Format~ B ] Freeze i Detach wap | @) OvemideOK ¥ WamingOK ¥

— Hentfication
Application Contars ' i
01/01/2012 0000000378 UNDEFINED APPROVED - FUNDED FUNDED GA-00004 : ADVANCE LEA. N N

Origination Stage

ot app Sub Unit status e

Pre
Producer Name Co Existing Customer
i

, Summary
Requested  Approved
1500000 1500000
8.5900 48900
3 S

Summary | Applicant | Request || Decision | Contract | Collateral | Comments | Tracking | Document || Verfication | Correspondence | Tools

Vendors

> Applicant

‘ > Ratios

» Bureau

> Checklist Change Status

Status APPROVEE

Collateral

Collateral

Asset Type SubType Primary  Year Hake Hodel Hileage New Wholesale Value
~ Servidng VEHICLE AR Y 2012 CHEVROLET. MONTE CARLO on 10,000.00
> Collections Type =
3 Sub v
RAWED Trade-In Type
7 Tools * Comment
> Setup Trade-In > -

Add Comment
= Alert

e Use Quick Search to search for an application based on application number, last 4
digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”.

e Summary section displays critical information that has to be referred repeatedly during
origination like — DTI, PTI, Book Value, Grade, FICO Score, Approved Advance, Rate
and Term.

e Use Change Status section to change the application status to next level. If the
application edit status is restricted, then the ‘Change Status’ will be read-only.

e Use Add Comment section to post an alert or comment during Underwriting and
Funding stages.

For detailed information on the above options, refer to respective sections in the
document.
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Servicing and Collection Screens

In Servicing and Collection > Customer Service screens, you can use the Right Splitter/Action

Window to do the following:

RACLE
Financial Services Lending and Leasing

Customer service (o
search
Quick Search
Account(s): 20170100010097: Elyen | Pt i
Vew~ Fomat~ B LFeese Hiveah W & ©CumentO Show Al GrapFolow
oo s St Dayspastoue Gurency PayOffAnt  Amuntue Sttus OldestoueDt  DiQReason
st usi UeEnE  mmneoies Lo VEHaE () 270 515 290,21 (ST I 2017 STPAMENTOS.
Bsbmt | [ @aex
Summary | Colectons | Custume Sevee | AccountDetals | Cutomer etals | Cstomr references | Transactn istory | Ptiodes | Garknotcy | Repofroredonre | Defoency | Colstersl | ureau | Timene | Crossp Sl Acites | Extems Inefaces
Q= =]
At Conditons
[ text Azt
Rlerts Conditions
Hert AccauntCondien ConditonStartDt Foomip 0t .
X . & [ e ezt
o dta to deplay REpOSSESSION 2 oejamir
oanquen oy osfte/017 Add Comment
“pe RecAR =
STy =
Account Details Other nformation oo
Dues Collateral Information
opomy oy ooy osiopn s prmay Hecaton s Yew AsetChss  AsetTpe  SbTie
g 003 003 3 3 155012 ¥ MECEROETHONECARLO DR BAGPASGIRIAZS2 2006 NEW Wi om
Customer Information B rostgoment | | @ Cear
mmmmmmm .
* Name Relaten s Natonsi D st Gender Add Cal Activity
00000, MADHAN ORACLE PRmRY e oopsies woemed “acn =
=
DM SRSIGHAL COM v ty =
N =
N
Colecor DEMOCOLL
3]
I pemison | "
we  Cument TSN g adgess hene )
e vy Y snemokmasnm ] &
]
Employment Information
B restcaliacity | | @ e

Use Quick Search to search for an account based on account number, or customer Id,
or last 4 digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”. You can also select the Queue Condition and Auto Run options during search.
Clicking ‘Next Account’ button opens the subsequent account listed in search and

clicking ‘Filtered Account’ opens the subsequent account fetched during a queue search

Use Add Comment section to post an alert or comment based on Type and Sub Type.

Use Add Call Activity section to post all types of call activities including promise to pay,
account conditions and so on, irrespective of the screen you are working on. This is
similar to the option available in ‘Call Activities sub tab’ under Customer Service tab.

For detailed information on the above options, refer to respective sections in the

[ ]
and listed in Queue Assignment section.
[}
[ ]
document.
The h

eight of Header and width of the Left and Right Panes do not change, with resizing of

application screen.

The s

ystem facilitates toggling Header and Left and Right Panes of the home screen to

increase the visible area of the screens. Click =u to toggle upper pane and j to toggle left

pane.

To un-toggle click == and |: respectively.
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1411

Time Zone Preference

Oracle Financial Services Lending and Leasing %
User Info
Organization DMC Time Zone |JSER TIME ZONE v
Division S0 Level
First Hame VARSHA User Time Zone UNDEFINED
Last lame VAIDYA Company US/CENTRAL (CENTRAL STANDARD
Branch Time TIME)

Responsibility SUPERUSER Zone

G Bost Lere IR 20 Server Time ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)

Session Language DEFAULT b skin Family Skyros (Default) il

Debug Enabled Ind

DE Submit || ¥ Close

You can select any of the following three time zones from the User Info screen:

e Application Server Time Zone
e Company Branch Time Zone
e User Time Zone

The time zones set up at each of these levels are displayed in the user info screen. However,
data is always stored in the application server time zone and based on the user preference of
time zone, the display time would be User or Company or Application Server time zone. Any
time zone related changes done at Ul does not impact the other time bound activities which
are dependant on database time.

Application Server Time Zone (Server Time Zone)

The Application Server Time Zone by default is the Production Server Time Zone. Selecting
this time zone will have all date and time fields defined as per the time stored in application
server. There is no offset in time if both storage (database server) and display (application
server) are in the same time zone.

Company Branch Time Zone (Organization - Division Time Zone)

This is the Company time zone and is setup at the organization - division definition level. The
various divisions defined under an organization can be set up with different time zones
depending on geographical locations. This time can be modified as per requirement.

To modify the Company Branch Time Zone:

e Navigate to Setup > Administration > User > Organization and select the company or
division listed under 'Division Definition'.

e Inthe Display Formats tab, select Time Zone and click ‘Edit’.

e Inthe Formatfield, select the required time zone from the adjoining options list and click
‘Save’.

If'Company Branch Time Zone' is selected as the time zone in User Info screen, then on save,
all the time and date fields are automatically updated with the time zone of the company
branch.

User Time Zone

User Time Zone or User Preference Time Zone can be set up at the User Level in the User
Definition screen. Various Users under same divisions defined under an organization can be
set up with different time zones depending on geographical locations.
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1.4.2

1.5

1.5.1

To modify the User Time Zone:

e Navigate to Setup > Administration > User > Users.
e Select the required User record listed in “User Definition” section and click Edit.

e Inthe Time Zone field, select the required time zone from the adjoining options list and
click Save.

If 'User Time Zone' is selected as the time zone in User Info screen, then on save, all the time
and date fields are automatically updated with the current updated time.

Screens

Details in few main screens are grouped into different sections. These sections are displayed
as tabs, horizontally within the screen. In turn, details in few of these tabs are again grouped
horizontally. The details are displayed when you click the tab under which they are grouped.
As similar to the main screen tabs, you can identify the active tab with its white background.

For example, Customer Service main screen has four main tabs. When you click on
‘Customer Service’ tab, the corresponding tabs are displayed.

Customer Service @

‘Sea\ch Customer Service: 20120200010231 Pmewﬂeque:t‘\?endmg:0)‘

Account(s): 20120200010231: YUTAKA OZAKA |/ AKANE [E]view | o audt
View Formatv (5 Freeze fDetach | ¢ Wrap W & @ curent O ShowAll O Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Status Oldest Due Dt
Uso1 USR1 UNDEFINED 2012020010231 LEASE VEHICLE 0 USD. 0.00 0.00 ACTIVE 02/10/2015

‘Eunr\'al‘f Customer Service  Account Details | Customer Details | Transaction History | Pmt Modes =~ Bankmuptcy | RepojForeclosure | Deficiency | Collateral | Bureau C\u::,‘bpSEHAftmliE:‘

‘CallAdi\lilies Maintenance ~ Comments Promises = Checdists Tracking Attributes ~ References  Correspondence  Letters  Document Tracking

Call Activities dpadd | ZEit | [Fvien | o audt
Views Formatv [ Freeze A Detach wap @
Adtion Result Contact Reason Cancel Promise Dt Promise Amt. Condition Appointr Follovup D Time Zone Adj Followup Dt Cor
AT PH ANSWERING MACHINE N 12/30f2015 1,000.00 NONE N 12/30/2015 12/29/2015 12:30:00 PM
AT P ANSWERING MACHINE N 123002015 1,000.00 NONE N 127302015 12/29/2015 12:30:00 P

b

You can click # to view the hidden tabs, if any.

Common Operations

Some of the operations are common to most of the screens. These are grouped into three
categories, based on their features.

e Basic Operations

e Basic Actions

e Personalization Options

e De-supported Special characters

Basic Operations

All the screens contain buttons to perform all or few of the basic operations. The four basic
operations available are:

e Add
e Edit
e View
e Audit

e add | A Edit | S view | o Audit
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When you click any of the operation tabs, system displays the corresponding records inline,
below the respective setup tables.

The table below gives a snapshot of them:

Basic Operation Description

Add Click to add a new record. When you click Add, the system displays
a new record enabling you to specify the required data. It is
mandatory to specify details for the fields marked with *’ symbol.

Edit Click to edit an existing record. Select the record you want to edit

and click ‘Edit’. The system displays an existing record in editable
mode. Edit the required details.

View Click to view an existing record. Select the record you want to view
and click ‘View’. The system displays the record details in display
mode.

Audit Click to view audit info. If an audit is set for a field, then the system

tracks the changes for that field. Select the record for which you
want to view the audit info and click ‘Audit’. The system displays the
details tracked for that field.

Close Click to close a screen or a record. When you try to close an
unsaved, modified record, then the system alerts you with an error
message. You can click ‘Yes’ to continue and ‘No’ to save the
record.

1.5.2 Basic Actions

Most of the screens contain buttons to perform all or few of the basic actions.

All or few of these actions are enabled when you select any of the Basic Operations.

E Save and Add E Save and Stay E Save and Return {;J Return

The table below gives a snapshot of them:

Basic Actions Description

Save And Add Click to save and add a new record. This button is displayed when
you click ‘Add’ button.

Save and Stay Click to save and remain in the same page. This button is displayed
when you click 'Add/Edit' button.

Save And Return Click to save and return to main screen. This button is displayed
when you click ‘Add’ or ‘Edit’ buttons.

Return Click to return to main screen without modifications. This button is
displayed when you click ‘Add’, ‘Edit’ or ‘View’ buttons.
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The summary screens consist of the following navigations. The table below gives a snapshot
of them:

Basic Actions Description

Click to navigate to the first record.
')

Click to navigate to the previous record.

= [F[E

Click to navigate to the next record.

Click to navigate the last record.

A

Along with the basic actions, the following buttons are available for specific actions. The table
below gives a snapshot of them:

Basic Actions Description

Ij Show File - Click to view the details of selected file.

List Files - Click to generate and view the list of files maintained in
the system.

|__|ﬁ' Download File - Click to download the details of selected data.

1.5.3 Personalization Options

You can personalize the data displayed in setup tables. Once personalized, system saves the
settings for that User ID until next personalization.

|“FlieWY Format « % Freeze HEDetach o] hirap E’ﬂl
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The table below gives a snapshot of them:

Options Description

View Click to personalize your view. The drop-down list provides the
following options of customization:

e Customize columns you wish to view
e Sort the order of displayed data
e Reorder columns

Additionally, the drop-down list provides selection of options
adjoining ‘View’.

M Format ~ | [&p Freeze pfiDetach

Columns ’ Show Al

|  Freez= + Product |
Detach + Description |
Sort v ¥ StartDt
Reorder Columns... + End Dt

+ Direct
+ Enabled

Query By Example

+ Collateral Type

+ Collateral Sub Type

+ Credit Bureau Portfolio Type
+ Credit Bureau Account Type

Manage Columns...

Format Click to resize columns or wrap a data in the table cells.
| =
Select the column you need to resize and select Resize Columns
option from the Format drop-down list.

Resize Column =

Column DESCRIPTION

width | 100 ] [Pixels  [=]
OK. Cancel

Specify the Width and unit for the selected column. Click OK to
apply changes and Cancel to revert.

Query by Example | Click to query for the data by an example. When this option is
selected, the system displays an empty row above column heads.
You can specify all or any of the details of the record you wish to

query.
View » Format’ Freeze i Detach o1l Wrap 0
¢ i i G| B [
Freeze Select the column at which you need to freeze the table and click

Freeze. Function is similar to the freeze option in MS excel.

Detach Click to detach the setup table from the screen. An example of the
detached table is provided below.
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Options Description

Wrap Select the column in which the data needs to be wrapped and click
Wrap.

loan  lne  lesse
Product Definition dpadd | Sedt | Evew | Lot
view - [Faimats] | B | [Freee ffivetach | [EIWRBN | @ NewProduct Create Copy
T T 7 7 T
I T T T (Credtpurea
ot et Jenao [prea |Fextle Repayment |enabied Jocdateraype  |cotatera subype [hedtBuens |
o+ LOANHOME () p1/01/1800 12/31/4000 B Y Y 'HOME COLLATERAL  REAL PROPERTY HOM INSTALLMENT
LOAN SECLRED
LOAN-SG 12/31/4000 N N Y HOUSEHOLD GOODS PERSONAL PROPERT INSTALLMENT
LOAN-UN R NSSEERE 1 011300 12/31/4000 Y Y Y UNSECURED COLLATIUNSECURED INSTALLMENT
LOAN-VE LOANVERICLEFR)Y p1/01/1800 12/31/4000 N Y La VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT
MDP1 MOP1. 3/08/1863 12/31/4000 Y N id VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT
MURABAHA ) A LMY 1/01/1800 03/13/2013 Y N Y HOME COLLATERAL REAL PROPERTY HON INSTALLMENT
s NORM DSER 3/11/1853 12/31/3000 v N v UNSECURED COLLATIUNSECURED INSTALMENT
o1 e 1oy/201 12/31/000 v N v HOME COLLATERAL REAL PROPERTY HOMMORTGAGE

Click to refresh the data in the table.

View Last For usability and performance, some of the data intensive screens
have ‘View Last’ option to sort the volume of data being displayed
on screen based on elapsed days.

View Last (2 1Day (7 1 Week(©) 1Month @) By Date  StartDt  07/01/2017 I'_?'@ EndDt 09/20/2017 E"@ &

You can select the ‘View Last’ option as 1 Day / 1 Week / 1 Month /
By Date. When ‘By Date’ is selected you can specify a date range
(within 3 months) in ‘Start Dt’ and ‘End Dt fields using the adjoining
calendar and clicking ‘Search’.

Print option in Customer Service screen

The Print button option in Customer Service/Collection screen facilitates you to print the
contents on the screen as is without scroll bars. This button is available along with other
options in the Action block. Clicking on this provides a browser print functionality and a new
tab is opened where the print content is displayed.

Detach
opacte
Financial Services Lending and Leasing

—— L} customerserice T
> Origination | © d quest (Pending: 0) R
Servicing
Sencing Account(s): 20120200010231: YUTAKA OZAKA / AKANE Bl view || «2 Audt
Cusbootns Senice Vieww Formatw [ Freeze 5 Detach o wrap W & @ curent O ShowAll C: Group Follow-up
Secuitzation Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Ant Amount Due Status Oldest Due Dt
Transaction Authorization uso Usk1 UNDEFINED 0120200010231 LEASEVEHICLE 015D 000 0.00 ACTIVE 02j10/2015

Post Date Checks
Escrow Transactions

e Summary | Customer Service | Account Details | Customer Details || Transaction History | PmtModes | Bankuptcy | Repo/Foreclosure  Deficiency  Collateral | Bureau | Cross/up Sell Activies
ccount Documents

Collateral Management Call Activities  Maintenance Comments Promises ChecKists Tracking Attributes References Corespondence  Letters Document Tracking
Repoits
Producers i .
eiidors Transaction Batch Information b add | AEdt || Bview | o auit
Batch Transactions Views Formatv [ Freeze B Detach Wrap W Frrost [ vod
bk Transaction Status Batch
Payments ADD CUSTOMER ADDRESS PHONE POSTED ]
Fee TERMINATE ERROR ]
Iterfaces TERMINATE VoI ] “
P Trancact 01050016 EXTENSION vom "
Detached Table %
View~| Format v [ Frecze [[EBetadh vap @ ot [5hvoid
Date Honetary Transaction Status Batch
02/10/2015 N ADD CUSTOMER ADDRESS PHONE POSTED N
01/07/2016 Y TERMINATE ERROR N
01/05/2016 Y TERMIATE von [
01/06/2016 Y EXTENSION vo N
12/24/2015 Y PAYOFF QUOTE LEASE POSTED N
Views Fomatv [ Freze G Detach wap @
> Collections Transaction Processing Detalls
SWER. (] | Direct Record Update, Transaction Posting Successful **++%
> Tools
> Setup

Click ‘Add’, ‘Edit’ or ‘View’ button to open a new screen in expanded mode with details.

Drop-down List

The system provides an option to select the required data from LOV, for few fields. You can
either select the record from list or enter first alphabet of the value you want. When you
provide the alphabet, system limits the selection to the values starting with the specified
alphabet. These lists are grouped into two types:
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e Drop-down list — Provides the selection option. You can either select a record from the
list or enter first alphabet of the required value.

e Combo drop-down list — The LOV contains huge data and provides both selection and
search option. These drop-down arrows are smaller in size, when compared to normal
drop-down arrows, thus enabling easy identification.

ORACLE" # Welcome, VAVAIDYA v o
Financial Services Lending and Leasing

Close
i Customer Service x [
5 Origimation seach | @ : quest (Pending: 0)
Serviding
Senicing Account(s): 20151200010012; MADHU BOBBURI Elview || & audit
Viewv Formatv Freeze 4 Detach Nrap @ & ©curent O showall O Group Follow-up
Company Branch Sub Unit Account = Product Days Past Due Currency Pay OFF Amt Amount Due Status Oldest Due Dt
ust ushQ 2015120001012 LOANVEHICLE (FR) 2 usD 5031851 2,183,30 [TV SO = e 01/03/2016
Post Date Checks
S e Sum Customer Service | Account Details | Customer Detals || Transaction istory | Pt Modes | Banka RepoForedos
i Summary | Customer Service | Account Details | Customer Details || Transaction History | Pt Modes | Bankruptcy || RepofForedos g o oon 0o
Collateral Management
9 Call Adtivities Maintenance Commen s | Promises | Checklists | Tracking Attributes | References || Correspondence || Letters [ Jgenrch T

® all O any
Transaction Batch Information

View v Formatv [ Freeze EfiDetach ¢l Wrap ® B post [} Veid

[ add | /gt | [Elview | o audt

02/10/2016 3 ACCOUNT NG Search: Transacti
01/22/2016 N ACH MAINTENANCE - - e Search Basic
GL Transactions 12/15/2015 Y ADJUSTMENT TO ADVANCE / PRINCIPAL - ADD 2 2
Transaction Batch Information ADIUSTMEAT TO ADVANCE | PRINCIPAL - SUBTRACT

ADIUSTMNT TO BANKRUPTCY EXPENSES - ADD Reset | | AddFields ~| Rearder

ADJUSTHENT TO BANKRUPTCY EXPENSES - SUBTRACT

~v~\w::, 1zc1n/‘zn15 .Wmc: %—,i o =
Parameters ;

> Collections & | Mfree e > @

i ::::5 Mo data to display.

fSelp Result i

Click the arrow button available before ‘Search’ to toggle the search options.

Buttons/Menu Do this
Basic Click ‘Basic’ for normal search.
Advanced Click ‘Advanced’ for advanced search. In this mode, you can select

the search option from drop-down list adjoining the search criteria.
Selected record will be highlighted (Hover to select).

Match Select ‘All’ to display results exactly matching the specified
characters. Select ‘Any’ to display results matching any of the
specified characters.

Search Click to search for values based on the specified search criteria.
The search results are displayed below with the details in respective
columns.

Reset Click to reset the search criteria.

Add Fields Click to add additional fields to search criteria.

The search criteria are provided below the ‘Match’ field. These criteria vary based on the Field
for which the search is executed.

Also, the system remembers your recent search options and demarcates them from the actual
ones.

| * Channel | WEB ENTRY = * Producer Name [
NY-02: PR HOLTSVILLE 43125313212
MT-00001 : SGFSADDF RAMEY 23132132
LR} FESF * B ]
TIF-OUOO L T TEST-00T RTINS T
MN-00001 : TERMINATE AGUADA a
MT-00001 : SGFSADDF RAMEY 23132132
NY-02: PR HOLTSVILLE 43125313212

Search...
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1.5.4

1.6

1.6.1

Comments

In all the user input screens wherever comments are accepted, the system allows an input of
4000 characters of information in the comment(s) field.

De-supported Special characters

OFSLL ‘does not’ support the following special characters while accepting data through Ul,
web service and file upload process.

<>{}\*[1°

Hence, ensure that the same is not used while processing any input data in the system.

Keyboard Compatibility

The system facilitates keyboard compatibility. You can perform most of your tasks using
keyboard short cuts also termed as ‘Hot Keys’. These hot keys are single keyboards or a
combination of keyboards. The available options are listed below:

1. Shift + Alt + mnemonic to activate buttons in the screen. For example, to open
‘Accessibility’ screen, press ‘Shift + Alt + y’.

2. Tab for forward navigation in the application. Shift + Tab for backward navigation in the
application. When the required link/tab/button/field is highlighted, press enter on the
keyboard to edit.

Space bar to check or uncheck ‘Check Box'.

4. Arrow Keys to hover within the drop-down list.

Keyboard Compatibility

The application is made compatible with keyboard only-operations. However, there is a
change in key combination based on the browser on which the application is running.

Browser Operating Key Combination Action
System

Google Chrome Linux Alt + mnemonic Click

Google Chrome Mac OS X Control + Option + mne- | Click

monic

Google Chrome Windows Alt +mnemonic Click

Mozilla Firefox Linux Alt + Shift + mnemonic Click

Mozilla Firefox Mac OS X Control + mnemonic Click

Mozilla Firefox Windows Alt + Shift + mnemonic Click

Microsoft Internet Windows Alt + mnemonic Set focus

Explorer 7

Microsoft Internet Windows Alt + mnemonic Click or set focus

Explorer 8

Apple Safari Windows Alt + mnemonic Click
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1.7

1.8

1.8.1

1.8.2

Browser Operating Key Combination Action
System
Apple Safari Mac OS X Control + Option + mne- | Click
monic

Also, one can use the following keyboard shortcuts in order to increase or decrease the zoom
level.

Shortcut Action

Ctrl++ To increase zoom level.

Ctrl+- To decrease zoom level.

Ctrl+0 To set zoom level to default level.
Tool Tips

The system is facilitated with tool tip option. When the cursor is moved to any of the field in
the screen, a popup is displayed with a tip on the action to be performed.

Accessibility

Understanding Accessibility

Accessibility is making the application usable for multiple user groups, which includes users
with physical challenges. One of the most important reasons to make the application
accessible is to provide them the opportunity to work. The four main categories of disabilities
are visual, hearing, mobility and cognitive.

A person with disability might encounter one or more barriers that can be eliminated or
minimized by making the electronic information user-friendly and approachable.

Application Accessibility Preferences

Oracle Financial Services Lending and Leasing is facilitated with the feature of Accessibility
to make the application more usable for the people who are differently abled.

By default, the following accessibility options are provided and there is no need to define
special accessibility preference in the application:

e The application user interface contents are readily accessible for all types of users
without the need to select special accessibility modes.

e The components within the user interface are optimized for use with a screen reader by
default.

e The contents are zoomable by default, eliminating the need for an application large fonts
mode.

e The user interface components auto-detect if operating system (OS) is set to high
contrast mode and automatically render content that is compatible with OS high
contrast, eliminating the need for an application high contrast mode.

Note that, Oracle Financial Services Lending and Leasing application user interface is built
on Oracle Application Development Framework (ADF) and the default accessibility feature
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1.8.3

supported by ADF are made available. For additional information, refer to ADF documentation
on accessibility preferences.

Documentation Accessibility Preferences

Apart from assigning the logical sequence and organizing topics, the following techniques are
used to enhance the accessibility of documentation.

Addition of text equivalent to all graphics

Usage of standard fonts and avoiding shadow or reversed text

Usage of strong foreground and background color contrast

Color usages as per Oracle Accessibility guidelines have been ensured
Usage of styles and formatting elements

Documentation in simple language to ensure easy understanding

Including accurate and effective navigational features, such as cross-reference, tables
of content and bookmarks as appropriate
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2.1

2. Search Function

Oracle Financial Services Lending and Leasing allows you to search for an account, customer
or application using specific search criteria. Since this section details the general search
options available in the User Interface, some or all the parts of this section are applicable to
you as per access provisions & licensing. The following sections explain the Search options
in detail.

Search Criteria

Search criteria has a list of parameters which enables to query the application / account from
the database by providing one or more parameter values. There are 15 parameters whose
values can be specified in combination with comparison operators which are described in the
table below. The Reset button enables to clear the comparison values for a fresh search.

Apart from this, Search can also be performed using wild card characters.

ORACLE = Welcome, PRAKRRAO v o
Financial Services Lending and Leasing

Customer Service 5 [E3k=
Search | Customer Service | Review Request (Pending: 0)
> Quick Search

Search Criteria

& Reset Critenia || @8 Search

Viewr formatv [EH| [IFresze Efioetach ol wrep G
vl
; Gperaior val
Lixe ~]
Lixe = =
Lixe ~l
EQUS [~
LIKE vl
Like =
EQUAL =
e I~
Lixe ~
EQUAL ~]
LIKE ~]
e ~]
Lie =
Like vl
Lixe i~
Lixe [~ =
) e o~
ke

<

Search Results
View v Fomatw | Ep Fresze G} Detach rap w0
> Collections Company Branch Account F Date Titke Product Status AopeUenY Amount Due
> WP No data to displar.
<
> Tools
> Setup

Description | Example Expression

LESS THAN | APPLICATION DATE < 01/22/2002

Result: The system searches for all applications created before Jan.
22, 2002.

LESS THAN | APPLICATION DATE <= 01/22/2002

gg EQUAL Result: The system searches for all applications created on or before
Jan. 22, 2002.

EQUAL APPLICANT SSN = 111-22-3333
Result: The system searches for all applications with applicant social
security number 111-22-3333.

NOT APPLICANT SSN <> 111-22-3333

EQUAL

Result: The system searches for all applications except those with an
applicant whose social security number is 111-22-3333.
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Description | Example Expression

GREATER APPLICATION DATE > 01/22/2002

THAN Result: The system searches for all applications created after Jan. 22,

2002.

GREATER APPLICATION DATE >= 01/22/2002

THAN Result: The system searches for all applications created on or after
OR EQUAL | Jan. 22, 2002

IN ACCOUNT NUMBER IN (‘20001000012512°, <20010100012645°,
£20010300012817)

IN is used with values that are within parenthesis.

Result: The system searches for the applications with the account num-
bers of 20001000012512”, <20010100012645°, and 20010300012817.)

NOT IN ACCOUNT NUMBER NOT IN (°20001000012512°, <20010100012645°,
€20010300012817)

NOT 1IN is used with values that are within parenthesis.

Result: The system searches for all applications except those with the
account numbers of 20001000012512°, <20010100012645°, and
120010300012817°.)

IS VIN IS NULL

IS is only used with a value of “NULL”. It enables you to search for crite-
ria that has no value; that is, fields where no information is present.

Result: The system searches for all applications without a vehicle iden-
tification number.

ISNOT VIN IS NOT NULL

ISNOT is only used with a value of “NULL". It enables you to search for
criteria that has any value; that is, fields where information is present.

Result: The system searches for all accounts with a VIN, vehicle identi-
fication number.

LIKE ASSET TYPE LIKE VEH%

LIKE enables you to search for close matches using wildcard charac-
ters.

Result: The system searches for all applications with asset type begin-
ning with the characters “veh” such as “vehicle car” or “vehicle van.”

NOT LIKE ASSET TYPE NOT LIKE VEH%

NOT LIKE enables you to search for close matches using wildcard
characters.

Result: The system searches for all applications with asset type other
than those starting with the characters “veh.”

Using Wildcard Characters

e Wildcard characters can only be used with the operator LIKE and NOT LIKE.
e % (percent) represents any number of characters, including no characters.
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e _ (underline) represents any single character.

Using Criteria Value

Search criteria values of 1234% will locate character strings of any length that begin with
“1234” for example,

e 1234ACB
e 12345678
e 1234

o 12348

e 12340980988234ABIL230498098

Search criteria values of 1234_ will locate character strings of five characters that begin with
“1234” for example,

o 12345
e 1234A
e 12340

Search criteria values of %1234 will locate character strings of any length that end with
“1234” for example,

e 1234
e 01234
e (098908LKJKLJLKJI000988071234

Search criteria values of _1234 will locate five character strings that end in “1234” for
example,

e A1234
e 11234

Search criteria values of %1234% will locate character strings of any length that contain
“1234” for example,

e 1234
e 01234
e 12340

e AKJLKJ1234128424

Search criteria values of _1234_ will locate character strings of 6 characters that contain
“1234” for example,

e A1234B
e 012341
e A12341

Using Search Criteria examples

Result: The system searches for all applications with application date May 1, 2001.

Criteria Comparison Operator Value
APPLICATION EQUAL 05/01/2001
DATE
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Criteria Comparison Operator Value
APPLICATION DATE EQUAL 05/01/2001
APPLICATION NUMBER | GREATER THAN OR EQUAL 0000000278

Result: The system searches for all applications with application date May 1, 2001 and an

application number greater than or equal to 0000000278.

Criteria

Comparison Operator

Value

FIRST NAME

EQUAL

JAN

Result: The system searches for all applications with applicant whose first name is “JAN”

e JAN ARBOR
e JAN FISHER

Criteria

Comparison Operator

Value

FIRST NAME

LIKE

JAN%

Result: The system searches for all applications with applicant’s first name starting with “JAN”

e JAN ARBOR
e JAN FISHER

e JANE MEYERS
e JANETTE NORDSTROM
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Application Status

While you are searching for an application in the Origination screens, the Search Result/
Task tab lists all the available applications and also the status of each application for edits.
The following table indicates the application status:

ORACLE’
Financial Services Lending and Leasing

T Origination (] Close
‘Origination SeardﬂTask Application Entry: 0000001023~ Review Requests (Pending: 0)
e -
;;;:ZG:S‘E:::;" ey App % D0DDDDIS37 SN Identification # B submit
Undernriting
Funding Queue [] | BB Next Application
Application Retrieval
Scenario Analysis > Search Criteria
Application Documents
Image Maintenance ﬂl New Application D Open Application @ View Application ‘Unlock Application
Reports
Producers Search Results/Task
Vendors Viewv Fomaty [ Feeze Hivetach | dwep @) vewAl M
Critical Locked  Allowsd  Company Branch Datz Tite Product Status Sub Status
e o1 USHQ 12/12/2015 CHODA PHANINDRA /... LEASE VEHICLE APPROVED FUNDED
0 UsoL UsHQ 12/14/2015 MADHU BOBBURI | BA... LOAN VEHICLE (FR) NEW BLANK =)
@ us01 USHQ 093 06/01/2015 HONEYSINGH YOYO LEASE VEHICLE APPROVED FUNDED
@ usot UsHQ 56 12/15/2015 BOND JAMES LOAN VEHICLE (FR) NEW REVIEW REQUIRED
@ UsoL UsHQ 62 02/02/2016 55AM LOAN VEHICLE (FR) APPROVED FUNDED
1 @ usoL UsHQ 05 08/01/2015 HOOD MARK LOAN VEHICLE (FR) NEW REVIEW REQUIRED
@ usot USHQ 01/04/2016 KABADE KIRAN LOAN VEHICLE (FR) APPROVED VERIFYING
@ usoL USHQ 02/02/2016 VANKAYA JOGAIAH LOAN VEHICLE (FR) APPROVED VERIFYING
@ usoL UsHQ 94 12/19/2015 MARTINEZ ANDRES / A... LINE HE (FR) APPROVED VERIFYING
@ UsoL UsR1 58 02/01/2012 LEWISJERRY [ JEAN LOAN VEHICLE (FR) APPROVED FUNDED
@ usoL UsHQ 03/01/2012 JONATHAN RYAN / JUL... LOAN VEHICLE (FR) APPROVED FUNDED
%] NLZ NLRI 04/01/2012 GARCIA PETER [ SHAR... LOAN VEHICLE (FR) APPROVED FUNDED
@ usot USHQ 05/01/2012 WALKER SIDNEY / SAM... LOAN VEHICLE (FR) APPROVED FUNDED
@ usoL UsR1 01/01/2012 FLOWER ANDY / JEAN  LOAN VEHICLE (FR) APPROVED FUNDED
@ UsoL UsHQ 01/01/2012 TIFFANY RUSSEL/ GR.. LOAN VEHICLE (FR) APPROVED FUNDED
& Usot UsHQ 02/01/2012 TOLMAN GREG [EVA  LOAN VEHICLE (FR) APPROVED AUTO APPROVED
@ usoL UsR1 03/01/2012 STANDFORD MICHEAL.. LOAN VEHICLE (FR) APPROVED FUNDED V]
@ UsoL UsR1 04/01/2012 SAXTON MARTIN / CH... LOAN VEHICLE (FR) APPROVED FUNDED
< >
» Servicing
> Collections
> WFP
> Toals
» Setup

Description | Example Expression

CRITICAL Whenever any application is updated with dealer comments, a system
generated alert will be posted in the application and a critical icon would
be displayed in this column against that application. Once User has
acted on the critical item, the alert flag should be manually be
unchecked by the User to remove the 'Critical’ flag on the application.

LOCKED An application already opened by another User will have a lock icon in
this column against the application. User with appropriate privileges can
unlock the application and proceed.

ALLOWED This field displays whether you can open the application from the
respective Origination Screen or not i.e. if the application is in decision
stage, a red flag will be displayed in Application Entry stage indicating
that the application can only be viewed and User has to open the appli-
cation in Underwriting for actioning. User can also see a green flag in
Underwriting against this application indicating that it can be actioned in
Underwriting.
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2.2

2.21

Searching for an Application

Oracle Financial Services Lending and Leasing allows you to search and retrieve a particular
application.

During application entry, queues can be created based on your user id and your user
responsibility. You can view the assigned queues in the Origination screen of DashBoard.

ORACLE" - 5
Financial Services Lending and Leasing
Cl
e DashBoard 5 [] Close.
DashBoard
DashBoard Origination Setup Admin
Users Productivity
System Monitor My User Queues Product Expiring in Next One Month Critical Batch Job Status
Producer Analysis Description Count Product End Date Batch Job Status
Process Files No data to display. No data to display. No data to display.

My Pending Review Requests By Applications
App # Fricrity
No data to display.

My Pending Review Requests By Priority
Priority Count
No data to display.

5 Servicing Producer Vendor
Number of Queues Hard Assigned
A Producers Count By Status Vendors Count By Status
Queus Description Count
TR Status Count Status Count
ACTIVE 2 ACTIVE 35
Number of Accounts Pl eisc A
Queus Description re Producers Expiring in Next One Month Vendors Expiring in Next One Month
No data to display. Producer End Date Company Name End Date
No data to display. No data to display.
My Pending Review Requests By Accounts
AcE Priority
No data to display.
> Origination My Pending Review Requests By Priority
Priority Count v
> Servicing No data to display.
> Collections
> WFP
> Tools
> Setup

In each stage of application, the queue name to which the selected application is assigned,
appears in Queue name field in Result screen.

You can begin processing the applications in the order in which they are listed. Select the
record and click Submit.

Search/Task tab

To view the Search/Task screen during Line of credit origination

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Origination master tab.
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Depending on the task to be performed and the link clicked, the respective screen opens
in the Search Results/Task screen.

ORACLE
Financial Services Lending and Leasing

jinati Close
T Origination x 7}
Origination Search/Task | Application Entry | Review Requests (Pending: 0)
Quick Search
Simple Application Entry 5 o ) = -
Application Entry App # ssN Identification 2 [ submit
Underwriting
Funding Queve [~] | [ next Application
Application Retrieval
Scenario Analysis > search Criteria
Application Documents
Image Maintenance o New Application | | (J] Qpen Application || [E] view Application Unlock Application
Reports
Producers Search Results/Task
Vendars View~ Format~ [ Freeze [fiDetach | ol wrap W viewan O]
it Loc AlloCompany  Branch App # Date Title Product Status Sub Status Qu
No data to display.
< >
Columns Hidden 1
1
> Servicing
> Collections
> WFP
> Tools
> Setup

2. Click the Search Criteria tab.

ORACLE
Financial Services Lending and Leasing

Origination

PashAoand

Search/Tack || applicarion Frry || Review Remuess (Pending: )
© Qulck search

Search Criteria

view - rormatw  [E¥] [ Fresss EfiDsmon ol wrep =N

<

Gomparison Oparator B e
quaL ~1
ouaL ~
GHEA 1SR | HAN O EQUAL -~ £
i = =
[T = 5
e =]
Ve =
[ =
ke (=]

e =1

ke =

i ~

ke =l

i =

=F [~

ke =

- New anpiicarion | | () Gnen Appiicarion | | (] view appiicarion Lintocic Applicarion
Search Results/Task
View~ Fommat— | B Frocze  Efi Dotach 0 weap @ viewan O
T Brarch s Dete e Prodia Status Subs Stats Qu

> Servicing
> Collections
> wre

> Tools

> Setup

The search tab enables you to locate an application using a broad range of search criteria.

e During Line of credit origination, the results are sorted according to the priority of
application and application identification number. However you can sort the records
using any criteria.

e If you try to open an application which is already opened by another user, system
displays an alert message indicating “Application is locked by <User Name> Phone
<phone number>".

The Search Results/Task screen.

3. On the Results screen, select the application you want to load and click Open
Application.
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The system loads the application on the respective screen.

ORACLE
Financial Services Lending and Leasing

DashBoard Origination »

Origination SearchjTask | Application Entry: 0000001537 || Review Requests (Pending: 0) A~

Application: 0000001537 RODRIGUEZ ROBINSON El View &7 Audit
View romate B Freeze [ Detach wrop | @ OvemidsOK v Waming OK v

Dt App # Sub Unit Status

09/05/2015 0000001537 APPROVED - FUN. FUNDED 'CA-00003 : ACE H... (818)-761-2277 N

Origination Stage: Producer Contact 3 Duplicate
& Producer Name s Existing Customer  DUPICRLE Contact
N

Summary || Applicant || Business || Request | Dedsion || Contract || Collateral || Comments | Tracking || Document || Verification || Correspondence || Took

> Applicant
> Ratios
> Bureau
> Checkdist

Collateral

Collateral
Asset Type Sub Type Primary  Year Make Model Mileage New Wholesale Value  Retail
VEHICLE car ¥ 2015 AUDE e o 15,000.00 19,500
< >

Trade-In

Trade-In
Asset Type Asset Sub Type Description Identification * Year Make Model Base Retail Amt  Addons
VEHICLE 2015 DODGE RAM... 3GCPCRECSEG145195 2015 DODGE RAM PICKUP 2500 5,300.00 200.00
VEHICLE 2012 CHEVROLET .. 3GCPCRECSEG145647 2012 CHEVROLET camaro 1,600.00 0.00

> Collections 53 >

> WFP

> Servicing

> Tools
> Requested ~

> Setup

You are now ready to begin work on the application.

2.2.2 Quick Search section

Quick Search enables to search for an application using any one of the following values -
Application Number, SSN, Identification Number or Queue.

To load an application using the Quick Search section:

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Origination master tab.

2. Inthe Quick Search section’s App # field, specify the application number you want to load
and click Submit.

You can also load the application by specifying the last 4 digits of the SSN Number. System
retrieves only those applications where the searched SSN is of the Primary Applicant. If
multiple matches are found, system displays an error message as ‘Multiple Matches found for
the SSN, Please use normal Search’.
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Note

Search cannot be performed using wild card characters in the Quick Search section.

ORACLE
Financial Services Lending and Leasing

Search Results/Task
. Format+ B Freere i ntach wean T viewan O]
peny Branch App # Date Title Product Status Sub status Qu

> servicing
> Collections
> WEP

> Tools

> Setup

The system loads the selected application.

To load an application from a queue during application entry

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Origination master tab.

2. In the Quick Search section’s Queue field, select the queue you want to work with and
click Next Application.

Other Features on the Results screen

The Results screen on the Applications screen has below listed common features (these
features are not present on the Result screen on Customer Service screen):

What is it? What does it do?

View All If you select View All check box, all applications in the system acces-
sible with your user id appear in the Results screen under search sec-
tion.

Queue Name This display only field indicates the queue in which the selected appli-
field cation is currently in. (This in normally related to one or more of the
following, based on setup: producer, state, or status.)

Secured box Indicates that the selected application is secured (that is, that the
applicant is an employee of the organization) and may only be loaded
by authorized users.

Copy Applica- | Creates a copy of the selected application. This feature is usually
tion button used when an applicant has submitted a previous application or when
an applicant submits a second application and you don’t want to
retype the information.

New Applica- | Opens a screen where a user can create a new application by provid-
tion ing required details.
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What is it? What does it do?

Open Applica- | Displays the application details for the selected application.
tion

Unlock Appli- | Unlocks the selected application locked by another user.
cation

Copying an Application

Once the application clears the pre-qualification edits successfully, it moves to the
underwriting queue. In the Underwriting/Funding screen, you can copy the information of an
existing application into a new application. using Results screen. The new application will
contain duplicated data of application information, the requested Line of credit information,
credit bureau data, and collateral information. The new application will have status/sub status
as NEW - REVIEW REQUIRED.

To copy an application

1. Open the Underwriting/Funding screen and use Quick Search screen to locate the
application you want to copy.

2. Select the application you want to copy on the Search Results/Task screen.

3. Click Copy Application.

ORACLE
Financial Services Lending and Leasing

= Welcome, PRAKRRAO + _'?_g e |

P —— Origination i (3 Gose

‘Originatis

(@ Information
Application copy successful. New application # success
Search/Task = Underwriting: 0000001537 ~ Review Requests (Pending: 0)

Quick Search
pp £ | 0DDDODIS3T SSN Identification # [ submi
Queue [~] | BB Next Application
©» search Criteria
5 Open Application | | [E] wiew Application | | % inkock Application | £ [i5] Copy Application
Search Results/Task
View~ Format~ P Frecze Gt Detach Wrap W viewar O
Crit Loc Alls Company  Branch App # Dat= Title Product Status Sub Status Qu

No data to display.

 Servicing
> Collections
> WFP

> Tools

> Setup

An Information message is displayed as “Application copy successful. New application # (new
application number).”

System creates a new application with details of the copied application with status NEW -
REVIEW REQUIRED. The new application can be accessed from the underwriting screen
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irrespective of whether it is copied in Underwriting/Funding screen. The system also notes

that this is a copied application with a system generated comment.

Financial Services Lending and Leasing
iginati Close
mET Origination x 7]
Origination Search/Task  Underwriting: 0000001533  Review Requests (Pending: 0)
‘Onigination
N Application: 0000001533 SIGG MARK Zede | Evew | o aude
simple Application Entry 7 —
Application Entry View - Format~ [ Freeze i Detach Wrap W overideok v  Waming Ok v
Undenwriting Origination Stage Producer Contact q Duplicate
i Dt App # Sub Unit Status Code Producer Nama Nuriber Existing Customer application ‘Contact
Application Retrieval 05/05/2015 0000001533 REJECTED - AUTO... NEW CA-00003 : ACE H... (B18)-761-2277 N N
Scenario Analysis < >
Application Documents
Image Maintenance
Reports Summary  Applicant = Business Request Decision Bureau = Collateral Comments  Tracking Document \Verification ~Comespondence  Tools
Producers
Vendors
Comments
add || [ saveandstay | [ save and Retum || Ca Retum
View v Format~  [Bp Fresze (i Detach 1l Wrap =)
Alert Type Sub Type ‘Comment Comment By Comment Dt
u REGULAR [v] | LoAN GRIGINATION [v] PRAKRRAQ 02/04/2016 04:35:38 AM
‘
DECISION_MULTI_OFFER LETTER GENERATED, ~ i
O SYSTEM GENERATED SYSTEM GENERATED {(CORRESPONDENCE: INTERNAL 02/01/2016 08:33:04 AM
CNLNCE_DEC_MULTIOFFER_FAX_VR JOB REQUESTID: W
CONTRACT_FUNDING LETTER GENERATED.
O SYSTEM GENERATED SYSTEM GENERATED (CORRESPONDENCE: CNLNCE_CON_LTR_VR 3OB REQUEST VEROUTHU 01/30/2016 12:30:35 AM
1D: 41039)
DECISION LETTER GENERATED. (CORRESPONDENCE:
O SYSTEM GENERATED SYSTEM GENERATED CNLNCE_DEC_FAX_VR JOB REQUEST ID: 41038) VEROUTHU 01/30/2016 12:06:18 AM
HAVING GOOD REFERRAL
O REGULAR LOAN ORIGINATION VEROUTHU ©1/29/2016 11:24:13 PM
> Servicing
> Collections
> WFP
> Tools
> Setup

2.2.2.3 Unlocking an Application

When an application is opened by a user, the same would be locked for other users. Using

Results screen in the Applications screen user can unlock the application.

To unlock an application

1. Open Applications Entry screen and use Quick Search screen to locate the application

you want to work with.

Submit.

On Search Results/Task screen, select the application you want to load and click

An Information message appears with the message: “An application is locked by another

ORACLE




user.”

ORACLE" 2 Welcome, PRAKRRAD ~ o
Financial Services Lending and Leasing

i Close.
TR Origination x 5]

Origination Search/Task | Undenwriting | Review Requests (Pending: 0)

Origination

sdestead Quick Search

Simple Application Entry ’ = gL 2 =
Application Entry App ¥ DODODD1622 Y Identification # (3 submit
Underwriting & Warning *

il Queue V] [By

Application Retrieval ) [Ea Application is locked by: KGOUDU Phone: 0 - Ext.: 0

SCeTRr Ak » Search Criteria ‘ DKW

Application Documents || || — — — | d i

Image Maintenance (] Cpen Application | | [Z] view Application Unlock Application Copy Application
Reports

Producers Search Results/Task

Vendors View - Format~  [EF Freeze i Detach Vrap W viewal ]

Critical Locked  Allowed  Company Branch  App # Dat= Title Product Status Sub Status Qu
No data to display.
<

 Servicing
> Collections
> WFP

> Tools

> Setup

3. Click Unlock Application.

4. Click Open Application. The system loads application on the Underwriting screen.

2.2.2.4 View Application

2.3

The View Application button is available in all origination screens (Application Entry,
Underwriting and Funding). You can view a selected application in the search results by
clicking on the View Application button even when the application is locked by another User.

The application will be opened in ‘View Mode’ only and no edits are allowed. However in Tools

sub tab, the 'Initialize' and 'Calculate' buttons will be enabled allowing you to use the calculator
options.

Searching for an Account and Customer

You can search or retrieve a particular account or customer through Customer Service
screen. The search tab available in the screen enables you to locate an account or customer
using a broad range of search criteria.

To view the Search screen during Line of credit servicing

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. If you want to perform a customer service task on the application, click Customer
Service link.
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Depending on the link clicked, Customer Service screen appears, opening at Results

screen.

ORACLE
Financial Services Lending and Leasing
@ Customer Service (3 Close:
Search | Customer Service  Review Request (Pending: 0) | Queue Assignment ‘ 2
> DashBoard Quick Search
> Origination
Servicing Acc Customer 1d SSN Identification # [ submit
Servicing =
Customer Service Queue/ Condition [=] Autorun [ | [ NextAccount | | [ Filtered Account
Securitization
Transaction Authorization » Gearch Criteria X
Post Date Chedss [Z100en Account
Escrow Transactions "
A:;num I‘Yocumer\rs 4 Search Results
Colaeralen aperient Vien ~ Format - [ Freeze [ Detach £ 5]
Reports = g
Producers ¢ 2]
Yooy Company Branch Account # Date Title Product Status SE‘WQUE"EY Amourtt Due su‘tsland\ng
Batch Transactions He Lt
A uso1 usHQ 00123455 03/20/2000 Downpmiamt Test .. LOAN VEHICLE (FR) CHARGED OFF o 0.00 0.00 -
P uso1 UsHQ 1008226531 01/01/2017 BAUER CHRISTIAN  LOAN VEHICLE (FR) ACTIVEIDELQ 217 158288 9,07m.00 [
i - uso1 UsHQ SEEEEEE] 01/20/2000 Downpmtamt Test ... LOAN VEHICLE (FR) CHARGED OFF 0 0.00 0.00
> Col P uso1 usHQ 12 01/20/2017 ORACLE MADHAN  LOAN VEHICLE (FR) ACTIVE -35 0.00 8,226.25
uso1 usHQ 1236459789 01/20/2000 Downpmtamt Test ... LOAN VEHICLE (FR) CHARGED OFF 0 0.00 0.00
> WEP uso1 usHQ 20000100010385 01/20/2000 Downpmtamt Test ... LOAN VEHICLE (FR) CHARGED OFF 0 0.00 0.00
 Tools uso1 usHQ 20000100010533 01/20/2000 Downpmtamt Test .. LOAN VEHICLE (FR) CHARGED OFF 0 0.00 0.00
> Setu uso1 usHQ 20000100011820 01/20/2000 ALIVEPRI /DEAS... LOAN VEHICLE (FR) CHARGED OFF 0 0.00 0.00
B uso1 usHQ 20000100011846 01/20/2000 ALIVEPRI [DEAS.. LOAN VEHICLE (FR) CHARGED OFF 0 0.00 0.00 ki

Note

Oracle Financial Services Lending and Leasing does not display the financial details of se-
cured accounts if the logged-in user is not authorized. Though the search display the re-
sults, the fields such as Status, Delinquency Days, Amount Due, and Outstanding Balance
are masked with ‘xxxxx’ and clicking on the same displays an error message indicating

‘Cannot open secured account’.

3. Click the Search Criteria tab.

Financial Services Lending and Leasing
Clase
e Customer Service x B
> Origination Search Customer Service  Review Request (Pending: 0) =
S > Quick Search
Serviding
Customer Service Search Criteria
Securitzation Search Options: (@ Acsount ©) Custamer ©) Business
Transaction Autherization
Post Date Checks & Reset Criteria || @ Search
Escrow Transactions View~ Formatv B Freeze i Detach Wrap 55 3
Account Documents Criteria Comparison Cperator Value 7
Collateral Management: AT § e =]
Reports
Sl ACCOUNT STATUS e [=] [=]
Producers
et PRODUCT i [=] YLOAN%
Advances CUSTOMER LAST NAME i [=]
Bt CUSTOMER FIRST NAME LxE [+
e CUSTOMER D EQUAL [=]
Interfoces =
S - BUSINESS NAME LIKE -
GLTransactions N e =
CASA Reconciiation YEAR EQUAL [=]
Conversion Accounts MAKE L &
MODEL LKE [=]
ASSETTYPE Lxe [=]
PRODUCER # LIKE =]
> Collections PRODUCER NAME LKe =
b wrR ACCOUNT CONDITION it [=] [+
> Tools 'QUEUE NAME {UNDEFINED FOR DEFALLT) LIKE [=]
> Setup QUELE DESCRIPTION LIKE [=] !

Using the Search tab

1. Create a search criteria by specifying the required details in Comparison Operator and

Value columns.

Click Search. System displays all accounts that meet the search criteria in the Results
tab.

On the Search Results/Task screen, select the account you want to load and click Open
Account.
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2.31

The system loads account on Customer Service screen.

ORACLE'
Financial Services Lending and Leasing

%, Welcome BSHEKER v EERRIOIRION] o

=

Customer Service
Search  Customer Service: 20190100010574  Review Request (Pending: 0) ~ Queus Assignment:
Account(s): 20190100010574: LOAN - VE VIK
View~ Formet~ Freezz [ Detach waep W) 8 OcurentOShow AlO) Group Follow-up ) Associated Accourts

Company Branch Sub Unit Account # Master Account #  Master Account Product

usot USRL UNDEFINED 20150100010574  UNDEFINED N AUSZ LOAN VEHICLE

L3

Summary Collections ~Customer Service  Account Defails ~ Customer Details  Customer Preferences  Transaction History ~ Pmt Modes  Benkruptcy
Alerts Conditions
y Alerts Conditions

Nert Account Condition
PAYABLE REQUISITIONS SENT TO THIRD PARTY CHECK PRINTING SYSTEM REPOSSESSION
NEW COLLATERAL ADDED - ASSET NBR: 1135, PRIMARY IND: N NATURAL DISASTER
NEW COLLATERAL ADDED - ASSET NBR: 1126 , PRIMARY IND: N PAYOFF/TERMINATION IN PROGRESS
Account Details Other Information

Dues Collateral Information
08/01/2019 07/01/2019 07/01/2019 06/01/2019 05/01/2019 Primary Description
0.00 0.00 0.00 0.00 0.00 Y 2019 PIVEHICLE PIVEHICLE

N 2021 ACTIVE HONDA
Delg Due 0.00 Total Due(ind 0.00 Oldest Duz Dt 09/01/2019 N 2016 ACTIVE HONDA
LCDue 0.00 cument due) At Paid Excess 13,825.87 <
NSF Due 0.00 Todays Payoff 0.00 Meo Excess 0.00
Other Due 0.00 Future Payoff 0.00 Amount .
R Fuure Payoff Dete 11/09/2019 eid Term 8 Customer Information

Biling Cycle
MONTHLY

Repo/Foredosure

Identification #

¥ Close:
A
[Eview o Audit
Purpose Days Past Due Currency
VEHICLE LOAN OR... 59 USD
>
Deficency = Collateral = Bureau = Timeli > ¥ A
Condition Start Dt Fallowup Dt
10/16/2019 10/19/2019
10/04/2019 10/04/2019
07/25/2019 10/30/2019
4
Year  AssetClass Asset Type
2013 NEW VEHICLE A
2021 NEW VEHICLE
2016 NEW VEHICLE v
>
v

Quick Search section

The Quick Search section in Customer Service screen enables you to load accounts using
any one of the fields Account Number, Customer Id, SSN, Identification #, or Queue/

Condition.

To load an account using the Quick Search section

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the

Servicing master tab.

2. If you want to perform customer service task on the application, click Customer

Service.
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2.3.2

3. Inthe Quick Search section’s Acc#/Customer Id/SSN/Identification # fields, specify the
corresponding Account number, or Customer Id, or last four digits of SSN or complete
SSN in the respective fields and click Submit.

ORACLE ) . SSHEKAR y g oo ©
Financial Services Lending and Leasing
@ Customer Service x [ Close
Search | Customer Service | Review Request (Pendng: 0) | Queue Assignment
> DashBoard Quick Search
> Origination
Servicing Acc# Customer Id SSN Identification # 3 submit
S
Customer Senvice Quete/ Coniton [#] Autorn [ | 3 NextAccount | | (5§ Fitered Account
Securitization
Transaction Authorization » Search Criteria
Post Date Chedks T
Escrow Transactions 3
A(Tun( I‘Z)n[umenfs 4 Search Results
Collateral Mz it =
S vien~ Fomat~ || [[[Frezze EiDetach U
Reports 4
Producers ¢ %
Deli Qutstandi
eriors Company Branch Account # Date Tite Product Status de'”q”E”q Amount Due B“‘ S prog
Batch Transactions ays alance
advanes Mo data to display.
‘ i v
Payments
Fess -
> Collections
5 WEP
> Tools
> Setup

4. You can also search for accounts which are mapped to a particular Queue or Condition
by selecting the same from ‘Queue/ Condition’ drop-down list and clicking ‘Next Account’
button. Clicking ‘Filtered Account’ opens the subsequent account fetched during a queue
search and listed in Queue Assignment section.

5. When the request to access an application comes from an external system, user needs
to check ‘Auto Run’ and click ‘Next’ button. System displays the customer service screen
for the respective Account.

To load an account from a queue

In the Quick Search section’s Queue field, select the queue you want to work with and click
Next Account.

Search Using Customer Details

There are different ways to search a customer account using the customer details.

To search for and load the customer details with the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Search Criteria

2-15 ORACLE



Select Customer as a search option.

ORACLE’
Financial Services Lending and Leasing

i Close
> DashBoard Customer Service 5 (]!
b Bexeation Search | Customer Service | Revien Request (Pending: 0) ke

Servicing > Quick Search
Servicng
Customer Service Search Criteria
Securitization Search Options: () Account @) Customer ©) Business
Transaction Authorization
Past Date Checks & resetcritera | @ Search
Escrow Transactions View v Format~ [ Fraeze  {ff Detach virap ®
Account Documents Criteria Camparison Operatar valuz
Colateral Management S o =l
Reports
& CUSTOMER FIRST NAME Lne [=]
Producers
VEhdEE CUSTOMER LAST NAME LIKE [=]
Baiteh Transactions CUSTOMER S5N EQUAL [l
Advances CUSTOMER NATIONAL ID LIKE [=] =
“
Payments CUSTOMER PASSPORT NUMBER LKE [=]
e CUSTOMER PHONE NUMBER EQUAL [=]
S CUSTOMER ZIP CODE LIKE [=]
AP Transactions =
GL Transactions
Conversion Accounts TR
Search Results
View > Format> [P Freeze [ Detach ol wrap o)
Customer 1d National ID First Name Last Name ssn Passport = zp
No data to display.
» Collections
AL vew~ Fomatv B [lFreeze [iDetach e | @
> Tools Company Branch Account # product Currency Pay OFf Amt Amount Due Status Oldest Due Dt Type
> Setup jladatite dsty.
B i Gl

1. On Search Criteria screen, use Comparison Operator and Value columns to create a
search criteria to find the account using customer details. You can click Reset Criteria at
any time to clear the Comparison Operator and Value columns.

2. Click Search.

The system locates and displays all the accounts that meet your search criteria on Search
Results screen.

ORACLE
Financial Services Lending and Leasing

= Close
e Customer Service [Efel
> Origination Search | Customer Service | Review Request (Pending: 0)
Servidng Quick Search
Serviang
Customer Service Ac# Customer Id SSN Identification # [ submit
Seauritization
Arxsachmnoaitiximiion Queue/ Condition [ autorun [ [ G Next Account
Post Date Checks
Escrow Transactions 5 Search Criteria
Account Documents =
Collateral Management [ Qpen Account
Reports
Producers Search Results
Vendors View ~ Format~ & Freeze i Detach &1l wrap (05
Batch Transactions Customer 1d National D First Name Last Name SSN Passport # Zp
Advances 31030 456321739 SATKRISHNAN K 0000E956 00775
Payments ¥
Fees
Interfaces
View + Format + Freezz  EfiDetach | ol Wrap
AP Transactions poAT hems & o ¢ @
A —— Company Branch Account # Product Currency Pay Off Amt Amount Due Status Oldest Due Dt Type
R uso1 UsHQ 0160200015584  LOAN VEHICLE (FR)  LSD 5,037.08 42276 ACTIVEDELG 03/01/2016 PRIMARY
> Collections
> WFP
> Tools
> Setup

3. On the Search Results screen, view the following information for each account:

In this field: View this:

Company The company of the account.

Branch The branch of the account

Account # The account number

Product The Line of credit product of the account.
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In this field: View this:

Currency The currency in which the account is operated.
Pay Off Amt The total pay off amount on the account.
Amount Due The total amount due on the account.

Status The status of the account.

Oldest Due Dt The oldest payment due date on the account.
Type The type of account.

Also the ‘Customer Details’ section below displays the Customer Information along with
Addresses, Telecoms, Employments, and Tracking Attributes. You can click ‘View’ to display
the details in each section.

4. On the Search Results screen, select the customer you want to retrieve. The system
displays all the accounts pertaining to that customer Id. Select an account and click Open
Account.

The system displays the account details on Customer Service tab.

Search Using Account Details

To search for and load an account using the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Search Criteria

1. Select Account as a search option.

ORACLE
Financial Services Lending and Leasing

Close
e Customer Service x [Ef
5 Origination Search | Customer Service || Review Request (Pending: 0)
S LY » Quick Search
Serviang
Customer Service Search Criteria
Securitization Search Options:  © Account ) Customer & Business
Transaction Autharization
Past Date Checks & Resetiiteria || @8 Search
Escron Transactions Vien ¥ Format~ [P Freeze  [fiDetach Wirap W 4
Account Documents Crteria Comparison Operator Value 1
Collateral Management EEANT R e =
Renarts ACCOUNT STATUS LiE [=l [=]
Producers
e PRODUCT LKE [=] SLOANYE
EaE—— CUSTOMER SSN EQUAL =
Advances i CUSTOMER LAST NAME LKE =
Payments CUSTOMER FIRST NAVE LKE [=]
= CUSTOMER 1D EQuAL [=]
Interfoces =
S BUSINESS NAME LKE -
oL Transactons L ue =
CASA Reconaliation YR EQUAL [=]
Conversion Accounts MAKE e =
MODEL LIE ]
ASSET TYPE LiE [=]
PRODUCER & LiE [=]
> Collections PRODUCER NAME LIKE =
> WEP ACCOUNT CONDITION LIKE ] [=]
> Tools 'QUEUE NAME (UNDEFINED FOR DEFAULT) LIKE [=]
> Setup ‘QUEUE DESCRIPTION LKe [+l e

2. On the Criteria screen, use the Comparison Operator and Value columns to create a
search criteria to find an account. You can click Reset Criteria at any time to clear the
Comparison Operator and Value columns.
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3. Click Search. The system locates and displays all the accounts that meet your search
criteria on Results screen.

ORACLE’
Financial Services Lending and Leasing
 DashBoard {Customer Service y [ Close
S Ot Search | Customer Service | Review Request (Pending: 0) <
S Quick Search
Senvicing
Customer Service Ac# Customer 1d = Identification # [E3 Submit
Seuritzation
Hrnc iy Queue/ Condiion 2] Auorn 1 [ [ NextAccont
Post Date Checks
Escrow Transactions » Search Criteria
Account Documents =
Collateral Management (L) Gpen Account
Reports
Producers Search Results
Vendors View v Formatvy [y Freeze  ifiDetach Wrap 7]
Bat:;::\:::mm i Company Branch Account # Date Tite Product Status ::‘Y‘Z""E"EV Amount Due :;:f:d‘”g Producer e
Payments usoL usHQ 0151200011060 12/10/2015 NATHNATH LOAN VEHICLE (FR) PENDING ] 0.00 0.00 CA-00002 : RAND' +
Fies usot usHQ MISI00L1391  12/18/2015 MADELLASURESH  LOAN VEHICLE (FR) ACTIVE:DELQ 1 147182 2503000  CA-00002:RANDY |
Interfaces usoL UsHQ 151200012331 12/10/2015 KNAVIN LOAN VEHICLE (FR) PENDING 0 0.00 0.00 CA-00002 : RAND"
S— usor usHQ 015120001234 12/17/2015 SOF SOF LOAN VEHICLE (FR) PENDING 0 0.00 0.00 AK-00001 : FELL
ey usoL usHg DI51200012612  12/18/2015 KNAVIN LOAN VEHICLE (FR) PENDING 0 0.00 0.00 CA-00002 : RAND'
. usoL usHQ 151200012894 12/24/2015 ASHOKPADMA  LOANVEMICLE (FR) ACTIVE 2 0.00 2000000 CA-00001:DEMO
e A usot usHg DISI00L3008  12/30/2015 ume LOAN VEHICLE (FR) ACTIVE -18 0.00 100,000.00  CA-D00S : HARR"
usor usHQ 0160100013092 01/06/2016 SPARROV/ MARYY  LOAN VEHICLE (FR) ACTIVE 2 0.00 S0,000.00  CA-00001: DEMO
usoL usHQ DI01000L3216  01/14/2016 JONES ANGELINA  LOAN VEHICLE (FR) ACTIVE -16 0.00 S0,000.00  CA-00001: DEMO
usot usHQ 160100013274 01/18/2016 RANADE SHWETA  LOAN VEHICLE (FR) ACTIVE 31 0.00 S00,000.00  CA-00001 : DEMO
usaL usHQ DI60100013414  01/19/2016 DALE ALAN LOAN VEHICLE (FR) ACTIVE 31 0.00 42,000.00  CA-00002: RAND'
> Collections usot usHg 0160100013963 01/20/2016 o LOAN VEHICLE (FR) ACTIVE -0 0.00 15,000.00  GA-D00D2 : ADVAT
e usoL usHQ 0151200014064 12/17/2015 KNAVIN LOAN VEHICLE (FR) PENDING 0 0.00 0.00 CA-00002 : RAND'
usot usHQ MDI60100014149  01/20/2016 HEGDE SUBHASH f... LOAN VEHICLE (FR) ACTIVE 24 0.00 15,000.00  GA-000D2:ADVAM |
> Tools usot usHQ 0160100014206 01/20/2016 HEGDE SUBHASH f... LOAN VEHICLE (FR) ACTIVE 24 0.00 1500000 GA-00002: ADVAN +
> Setup < i 1 v

4. On the Search Results screen, view the following information for each account:

In this field:

View this:

Company

The company of the account.

Branch

The branch of the account

Account #

The account number

Date

The date the account was created.

Title

The primary and other applicant(s) attached to the account.

Product

The Line of credit product of the account.

Status

The status of the account.

Delinquency days

The number of days the account has been delinquent.

Amount Due

The total amount due for the account.

Outstanding Balance

The total outstanding balance for the account.

Producer

The producer of the account.

Secured

If selected, indicates the account is secured and may only be
loaded by authorized users.

5. On the Results screen, select the application you want to retrieve and click Open

Account.
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The system loads the account under the tab

ORACLE
Financial Services Lending and Leasing

#, Welcome, VAVAIDYZ

234

ustomer Service x Close
> DashBoard Sistomen 56 =
* Origination Search  Customer Service: 2015100011054 Review Request (Pencing: 0)
Servicing
Senvidng Account(s): 20151000011054: K NAVIN [El view |[ 2 audit
Customer Service Vieww Formatv [ [[[Frecze FiDetach | oJwp @ & @ Current O ShowAll O Group Follov-up
Securtization Company Branch Sub Unit Account = Days Past Due Currency Pay Off At Amount Due Status Oldest Due Dt
Transaction Autherization usHo. UNDEFINED 0151000011054 LOAN VEHICLE (FR) 83162 0.00 ACTIVE 10/01/2016
Post Date Checks
Escrow Transactions
S Summary | Customer Service || Account Details | Customer Details | Transaction History | Prt Modes || Banksuptey || Repo/Forecosure || Deficency | Collteral || Bureau | Cross/Up Sell Actties
Collateral Management
Reports Alerts Conditions
Producers
Vendors Alerts Conditions
Batch Transactions Alert Condition Sttt Followup Dt
A TesT o data to dispay
s
Fees
Intesfaces
AP Transactions
GL Transactions
CasA Reconciition
‘ Account Details Other Information
Conversion Accounts ‘
Dues Collateral Information
Description Ientification = Year AssetTpe  SsubType
000 000 000 0.00 000 o 0 i
o 0 i i
Delg Due 0.00 Total Due 2000 Future Pt Dt 10/04/2016 o 0 x© i
LCDue 0.00 Todays Payaff 4531462 Oldest Due Dt 10/01/2016
F Due 2000 Future Payoff 4537630 Amt paid Excess 0.00 :
Other Due 0.00 Future payoff Date. 02/27/2015 QustomerTntormetion
. . Customer e Relation S5 Birth Dt Gender
Delinquency Information #
o0 @6 15 (80 Cateqory [ba 000000... KAVINK PRINARY oc2008677 02/12/1557
0 0 0 0 0 0 27 000000.., RICHARD MURRAY 3R PRIMARY 009332 12/08/1585 UNDEFINED
»
nsk(ife) 1 Collector DEMOCOLL
NsF(vear) 1 Privacy Opt Out ¥
Language ENGLISH Active Mitary Duty 1
Activities Marital Status op N e 2
S MaritalStatus ey Time Z
Active Dt 12/10/2015 App £ 0000001013 Last Pt Amt 0.00 Cortespondence
> wep Last Activity Dt 02/17/2016 Paid Off Dt Charge Off Dt
ue Day 1 Effective Dt 10/12/2015
> Tools Due Day %
Last Pt DX Current Pt 3,981.80 fddress Infomatios
> Setup Customer Grade B Last Bill Amt 0.00 Type current PEMISH waiing address Phone. i

You are now ready to begin

work on the account.

You can view the accounts pending for your review by selecting Receiver in the Review

Request tab.

Search Using Business Details

To search and load an account with specific business using the Search screen
On the Oracle Financial Services Lending and Leasing home screen, click Servicing >

Servicing > Customer Service > Search Criteria

1. Select Business as the search option.

ORACLE’
Financial Services Lending and Leasing
@ Customer Service [ ose
Search | Customer Service | Review Request (Pending: 0) | Queue Assignment =
> DashBoard » Quick Search
> Origination
Serviding Search Criteria
E Search Options: Account () Customer @) Business
ervidng
;“smzar:mm & Resetciiteria | @8 search
ecuitization
Transaction Autiorizstion ey~ papets | | Mo ffivses we | @
Post Date Checks Criteria Comparison Operator Value
Escrow Transactions BUSINESS # LIKE =
Account Goauments BUSINESS NAME e [+]
Collatersl Management — — &
Reperts STaRTDATE GREATRTHANOREQUA.  [=] Y
Producers < =
Wy PrONE NUVBER cqun =
Batch Transactions ZIP CODE LKE =
Advances
Payments =
5 - (L) 0pen Account
ees
Interfaces
Search Results
2P Transactions .
S View~ Formatv Freeze ffi Detach rap @
PoRETE Business # Business Name. Tax1d Start Dt Phone Number Zp
Mo data to display.
> Collections
> WFP view~ Formatv | Freeze  faft Detach Wrap ®
vk Company Branch Account # Product Currency Pay Off Amt. Amount Due Status Oldest Due Dt
00 No data to cispay.
> Setup

2. On the Criteria screen, use the Comparison Operator and Value columns to create a
search criteria to find the business type. You can click Reset Criteria at any time to clear
the Comparison Operator and Value columns.
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3. Click Search. The system locates and displays all the records that meet your search
criteria on ‘Search Results’ section.

ORACLE’ ABSHEAR ~ 1 Signout O
Financial Services Lending and Leasing
68 Customer Service (3] Close
Search Results =
= ew v Formatv [ Freese i Detach ra o)
< Dasmm?rd vEus\nEsZ# : Business Name : Tax1d Start Dt Phone Number Zp
> Origination 0000021005 oFsiL 55236 02/08/2010 (co0}000-0000 01152
Servicing
Customer Service View ™ Format+ | Frezes [#Detsch ®
SeamtEz o] Company Branch Account # Product Currency Pay Off Amt Amount Due Status Oldest Due Dt
Transaction Authorization Uso1 usHQ 2017020002995 LOAN VEHICLE (FR) usp 10,000,00 0.00 AcTive 03/15/2017
Post Date Checks
Collterl Management s
Producers A Business Details
Vendors ] vew
Batch Transactions
Advances View - Format~  EF Freeze i Detach Wirap ®
Interfaces CCORP CORPORATE CORPORATE OFSLL OFSLL 0005236 02/08/2010 200
Conversion Accounts Addresses Telecoms Partners  Affiiates  Tracking Attributes.
& Gollections Address Information Evew
view~ Fomat~ Freeze Efpetach | ol wiap 5}
1AL Address Type Current Country Address # city State Postal Type StreetPre Street Name. Street Type st
7 Tools WORK Y UNITED STATES SPRINGFIELD MASSACHUSETTS ~ NORMAL ADDRESS
» Setup A . L4 o
You can view the view the following information for each business record:
In this field: View this:
Business # The registered business number of the company.
Business Name The name of the business.
Tax ID The taxation identity number of the business.
Start Dt The date when the business was initiated.
Phone Number The contact number of the business.
Zip The zip code where the business is established.

4. Onthe Results screen, select the business type of your interest. The sub section displays
the accounts associated with the selected business with the following details:

In this field: View this:

Company The company of the account.

Branch The branch of the account

Account # The account number

Product The Line of credit product of the account.
Currency The currency in which the account is operated.
Pay Off Amt The total pay off amount on the account.
Amount Due The total amount due on the account.

Status The status of the account.

Oldest Due Dt The oldest payment due date on the account.
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Also the ‘Business’ section below displays the Business Details along with Addresses,
Telecoms, Partners, Affiliates and Tracking Attributes. You can click ‘View’ to display the
details in each section.

5. Select the required account and click Open Account. The system loads the account
associated with the business type in the tab

ORACLE"
Financial Services Lending and Leasing

Close
e CustomerService x EE
I+ Oapinatica seah| G + 2015100011054 quest (Pending: 0)
Servicing
Seniilia Account(s): 20151000011054: K NAVIN Elyew || Pt
Customer Senice View- Fomat P (lfreze BiDetach | olwrp | @ &  © Curent O ShowAll O Group Folloveup
securitzation Company Branch Sub Unit Account = Product Days Past Due Currency Pay OFF Amt Amount Due Status Oldest Due Dt
Transaction Autharization uso1 UsHQ. UNDEFINED 2015100001054 LOAN VEHICLE (FR) 27 UsD 4531462 0.00 A 10/01/2016.
Post Date Checks
Loow Teheuciong s Customer s¢ Account Details | Customer Detalls | Transaction Hitory | Pt Modes | Bankruptcy | Repo/Foreck Def Collateral | B Cross/Up Sell Actvties
e ummary || Customer Service | Account Details | Customer Details | Transaction History | Pt Modes | Bankruptcy | Repo/fForedosure | Deficiency | Collaeral | Burcau | Cross/Up Sell Activities
Collateral Management
Reports Alerts Conditions
Producers
Alerts Conditions
Alert Condition Start Ot Followup Dt
TEST o data to display
GL Transactions
CasA Reconcilation q o DeaE N
Conversion Accounts S gt i ‘<
Dues Collateral Information
Description Hentification = Year AssetClass AssetTpe  SubType
000 000 000 000 000 0 0 I i
0 0 x i
Delg Due 0.00 Total Due 2000 Future Pt DE 10/01/2016 0 0 1 x
LCDue 0.0 Todays Payoff 4531462 Oldest Due DE 10/01/2016
NSF Due 2000 Future Payoff 45,376.30 At Paid Bxcess 000 "
& Customer Information
Other Due 0.00 Future Payoff Date 02/27/2016
: . Costomer ame Relation S5 Bith ot Gender
Delinquency Information *
e 30 0 @ 20 0 180 Category Days 000000... KAVIN K PRINARY 010068677 02/12/1987
: £ 5 5 : e & = 000000... RICHARD MURRAY JR PRIMARY 00009332 12/08/1585 UNDEFINED
,
Be(lfe) 0 NsF(Life) 1 Collector DEMOCOLL
ep(Year) 0 NsF(Year) 1 Email Privacy Opt Out Y
Language ENGLISH Active piitary Duty N
Activities MaritalStatus stop N Time Zone
2. Collectionss Actve Dt 12/10/2015 Aop # 0000001013 Conespandence
> WP Last Actiity Dt 02/17/2016 Paid OFf Dt
Due Day Effective Dt 10/12/2015 :
> Tools
LastPmt Dt Current Pt 3,981.80 jAddress Information
» Setup Customer Grade B Last Bil Amt 0.00 Type current PEM waiing Address Phane. =
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3.1

3.2

3. Dashboards

Introduction

This document is designed to help acquaint you with the features of Dashboard, on the
landing screen of Oracle Financial Services Lending and Leasing. Information from multiple
products is integrated and displayed as Dashboard on home screen of the application.

This manual explains the functionality of Dashboard facility and various Dashboards present
in the system. Since this section details the general dashboard options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing. Besides providing these details, the manual also provides a brief description of
other features associated with Dashboard link. The Dashboard main Menu further provides
links to the following screens:

e Dashboard

e Users Productivity
e System Monitor

e Producer Analysis

Dashboards

Dashboards are the tiny windows displayed on landing screen of the Application. Dashboard
renders quick and crisp information of specific transactions or tasks mapped to the ‘User
Role’, who logs on to the system.

The system facilitates integration of Information from different levels and displays it as
Dashboard on home screen, also called the landing screen of the application.

Navigating to Dashboards
Click Dashboard > Dashboard > Dashboard.

[e=]

RACLE
Financial Services Lending and Leasing

DashBoard x (3] Cos=

Origination Setup Admin

My User Queues Product Expiring in Next One Month Critical Batch Job Status
Count. Product End Date Batch Job Status
No data to display. No data to display. No data to display.

My Pending Review Requests By Applications
App = Priority
No data to display.

My Pending Review Requests By Priority
Priority Gount
No data to display.

Servicing Producer Vendor

Number of Queues Hard Assigned A~ Producers Count By Status ‘Vendors Count By Status
Queue Description Count. Status Count Status Count
No data to display. ACTIVE 82 ACTIVE 35

Number of Accounts Producers Expiring in Next One Month Vendors Expiring in Next One Month
ueue Description Count Producer End Date me End Date
No data to display. No data to display.

My Pending Review Requests By Accounts
Acc = Priority
No data to display.

> Origination My Pending Review Requests By Priority o
> Servicing | prienty Count

> Collections

> WFP

> Tools

> setup

Features

Following are the features of Dashboard:
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3.3

3.3.1

3.3.1.1

e The system organizes Dashboards to provide comprehensive and consolidate snapshot
in tiny windows, to access information easily. Thus, helping to; analyze, monitor and
make better decisions which in turn help save time and cost.

e The screen is designed to display six Dashboards, distributed in two rows with three
Dashboards per row, without scroll bars.

e The height and width of all Dashboards are fixed; however, you can expand or collapse
the Dashboards. Click the arrow heads at the top left corner of the Dashboard windows
to expand or collapse the dashboard windows.

e Each section in Dashboard is hyperlinked to home screen of the respective section. The
main screen will present descriptive information of details shown in Dashboard only.

e Each window in the dashboard is provided with a Refresh button and clicking on the
same would fetch the latest status of the dashboard being viewed.

User Productivity

Oracle Financial Services Lending and Leasing User Productivity screen is a supervisor
feature that allows you to monitor the daily performances of users completing Line of credit
origination and servicing tasks.

These tasks are categorized as underwriting funding tasks (loan origination).The system
updates these details on daily basis.

Using the User Productivity screen, you can review the following daily tallies:

e Number of applications entered, by user

e Number of underwriting decisions (approved, rejected, conditioned, or withdrawn), by
user

e Number of funding decisions (verified or funded), by user
e Number of applications entered, by queue

This chapter explains how to use the User Productivity screen to view this information.

Navigating to User Productivity Screen
1. On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > User Productivity.

2. The system displays the User Productivity screen. You can view the tasks related to:
e Underwriting/Funding
e Customer Service/Collection

Viewing Underwriting/Funding tasks

Daily tallies from the

e Collector Activity

Collector Activity

The Collector Activity screen displays the number of accounts worked and call activities by
collector for the day. It also displays details regarding calls and total number of calls per
queue.
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To use the Collector Activity

1. Click Dashboard > Dashboard > User Productivity > Collector Activity. The details
on this screen are grouped into two:

e Users
e Activity Details

2. In the Users section, you can view the following information.

ORACLE 2 Welcome, PRAKRRAC = (<)
Financial Services Lending and Leasing

= Close
T Users Productivity o

DashBoard Application Entry | Underwriting || Funding || Origination Queues | Collector Activity | Senvice/Callection Queues
DashBoard

Users Productivity
System Monitor Users
Producer Analysis View~ Formaty [ Frecze T} Detach Wrap 5]

Process Files User Neme Accourts Call Activities

No data to display.

Activity Details
Viewv Format~ [ Freeze [t Detach J wrap i

Quaue Name LeftMessages  Promisa To Pay Mo Answer Other Total
No data to display.

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

A brief description of the fields is given below:

Field: View this:

User Displays the user code.

Name Displays the user name.

Accounts Displays the number of accounts worked.
Call Activities Displays the number of call activities.

3. In the Activity Details section, you can view information for the selected user. A brief
description of the fields is given below:

Field: View this:

Queue Name Displays the queue name.

Left Messages Displays the left message activity count.

Promise To Pay | Displays the promise to pay activity count.

No Answer Displays the no answer activity count.

Other Displays the other activity count.
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3.41

Field: View this:

Total Displays the total activity count.

System Monitor

The System Monitor screen is the one stop place to check all the activities in and around the
system. It maintains the progress of;

e Batch Jobs

e Jobs

e Services

e Database Server Log Files
e Users

Navigating to System Monitor

On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > System Monitor.

Monitoring Batch Jobs

The system tracks the success of each batch process on the Batch Job. If either a set of batch
jobs or specific batch job should fail, you can resubmit it on this screen and review the results
in Request Details section.

The Monitor Batch Jobs screen is only a display screen that contains the following sections:
e Batch Job Sets
e Batch Jobs
e Batch Jobs Threads
e Request Details
e Request Results

To Monitor Batch Job
1. Click Dashboard > Dashboard > System Monitor > Batch Jobs.
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2. In the Batch Job Sets section, you can view the following information

ORACLE . . . W PRAKRRAO ~ o
Financial Services Lending and Leasing
it Close.
e System Monitor md
BatchJobs  Jobs | Services  Database Server Log Files | Parked Transactions | Users
Users Productivity
System Monitor Batch Job Sets
Producer Analysis Vieww Formatw [} Fresze i Detach Wirap T BB Re-submit Job Set
Process Files Set Code Job Set Description  Status Fraquency Frequency Value  Start Time Enzbled Critical Last Run Dt Next Run Dt
SET-AAL ACOOUNT CREATL.. READY DAILY DAILY 10:00 AM N N 08/08/2003 08/03/2003 A
SET-ACR ACCRUALS AND D... READY DALLY DALLY 10:30 PM N ¥ 08/07/2003 08/08/2003 W
<
Batch Jobs
Vieww Format~ [ Freeze ) Detach Wrap @ BB re-submit Job
Seq Job Type Job Code Status Job Description Threads Commit Count Errors Allowed Weskend Holiday
1 PROCEDURE AAIPRC_BJ_100_01 COMPLETED APPLICATION TO. 1 Y
2 PROCEDURE TXNACT_B]_100_01 COMPLETED AGOOUNT ACTIVA. 1 100 50 Y Y
< >
Batch Job Threads
i View- Fomaty B Freeze 1! Detach Wrap (65
Thread Status Errors. Records Trace Level Enabled
1 IDLE o o oy
Request Details
View » Format+ [ Fresze ) Detach Wrap (5]
Request Type Status Start Dt End Dt Run Start Dt Run End Dt Process Dt
No data to display.
>
Request Results
View» Fomat- [ Frezze ! Detach Wrap ®
Requast Result Description
> Origination No datz to display.
> Servicing
> collections
> WFP
> Tools
> Setup

A brief description of the fields is given below:

Field:

View this:

Set Code

Displays the code for batch job set.

Job Set Description

Displays the description for batch job set.

Status

Displays the job set status.

Frequency Code

Displays the frequency at which the job set is to be executed.

Frequency Value

Displays the value of frequency code chosen for the job set.

Start Time Displays the start time for the job set.

Enabled Displays if the job set is enabled or not.

Critical Displays if this job set is critical or not.

Last Run Dt Displays the date of last run of the job set.

Next Run Dt Displays the next run date for job set.

Parent Displays the preceding job set.

Dependency Displays the type of dependency on predecessor.

To resubmit a batch job set

Whenever a batch job set fails, it is best to resubmit it after correcting the errors that caused
the failure. Resubmitting a set causes system to re-perform the batch job set and dependent

batch jobs.
e [nthe Batch Job

Sets section, choose the batch job set to resubmit (only a batch job

set with a status of FAILED can be resubmitted), then click Resubmit Job Set button.
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The Batch Job screen also allows you to resubmit jobs which are in READY or COMPLETED
or FAILED status if you have access key privileges define for your user responsibility. If
provisioned, then a ‘Force Re-Submit Job Set’ button is available instead of ‘Resubmit Job
Set’ button to resubmit the jobs with above status.

The Batch Jobs section lists the batch jobs within a job set. The status, threads, commit
count, dependencies, enabled indicator and the holiday and weekend runtime indicators are
shown for each job.

A brief description of the fields is given below:

Field: View this:

Seq Displays the batch job sequence number.
Job Type Displays the batch job request type.

Job Code Displays the batch job request code.
Status Displays the job status.

Job Description

Displays the batch job description.

Threads

Displays the number of threads used by the job.

Commit Count

Displays the number of rows after which auto-commit is
triggered.

Errors Allowed

Displays the number of errors allowed.

Weekend Displays if the batch job will execute job on weekend or
not.

Holiday Displays if the batch job will execute job on a holiday or
not.

Enabled Displays if the job is enabled or not.

Parent Displays the preceding job.

Dependency Displays the type of dependency on predecessor.

Command Displays the command line for the job.

Rollback Segment Displays the rollback segment for job.

To resubmit a batch job

Whenever a batch job fails, it is best to resubmit it after correcting the errors that caused
failure. Resubmitting a set will cause system to re-perform the batch job.

e In the Batch Jobs section, choose the batch job to resubmit (only a batch job with a
status of FAILED can be resubmitted), then choose Resubmit Job Set.

e The Batch Job Threads section displays the status of individual threads.

A brief description of the fields is given below:

Field:

View this:

Thread

Displays the name of thread.
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Field: View this:

Status Displays the status of thread.
Errors Displays the number of errors in the thread.
Records Displays the number of records in the thread.

Trace Level Displays the SQL trace level (0, 1, 4, 8, 12).

Enabled Displays if the job thread is enabled or not.

The Request Details section displays the status and runtimes for each time the selected job
ran.

A brief description of the fields is given below:

Field: View this:

Request Type Displays the job request type.

Status Displays the job request status.

Start Dt Displays the job request is valid from this date and time.

End Dt Displays the job request is valid till this date.

Run Start Dt Displays the date and time on when the job run started.

Run End Dt Displays the date and time at which the job run ended.

Process Dt Displays the transaction is posted with this General Ledger effec-
tive date.

Description Displays the job request description.

If a particular job requires that a result message be created, then that message appears in the
Request Results section. A message is usually created in the event of an error.

A brief description of the fields is given below:

Field: View this:

Request Results | Displays the result of job request.

Description Displays the result details.

3.4.2 Monitoring Jobs

The Monitor Jobs screen provides another view of monitoring all system processes, including
credit bureau requests and payment posting. This screen displays the data in reverse
chronological order of the Run Start Date/Time, whereas the Monitor Batch Jobs screen
provides the historical data about each job and job set.
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To Monitor Job Details
1. Click Dashboard > Dashboard > System Monitor > Jobs.

ORACLE’

Financial Services Lending and Leasing

System Monitor x

Batch Jobs | Jobs

Job Details

View ~ Format

Request Type

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE
<

Services || Database Server Log Files

Batch  BackGround | Credit Request

- &
Status

COMPLETED.
COMPLETED
COMPLETED
COMPLETED
COMPLETED
COMPLETED

[ Close
Perked Trensactions | Users &
Freez fiDetach ep ) Viewlast @ 10ay©) 1weekE 1Month© By Date  StartDt Endt @ Vew © Faled ® Al
Valid Execution
Job Set. Job Description Thread Errors. Records Run Start Date/Time Run End Date/Time  Process Dt Period Start
Date/Time
SET-TRE TXNDDT_BJ_100_. TXNDDT_B1_100_ 2 0 2 09/19/2017 11:52:... 09/19/2017 11:52:... 09/20/2017 09/18/2017 11:52
SET-TRE TXNDDT_BJ_100_.. TXNDDT_B1_100_ g 0 8 09/19/2017 11:40: . 09/18/2017 11:41:_. 09/20/2017 08/15/2017 11:40;
SET-QRT QCSPRC_BI_100_.. QCSPRC_BI_100_ 1 0 2 08/19/2017 03:31:.. 03/18/2017 09:31:... 08/20/2017 08/19/2017 03:31; g
SET-QRT QCSPRC_BI_100_. QCSPRC_BI_100_ 1 0 2 09/19/2017 08:31:. . 03/18/2017 0&:31:... 08/20/2017 08/19/2017 08:31;
SET-QRT QCSPRC_BI_100_. QCSPRC_BI_100_ 1 0 2 08/18/2017 07:31:. . 03/18/2017 07:31:... 08/20/2017 08/18/2017 07:31;
SET-QRT QUSPRC_BI_I00_.. QCSPRC_B1_100._ 1 0 2 08/19/2017 06:31:... 09/19/2017 06:31:... 03/20/2017 08/19/2017 05:31;

7

Job Detail Description
THNDDT_E_100_0 1 TXNDDT_B]_100_01(6006)

Job Results
View = Formatv [

Request Result
in Ani St

Freeze i Detach

Description

2. Onthe Job screen, you can select any of the following type of jobs which are available in

separate tabs:

Select: System Displays:
Batch Batch jobs (used primarily for the nightly processes).
Back Ground User submitted requests, such as reports and payment posting.

Credit Request

Credit bureau requests.

3. Inthe Job Details section, select the time frame based on elapsed days. You can select
any of the following options:

Select: System Displays:

1 Day All the types of jobs selected in Jobs Type section in last one-day.

1 Week All the types of jobs selected in Jobs Type section in last one-week.

1 Month All the types of jobs selected in Jobs Type section in last one-month.

By Date All the types of jobs selected in Jobs Type section for specific duration.
You can specify a date range (within 3 months) in ‘Start Dt and ‘End Dt’
fields using the adjoining calendar and click ‘Search’.

4. If you select Failed option in the View section, the system displays failed jobs on the type
and time frame you have selected.

5. In the Job Details section, you can view the following information about jobs matching
the contents of Job Type, View Last and Failed boxes:

A brief description of the fields is given below:

Field: View this:

Request Type Displays the job request type.
Status Displays the job request status.
Job Set Displays the job set code.
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3.4.3

Field:

View this:

Job Displays the job description.

Thread Displays the job thread.

Errors Displays the number of errors.

Records Displays the number of records processed by the job.

Run Start Date/Time

Displays the job run start date time.

Run End Date/Time

Displays the job run end date time.

Description

Displays the job request description.

Process Dt

Displays the job process date.

Valid Execution Period

Start Date/Time

Displays the job start date/time.

End Date/Time

Displays the job end date time.

6. Inthe Job Results section, you can view the following information about the Job selected

in Job Details section:

A brief description of the fields is given below:

Field: View this:
Request Type Displays the job request type.
Description Displays the job request description.

Monitoring Services

The Services screen allows you to track and maintain the system’s processing services,
including credit bureaus, fax-in and batch job scheduler. The system administrator can start
or stop the service on this screen using the action buttons respectively.

To stop, start or refresh a processing service
1. Click Dashboard > Dashboard >System Monitor > Services.
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2. Inthe Services section, you can view the following information about the system’s
processing services:

ORACLE’
Financial Services Lending and Leasing

& Welcome, PRAKRRAO o

: Close
DpashBoard System Monitor 5 —
DashBoard

DashEoard

Users Praductivity .

System Monitor Services

Producer Analysis Vieww Formatv | B e

Progess Files Semce

BatchJobs  Jobs | Services Database Server Log Files | Parked Transactions | Users

! Detach Wrap @) @ status st Clstop
Description

CREDIT BUREAU SERVICE (EFX TEST FILES)
UREAL SERVICE (EXP TEST FILES)

Company Branch
v AL AL
sV AL ALL CRED)
v AL AL CREDIT BUREAU SERVICE (TUC TEST FILES)
B5C AL ALL JOB SCHEDULER
sV AL AL JOB SERVICE

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

A brief description of the fields is given below:

Field: View this:

Service Display the service name.
Company Display the service company.
Branch Display the service branch.
Description Display the service description.
Status Display the service status.

3. Inthe Action section, select the processing service you want to work with and choose
one of the following commands in Action section.

Choose: System:

Status Refreshes (updates) the status of service. The Service screen does
not update the status in real time. You must choose Status after
choosing Start or Stop to perform that command.

Start Starts the job service.

Stop Stops the job service.

344 Database Server Log Files

Various processes in the system create reports in different log files with regards to what tasks
they performed and what they encountered (for example, errors, failures, erroneous data and
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so on). The Database Server Log files tab lists and describes all such log files within the
system on the database server.

To view a log file on the database server
1. Click Dashboard > Dashboard > System Monitor > Database Server Log Files.

ORACLE’ oW ABSHEKAR ~ i Signout
Financial Services Lending and Leasing
@ Svstem Monitor (3] Close
Batchlobs Jobs | Services  Database Server Log Files | Parked Transactions | Users 2
DashBoard
DashBoard e Database Server Log Files
DashBoard | Wity .1 Do ek L o B B Doy EndDt L @8 View © Aert® Debug () Interfaces
Users Productivity = -
View » Format = Freeze (i Detach urap 5 UistFlles Download File =
System Maritor & s @ 3= &
¥t A L File Name File Type File Size File Time
o T xaeprc_em_100_02_FMW116_7033906.log fie 159179 08/31/2017 02:28:52 AM -
JSVPRC_EN_000_01_DB12102_6974056.log file 171338 08/29/2017 07:42:07PM [
JSVPRC_EN_000_01_DB12102_7283869.log file 19897 09/10/2017 10:39:59 AM
g XAEUPD_EM_100_02_FMWW 116_7203940.log fie 26704 09/07/2017 03:50:43 AM
RDNLOG_EW_100_01_FMW116_7284144.log file 1108 09/08/2017 06:00:34 AM -
> Origination Fle:Conimat
View = Format * Fr & Detach Nrap @ Beginning © End £ ofLines 50 Show File
> Servicing e @ a8
- Text
& Colerions 08/31/2017 12:35:32: cmnini cl 000 0i.initialize svc -
> WEP 08/31 :32: cmnsyp_cl_00 get_syp paramever value parameter: XAEPRC EM 100 02 _DEBUG_LEVEL
> Tools 2: xaeprc_em submit for Bpp No:
: User code: INTERNAL
> Setup = x
2: 1v_statement - SELECT ptc_cur_currency code FROM xae ptc_evw WHERE FTC_COMEANY = :bl 1 |-

2. In the Database Server Log Files section, you can sort the list of logs to be displayed
based on following options:

e Select the ‘View Last’ option to display the logs based on elapsed days by selecting 1
Day /1 Week /1 Month / By Date. If ‘By Date’ option is selected, you can specify a date
range (within 3 months) in ‘Start Dt’ and ‘End Dt’ fields using the adjoining calendar.
Click ‘Search’.

e Select the ‘View’ option to further filter the list based on the type of logs to be displayed
by selecting Alert / Debug / Interfaces.

3. Click on = List Files button to view the list of logged files. A brief description of the fields
are given below

Field View this:

File Name Displays the name of file.

File Type Displays the type of file.

File Size Displays the size of file.

File Time Displays the date and time stamp of file.

4. To extract a local copy of debug details, click & Download File button and save the file.

5. Inthe File Content section you can view the content of the file selected in the Database
Server Log Files by clicking & Show File button.

6. To sort the view of file contents, select the order as either ‘Beginning’ or ‘End’ and specify
the value for ‘# of Lines’ to be displayed (default 50).

3.4.5 Monitoring Users

The Users Logins section allows you to view all users who have logged on to the system,
along with the log on time stamp and logout time stamp. The information appears in reverse
chronological order of the log on time stamp.
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3.4.6

To monitor users who have logged on to the system

1. Click Dashboard > Dashboard >System Monitor > Users.

ORACLE' e, ABSHEKAR 1 Signout &
Financial Services Lending and Leasing

System Monitor [®Close
Batch Jobs || Jobs  Services  Datsbase Server Log Flles | Parked Transactons  Users 2
User Logins
View v Formatv P Freeze i Detach Wrap ) ViewLast © 1Day @ 1Week © 1 Month () By Date  start Dt = EndDt & View User ) Current User @ Al Users
User User Name: Detaiis Login Date and Tine 102247021 and
SURABHI SURABHI DESAL 09/20/2017 04:56:... 12/30/4000 12:30:...
SURABHI SURABHI DESAT 09/20/2017 04:44:... 12/30/4000 12:30:...
ABSHEKAR ANAND SHEKAR 09/20/2017 04:38:... 12/30/4000 12:30:...
PRITAM PRITAM JENA 09/20/2017 04:30:... 12/30/4000 12:30:...
SKSK SALSK 09/20/2017 03:54:... 12/30/4000 12:3
> PRITAM PRITAM JENA 09/20/2017 03:47.., 12/30/4000 12:30:... | (%
NAVEEN NAVEEN RECDY 09/20/2017 03:47:... 09202017 04:55:...
IAYANTA JAYANTA C 09/20/2017 02 12/30/4000 12:30:
SKSK SAISK 09/20/2017 02:35:... 12/30/4000 12:30:
NAVEEN NAVEEN RECDY 09/20/2017 02:08:... 12/30/4000 12:30:
PRITAM PRITAM JENA 09/20{2017 01:45:... 12/30/4000 12:30:
IAYANTA JAYANTA C 09/20/2017 01:45:... 09/20/2017 02:37:
PRITAM PRITAM JENA 09/20/2017 01:27;... 12/30/4000 12:30:
svsv SHRIVATS SINGH 09/20/2017 01:20:... 12/30/4000 12:30:
NAVEEN NAVEEN RECDY 09/20/2017 01:14:... 12/30/4000 12:30
NAVEEN NAVEEN RECDY 09/20/2017 12:39:... 12/30/4000 12:30:
ABSHEKAR ANAND SHEKAR 09/19/2017 11:45:... 12/30/4000 12:30;
PHACHCODA PHANINDRA CHODA 09/19/2017 11:37:... 12/30/4000 12:30
NAVEEN NAVEEN RECDY 09/19/2017 11:32:... 12/30/4000 12:30
NAVEEN NAVEEN REDDY 09/19/2017 11:21:... 09132017 11:32: 5

2. Inthe User Logins section, sort the list of records to be displayed based on elapsed days
by selecting 1 Day / 1 Week / 1 Month / By Date. If ‘By Date’ option is selected, you can
specify a date range (within 3 months) in ‘Start Dt and ‘End Dt’ fields using the adjoining
calendar. Click ‘Search’.

A brief description of the fields is given below:

Field: View this:

User Displays the user ID.
User Name Displays the user name.
Details Displays the details.

Login Date and Time | Displays the login date time for the user.

Logout Date and Time | Displays the logout date time for the user.

Monitoring JMS Queues

OFSLL uses MDB infrastructure as an interface for asynchronous communication with third-
party integrated applications and all the outgoing communications through all the interfaces
are tracked in ‘JMS Queues’ tab.

The ‘JMS Queues’ tab in System Monitor screen facilitates as a dashboard to monitor the
status of all the configured MDB (Message-Driven Bean) queues and provides a statistics of
the total messages / requests that are sent from OFSLL to external system along with their
status.

The ‘JMS Queues’ tab has the following sub tabs:

e Status sub tab - to view the last status of configured MDB
e Messages sub tab

— To view the list of configured interfaces and total messages triggered to the
interface.

— To view the status of response for the message received from the interface.
— To ‘Re-submit’ failed messages.
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To view the status of all the configured MDB

1. Click Dashboard > Dashboard > System Monitor > JMS Queues. The Status sub tab
is displayed by default.

ORACLE’

Financial Services Lending and Leasing

# Welcome, ABSHEKAR v o

System Monitor

Status = Messages

Status

View * Format v

&
Service
BIF MDB
i DLR TRACK MDB
EFX MDE
EMAIL MDB
EXP MDE
GAL MDE
GRI MDE
POST DEALER. MDE
ROUTECNE MDE
TORQUE ITS MDB

Batch Jobs  Jobs  Services  Database Server Log Files | Parked Transactions  Users  JMS Queues

[#] Close

Freeze ﬁ' Detach @E} G Status

Description Last Updated Status
BIF INETRFACE MDB

DEALER TRACK INTERFACE MDB

EFX INTERFACE MDB

EMAIL MDB

EXP INTERFACE MDB

GENERIC AUCTION INTERFACE MDB
GENERIC RECOVERY INTERFACE MCB
POST DEALER INETRFACE MDB
ROUTEQNE INTERFACE MDB
TORQUE ITS INTERFACE MDB

2. Inthe ‘Status’ section, you can view the following details of configured MDB:

Field View this:

Service Displays the name of the message service suffixed by MDB to
differentiate the different MDB services.

Description Displays the description or abbreviated name of MDB inter-
face.

Last Updated Status | Displays the status of MDB interface. Following are the status
displayed:
* UNKNOWN - indicates that no MDB infrastructure is con-
nected or status ping message is not sent to that MDB.
+ SUBMITTED - indicates that a dummy ping message is sent
to MDB.
* RUNNING - indicates that the message is consumed by
MDB infrastructure.
+ STOPPED - indicates if MDB infrastructure is down.

3. Inthe ‘Status’ section, select the required service for which you need the status and click
Click & button. On clicking, a dummy ping is sent to the interfaced server and status in
‘Last Updated Status’ column is updated as ‘SUBMITTED’.

4. Click @ (refresh) button, to fetch the latest status and the response received is updated

in ‘Last Updated Status’ column.
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To view the messages triggered to all configured MDB
1. Click Dashboard > Dashboard > System Monitor > JMS Queues > Messages tab.

ORACLE’ # Welcome ABSHEKAR v o
Financial Services Lending and Leasing

System Monitor [3] Close
BatchJobs Jobs Services | Datmbase Server Log Files | Parked Transactions ' Users ~JMS Queues Events @
Status  Messages
Company ALL v View Last (O 1 Day(O 1 Week®) 1 MonthO By Date  Start Dt End Dt @
Messages
! Detach Wrap ®
Service Description Submitted Completed Falled Resubmitted
WEBHOOK MDB  WEBHOOK MDB 132 18 104 3
EXP MDB EXP INTERFACE MDB 3 3 0 0
EVENTS MDB EVENTS MDB 145 145 0 0
Message Details (5] view
View v Format~ [ Freeze [ Detach Wrap W
»
Message ID Request Type Request SubType  Message Type Status Message Content Time
95F4139888951EB... OUTBOUND EVENTS EVENT_ACTION ~ COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TY VI I _TYPE=TXN... 10/28/2019 02:03... A
95F428A97024209... OUTBOUND EVENTS EVENT_ACTION ~ COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=20190100034443|EVENT_TYPE=TXN... 10/28/2019 02:07.
95F642DA46FS57... OUTBOUND EVENTS EVENT_ACTION ~ COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=20100100034443|EVENT_TYPE=TXN... 10/28/2019 04:38.
96067A77ED607A... OUTBOUND EVENTS EVENT ACTION  COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=DEMO-MOTORCYCLES-ASSOCIATE-0... 10/28/2019 11:50...
96067A77ED627A... OUTBOUND EVENTS EVENT_ACTION ~ COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=DEMO-MOTORCYCLES-ASSOCIATE-0... 10/28/2019 11:59...
96067A77EDG47A... OUTBOUND EVENTS EVENT_ACTION ~ COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=DEMO-MOTORCYCLES-ASSOCIATE-0... 10/28/2019 11:59...
96067A77EDSE7A... OUTBOUND EVENTS EVENT_ACTION  COMPLETED REQUEST_TYPE=OUTBOUNDSUB_TYPE=EVENTS|ENTITY_NBR=DEMO-MOTORCYCLES-001|EVENT_T... 10/28/2019 11:59.
960B86096B66037... OUTBOUND EVENTS EVENT_ACTION ~ COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=20181100045447|EVENT_TYPE=TXN... 10/29/2019 06:00.
960B86006B6A03... OUTBOUND EVENTS EVENT ACTION  COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=20190100001582|EVENT_TYPE=TXN... 10/29/2019 06:00...
960B8609686C03... OUTBOUND EVENTS EVENT ACTION ~ COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=20190600062140|EVENT_TYPE=TXN... 10/29/2019 06:00... V
Response Message Details
View v Format v Freeze (i Detach Wrap @ Viewoption ® BeginningOEnd  # Of Characters 50 [E] show File [ show Al
Text
No data to display.
< )
v

2. Inthe ‘Messages’ section, filter the list of messages using the following options:

— Select the required Company from the drop-down list to view JMS message at
company level. The list is populated only with those Company Definitions to which
you have been provisioned access. By default, ‘ALL’ is selected.

— Select the ‘View Last’ option to display the messages based on elapsed days by
selecting 1 Day (default) / 1 Week /1 Month / By Date. If ‘By Date’ option is selected,
you can specify a date range (within 3 months) in ‘Start Dt’ and ‘End Dt’ fields using
the adjoining calendar.

3. The ‘Messages’ section displays the list of configured interfaces and the total of
messages exchanged between OFSLL and MDB in Submitted, Completed, Failed and
Resubmitted status. Click &l (refresh) button to update the latest status.

4. In the ‘Messages’ section, you can view the following details:

Field View this:

Service Displays the name of the message service suffixed by MDB to
differentiate the different MDB services.

Description Displays the description or abbreviated name of MDB inter-
face.

Submitted Displays the total count of requests submitted.

Completed Displays the total count of requests completed.

Failed Displays the total count of requests failed.

Resubmitted Displays the total count of only those requests which are

failed and resubmitted again for processing.

To ‘Re-submit’ failed messages
1. Click Dashboard > Dashboard > System Monitor > JMS Queues > Messages tab.

2. Inthe ‘Messages’ section, select the required MDB interface.
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3. The ‘Message Details’ section below displays the list of messages sent to the interface
with the following details:

Field View this:
Message ID View the system generated MDB message ID
Request Type View the message request type

Request SubType View the message request sub type

Message Type View the message identifier
Status View the message processing status
Response This column data is displayed only for Webhook MDB.

View the HTTP Header received as response during Web-
hook event action invocation.

Message Content View the message content

Time View the message time stamp

4. Inthe ‘Message Details’ section, select the message in ‘Failed’ status. Click [@l (refresh)
button to update the latest status.

5. (Optional) You can click ‘View’ to display the selected record in ‘Message Details’ section.
6. Click B Re-submit. The details are triggered again for processing and the ‘Resubmitted’
counter in ‘Messages’ section is updated along with other counters.

Response Message Details

This section is enabled if Events or Webhook type of MDB service is selected in Message
section and displays the request Message Details that is propagated to external system for
the posted event action.

To view ‘Response Message Details’ of an Event
1. Select the required record from the Message Details section and click ‘Show File’.

e The first 50 characters of the request in json format is displayed since the default
preference selected is ‘Beginning’ in View option and ‘# of Characters’ is set to 50.

2. You can customize the preference using View Option (Beginning / End) and specifying
the number of characters to be displayed.

3. Also you can click ‘Show All’ to display the complete request.

Monitoring Events

The Events screen is a dashboard to view all the Events triggered in the system. In the Events
screen you can view the latest status of all the processed events and ‘Re-submit’ only failed
events for re-processing. However, this is a display-only field and does not allow to modify the
defined event action parameters.

The Events screen has the following sections:

e Event Actions
e Action Parameters

In the ‘View Options’ section, you can filter and view the list of Events based on following
Status:
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e ALL
e SUBMITTED

e WAITING FOR USER INPUT
e COMPLETED

e FAILED

e CRITERIANOT MET

e VOID

In the ‘View Last’ section, you can further sort the volume of records displayed on the Events
screen with the following options:

Select: System Displays:

1 Day List of all events posted in last one-day.

1 Week List of all events posted in last one-week.

1 Month List of all events posted in last one-month.

By Date List of all events posted between specific dates. You can specify a date
range (within 3 months) in ‘Start Dt’ and ‘End Dt fields using the adjoin-
ing calendar.

To View the Events triggered in the system

1. On the Oracle Financial Services Lending and Leasing home screen, Click Dashboard >
System Monitor > Events tab.

ORACLE’
Financial Services Lendi

ng and Leasing

Welcome ABSHEKAR o

a

System Monitor

Event Actions
View Options  ALL

View > Format~ [}
Entity Nbr Event Code

Freeze

ASSO_ABHI_INT_...

Action Parameters
Formatv [
Description

REQUEST TYPE
SOURCE

REPORT

CUSTOMER RELATION

View v Freeze

LINK_ABHI_INT_0... EVENT TO PROCE...
LINK_ABHI_INT_0... EVENT TO PROCE...
LINK_ABHI_INT_O... EVENT TO PROCE...
» LINK_ABHI_INT_0... EVENT TO PROCE...
EVENT TO PROCE...

BatchJobs Jobs Services Database Server Log Files Parked Transactions Users JMS Queues Events

View Last O 1 Day(O 1 Week(®) 1 Month O By Date  Start Dt

\i Detach
Event Query
PENDING_EVENT_ACTIONS
PENDING_EVENT_ACTIONS
PENDING_EVENT_ACTIONS
PENDING_EVENT_ACTIONS

Wrap

i Detach Wrap

EVENT_ACC_UPDATE_BATCH_LOAN

@ [B Re-submit

Event Action
REQUEST FOR CR...
SEND LETTER
CREATE REVIEW ..
CREATE WORK OR...
CREATE REVIEW

@

End Dt

Process Type
ONLINE
ONLINE
ONLINE
ONLINE
BATCH

Failure Count
0

0
0
0
0

Value Type
CONSTANT
CONSTANT
CONSTANT
USER INPUT

[3] Close

Status

FAILED

WAITING FOR US...
WAITING FOR US...
WAITING FOR US...
COMPLETED v

Run Dt
11/01/2019 03:07... A

Value
MANUAL
EXp
FICO

Required

2. By default, the Events screen displays all events posted in last one day.
3. Inthe ‘Event Actions’ section, view the following information:
Field: View this:
Entity Nbr Entity Number on which event generated.
Event Code Event Definition Description.
Event Query Event Criteria Definition Description.
Event Action Event Action Description.
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Field: View this:

Process Type Event processing type as either Online/Batch fetched
from EVENT_PROCESS_TYPE_CD lookup.

Failure Count Number of times the event processing has failed.

Status Event action with following execution status:
CRITERIA NOT MET

SUBMITTED

VOID

COMPLETED

FAILED

ALL

WAITING FOR USER INPUT

Run Dt Event Action Generation Date and Time.

4. Inthe ‘Action Parameters’ section, view the following information:

Field: View this:

Description Event Action Parameter Description.

Value Type Event Action Input Parameter Type.

Value Value defined for the event action.

Required Y/N indicating if the Action Parameter is mandatory.

Re-submit Failed Events

In the Events screen you can filter and re-submit only the ‘FAILED status Online Event
Actions’ for processing. An Event is marked with ‘Failed’ status when the same could not be
processed in the system due to setup/infrastructure issues. This is an additional option to re-
process the event actions. On resubmitting an event, the Failure Count against the record is
incremented by 1.

However, ‘Resubmit’ option is not allowed for Webhook and SEND JMS MESSAGE actions
since the same functionality is available in JMS Queues.

In the ‘Event Actions’ section, select the required event record listed with status FAILED and

click ‘RE-submit’. On triggering the event, the ‘Run Dt column is updated with Event Action
Generation Date and Time. Click ‘Refresh’ to fetch the latest status.

Producer Analysis

The Producer analysis screen enables you to view and know the status of all applications
sourced by different Producers.
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Navigating to Producer Analysis
Click Dashboard > Dashboard > Producer Analysis.

ORACLE’ . . 5 # Welcome, PRAKRRAO v o
Financial Services Lending and Leasing
Producer Analysis 5
Select Criteria
Users Productivity
System Monitor Company ALL [v] Territory - Funder AL 3] —
Producer Analysis Branch ALL[w] Sales Agent ALL [~] Status - = v
Process Files
TmeEhE Region AL [v] Undenwriter ALL [v] zip v
Producers | Terrtories Activity | Volume || Mix
> Dealer
> o
Recent Activity
MonBE th digiy, Last Funded Approved Funded Comments
No data to display.
Recently Approved Applications
Applicant Name _ Application # Amt Collateral Desc
Mo data to display.
‘4
Recently Funded Applications
Applicant Name Application # Amt Collateral Desc
No data to display.
4
Recent Comments
&f petach Wrap
Date Comment Desc
No data to display.
> Origination
> Servicing
> Collections
> WFP
> Tools
> Setup

[ Close.

You can filter producer details based on any or all of the following criteria:

e Company

e Branch
e Region
e Territory

e Sales Agent
e Underwriter
e Funder

You can select the values from the adjoining drop-down list. Click ‘Submit’ button. System

displays the Producer details satisfying the criteria, you selected.

The following details are displayed under Producer Details section:

e Producer #
e Name

e Company
e Branch

e Type

Select the producer you need to view the statistics. The system displays the statistics under

‘Summary’ sub tab and the status and sub status of various applications under ‘Applications’

sub tab, of the selected producer.

The system displays the following details under ‘Summary’ sub tab:

e Year
e Total Apps
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Approved
Conditioned
Rejected
Withdrawn
Funded
Amount

The system displays the following details under ‘Applications’ sub tab:

Company
Branch
App #
Date

Title
Product
Status

Sub Status

Process Files

The Process files screen allows you to view the incoming and outgoing files exchanged
between OFSLL and other interfaced systems for processing and also perform a bulk upload
of required files.

The Process files interface also provide information on the type of files uploaded along with
other attributes. In-order to facilitate the process files handling, the following parameters has
to be enabled in Setup > Administration > System > System Parameters screen. For more
information on enabling system parameters, refer to ‘System Parameters’ section in Setup
Guides.

CMN_FILE_PROCESS _TO_LOB

On enabling the above parameter, system stores the incoming / outgoing documents in
the relevant tables and not in the file system.

UIX_INCOMING_FILE_PATH

UIX_OUTGOING_FILE_PATH

On enabling the above two parameters, the incoming and outgoing file path of
application server need to be defined to the required folder path by updating the
‘Parameter Value’ which by default is ‘SETME’. (For example: /tmp)

If both the parameter ‘CMN_FILE_PROCESS_TO_LOB’ and ‘OUTBOUND_CALL_Q’
are enabled (status ='Y"), system automatically handles upload/download of files from
Weblogic configured process files.

Depending on the CLOB parameter option, if set to ‘Y’ the incoming/outgoing file directories
are to be manually created in Web Logic server. For details of directories, refer to ‘Creating
Application Home directory’ section in Database Installation Guide.
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Incoming Process File

The incoming process file screen displays the list of files being shared from an external
system along with other attributes such as directory path, file name, type, size, date and
status. You can select the file required and upload it into the system for immediate processing.

ORACLE’

Financial Services Lending and Leasing

SHEKAR v 1 sgnout O

Process Files

Incoming Process File  Outgeing Process File

Incoming Process File

view ~ Format + B
¢en

select Al [

Freeze  FfiDetach

Directory Name

" uploaded Files
View * Format~  [EF

File Name

SampleR esponseAssets.json
SampleResponseAssets. json
LookupResponseWithLookupDescPassedAs_CALC.json
LookupR espanse\With ookupDescPassedAs_CALC json
LookupResponseWithl ookupDescPassedAs_CALC json
LookupResponseWithl ookupDescPassedAs_CALC json
LookupResponseWithLookupDescPassedAs_CALC json
LookupRespanse\WithLookupDescPassedAs_CALC json
LookupResponseWithl okupDescPassedAs_CALC json
LookupResponseWithl ookupDescPassedAs_CALC json

Freeze  EfiDetach

@

2= List Files

File Name

[} Jscratchfwork_area/DEV/DE. . callactivity_test XV.tet

B upload

File Type

W) Viewlast © 1Day® 2Days® 5Days@® Al Days

Fie Type

FACTORY DATA LPLOAD
FACTORY DATA LPLOAD
FACTORY DATA UPLOAD
FACTORY DATA LPLOAD
FACTORY DATA UPLOAD
FACTORY DATA LPLOAD
FACTORY DATA UPLOAD
FACTORY DATA LPLOAD
FACTORY DATA LPLOAD
FACTORY DATA LPLOAD

File Dt

08/14/2017 12:41:17 PM
08/14/2017 12:39:22PM
08/04/2017 01:07:23 PM
08/04/2017 11:45:18 AM
08/04/2017 01:26:24 AM
08/04/2017 01:20:29 AM
08/03/2017 09:37:30 PM
08/03/2017 09:34:58 PM.
08/03/2017 02:23:56 AM
08/03/2017 02: 18:27 AM

[E@ Download Bad Data
Status
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED

File Size(bytes)

39 08/12/2016 05:23:01 AM NONE

[ Download Log Data

File Date

[®] Close

)

Status

User
INTERNAL INT %
INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT —

View the list Incoming Process File

1. Click Dashboard > Process Files > Incoming Process File.

2. Inthe Incoming Process File section, click List Files. System displays the list of incoming

files.

A brief description of the fields is given below:

Field:

Description:

Select All

Select this option to select all the listed files.

Directory Name

View the directory path where incoming file is stored.

File Name

View the name of the file.

File Type

View the type of incoming file. The file type is auto populated
based on ODD (Output Data Definition) details maintained for
the specific file type in INCOMING_FILE_TYPE_CD lookup.

File Size(bytes)

View the size of incoming file.

File Date

View the date and time when the incoming file was placed in

the directory.

Status

View the status of the file.

Upload Incoming Process File

1. Click Dashboard > Process Files > Incoming Process File.

2. Inthe Incoming Process File section, click List Files. System displays the list of incoming
files. You can click L2l to refresh the grid data.

3. Select the check box adjacent to the required file and click Upload. You can also click

Select All check box to perform a bulk upload of all the listed files.
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3.6.2

The uploaded files are listed in below ‘Uploaded Files’ section and the status of the files
are changed from ‘Generated’ to ‘Uploaded’. In case of a processing error, the status of
the file is indicated as ‘Processed Error’.

Uploaded Files

The uploaded files section displays the list of incoming files uploaded into the system. You
can sort and view the list of files depending on the number of days based on Last 1 Day / 2
Days / 5 Days / All Days. You can click X2 to refresh the grid data.

On selection, you can view the following information:

Field: Description:

File Name View the name of file uploaded.

File Type View the type of file uploaded.

File Dt View the date and time when the file was uploaded.
Status View the status of upload.

User View the login ID of User who performed the file upload.

In the Uploaded Files section, you can do the following:

e Click Download Bad Data to download the list of uploaded files which had processing
errors due to bad data.

e Click Download Log Data to download a log of all the files uploaded.

Outgoing Process File

The outgoing process file section displays the list of files being shared for upload to other
system for processing and allows you to download the required file for inspection.

Financial Services Lending and Leasing
Process Files (%] Close
Incoming Process Fle  Outgoing Process File 2
Outgoing Process File
View v Format~ Freeze i Detach o] irap @R G Download  View Last @ 1Day (D 2Days (D) 5Days @ Al Days
selectal O] File Name File Type File Date: File Size(bytes) Status
customer_ach OUT PUT DATAFILE 07/10/2017 05:29:20 PM 533 GENERATED &
] customer_ach OUT PUT DATAFILE 07/10/2017 05:20: 19 PM 533 GENERATED A
0B customer_ach OUT PUT DATAFILE 07/10/2017 05:29:18 PM 533 GENERATED 1
] customer_ach OUT PUT DATAFILE 07/10/2017 05:20:17PM 533 GENERATED
) customer_ach OUT PUT DATAFILE 07/10/2017 05:29:15PM 533 GENERATED A
i = customer_ach OUT PUT DATAFILE 07/10/2017 05:29:15 PM 533 GENERATED |
[ data_change_lien_07102017_172914.dat OUT PUT DATAFILE 07/10/2017 05:29: 14 PM 0 GENERATED
B customer_ach OUT PUT DATAFILE 07/10/2017 05:29: 13PM 533 GENERATED
B customer_ach OUT PUT DATAFILE 07/10/2017 05:20: 12 PM 533 GENERATED
] customer_ach OUT PUT DATAFILE 07/10/2017 05:20: 11 PM 533 GENERATED -
History
View » Format~  [EP Freeze i Detach 1] irap 150
User Download Dt
DILEEP GRANDHI 08/10/2017 06:42:22 PM
DEMO SUPERUSER 07/31/2017 03:28:20 PM -

You can sort and view the list of files depending on the number of days based on Last 1 Day
/ 2 Days / 5 Days / All Days.
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On selection, you can view the following information:

Field: Description:

Select All Select this option to select all the listed files.

File Name View the name of upload file.

File Type View the type of file shared for upload. The file type is auto pop-

ulated based on ODD (Output Data Definition) details main-
tained for the specific file type in OUTGOING_FILE_TYPE_CD

lookup.
File Date View the date and time when the file was shared for upload.
File Size(bytes) View the size of upload file.
Status View the status of upload file.

Download Outgoing Process File

1. Click Dashboard > Process Files > Outgoing Process File.

System displays the list of files shared for upload. You can click ¥ to refresh the grid
data.

2. Select the check box adjacent to the required file and click Download. You can also click
Select All check box to download all the listed files.

History

The history section displays the following details:
Field: Description:
User View the login ID of User who downloaded the file.
Download Dt View the date and time when the file was downloaded.
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4. Sales Lead

The Sales Lead screen enables you to record information gathered during a sales query or a
call from a potential borrower. A sales representative can then use the Sales Lead screen to
follow-up with the borrower. This is not a mandatory screen. You can always begin the Line
of credit origination process directly using the Application Entry screen.

Information on the Sales Lead screen can be attached to the Application Entry screen as
optional information. Attaching a lead to an application can help the sales department analyse
the effectiveness of following-up with prospective borrowers. Once a lead is attached to an
application from the Sales Lead screen, Oracle Financial Services Lending and Leasing
changes its status to COMPLETED.

Lead Entry screen

The Lead Entry screen enables you to record information regarding prospective borrowers
from a sales query or a call to be used in a follow-up call. The initial status for the lead can be
set as NEW or FOLLOW-UP.

To complete the Lead Entry screen

1. On the Oracle Financial Services Lending and Leasing home screen, click Origination
underSales Lead.

2. Onthe Sales Lead screen, click the Lead Entry.

ORACLE
Financial Services Lending and Leasing

& Welcome, PRAKRRAO ~ (=]

Sales Lead () Clos=

vashBoard

Lead Entry | Follow Up | Maintsnance

Applicant Information & add || 2 edie
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3. If you are entering a new applicant, click Add in the Applicant Information section.
_or'_
If you want to edit an existing applicant, select it in the Applicant Information section.

If you click Previous, Oracle Financial Services Lending and Leasing displays
information for the previous applicant. If you click Next, the system displays information
for the next applicant.

4. In the Applicant Information section, enter, view or edit the following information:

In this field: | Do this:

Lead # View the sales lead number (display only).
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In this field:

Do this:

Lead Date View the sales lead date. System defaults the current date
(display only).

Company Select the company name (required).

Branch Select the branch name (required).

First Name Enter the applicant’s first name (required).

Birth Dt Specify the date of birth. (required).

Last Name Enter the applicant’s last name (required).

Channel Select the channel of the sales lead (required).

Source Select the source of the sales lead (required).

5. Inthe Address section, enter, view or edit the following information:

— For creating a new record, click Add.

In this field: | Do this:
Type Select the address type (required).
Postal Type | Select the postal address type (required).
Apt# Enter the building number (optional) .
Pre Select the street prefix (directional) (optional).
Street Name | Enter the street name (optional).
Street Type | Select the street type (optional).
Post Select the street postfix (directional) (optional).
Apt # Enter the apartment number (optional).
Address 1 Enter the first address line (optional).
Address 2 Enter the second address line (optional).
City Enter the city (required).
St Select the state (required).
Zip Select the zip code (required).

Note: For non US country, you have to enter zip code.
Country Select the country code (required).
Email Enter the e-mail address (optional).
Alternate Enter the Alternate e-mail address (optional).
Email
Status Select the status for the sales lead (required).
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In this field: | Do this:

Assigned View the user code creating the sale lead (display only).
By

Status Dt View the last sales lead status change date (display only).
Follow-up Enter the sales lead follow-up date (required).

Dt

— If you enter a new record in the Address section, click Save.

411 Telecoms sub tab

The Telecoms sub screen records additional phone numbers for the sales lead.

To complete the Telecoms sub tab

1. On the Oracle Financial Services Lending and Leasing home screen, click the Sales
Lead master tab.

2. Onthe Sales Lead screen, click the Lead Entry tab, then click the Telecoms sub tab.
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3. On the Telecoms sub tab, enter, view or edit the following information:
— To create a new record, click Add.

In this field: | Do this:

Telecoms section

Telecom Select the type of telecommunications device
Type (required)

Phone Enter the phone number (required)

Current Select the Current check box to indicate the phone

number is in service.

— If you enter a new record in the Telecoms sub tab, click Save.

4.1.2 Comments sub tab

The Comments sub tab records any comments regarding the sales lead.
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To complete the Comments sub tab

1. On the Oracle Financial Services Lending and Leasing home screen, click Sales Lead.

2. On the Sales Lead screen, click the Lead Entry tab, then click the Comments sub tab.
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> Servicing
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> WEP

> Tools
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3. Onthe Comments sub tab, enter, view or edit the following information:
— If you are creating a new record, click Add..

In this field: | Do this:

Comments section

Comment Select the comment type (required).
Type

Sub Type Select the comment sub type (required).

Comment Enter the comment (required).

Comment View the date the comment was entered and saved (dis-
Dt play only).

Comment View the user id of the person who entered and saved
By the comment (display only).

e If you enter a new record in the Comments sub tab, click Save.

41.3 Documents sub tab

The Documents sub tab needs to be completed if:

e The customer had requested any documents.

e Any document has been sent to the customer during sales lead entry.
To complete the Documents sub tab

1. On the Oracle Financial Services Lending and Leasing home screen, click the Sales
Lead master tab.
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2. Onthe Sales Lead screen, click the Lead Entry tab, then click the Documents sub tab.
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3. On the Documents sub tab, enter, view or edit the following information:

— If you are creating a new record, click Add.

In this field: | Do this:

Documents section

Document Select the document type (required).

Type

Sub Type Select the document sub type (required).

Documents | Enter the document (required).

Document View the date the document was entered and saved (display
Dt only).

Document View the user id of the person who entered and saved the
By document (display only).

— If you enter a new record in the Documents section, click Save.

Requests sub tab

The Requests sub tab records the product the customer is interested in and the requested

amount for each product.

To complete the Requests sub screen

1. On the Oracle Financial Services Lending and Leasing home screen, click the Sales

Lead master tab.

2. On the Sales Lead screen, click the Lead Entry tab, then click the Requests sub tab.

3. On the Requests sub screen, enter, view or edit the following information:

— If you are creating a new record, click Add.

In this field: | Do this:

Requests section
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In this field: | Do this:

Product Enter the requested product as Line of credit
(required).

Requested Enter the requested amount (required).
Amount

e If you entered a new record in the Requests section, click Save.

Follow-Up screen

The Follow-Up screen enables you to update customer information based on sales lead
follow-ups with the customer.

To use the Follow-Up screen

1. On the Oracle Financial Services Lending and Leasing home screen, click the Sales
Lead master tab.

2. Onthe Sales Lead screen, click the Follow-Up tab.

3. In the Status section, click:
— New to view all leads on the Follow-Up screen with the status of NEW.
-or-
— Follow Up to view all leads on the Follow-Up screen with the status of FOLLOW UP.
-or-
— All to view all leads on the Follow-Up screen.
4. In the Assigned section, click:
— Assigned By to view all leads on the Follow-Up screen assigned to the current user.
-or-
— All to view all leads on the Follow-Up screen assigned to any user.

5. On the Follow-Up screen, enter, view or edit the following information:

In this field: | Do this:

Company View the company name of the sales lead (display only).

Branch View the branch name of the sales lead (display only).

Followup Dt | Select the follow-up date of the sales lead (required).

Lead # View the sales lead number (display only).
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In this field: | Do this:

Lead Date View the creation date of the sales lead (display only).
Name View the applicant’s name (display only).

Last Name View the applicant’s last name.

First Name View the applicant’s first name.

Assigned View the user assigned to the sales lead (display only).
by

Status Select the status of the sales lead (required).

Status Dt View the last sales lead status change date (display only).

6. Click Save on the Follow-Up screen.

Maintenance screen

The Maintenance screen enables you to attach a sales lead to a different or missed
application or change status of lead as NEW.

To attach a sales lead to an application

1. On the Oracle Financial Services Lending and Leasing home screen, click the Sales
Lead master tab.

2. On the Sales Lead screen, click the Maintenance tab.

3. Inthe Lead Details section, view the following display only information:

In this field: | Do this:

Select If selected, indicates this is the current record.

Lead # View the sales lead number.

Last Name View the last name of the sales lead.

First Name View the first name of the sales lead.

Status View the status of the sales lead.

Company View the company of the sales lead.

Branch View the branch of the sales lead.

Days of View the number of days of inactivity regarding the sales
Inactivity lead.

4. Inthe Lead Details section, select the sales lead you want to attach to the application.
5. In the Action section, click Attach to an Application.

6. Inthe Action section, select the application number to which you want to attach the sales
lead in the unlabelled App # field.

7. In the Action section, click Post.
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In the Application section, view the following display only information:

In this field: View this:
Select If selected, indicates this is the current record.
Priority The priority of the sales lead.
Application # The application number of the sales lead.
Date The date of the application.
Title The title of the application.
Product The product of the application.
Status The status of the application.
Producer The producer of the application.
Note

If a wrong sales lead is attached to an application, detach it from the existing application
by clicking Change to New Status in the Action section. You can then attach it to the cor-
rect application clicking Attach to an Application, completing the App # field and clicking

Post.
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5.2

5. Simple Application Entry

Introduction

The first step in the Line of credit origination process is entering credit application data into
Oracle Financial Services Lending and Leasing Application. The Simple Application Entry
screen enables you to specify information from the credit application into the system and
request a credit bureau report.

This chapter explains how to use the Applications screen to specify and validate a credit
application.

Entering a Credit Application

There are four main steps in entering an application

1. Select product type and producer at the top of the Application screen in the Applications
section. The product defines the type of credit application: Line of credit as well as any
collateral, such as vehicles or homes, associated with the Line of credit. When you save
the application, system activates the links on Applications screen that are associated with
the product, streamlining the application process. The producer is the dealer supplying
the application. When selected, the status of the Producer is displayed along with
Producer Name.

2. Enterinformation regarding the primary applicant, such as name, social security number,
address, place of employment and financial assets and liabilities. Enter this same
information for any other applicants, such as co-signers or joint applicants, if they exist.
System displays the error message as “The Application does not exist” if the provided
details does not match with any application details.

3. Enter information about the requested credit for the Line of credit such as Line of credit
amount and number of terms.

4. Enter information about the collateral.

You can also enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In container. For more details, refer to ‘Application Entry using Fax-
In’ section.

Once the basic details are entered, the user has to check whether the application pre qualifies
or not. Once the pre-qualified edits are satisfied, click Submit in the Application screen.

When finished, Oracle Financial Services Lending and Leasing checks the application for
completeness using a predefined set of edits. These edits search for errors and warnings
based on your system setup. Status change of the application can be determined by the credit
bureau and scoring model of the application. The prescreening checks ensure that automatic
credit bureau reports are pulled only for applications which meet set criteria, thus saving cost.

After an application clears the edits check, click Process Application in the Applications

section. The system begins the processes of prescreening the application and pulling a credit
bureau while you can begin entering the next application in your queue.
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To enter a new application

1. Click Origination > Origination > Simple Application Entry.
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2. The Simple Application Entry screen appears, opened at the Search link’s Results

screen.
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The Recreate Instance button appears only when the BPEL parameter is YES.
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3. Inthe Results tab’s Quick Search section, click New Application. The Search link’s
Applications Entry screen opens at the Simple Application Entry tab.
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For field description refer Applications of the Underwriting chapter:

Pre-fill applicant information from Sales Lead

You can pre-fill the applicant information if the same applicant details are already captured as
a prospect in the Sales Lead screen. To do so, select the sales lead number in the drop-down
of ‘Lead # field and save the Application details. The ‘Copy Lead Details’ button is enabled in
the Applicant section below. Click on it to auto populate the Applicant details.

Pre-qualifying an Application

After entering the basic details of the applicant like identification and demographic details
along with the address, employment, assets, liabilities and other income information and
requested details, the user has to check whether the application pre-qualifies or not by
clicking Pre-qualify Application button. This is governed by a set of Pre-qualification edits.

If pre-qualified edits are satisfied, the status is changed to NEW-PREQUALIFY APPROVED
and user can modify or update any further details in the Application Entry screen.

If the edits are not satisfied, application will be pushed to REJECTED APPLICATIONS queue
with a status update to REJECTED-PREQUALIFY REJECTED. You can also view rejected
pre-qualification in the Underwriting screen.

When specific services listed in Dashboard -> System Monitor -> Services tab are 'stopped’,
the application status will display 'NEW PRE-SCREEN APPROVED' and user will not be able
to change the status manually to move it to Underwriting queue. In such cases, services
should be started post which the application is processed automatically by the system and
falls in the appropriate queue as per work flow.
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5.3 Applicants Tab

Using the information supplied on application, complete Applicants tab details and the
following sub tab details:

e Address

e Employments

e Telecoms
e Financials
o Liabilities

e Other Incomes

e Summary

e Credit Scores

e Duplicate Applicant

e Existing Accounts.

The system uses information on Financial and Liabilities sub tabs to determine the applicant’s
net worth. The system uses information on Employments tab and Other Incomes sub tab to
calculate applicant’s debt-to-income ratio.

Note the following while completing frequency fields:

e Biweekly in the system means ‘once every two weeks’ and not ‘twice a week’.

e Bimonthly in the system means ‘once every two months’ and not ‘twice a month’.

For more information, refer appendix Payment Amount Conversion.

To complete the Applicants Details screen

1. On the Simple Application Entry tab, click Applicant > Applicant.
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2. For details on this screen refer Applicant Tab of the Underwriting chapter.
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5.4 Business Tab

Oracle Financial Services Lending and Leasing can record SME business related financial
information and business partners on the Business screen to assist in approving Line of credit
application during underwriting. The Business Applicant screen is available for Line of credit
and contains the following sub screens:

e Address

e Telecoms

e Financials

e Liabilities

e Partners

o Affiliates

e Other details

To complete the Business tab

1. If SME business information is included on the application, select SMALL BUSINESS in
the Class field on the Applications section and click Save.

The Business tab appears on Application Entry screen.

2. On the Application Entry screen, click Business.
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For details on this screen, refer Business Tab of Underwriting chapter.

5.5 RequestTab

Depending on the type of product you select, the following screen will be available from
Requested tab

To complete Request tab:
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1. On the Application Entry tab, click Request tab.
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For details on this screen refer Request Tab of the Underwriting chapter:

Collateral Tab

Depending on the type of product or producer you select, the Collateral tab opens one of the
three following collateral screens: a vehicle information screen, a home information screen or
an other information screen. Complete the screen that is available on your Applications
screen. After that, complete the Valuation and Tracking sub screen, which the Collateral
screens share. If you are entering an unsecured Line of credit, the Collateral tab is present

but inactive; in which case, skip this step.
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To enter vehicle information from the Collateral tab

1.

ORACLE"
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On the Application Entry link bar, click Collateral.

DashBoard
Origination
Origination
Sales Lead
Simple Application Entry
Application Entry
Underwriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Tmage Maintenance
Reports
Producers
‘Vendors

> Servicing
> Collections
> WEP

> Tools

> Setup

Origination 5 [ Close
Search/Task | Simple Application Entry: 0000001536 = Review Requests (Pending: 0)
Application: 0000001536: RODRIGUEZ MILDRED fiew | o Audit
View w Format— [ Fre & Detach p W Override 0K v Waming OK ¥
Origination Stage Producer Contact 3 Duplicate
[ App % Sub Unit Status b Producer Name 1 o0U°e Existing Customer RS Contact
] 0sfos/2015 0000001536 APPROVED - FUN... FUNDED CADOG03 : ACEH... (B18)761-2277 ¥ B
< >
Applicant | Business || Request | Collateral || Comments | Tracking || Verification
Collateral
Home [Evew | o aui
Vieww Format [ Freeze E Detach ®
DY Eristing Assetld  Primary  Asset Class Asset Type Sub Type Occupancy Identification #  Country. Address =
N (> NEWVEHICE  HOME SINGLE FAMILY H.. (OCCUPIED BY OW... E26A119602 UNITED STATES 480 NEPONSET 5T
< >
“«
Valuation  Tracking
Vvaluation o Audt
View v Formatw B Freere Effi Detach &l o]
Loan Currency Usage Value Amt .
Qument | 0N CUTeNY Retall Base Amt () Valuation ot Source Currency Eition Supplement Whlesa
|2 19,000.00 15,500.00 0.00 0/05/2015 INVOICE US DOLLAR
< >
Addons View || of Audit
View v Formatv B Freeze &4 Detach (20}
Description value Amount Loan Currency Amount
ANTI THEFT 250.00 230.00

To enter home information from the Collateral tab

1.

ORACLE'

Financial Services Lending and Leasing

On the Application Entry tab, click Collateral sub tab.

DashBoard
Origination
Origination
Sales Lead
Simpie Application Entry
Application Entry
Underwriting
Funding
Apglication Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
> Collections
> WEFP

> Tools

> Setup.

Origination x (3] Close
Search/Task ~ Simple Application Entry: 0000001536 ~ Review Requests [Pending: 0) -
Application: 0000001536: RODRIGUEZ MILDRED Bl view || < Audit
View v Formatv [ Hipetach Wirap 8 ovemideok v Waming OK v
Dt AppE Sub Unit Status g:g;“am" S8 producer Name :ﬁb“‘;’ Contact  picting Customer E:;!I::;fm Contact
f | 08/05/2015 0000001536 APPROVED - FUN. FUNDED CA-D0003 : ACE H. (818)-761-2277 o -
>
Applicant | Business | Request| Collateral | Comments  Tracking || Verification
Collateral
Home [El view ||« Aud
View v Fomat~ [ Freeze g Detach i)
Xen0  Bastingassetld  Prmary  Asset Class asset Type Sub Type Oceupancy Identification £ Country Address & A
i~ ¥ NEW VEHICLE HOME SINGLE FAMILY H... OCCUPIED BY OW... E26A119602 'UNITED STATES ‘480 NEPONSET S1
4 <
4
Home
{3 Retum
Buisting_ State MASSACHUSETTS Legal Deseription
Asset County NORFOLK Lot 23
Doy Sub Division
-ﬁ;mt u . Type & Description st
il Census Tract / BNA Code Niebes-Boninds.
t NEW HOME -
Aﬂﬁ‘ass o MSA Code Flood Zone
ReETipe GEO Code 1098 Not Required ¥
] quire
Sub Type SINGLE FAMILY HOME Condition GOOD CONDITIGNED
Occupancy OCCUPIED BY OWNER AS PRINCIPAL RESIDENCE Description 3015 INVERNIZZT e
Identification E26A119602 CONSTRUCTION CO VILLA
: Year 2015 Construction Permit Dt 01/30/2016
ey Age O Desd Dt 01/30/2016
g Make INVERNIZZI CONSTRUCTION D« F
Country UNITED STATES ueaidﬂatafﬂ Issue AMESBURY
P rties Bou om East
Address # 480 NEPONSET 5T R o roper undary from =
Address Line width 1200 N: i
west
] Length 3400 i
Address 15 RNy e -
o PO # 122 RABEIT
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If collateral is any other, the Collateral link displays information about that collateral.

ORACLE’

Financial Services Lending and Leasing

DashBoard
Origination
Origination
Sales Lead
Simple Application Entry
Application Entry
Underwriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Froducers
Vendors

> Servicing
> Collections
> WEP

> Tools

> Setup

Origination x (3 oze
Search/Task  Underwriting: 0000001533 | Review Requesis (Pending: 0) ~
Application: 0000001533: SIGG MARK A Edt || Elvew || & audt
View » Formatw  [E Freeze i Detach A Wrap B Overide 0K v Waming OK v
Origination Stage Producer Contact 2 Duplicate
Dt App = Sub Unit Status Code Producer Name Nur Existing Customer Application Contact
| 09/05/2015 0000001533 REJECTED - AUTO... NEW CA-00003 : ACEH.. (818)-761-2277 N N
>
Summary | Applicant || Business || Request || Dedsion | Bureau | Collateral | Comments | Tracking | Document | Verfication | Comespondence = Teols
Collateral | Seller
Other Collateral E view | < Audit
View = Fomatv Freeze fiDetach | ol Wrap B Existing Asset 1d d
zsh;”g Existing AssetTd Primary  Asset Class Asset Type Sub Typs Status Year Age Make Model
In B ]
N oy NEW VEHICLE VEHICLE CAR NOT DEFINED 2015 0 AUDI A4
< > 5
Other Collateral
A ssveandadd | Bl Saveand Stay || [ Save and Retun || 3 Retum
Existing Asset Body z =
Existing Asset Id = Registration # UNDEFINED Zip Extn
* primary & P
Identification #
* Asset Class NEW ASSET [v] Gity
Description T
F—— State [v]
Aezel Tye [HOUEEHOLD HO00S ¥ Condition GOOD CONDITIONED [~ M ~
g v
= Sub Type | GENERAL HOUSEHOLD GOODS / EC[v | =
* Status |NOT DEFINED V] Address Usage Details
= Country UNITED STATES [v] %
Select Make and Model - " Start |0
Address # %
=Year 0 g u Basz 0
ddress Line 1 -
Age i =B 0
Make Bitelnet *Total 0
Model * Charge Amt 0.0
Valuation ~ Tracking v

For details on this screen, refer Collateral Tab of the Underwriting chapter.

Comments Tab

When using the Simple Application Entry screen, you can add comments to an application at
any time in the application entry process by clicking Comments tab.
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To complete the Comments tab

1. On the Application Entry tab, click comments.

ORACLE
Financial Services Lending and Leasing
DashBoard Oralntion x
Origination Search/Tesk  Simple Application Entry | Review Requests (Pending: 0)
Originaticn
s L i
el Application
Simple Application Entry - =
‘Application Entry View v Format~ Freeze G Detach ] Wrap @ Override 0K __ Warning OK __
undernriting Origination Stage Producer Contact
iy ot App % Sub Uit Status ik Producer Name ([ oCL<
2 to display.
Application Retrieval ke d(” o ol
Scenario Analysis
Application Documents.
Image Maintenance
Reports Applicant | Request = Comments —Tracking | Verification
Froducers
Vendors
Comments
View v Formstv B Freeze i Detach J wrap 6]
Aot Type Sub Type Comment
U REGULAR [v] | Loan oRIGINATION [v]
o
> Servicing
> Collections
> WFP
> Tools
> Setup

Bxisting Customer  Duplicate Contact

| Bl seve and stay || Bl save and Retum || Gagetum

dpadd | Aedi || 5 view || o audie

Application
>

Comment By Comment Dt

PRAKRRAQ' 102/04/2016 05:54:58 AM

For details on this screen, refer Comments Tab of the Underwriting chapter.

Tracking Tab

The Tracking tab enables you to record further information associated with the application.

What items you choose to track are setup during implementation.
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To track attributes

1. On the application entry screen, click the Tracking tab.

ORACLE & Welome, VAVAIDYA ~ o
Financial Services Lending and Leasing

R Origination x (3 Qlose

Origination SearchfTask  Simple Application Entry | Review Requests (Pending: 0)

Origination

Sales Lead Application e add | Edit View || < Audit
Simple Application Entry
‘Application Entry View » Formatw [ Freeze ! Detach Wrap @ Overide OK_  Warning OK __
l:::;r’:;mmq o App # Sub Unit Status Origination St20°  producer Name (5 E et con. E::"“f::in Contac
Application Retrieval s S =
Scenario Analysis < >
Application Documents
Image Maintenance
Reports
Producers Agplicant || Request || Comments = Trackng | Verification
Vendors
Tracking Attributes | Field Investigation
Tracking Attributes A Edit || of audit
View~ Format~ [ Freeze i Detach ol Wrap 7] o Load Tracking

Sub-Parameter Parameter Value
No data to display.

> Servicing
> Collections
> WFP
> Tools

©» Setup

For details on this screen, refer Tracking Tab of the Underwriting chapter

Verification Tab

Oracle Financial Services Lending and Leasing can be configured to automatically validate
portions of an application when you attempt to change its status. The results of this data check
appear on the Verification link’s Edit screen as an Error, a Warning or an Override.

If it is an Error, the system will not allow you to change application’s status and approve Line
of credit until you fix all the errors.

Ifitis a Warning, the system enables you to change an application’s status without correcting
the matter. While you should still investigate the problem, Warning messages are of a lesser
importance than Error messages.

Ifitis an Override, the system displays a dialog box informing you that an override is needed;
your responsibility level does not have the authority required to process this step. (Choose
Yes on the dialog box to move the application to the queue of the user with the required
authority.)

To validate a credit application

1. Enter all the information associated with the application on the Application Entry screen.
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2. When you are finished entering data, on the Application Entry tab, click Verification sub
tab, then click the Edits sub tab.

ORACLE’
Financial Services Lending and Leasing

& welcome, vavaova - [ElSETGIGN O

V Close
DashBoard Origination —

Origination Search/Task  Simple Application Entry Review Requests (Pending: 0)

Application
View v Formaty B Freeze & Detach Wrap T Overide 0K

Fadd | AEdt || Bl view || o audit

Pre
ot App # Sub Unit Status Producer Name Co Bxsting Customer  DUPlicate Contac
o Application

No data to display.
< >

Applicant | Request | Comments | Tracking Verification

Edits

Edit Types

View~ Format~ [ Freeze i Detach Wrap [o:] Edit Type [V] 48 check Edits
Date Edit Typ:
No data to display.
Edit Details
View w Formatw |58 Freeze [ Detach Wrap 50

Edit Name Result
No data to display.

Expected Value  Actual Value  Override Responsibility

> Servicing
> Collections
> WEP

> Tools

> Setup

For details on this screen, refer Verification Tab of the Underwriting chapter.

Application Entry using Fax-In

You can enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In image functionality using the Fax-In container. Once the all the
images are loaded into the system using the steps mentioned in ‘Entering a Credit Application’
section, you can view those images in the Fax-In container and perform data entry
concurrently.

The Fax-In container option is a simple image holder which is available to the user on clicking
the ‘New Application’ button. The option is available only if has been enabled in the system
settings by the administrator.

If you are the administrator, you can enable/disable this feature to the users in the access
screen. However, you can view the availability of this feature by navigating to Main Menu >
Setup > Administration > User > Access screen. Select Screen tab and in the Security Access
Definition section, the status of “ACCESS TO MENU IMAGE MAINTAINENCE?” flag defines
the availability of this feature. If the flag is set to Y’ then the Fax-In container is available in
Application Entry screen.

The image container displays the image with the header information stored in the tables
loaded as a part of the loading process. You can navigate through the pictures using the
navigation buttons (First, Previous, Next and Last) available on the top right.

After entering the Application details, you need to select the Image check box placed on the
top of Fax Image container. By doing so the system will automatically associate the current
image with the application and save it along with the other application details. Also the image
will no longer be available in the container since the container only holds those images which
are not associated with any application.
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5.10 Review Request

The Review Request tab facilitates to flag an Application for the attention of another Oracle
Financial Services Lending and Leasing user and ask for review / feedback. It allows the
system users to send and receive requests (including e-mail) commenting on a specific
account or application. The Review Request tab supports iterative review of selected
Application and also to process the review with multiple reviewers.

For detailed information on using this feature, refer to ‘Review Request’ section in
Underwriting chapter of the document.
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6.1

6.2

6. Application Entry

Introduction

The first step in the Line of credit origination process is entering credit application data into
Oracle Financial Services Lending and Leasing Application. The Application Entry screen
enables you to specify information from credit application into the system and request a credit
bureau report.

This chapter explains how to use the Applications screen to specify and validate a credit
application.

Entering a Credit Application

There are four main steps in entering an application

1. Select product type and producer at the top of the Application screen in Applications
section. The product defines the type of credit application: Line of credit as well as any
collateral, such as vehicles or homes, associated with the Line of credit. When you save
the application, system activates the links on Applications screen that are associated with
the product, streamlining the application process. The producer is the dealer supplying
the application. When selected, the status of the Producer is displayed along with
Producer Name.

2. Enterinformation regarding the primary applicant, such as name, social security number,
address, place of employment and financial assets and liabilities. Enter this same
information for any other applicants, such as co-signers or joint applicants, if they exist.
System displays the error message as “The Application does not exist” if the provided
details does not match with any application details.

3. Enter information about the requested credit for the Line of credit such as Line of credit
amount and number of terms.

4. Enter information about the collateral.

You can also enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In container. For more details, refer to ‘Application Entry using Fax-
In’ section.

Once the basic details are entered, the user has to check whether the application pre qualifies
or not. Once the pre-qualified edits are satisfied, click Submit in the Application screen. Pre-
qualification edits can be viewed from the 'Verification' sub tab.

When finished, Oracle Financial Services Lending and Leasing checks the application for
completeness using a predefined set of edits. These edits search for errors and warnings
based on your system setup. Status change of the application can be determined by credit
bureau and scoring model of the application. The prescreening checks ensure that automatic
credit bureau reports are pulled only for applications which meet set criteria, thus saving cost.

After an application clears the edits check, click Process Application in the Applications

section. The system begins the processes of prescreening the application and pulling a credit
bureau while you can begin entering the next application in your queue.
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To enter a new application

1. Click Origination > Origination > Application Entry.

ORACLE
Financial Services Lending and Leasing
— dlose
T Origination » N [T}
Origination Search/Task Application Entry: 0000001394  Review Requests (Pending: 0)
orignation
SalesLead Application: 0000001394: MEHTA SHRIVA ZEdt || Elvien || o audt
:"”'i'ﬁ CW";E‘;”" Entry View » Formatw [ Freeze {fiDetach @) OverrideOK ¥ WarningOK v {8} Process Applicaton  §€} Pre-Qualify Application
ppiication Entry
% Sub Origination Producer Existing  Duplicate
Emd;rmhng Dt App £ ot Status Stage Code_ Producer Name o M it e (CoTacE Sales Agent
o 1 01/19/2016 0000001394 NEW - BLANK. NEW. CA-00001 : DEMO{ ACTIVE ) (000)-000-0000 ¥ Y DEMOSALES
Application Retrieval o = i v
Scenario Analysis .
Application Documents
Image Maintenance
Reparts Summary | Applcant  Request  Colateral | Comments | Trading || Verficston | Tools
Producers
Vendors
Requested A Edit View | o Audit
View v Formatv [y Freeze pfiDetach | ol Wrap [%0)] [l Caaate
Begieced "dvam Pt Amt. Term  RequestedRate Down Prit % Down Pt Approx Pre Promotion Balloon Amt Sigring Dt
00 w0 0 0.0000 0.00 0.00 0.00 NONE 000
« 1 L3
b
L3
Ttemization | Tradeln  Sibvention
Itemization AEdt || e | of Audt
View v Formatv [y Freeze  ffDetach ®
Itemization 4+ Requested Amt Comment
| ITM DOWN PAYMENT B 0.00
ITM AMOUNT PAID TO OTHERS ONMY .. + 0.00
ITM DOUN PAYMENT PATOFF + 0.00
ITM AMOUNT PAID ON MY LOAN ACCO... + 0.00
ITM DOUN PAYMENT TRADEIN 3 0.00
ITM CREDIT INSURANCE LIFE + 0.00
ITM CREDIT INSURANCEDISAELLITY  + 0.00
» Servidng ITM INSURANCE GAP + 0.00 -
- Coléctions Total Requested Amt 0.00
7 WP
> Tools
> Setup

2. The Application Entry screen appears, opened at the Search link’'s Results screen.

ORACLE’
Financial Services Lending and Leasing

e P Origination x
Origination SearchfTask | Appication Enfry | Review Requests Pending: 0)
Orignation Quick Search
Sales Lead
Simple Applcation Entry App # Ssh Identification =
Appiication Entry
Underuriting
Funding Queue [=] | (B dext pplication
Application Retrieval
Scenario Analysis > Search Criteria
Application Documents
Image Maintenance
Reports
Producers Search Results/Task
Vendors vewr Fomaty [Ef] (lFees et urep | @ viewal [
GritLodl Al Company  Branch App Date Tike Product
No data to display.
] i ]
Colums Hidden 1
4
> Servicing
> Collections
> WFP
> Tools
> Setup

[ Cose
o New Application | | [J] Open Application Unlock Application
SHFUNDED %
Status Sub Status

The Recreate Instance button appears only when the BPEL parameter is YES.
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3.

In the Results tab’s Quick Search section, click New Application. The Search link’s
Applications Entry screen opens at the Application Entry tab.
ORACLE'

Financial Services Lending and Leasing

 DashBoard
Origination
Origination
Sales Lead
Simple Application Entry
Application Entry
Underwriting
Funding
Application Retrieval
Seenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

»» Serviang
> Collections
> WEp

> Tools

> Setup

m_

Origination [W]Close
SearchyTask ~ Application Entry: 0000001810  Review Requests (Pending: 0} -
Appiication: 0000001810: AGRAWAL PRACHI | [ tem | o Audt
Vew~ Fomatv [ Freeze i Detach 1| Wrap W overdeox v wamngok ¥
Origination Stac Producer Contact
Dt App # Sub Unit Status c:glga o progucer Name NLDN:: on Existing Customer  Duplicate Appication ~ Con |
02/25/2016 0oDooO1810 51 APPROVED - FUNDED FUNDED CA-00009 : HARRY M... (618)-887-9876 ¥ ¥
4 [ il +
Application
{aRetum
App = 0000001810 Billing Cyde WEEKLY Class INDIVIDUAL
1
Dt 02/25/2016 Purpose VEHICLE LOAN OR LEASE Sales Agent DEMOSALES
Product LINE HE {FR) Producer DEALER Joint _
Channel WEB ENTRY Producer Name  CA-00009 : HARRY MOTORS( ACTIVE) CoSigned _
Priority NORMAL Producer Contact (513)-887-9876 Contact
Company US01 Number Lead #
Branch USHQ Region ALL CRBPUl _
SubUnit 51 Territory AL Override OK ¥
Status APPROVED - FUNDED Existing Customer ¥ Warning OK ¥
Origination Stage Code  FUNDED Duplicate Application '
Loan Currency USD
Summary Appiicant  Reguest Dedsion Contract  Colatersl Comments = Tracking  Document Verification — Correspondence
Applicant

For details on this screen refer Applications section in Underwriting chapter.

Applicants Tab

Using the information supplied on application, complete Applicants tab details and the
following sub tab details:

Address

Employments

Telecoms

Financials

Liabilities

Other Incomes sub screens

Summary

Credit Scores

Duplicate Applicant

Existing Accounts

Tracking Attributes

The system uses the information on the Financial and Liabilities sub tabs in determining the
applicant’s net worth. The system uses information on the Employments screen and Other
Incomes sub screen to calculate the applicant’s debt-to-income ratio.
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To complete the Applicants Details screen

1. On the Application Entry tab, click Applicant > Applicant.

ORACLE ABSHEKAR ¥ 1 Signout &
Financial Services Lending and Leasing
inatic Close
T Origination x [l
Origination Applicant
Save and Stay Save and Return Retum
Origination = d d &
Sdlestead | | R o
= " = rior Applcant ; E,
Simple Applicat] Relation Type | COSIGNER [=] ool Bankruptzy Discharge Dt 73
Existing Customer _
application Ent] Salutation =]
T Existing Customer ID NONE [0] Ky
i *First Name | RAF Existing Customer # 0000000000
Funding
Mt Reference ¥
ppaae| Other Details
Scenario Analy| * LastName | GERWYH] Status [+l
| “
Application Do Family Name Name in Local
Image Mainten| FATCA
Qe Suffix EI Language I}i
Reports - @ Gender UNDEFINED [=
Producers Bithot 07/04/1590 By Birth Place
3 Mother's Maiden
Vendors S5 XKX00C-4564 L T Birth Country [=]
& Education [=] -
Class | NORMAL B3] Permanent US Resident [F]
A e *+Language ENGLISH [=] Status
- *Dependents 0
Tine Zone [+ Power of Attorney
Marital Status [=]
Identity Information ECOA TNDIVIDUAL = Power of Attorney [ A
Race = Holder Name
* Nationality USA Address
Ethidty =
*National D 4-654-1561 - Couiry:
Passport & *Dishbty ;‘ Natonality
@ *privacy Opt out [ Telephone Number
2 Passport Issue Dt Zc) * Insurance Opt out [
i » Passport Expiry Dt ) *Marketing Opt out [T
> Servicing Viea & * Share Credit Opt out 1]
 Collections License # *prior Barkruptey [
> wre License State [+
> Tools Address | Employments | Telecoms | Summary | Credit Scores | Duplicate Applicant | Existing Accounts || Tracking Attributes
> Setup
About

For details on this screen refer Applicant Tab section in Underwriting chapter.

Business Applicants Tab

Oracle Financial Services Lending and Leasing can record SME business related financial

information and business partners on the Business screen to assist in approving the Line of
credit application during underwriting. The Business Applicant screen is available for Line of
credit and contains the following sub screens:

e Address
e Telecoms

e Financials

o Liabilities

e Partners
o Affiliates
e Other details

To complete the Business Applicant screen

1. If SME business information is included on the application, select SMALL BUSINESS

inClass field on Applications section and click Save.

The Business tab appears on the Application Entry screen.
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2. On the Application Entry screen, click Business.

ORACLE

Financial Services Lending and Leasing

& welcome, DEMOSUPR 2 signout O

>| DashBoard

Origination

V' Origination
Sales Lead
Simple Application Entry
Application Entry
Underuriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

>| Servicing
>/ collections
2| WP

>/ Tools

»| setup

Origination (3] dose
ResuitfTask  Application Entry: 0000002668 Search Review Requests (Pending: 0) =
Application FEdt | Elvew | of audt
View v Format v | Ep Freeze EfiDetach | ol Wrap B overrice 0k [] wWarning 0K 83 process Appicaton | 83 Pre-cuaify Applcation |
Producer
Dt App # |5|atus lmg'na‘m Stage Producer Name Contact baewng
| |Code Customer |=
| Number
W 112772014 NEV - BLANK NEW AE-00002 : TIN TAN PRO{ ACTIVE ) (147)852-3697N
] . ] ¥
Summary Applicant Business Request Collateral Comments Tracking Verification Tools
Business Details Gradd | FEdt | [Sven | o audt
Wiew =] Fomat ~ | Freeze  GfiDetach wap | @R
Organization Type  |Business Type Business Name |Legal Name TaxID & Start Dt # of Employees(Cur)| #of Employees Contact Per
o 0
Pl M ] B
Business Details ﬂ
H saveand add | [ saveandstey | [ saveandRetum | Gametm |
* Organization [+ *StartDt B *Bank Acc #
Type
- i *sof *avg[g
Business [=] Employess(cur) Chedking
Type *2of g Balance
e Employees zof
ame
Contact Person e
*Legal Name *Management [
* Business 2]
*TaxID # Checking Bank
£ P = = i '
Address  Telecoms Finandals | Liabilties Partners Afflictes Other Detalls
Address Information dpadd | Fede | [Svew | of st
View » Formatv | Ep Freeze i Detach ol Wrap o)
|address Type |country |address # |eity |state |ownpLease |comment |Postal Type |streetPre
No data to display.
o i v
Columns Hidden 1

For details on this screen refer Business Tab section in Underwriting chapter.

Request Tab

Depending on the type of product you select, the following screen will be available from

Requested link

To complete the request tab:
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1. On the Application Entry tab, click Request tab.

ORACLE
Financial Services Lending and Leasing

T — Origination [ Close.
Ot Search/Task  Application Entry: 0000000382 | Review Requests (Pending: 0)
Origination
SalesLead Application: 0000000382: TOLMAN GREG / EVA ZEdt | Elven | o audt
i\mp‘\e :PP“;E‘:“ Entry View v Formatv [ Freeze i Detach ] rap W) overideOK ¥ WamingOK v {§}Process Appiicaton  {§} Pre-Qualify Appication
\pplication Entry :
5 Sub Origiation Producer Existing  Duplicate

:ndsmrmng ot hpp o stas chage Code  ProducerName Cootic e e At (St Sales Agent

e 02/01/2012 UND... APPROVED - AUTO APPR... NEW GA-00004 : ADVANCE LEA .. (770)-424-6450 N N

Application Retrieval

< L, ] r
Scenario Analysis

Application Documents
Image Maintenance

Reports Summary || Appicant  Request | Dedsion || Contract || Collateral | Comments | Tracing | Document  Verification | Correspondence | Tools
Producers
Vendars
Requested A Et || [ vew || o audt
View v Formatv [} Freere  fiDetach | ol Wrap (5] [ [@ cdaiste
Eedested “d"a:,;i Pmt Amt Term  Requested Rate Down Pmt % Down Pt Approx Prc Promotion Balloon Amt Signing Dt
15,000.00 476,77 3 8.9900 0.00 0.00 15,000.00 NONE 0.00

«| 1

Itemization = Trade-n  Subvention

Itemization St | [Fvew | of Audt
view » Format~ (5 freeze ffiDeach | ol wrap (o]
Ttemization +- Requested Amt Comment
ITM DOWN PAYMENT 0.00 A
TTM DOWN PAYMENT PAYOFF + 0.00
TTM DOWN PAYMENT TRADEIN s 0.00 4
ITM CREDIT INSURANCE LIFE + 0.00
ITM CREDIT INSURANCE DISABILITY + 0.00
ITM INSURANCE GAP + 0.00
ITM FILING FEE + 0.00
» Servicing TTM LICENSE FEE + 0.00 s
> Collections Totel Requested Amt 15,000.00
> WFP
I Tools
> Setup

For details on this screen refer Request Tab section in Underwriting chapter.

Master Account tab

The Master Account tab in Origination screen facilitates to categorize the current application
to be considered as ‘Master Account’ after funding or link the current application to another
existing master account in the system.

To define Master Account Details

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click ‘Master Account’ tab.

ORACLE’
Financial Services Lending and Leasing

Customer Service  Origination 3 lose
Search/Task  Underwriting: 0000001017 | Review Requests (Pending: 0) =
Application: 0000001017: YADAV_3 VIK A Edt | [F]View | & Audit
Viewv Formatv [ Freeze i Detach Wrap @ overideok ¥ WamningOK ¥ MANUAL Contract
v Origination Stage Producer Contact .. Duplicate

Dt App # Sub Unit Status o Producer Name Bxisting Customer it P Contact Sales Agent Bran

01/01/2019 0000001017 UNDEFINED APPROVED - REH... REVIEW NY-00002 : SUNRL.. (631)-589-0047 Y ¢ DEMOSUPR USR

x

Summary  Applicant | Request Decision Bureau Contract Master Account Comments | Tracking Document  Verification = Correspondence = Tools

Master Account Details / Edt View | < Audit
View v Format~ [ Freeze  [ff Detach Wrap W
» -
Master Account. P esieg Linked Account Payment Hierarchy
Account
N UNDEFINED UNDEFINED

Master Account Details
[ Saveand Stay || [ Save and Retum | {3 Retum

* Master Account
Link to Existing Master Account UNDEFINED - f
Linked Account UNDEFINED \.4
Payment Hierarchy OUTSTANDING BALANCE -
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6.8

For details on this screen refer Master Account tab section in Underwriting chapter.

Bureau Tab

The Bureau tab displays credit report (if pulled) for an applicant. If there is a need for another
pull for any applicant, it can be done here manually using the New Request section.

To verify the credit bureau data using the Bureau tab
1. Open the Application Entry screen and load the application you want to work with.
2. Click Bureau

ORACLE’
Financial Services Lending and Leasing

. Close
e Origination 3 £
Origination Search/Task | Application Entry = Review Requests (Pending: 0) =
Qrigination ¥
Sales Lead
simple Application Entry
Application Entry Applicaion padd | Zedt | [Fven | o Audt
Underwriting view ~ Format ~ [ Freeze i Detach Wrap M overideOK _ WamingOK _
Funding .
Application Retrieval ¢ % = e o T
¢ 5 u rigination roducer visting  Duplicat
Scenario Analysis Dt App # Ut Stus Stage Code  Producer Name Contact Number Customer Appication CoMtact Sales Agent
Application Documents bio it gy,
Image Maintenance 7 = i v
Reports
Producers
Vendors
Summary  Applicant | Request | Decsion | Bureau | Confract| Comments | Tracking Document | Verificaon = Correspondence
Consumer
Bureau Details dpadd | Lt | Fuew | of Audt
g IMPORTANT: Access to credit reporting agency systems is for authorized users and anly for permissible purposes. Unauthorized access is prohibited under the Fair Credit Reporting Act and is punishable
by & §2500 fine andjor 1 year in Federal prison per occurrence “
View v Format~ [ Freeze  EdiDetach lrap @ D submitRequest
» Credit Bureau
Type Bureau # Status Dt Report ik
No data to display.
1 il = e
Bureau Details
ZaReum
Bureau Details
Type Status Credit Bureau Reorder #
Bureau Dt Applnd
= Report
> Servidng Applicant/Customer Details
» Collections Birst Previous Next Last
> WEP
Type Suffix Address Line 2
> Tools First Name Include Debt State
 Setup MI Populate Debt p 5

For details on this screen refer Bureau Tab section in Underwriting chapter.

Collateral Tab

Depending on the type of product or producer you select, the Collateral tab opens one of the
three following collateral screen: a vehicle information screen, a home information screen or
an other information screen. Complete the screen that is available on your Applications
screen. After that, complete the Valuation and Tracking sub screen, which the Collateral
link’s screens share. If you are entering an unsecured Line of credit, the Collateral link is
present but inactive; in which case, skip this step.

To enter vehicle information from the Collateral tab
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ORACLE
Financial Services Lending and Leasing

On the Application Entry link bar, click Collateral. If the collateral is a vehicle, the
Collateral link displays information about the vehicle

iginati Close
T Origination x =
Origination Search/Task  Simple Application Entry: 0000001536  Review Requests (Pending: 0)
‘Onigination
e st Application: 0000001536: RODRIGUEZ MILDRED Bl view || < Audit
Simple Application Entry ‘
Application Entry View~ Format~ [} freeze EfiDetach | ¢Jwp | @) Ovemideok v Waming OK v
Underwiting Origination Stage Producer Contact ¢ Duplicate
g Dt App E Sub Unit Status Code Producer Name Nu Existing Customer Apyicotion Contact
e [ osfos2015 0000001536 APPROVED - FUN.. FUNDED CA-DDOD3 = ACE H... (818)-761-2277 i E
Scenario Analysis >
Application Documents
Image Maintenance
Reports Applicant | Business | Request Collateral ~Comments | Tracking | Verification
Producers
Vendors Collateral
Home o Audit
View v Format~ [ Freeze  FiDetach ol Wrap 5]
ME"E;”Q Existing Asset1d  Primary  Asset Class Asset Type Sub Type Oceupancy Identification #  Country Address £
N Y NEW VEHICLE HOME SINGLE FAMILY H... OCCUPIED BY OW.. E26A119602 UNITED STATES 480 NEPONSET ST
4 <
Pl
Valuation  Tracking
Valuation
View » Format-  [Ep Freeze i Detach irap 5]
an Currency il Usage Value Amt
Current iR Retail Base Amt pik} Valuation Dt Source Currency Edition Supplement. Wholesa
¥ 15,000.00 19,500.00 0.00 09/05/2015 INVOICE US DOLLAR.
< >
Addons View | o Audit
View = Fomatw (B dl Wrap 5]
= — Description Value Amount Loan Currency Amount
pservicing ANTI THEFT 290.00 250.00
> Collections
> WFP
> Tools
> Setup

If the collateral is a home, the Collateral link displays information about the home.

ORACLE
Financial Services Lending and Leasing

iginati Close
> DashBoard Ofesiation’s: ]
Origination SearchfTask  Application Entry: 0000001155 | Review Requests (Pending: 0) a
Origination
Sales Lead Application: 0000001155: CCINQUWFOIL PIERRE / JEAN A et view | o Audit
Z"m‘i‘e :"D"éa':” Eniry; View v Formaty Freere HfiDetach ¢ Wrap M) OverideOK v WamingOK v  {8hProcess Application  §8% Pre-Qualify Application
pplication Entry
Underwriting Dt App £ Sub Urit Status Origination Stage o0y cer Name P”r::;f' Contact  pyicting Customer  Dupicate Application Contact
| 1 04f0if2012 0000001155 UNDEFINED  NEW - REVIEW REQUIRED REVIEW MN-00001: INHO... (952)9426297 N N
Application Retrieval < = ] 5
Scenario Analysis
Application Documents
Image Maintenance
Reports Summary | Applicant | Request | Decsion | Bureau | Collateral | Comments  Trackng | Doaument  Verification | Correspondence  Tools
Producers
Vendors Collateral  Seller
Home dqradd | Fedt | [Guew | of dudt
View » Format~ B} Freeze i Detach B Edsting Asset 1d ¥ o Load Detais
DOM0 edstngAssetld  Primary  Asset Class AssetType Sub Type Occupancy Identification = Country Address =
! N Y USED HOME HOME SINGLE FAMILY H 1YVFPBOD43SMSL.. UNITED STATES 123 E
s in ] b
Valuation  Tracking
Valuation dpadd | Aedt || [Friew | o At
View v Formatv Freeze EfiDetach ol Wrap [T
Loan Currency
Current Wholesale Base Amt Retail Base Amt Usage Value Amt (+) Valuation Dt Source Currency Edition Supplement Wholes
¥ 10,000.00 10,000.00 0.00 04/10/2012 INVOICE US DOLLAR
Rl m. " »
Addons Apadd | ZEdt || [vew | o Audt
> Servicing View v Format~ Freeze  EfiDetach o]
* Collections Desaiption Value Amount Loan Currency Amount
— No data to display.
> Tools B
> Setup -

If the collateral is any other, the Collateral link displays information about that collateral.

6-8

ORACLE



6.9

6.10

For details on this screen refer Collateral Tab section in Underwriting chapter.

ORACLE"
Financial Services Lending and Leasing

)

Oniginatio 36 lose
* DashBoard THpLT O X
b Search/Task  Application Entry: 0000000382 | Review Requests (Pending: 0)
Origination
Sales Lead Application: 0000000382: TOLMAN GREG / EVA Elyew || o Audit
Simple Application Entry . e s
View v Format = Freeze fHfiDetach | o wrap Override Ok ¥ Warning OK v
Application Entry & o @ 2
Underwriting ot hop # S stats Origination Stage Code  Producer Neme  Producer Contact Mumber  =oond.  Duplicate Applcation Contact
] 02/01/2012 0000000382 UND... APPROVED - AUTO APPROVED NEW GA-00004: ADVA.. | (770)-424-6450 N N
Application Retrieval e e s 3
Scenario Analysis
Application Documents
Image Maintenance
Reports Summary | Applicant | Request | Dedsion || Contract || Colstersl | Comments || Tracking | Document || Verification || Correspondence || Tools
Producers
Vendors
Comments Bl view | of Audit
View = Format~ Freeze B Detach ] wirap o]
Alert Type Sub Type Comment Comment 8y Comment Dt

Comments Tab

When using the Application Entry screen, you can add comments to an application at any time
in the application entry process by clicking the Tracking tab.

To complete the Comments screen

On the Application Entry tab, click Comments.

ORACLE’

. -~ . 5 P & Welcome, DEMOSUPR + 13 Signout ©
Financial Services Lending and Leasing

»| DashBoard Origination [ dose
Origination Result/Task Application Entry: 0000000266 Search Review Requests (Pending: 0) &
V' Origination

i Edit View Audit
Sdeslead Application _ At | Buen | Lan |
Simple Application Entry View - Format ~ | B Freese EfiDetach | J Wiran W override ok [F] waming Ok {83 Process Appication | {8} Pre-Quailfy Application |
Application Entry \ ‘ | | Producer |
e |Origination Stage | |Existing
Underwriting Dt iAuu # is«ams |Code ‘Fruducer Name ﬁiﬁf@f |Cumm ‘5‘
Funding = L . L - . . . L
Appiication Retrieval .u‘m_uznu 0000000265 . APPROVED - AUTO APPROVED | DECISIONED 'MN-00001 : TN HOUSE (DIRECT DEAL){ ACTIVE } (852)-942-6297 N -
Scenario Analysis
Application Documents
Image Maintenance
Reports Summary Applicant Reguest Dedision Contract Comments Trading Document Verification Correspondence Tools
Producers
Vendars Comments
{aRetun
View v Format~ | Ep Freeze i Detach 1l wrap 55
| mlert [Type |sub Type |comment (Comment By |comment pt |
No data to display.
\
d

For details on this screen refer Comments Tab section in Underwriting chapter.

Tracking Tab

The Tracking tab enables you to record further information associated with the application.
What items you choose to track are setup during implementation.
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To track attributes

1. On the application entry screen, click Tracking tab.

ORACLE 5 .
Financial Services Lending and Leasing
Originat [ Ciose
> DashBoard TEPER X
Origination SearchfTask ~ Application Entry | Review Requests (Pending: 0)
Origination
Sales Lead Application qpadd | AEdt | 5] view | o Audit
Simple Appiication Entry L o i
- - ull Wrap O ide OK. w oK
Application Entry g ﬁb B OverideOk _ WamingOK > =
" sul Origination Producer Existng  Duplicate
ur\dda\ wiriting Dt App # Unt  Status Stage Code _ Producer Name ContactNumber Customer Application Contact Sales Agent
Funding No data to display.
Application Retrieval [ = . »
Scenario Analysis
A tion Documents
Image Maintenance
Reports Summary Appicant Request Dedsion Bureau Contract Comments Tracking Document Verification | Correspondence
Producers
Vendors Tracking Attributes  Field Investigation
Tracking Attributes A Edit || of audt
View v Fomate B Freeze EfiDetach | ol Wrap 5] o Load Trading
Sub-Parameter Parameter Value
No data to display.
“
»

For details on this screen refer Tracking Tab section in Underwriting chapter.

Document Tab

Document Sub Tab

Application Entry’s Documents screen enables you to view Application Documents and

Application Documents Details.

ORACLE’
Financial Services Lending and Leasing

e Origination 5
Origination SearchfTask | Application Entry | Review Requests (Pending: 0)
Origination
Sales Lead Application
Simple Application Entry - = e :
ew = Format ~ resze ] Detach Wrap Override OK Warning OK
Appiication Entry & e = @ - = chba
Underwriting Dt App = Sub Unit Status Origination Stage o cor pame
Funding No data to display.
Application Retrival 5 i
Scenario Analysis
Application Documents
Image Maintenance
Reports summary | Applicant || Request | Decson | Buréau | Contract | Comments  Trackng  Document | Verification
Producers
Vendon Checklist Document
Checkiist
View v Formatv [ Freeze  {fiDetach | wrap @ Load Cheddist
Checklist Type Checlist Comment
Mo data to display.
‘
Regular  Document
Checklist Actions
View v Formatw Freeze i Detach ol Wrap (o7
Action Comment
No data to display.
» Servicing
»» Collections
> WFP
> Tools
» Setup

[ close

deadd || Ledt | B view || o Audit

P’",:‘j:;f’ CONXE. | o Oty | Dot Arpicabion |Conk
v
Correspordsnce
o Edit view | o Audit
Complete
‘
A Edt | [Gven | o audt
Response

For details on this screen refer Document Tab section in Underwriting chapter.
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Verification Tab

Oracle Financial Services Lending and Leasing can be configured to automatically validate
portions of an application when you attempt to change its status. The results of this data check
appear on the Verification link’s Edit screen as an Error, a Warning or an Override.

If it is an Error, the system will not allow you change the application’s status and approve the
Line of credit until you fix all the errors.

If itis a Warning, the system enables you to change an application’s status without correcting
the matter. While you should still investigate the problem, Warning messages are of a lesser
importance than Error messages.

Ifitis an Override, the system displays a dialog box informing you that an override is needed;
your responsibility level does not have the authority required to process this step. (Choose
Yes on the dialog box to move application to queue of the user with required authority.)

To validate a credit application
1. Enter all the information associated with the application on the Application Entry screen.

2. When you are finished entering data, on the Application Entry tab, click Verification sub
tab, then click the Edits sub tab.

ORACLE’
Financial Services Lending and Leasing
= Close
e Origination [
ey Search/Task  Application Entry | Review Requests (Pending: 0)
Qrigination
Sales Lead Application dpadd | At | B vew | o Audt
Simple Application Entry View v Format = = S Detach e z =
v v Freeze H Wrap Override OK War oK
Application Entry & ﬁ.h L Sl 3 g
i ” su Origination Producer Existing  Dupiicate
Unddemmhng Dt App = tnt  Status Stage Code Producer Name Contact Mumber Customer Application C7¢t Sales Agent
Funding No data to display.
Application Retrieval o = o ¥
Scenario Analysis
Application Documents
Image Maintenance
Reports summary | Applicant = Request Dedsion  Bureau | Contract —Comments | Tracking  Document —Verfication | Correspondence
Producers
Vendors Edits | Audits | History
Edit Types
View = Format= B Freeze fiDetach firap @ Edit Type [=] {8 CheckEdis
Date Edit Type
No data to display.
4
»
Edit Details
View v Formatw B Freeze 5t Detach Wrap ;]
Edit Name: Result Expected Value Actual Value Override Responsibility
No data to display.
> Servicing
> Collections
> WFP
> Tools
> Setup

For details on this screen refer Verification Tab section in Underwriting chapter.
Tools tab

The Tools tab calculates the payment amount, term, interest rate, Line of credit amount,
amortization schedule and allows for the printing of a report.

For detailed information on using the tools, refer Tools chapter.
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6.14

Application Entry using Fax-In

You can enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In image functionality using the Fax-In container. Once the all the
images are loaded into the system using the steps mentioned in ‘Entering a Credit Application’
section, you can view those images in the Fax-In container and perform data entry
concurrently.

The Fax-In container option is a simple image holder which is available to the user on clicking
the ‘New Application’ button. The option is available only if has been enabled in the system
settings by the administrator.

If you are the administrator, you can enable/disable this feature to the users in the access
screen. However, you can view the availability of this feature by navigating to Main Menu >
Setup > Administration > User > Access screen. Select Screen tab and in the Security Access
Definition section, the status of “ACCESS TO MENU IMAGE MAINTAINENCE?” flag defines
the availability of this feature. If the flag is set to Y’ then the Fax-In container is available in
Application Entry screen.

The image container displays the image with the header information stored in the tables
loaded as a part of the loading process. You can navigate through the pictures using the
navigation buttons (First, Previous, Next and Last) available on the top right.

After entering the Application details, you need to select the Image check box placed on the
top of Fax Image container. By doing so the system will automatically associate the current
image with the application and save it along with the other application details. Also the image
will no longer be available in the container since the container only holds those images which
are not associated with any application.

Review Request

The Review Request tab facilitates to flag an Application for the attention of another Oracle
Financial Services Lending and Leasing user and ask for review / feedback. It allows the
system users to send and receive requests (including e-mail) commenting on a specific
account or application. The Review Request tab supports iterative review of selected
Application and also to process the review with multiple reviewers.

For detailed information on using this feature, refer to ‘Review Request’ section in
Underwriting chapter of the document.
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7. Underwriting

71 Introduction

Underwriting is the next step after application entry in Line of credit origination cycle. At the
beginning of underwriting process, the application has been entered into Oracle Financial
Services Lending and Leasing, receiving an application number. The application, then passes
through the initial prescreening checks, and receives a credit bureau report. (Credit bureau
pulls are based upon zip code setup.) The system assigns it a custom credit score and based
on this, the application automatically updates its status and sent to the appropriate queue. In
doing so, one of three things happen to the application:

The application passes all the prescreening requirements and is automatically approved
based on the auto-decisioning process. The system, then, automatically notifies the
producer with a decision fax. You can use the Underwriting screen to view the
application and decision information and proceed to funding.

The application fails the prescreening requirements and is automatically rejected based
on the auto-decisioning process. Again, the system notifies the producer with a decision
fax. You can use the Underwriting screen to view application and decision information.
Also, you can rehash the application.

The application receives a status requiring a manual review and is sent to the
underwriting queue. It is now up to the underwriter to verify data and manually change
the status of application using Underwriting screen.

This chapter explains how to use the Underwriting screen to complete the following tasks:

Loading an application on the Underwriting screen
Verifying the applicant information

Verifying the credit bureau data

Calculating and validate the debt-to-income ratios
Requesting a credit bureau report manually
Adding comments and tracking attributes

Making a decision about an application

Verifying the edits

Rehashing an application

Ageing an application.

Review Requests

7.2 Underwriting Screen - an overview

The underwriting process follows these basic steps:

Opening the Underwriting screen and loading the application you want to work with.
Viewing and verifying information about the applicant supplied during application entry.
Viewing information from the credit bureau report.

Viewing and verifying information regarding the collateral, if present.

Viewing and verifying information regarding the trade-ins, if present.

Calculating and validating the debt-to-income ratios.

Selecting the pricing for the application.
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7.3

7.3.1

e Specifying information regarding stipulations, itemizations, check lists, and rate
schedules (variable rate Line of credit only), if required. (The checklist can be configured
to display a list of tasks to follow when using the Underwriting screen.)

e Making a decision on the Line of credit (APPROVE, REJECT, or CONDITION).
e Performing an edits check to verify the information on Underwriting screen.

e Viewing errors and warnings from the edits check and make the required corrections to
the data.

e Changing the status of the application.

Loading an Application on the Underwriting screen

The first step in the underwriting process is to load the application you want to work with. For
details about using the Loading an application, refer Searching for an Application in the
chapter Search Function.

Applications

The Underwriting screen’s Applications section appears at the top of the screen opened from
Underwriting master tab. The screen displays the application number and name on the
header and contains information such as application purpose, product and producer.

In this section, you can perform any of the Basic Operations mentioned in Navigation chapter

ORACLE"
Financial Services Lending and Leasing

: o
DashBoard Origination —

Search/Task | Underwriting | Review Requests (Pending: 0)

Application
View~ Formatv B

No data to display.
< >

Application

Super Summary

Applicant

> Servicing
> Collections
> WFP

> Tools

> Setup

sssss

A brief description of the fields is given below:

Field: View this:

App # The application number

Dt The application date

Product The Line of credit product of the application.
Channel How the application information was received.
Priority The priority of the application.
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Field:

View this:

Company The company of the application.
Branch The branch of the company.
Status The status of the application.

Origination Stage Code

The origination stage code of the application.

Billing Cycle

The billing cycle of the application. System displays the
applicable billing cycle by default based on the product
and the calculation method defined at Setup > Products
screen. The editable nature of billing cycle is controlled by
the system parameter UIX_BILL_CYCLE_AL-
LOWED_IND. However, for Rent Factor type of lease cal-
culation, only ‘Monthly’ is applicable and system displays
an error on save if any other value is selected.

Purpose

The purpose of the application.

Producer

The producer type and producer of the application.

Producer Name

The name of the producer of the application. The Producer
Name is displayed as a hyperlink and clicking on the same
will open ‘Producers’ page with details of the producer.

Producer Contact Num-
ber

The system displays the contact number of the producer.

Region

The region of the producer.

Territory

The territory of the producer.

Existing Customer

Indicates if the customer is an existing customer.

Duplicate Application

Indicates if the application is a duplicate application.

Line of credit Currency

The Line of credit currency of the application.

Class The class of the application.

Sales Agent The sales agent of the application.

Contract Type The type of application. ‘Manual’ indicates OFSLL gener-
ated application, where as ‘eContract/Dealer’ indicates
that application is generated from external system.

Joint If selected, indicates this is a joint application.

Cosigned If selected, indicates this is a co-signed application.

Contact The contact of the application.

Lead # The lead number will appear in the list only if a lead is

already created using the Sales Lead link.
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7.3.2

Field: View this:

CRB Puli Check this box to pull an initial credit bureau report, after
the application passes the pre screen edits. Uncheck the
box, if you want to enter an application without pulling a
credit report. To use a previously pulled credit bureau
report, uncheck this box and specify the Bureau and
Bureau Reorder # fields on the Primary Applicant screen.

Override Ok Check this box to ignore the overrides.

If the application has been marked as ‘Override OK’ then
the system would allow you to change the application sta-
tus even when override condition exists.

Warning Ok Check this box to ignore the warnings.

If the application has been marked as ‘Warning OK’ then
the system would allow you to change the application sta-
tus even when warning exists.

Proxy for Underwriter If you are acting as a proxy for an Underwriter, then you
can select the Underwriter’s name from the adjoining
options list. The list displays all the associated Underwrit-
ers, Underwriting Supervisors, and Underwriting Manag-
ers.

However, this is not mandatory and can be used while
auctioning an application on behalf of another underwriter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Changing the Status of the Application

You can use underwriting screen’s Applications master screen to change the status and sub
status of the application.

To change the status of the application

1. On the Underwriting form’s Application master screen, change the status of application
to either APPROVED, CONDITIONED, or REJECTED in the Status field and click Save.

The system checks the information on the Underwriting form using guidelines
established during implementation.

The system finds an error based on these guidelines, a Warning message appears
stating “Validation Error exist, Unable to Change the status. Please check the Edits.”

2. Click the Verification link and begin verifying edits on the Edits screen (For more
information, see the Verification link section in this chapter.)

During status change:

e Ifthereis an error in the edit, system displays an error message as ‘Errors exist. Cannot
change status. Please Verify Edits.” and previous status is retained.

e Ifthereis an edit which requires override, the system displays an override message as
‘Override Required. Do you want to continue?’

— If you select ‘Yes’, the system will continue with OVERRIDE_REQUIRED
processing by changing the status.

— If you select ‘No’, the system will change the status back to old status.
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7.3.3

7.3.4

7.4

During status change, if there is a warning in the edit, the system displays an error message
as ‘Warning Exists. Do you want to continue?’.

o If you select ‘Yes’, the system will continue processing by changing the status.
e If you select ‘No’, the system will change the status back to old status.

Rehashing an Application

Once the application moves to status of APPROVED, REJECTED, or CONDITIONED status,
you cannot amend the information. However, you can amend the application, by changing the
sub status of the application to REHASHING.

To Rehash the Application

1. Open the Underwriting screen and load the application you want to change with the
APPROVED, REJECTED, or CONDITIONED status.

2. Inthe Applications master section, select REHASHING in the Sub Status field and click
Save.

After you enter the information required in the application, you can change the status to
APPROVED, REJECTED, CONDITIONED, or WITHDRAWN. (For more information,
refer Decision Tab section in this chapter.)

Once the status is changed to Approved, Rejected, conditioned, or Withdrawn, you
cannot make further changes to the information on the Decision tab.

Aging an Application

The Underwriting screen can be configured so that applications will be moved to a separate
queue after a certain amount of time. (This time frame is determined in setup). This
applications receive a sub status of AGED APPLICATION. This housekeeping function allows
you to keep your system free of stagnant application by moving them into an archive.

Summary Tab

The summary screen provides a unified view of the application details without navigating to
the respective screens/ sub-tabs.

Using this screen, you can view the following details in their respective sections:

e Super Summary

e Applicant
e Ratios

e Bureau

e Checklist
e Collateral
e Trade-In

e Requested

e Approved

e Decision Itemizations

e Decision History

e Comments

e Stipulations/Adverse Actions
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To view the Super Summary
1. Open the Underwriting screen and load the application you want to work with.

2. Click Summary tab. By default the system opens the summary tab. Expand the Super
Summary section.
[PRACLE

Financial Services Lending and Leasing

> DashBoard Ot 100 3 (] close
Origination SearchTask ~ Underwriting: 0000001015  Review Requests (Pending: 0)

Origination
Sales Lead Application; 0000001015; K NAVIN ZEit | [Bview | o audit
e S View~ Fomat~ B} Freeze i Detach rap B overdeok v Wamingox v

Undervriting
Funding
Application Retrieval 10/12/2015 0000001015, UNDEFINED NEW - REVIEW REQUIRED  NEW CA-00002 = RANDYS AUTO . . ¥ ¥ DEMOSURR UskQ (1]
Scenario Analysis

Application Documents

Image Weintenance

Reports

Producers Summary || Applicant | Request = Decsion | Bureau | Comments| Trackng = Document | Verification = Correspondence
Vendors

Duplicate

7 Origination Stage
ot A Sub Uit Status il Application

Prc
Producer Name Co Bxisting Customer Contact Sales Agent Branch Pro
Hu

3

Super Summary

Super Summary

Applicant Requested 1
Relation Type PRIMARY Req. Cr Limit 200,000.00 Ren. Advance 35000.00

Decision

Credit Limit 200,000.00 DrawTerm 6
Bith Dt 12/02/1967 Rate(%) 13.9800 Repayment Term 24
Address AR NARLECH N # AR2 AR3

Contract

Phone  (000)}-000-0000 Credit Limit 0,00 DrawTerm 0
v orRent. OWNS HOME First Pt Dt Repayment Term 0
n Term 0

> Senvicing
> Collections Actual Time at Residence f
> WFP 5 Verify Address
> Tools

Emplovment @

> Setup Twne Filll TIME .

The Super Summary tab provides a snapshot of all relevant details in a single screen and
contains details of Applicant, Employment, Ratios, Bureau, Requested financials, Decision
updates, Contract updates and Primary Collateral details. You need not have to navigate to
each of these tabs for specific information on the application. Also clicking on the hyperlinks
of Address, Employment, Ratios, and Trade-In helps you to directly navigate to respective
tab(s),

During the Underwriting and Funding stages, 'verified' button is displayed just below the
address and employment details for each of the applicants. This would be enabled only when
the Verified by and Verified Dt in the respective tabs are blank. You can verify the details from
the Super Summary tab. Clicking on Verified will do the following:

1. System will copy the stated values to Actual values.

2. System will stamp the “Verified By” as 'User Name' and 'Verified Date' as 'Current GL
Date' for the respective applicant.

3. If'Verified Details' are already updated in tab or if the details are stamped, this button will
be disabled.

4. ‘'Verified' button will be available when 'Actual Amount' equal to ZERO or 'Verified By' or
'Verified Date' is NULL.

You need not navigate to Address and Employment tab for verifying applicant details.

Decision details will be displayed when application has Origination Stage as “Review,
Decisioned, Contract or Funded”. In case an application is Rehashed, only Decision
information will be displayed and Contract information will not be displayed. Contract details
will be displayed when application has Origination Stage as “Contract or Funded”.

The system displays the collateral details maintained in the collateral tab on click of navigation

button under the headings Primary Collateral and Secondary Collateral. Collateral details for
Unsecured loan also will be displayed if they are maintained.
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7.5

All the trade-in details, if any, maintained in the application would be displayed on click of
Navigation button.

Applicant Tab

Having selected and loaded an application, you can view the information about applicant in
the Applicants tab. This is information that was recorded on the Application Entry screen or
gathered during the credit pull. You can edit data from the Application Entry screen at anytime
in the following steps. Remember to save your work with each change. Information from the
credit bureau pull is available to view only.

Using the information supplied on the application, complete the Applicants tab details and the
following sub tab details:

e Address

e Employments

e Telecoms

e Summary

e Credit Scores

e Duplicate Applicant
e Existing Accounts.

e Tracking Attributes

Primary Applicant details are required for SME applications also. The system uses
information on the Financial and Liabilities sub tabs in determining the applicant’s net worth.
The system uses information on the Employments screen and Other Incomes sub screen to
calculate the applicant’s debt-to-income ratio.

To verify applicant information on the Underwriting screen

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Applicants tab.

In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter
ORACLE’ & Welcome ABSHEKAR ~ o
Financial Services Lending and Leasing
Origination 3] Close
Applicant &

[ saveand Stay | [ Save and Retum || (3 Retumn

* Relation Type PRIMARY v Existing Customer ID NONE [0]
4 Existing Customer # (0000000000 Reference #
Salutation i
* Update Customer Info [ ] ~
* First Name THE Status
MI Other Details FATCA

* Last Name LOAN

Name in Local Language Birth Place

Family Name
g Gender UNDEFINED 57 Birth Country 3 “
uffix v
Mother's Maiden Name s
*Birth Dt 02/04/1991 Permanent US Resident [_]

Education UNDEFINED Status
*SSN XX-XXK-2722

* Language ENGLISH ~

* Class NORMAL > Power of Attorney
A Cat INDIVIDUAL *Deeee 0
S = [ f Al
Marital Status  UNDEFINED = ower of Attomey []
Email Holder Name
ECOA COMAKER >
Time Zone US/PACIFIC v Address
Race < Country
Identity Information Ethnicity UNDEFINED v Nationality
* Disability [] Telephone Number
* Nationali v
ationality LUXEMBOURG AL A
* National ID. - 457890 Military Service
* Insurance Opt Out (]
Passport # 211241424141 * Marketing Opt Out [] * Active Military Duty []
Passport Issue Dt 11/03/2019 & * share Credit Opt Out [] Effective Dt
Passport Bxpiry Dt 11/10/2022 * Prior Bankruptcy [] Order Ref #
Visa # Bankruptcy Discharge Dt [£:) Release Dt £
License # Payment Hierarchy OUTSTANDING BALANCE -
License State =
KYC
Prior Applicant ¥
Existing Customer _ v
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A brief description of the fields is given below:

Field

Do this

Relation Type

Select the relationship type from the adjoining drop-down list. For
example, primary, spouse, secondary, or cosigner.

Salutation Select the salutation from the adjoining drop-down list.
First Name Specify the applicant’s first name.

Mi Specify the applicant’s middle name.

Last Name Specify the applicant’s last name.

Family Name

Specify the applicant’s family name.

Suffix Select the name suffix/generation from the adjoining drop-down list.

Birth Dt Specify the applicant’s date of birth.

SSN Specify the applicant’s social security number.

Class Select the classification of the applicant from the adjoining drop-down
list. For example, NORMAL or EMPLOYEE. The system uses this
information to restrict access to the database by recognizing employ-
ees as ‘secured applications’.

You can create a SME (Small Medium Enterprise) application by
selecting SMALL BUSINESS. When you select SMALL BUSINESS
and save your entry, the Business Applicants link on the Applicants
link is available. (required).

Email Specify the personal Email ID of the applicant.

Time Zone Specify the time zone to which the applicant belongs. This information

appears when you enter and save the zip code for the primary appli-
cant’s current home address on the Address sub screen. You can also
manually complete this field.

Identity Informa

tion Section

Nationality Select the applicant’s nationality from the adjoining drop-down list.
National ID Specify the national identification number.

Passport # Specify the passport number.

Passport Select the date on which passport was issued.

Issue Dt

Passport Select the passport’s expiration date.

Expiry Dt

Visa # Specify the applicant’s visa number.

License # Specify the applicant’s license number.

License State

Select the state where the license was issued, from the adjoining
drop-down list.
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Field Do this

Prior Appli- Check this box to indicate that the customer is an existing customer.

cant

Existing Cus- | Check this box to indicate that this applicant has a previous account.

tomer

Existing Cus- | Specify the customer ID if the applicant is an existing customer.

tomer ID

Existing Cus- | Specify the customer number if the applicant is an existing customer.

tomer # On saving the applicant details, the data in ‘Existing Customer #  is
displayed as a link in ‘Applicant’ section header and clicking on the
same will display the customer details in Search Results section of
Servicing module.

Update Cus- Check this box to indicate if system can override the existing cus-

tomer Info tomer information and create the record with latest address and com-

munication details of the customer.

Other Details section

Name in Local

Specify the applicant’s name in local language.

Language
Gender Select the gender of the applicant from the adjoining drop-down list.
Mother’s Specify the mother’s maiden name.

Maiden Name

Education Select the education of the applicant from the adjoining drop-down
list.

Language Select the applicant’s native language from the adjoining drop-down
list.

Dependents Specify the number of dependents.

Marital Status

Select the marital status of the applicant from the adjoining drop-down
list.

ECOA Select the ECOA (Equal Credit Opportunity Act) code, from the
adjoining drop-down list. This defines the various possibilities on who
is liable; individual, joint, cosigner and so on.

Race Select the applicant’s race from the adjoining drop-down list.

Ethnicity Select the applicant’s ethnicity from the adjoining drop-down list. This
is the information the Home Mortgage Disclosure Act requires to be
reported.

Disability Check this box if the application has a disability.

Privacy Opt Check this box to indicate that the applicant has elected to refrain

Out from the non-public sharing of information.

Insurance Opt
Out

Check this box to indicate that the applicant has elected to refrain
from insurance related inquiries.
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Field

Do this

Marketing Opt
Out

Check this box to indicate that the applicant has elected to refrain
from marketing related inquiries.

Share Credit

Check this box to indicate that the applicant has elected to refrain

Opt Out from financial information and share credit related inquiries.
Prior Bank- Check this box if prior bankruptcy exists.

ruptcy

Bankruptcy Enter the discharge date of prior bankruptcy (if one exists).

Discharge Dt

Payment Hier-
archy

Select the required Hierarchy Definition to be used for payment appro-
priation from the drop-down list. The list is populated with all the pre-
defined and enabled hierarchy definitions maintained Setup > Admin-
istration > Users > Payment Hierarchy screen.

The Hierarchy Definition selected here is propagated to Servicing >
Customer/Business details. If an existing hierarchy is modified and
the ‘Update Customer/Business info’ option is enabled, then the Pay-
ment Hierarchy in Servicing > Customer / Business details are also
updated.

KYC Section

Reference #

Specify the reference number.

Status Select the status of the applicant from the adjoining drop-down list.
FATCA Section

Birth Place Specify the birth place of the applicant.

Birth Country | Select the country of birth of the applicant.

Permanent US | Check this box if the applicant has permanent US resident status.

Resident Sta-
tus

Power of Attorn

ey Section

Power of
Attorney

Check this box if you hold a power of attorney.

Holder Name

Specify the holder name of the power of attorney.

Address Specify the address of the holder.

Country Specify the country of the power of attorney holder.
Nationality Specify the nationality of the power of attorney holder.
Telephone Specify the telephone number of the power of attorney holder.
Number

Military Service -

this section can be used to capture applicant’s Active Military Duty

details and can be validated with applicant Bureau Details.
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7.5.1

Field Do this

Active Mili- Check this box to indicate if applicant is on Active Military Duty.
tary Duty

Effective Dt Select the date from when the applicant is on Active Military duty
using adjoining calendar.

Order Ref # Specify the Order Reference number which indicates the applicant’s
Active Military duty service.

Release Dt Select the date from when the applicant was released from Active Mil-
itary duty using adjoining calendar.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

You can verify the personal information about the applicant. Two check boxes indicate if
this is an existing customer or a prior applicant. The Existing Customer field enables you
to select the existing customer.

Address Sub Tab

You can specify more than one address for each applicant, such as a home address, second
home address, and vacation home address. However, at least one must be marked as
current. Also, only one address can be selected as the mailing address, and that address
must be marked as current. Finally, while you can have more than one Home type address,
only one can be marked as current.

To complete the Address sub tab
1. Click Address sub tab.

2. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

Based on the country chosen in the address tab, the fields for capturing the address will
vary.

A brief description of the fields is given below:

Field Do this

Address Type | Select the type of address from the adjoining option list.

Current Check this box if this is a current address.

The mailing address must be marked as current.

Confirmed Check this box if the address is the confirmed one

Mailing Check this box if this is the mailing address. Only one address entry
can be marked as the mailing address.

Permission to | Check this box if customer has provided permission to contact
Call through the specified phone number.

Atleast one phone number per application should have the permis-
sion to call (flagged as 'Y') for the successful pre-qualification of the
application. Else, an error message is displayed.
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Field

Do this

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

Country

Select the country of mailing address from the adjoining drop-down
list.

Address Details

section

Postal Type Select the postal address type from the adjoining drop-down list.
Address # Specify the address number of the mailing address
Street Pre Select the street prefix (directional) from the adjoining drop-down

list.

Street Name

Specify street name.

Street Type

Select the street type from the adjoining drop-down list.

Street Post

Select the street postfix (directional) from the adjoining drop-down
list.

Apt #

Specify the apartment number.

Address Line
1

Specify the first address line.

Address Line
2

Specify the second address line.

Address Line
3

Specify the third address line.

Zip Select the zip code from the adjoining drop-down list.
For non US country, you have to enter zip code.

Zip Extn Specify the extension of the zip code.

City Specify the city of the mailing address.

State Select the state of the mailing address, from the adjoining drop-down
list.

Phone Specify the phone number.

Additional Information section

Own / Rent Select the ownership type from the adjoining drop-down list.
Landlord Specify the landlord’s name.

Landlord Specify the landlord’s phone number.

Phone

Contact Specify the person contacted on behalf of landlord.
Contact Title Specify title of the person contacted on behalf of landlord.
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Field Do this

Contact Phone | Specify phone number of the person contacted on behalf of landlord.

Extn Specify the extension of the phone of the person contacted on behalf
of landlord.

Census Tract/ | Specify census tract/BNA (block numbering area). These are defined
BNA code by the US Census Bureau code.

MSA Code Specify the metropolitan statistical area (MSA) code. These are sim-
ilar in concept to a zip code, but used mostly on government reports.

Comment Specify a comment.

Address Rent Mortgage Stated section

Years Specify the stated number of years at residence.
Months Specify the stated number of months at residence.
Currency Select the currency code of payment amount, from the adjoining

drop-down list.

Pmt Amount Specify the stated payment amount.

Frequency Specify the stated payment frequency.

Rent/Mortgage | The system displays the rent or mortgage amount.

Address Rent Mortgage Actual section

Years Specify the Actual number of years at residence.
Months Specify the Actual number of months at residence.
Pmt Amount Specify the Actual payment amount.

Frequency Specify the Actual payment frequency.

Rent/Mortgage | The system displays the rent or mortgage amount.

Verified Section

Verified By The name of the verifier.

Verified Dt The date of verification.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. If there are more than one addresses associated with the applicant, click Save And Add
on the Address sub screen and add address details.

7.5.2 Employments Sub Tab

Use the Employment sub screen to record employment information about the applicant. You
can have more than one entry.

To complete the Employments sub tab

1. Click Employments sub tab
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2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Current

Check this box if this is the current employment.

Permission to Call

Check this box if customer has provided permission to contact
through the specified phone number.

Atleast one phone number per application should have the
permission to call (flagged as 'Y") for the successful pre-quali-
fication of the application. Else, an error message is dis-
played.

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

Type Select the address type from the adjoining drop-down list.
Employer Specify the employer’s name.

Occupation Select the occupation from the adjoining drop-down list.
Title Specify the title.

Department Specify the department of the employer.

Employee ID Specify the employee identification.

Employer Address section

Country

Select the country from the adjoining drop-down list.

Address #

Specify the building number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.

Zip Select the zip code from the adjoining drop-down list.
For non US country, you have to enter zip code.

Zip Extn Specify the zip code extension.

City Specify the city.

State Select the state from the adjoining drop-down list.

Additional Information section

Phone Specify the work phone number.

Extn Specify phone extension.

Contact Specify the person contacted on behalf of the employer.
Contact Title Specify title of the person contacted on behalf of the employer.
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Field: Do this:

Contact Phone Specify phone number of the person contacted on behalf of
the employer.

Contact Extn Specify the extension of the phone of the person contacted on
behalf of the employer.

Comment Specify a comment.

Employment Details Stated section

Years Specify the stated number of years with the employer.
Months Specify the stated number of months with the employer.
Pay Day Select the stated payment day of the month using the adjoin-

ing calendar. Ensure that the date selected is greater than or
equal to current system date.

Frequency Select the stated payment frequency from the adjoining drop-
down list.

Currency Select the currency code from the adjoining drop-down list

Income Amt Specify the stated income.

Salary View the salary of the customer.

Employment Details Actual section

Years Specify the Actual number of years with the employer.
Months Specify the Actual number of months with the employer.
Pay Day Select the Actual payment day of the month using the adjoin-

ing calendar. Ensure that the date selected is greater than or
equal to current system date.

Frequency Select the Actual payment frequency from the adjoining drop-
down list.

Income Amt Specify the Actual income.

Salary View the salary of the customer.

Verified Section

Verified By The name of the verifier.

Verified Dt The date of verification.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

7.5.3 Telecoms Sub Tab

The Telecoms sub screen only needs to be completed if additional phone numbers exist. If
not, this sub screen can be left blank.
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7.5.4

To complete the Telecoms sub tab

1. Click the Telecoms sub tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Type Select the telecommunication type from the drop-down list.

Phone Specify the phone number.

Extn Specify the phone extension.

Current Check this box if this Telecom number is current.

Permission | Check this box if customer has provided permission to contact through

to Call the specified phone number.
Atleast one phone number per application should have the permission
to call (flagged as "Y') for the successful pre-qualification of the applica-
tion. Else, an error message is displayed.

Permission | Check this box if customer has provided permission to contact through

to Text text message.

Time Zone Select the applicant’s time zone from the drop-down list.

Start Time Specify the best time to start the call.

Period Select the time period for the best time to call start time, AM or PM, from
the drop-down list.

Best day to | Select the preferred day of the week to contact the customer from the

call drop-down list.

End Time Specify the best time to end the call.

Period Select the time period for the best time to call end time, AM or PM, from
the drop-down list.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Summary Sub Tab

The system calculates debt ratios in the Ratios section on the Summary sub screen
(Applicants link) using the data in the Incomes and Liabilities sections. Information in the

Incomes section comes from the Employments sub screen and the Other Incomes sub screen
during application entry. The information in the Liabilities section comes from the Address sub

screen, the Liabilities sub screen during application entry, and the credit bureau pull.

To View Summary sub tab

1. Click the Summary sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field Do this

What if Pmt Amt Specify the payment amount you want to use in the ratios.
Score View the credit score for the application

Grade View the credit grade for the application

Totals

Monthly Income- Stated | The stated monthly income.
Amt

Monthly Debt- Stated The stated monthly liability.
Amt

Monthly Income- Actual | The actual monthly income.
Amt

Monthly Debt- Actual The actual monthly liability.
Amt

Assets Amt - Liabilities The net worth amount.
Amt

Ratios

Debt - Stated Before (%) | The debt amount stated before.

Debt - Stated After (%) The debt amount stated after.

Debt - Actual Before (%) | The actual debt amount before.

Debt - Actual After (%) The actual debt amount after.

Disposable Inc - Stated | The disposable income stated before.
Before (%)

Disposable Inc - Stated | The disposable income stated after.
After (%)

Disposable Inc - Actual The actual disposable income before.
Before (%)

Disposable Inc - Actual | The actual disposable income after.
After (%)

Revolving Debt - Stated | The stated revolving debt before.
Before (%)

Revolving Debt -Stated The stated revolving debt after.
After (%)

Revolving Debt - Actual | The actual revolving debt before.
Before (%)

Revolving Debt - Actual | The actual revolving debt after.
After (%)
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Field Do this

Pmt to Income - Stated The stated income payment before.
Before (%)

Pmt to Income - Stated The stated income payment after.
After (%)

Pmt to Income - Actual The actual income payment before.
Before (%)

Pmt to Income - Actual The actual income payment after.
After (%)

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Once the payment amount is approved in Decision screen, it will be copied and
displayed in the What if Payment field in Summary sub screen.

Calculating Debt Ratios

The system offers powerful tools to the underwriter for analyzing an applicant’s debt-to-
income ratios (total of an applicant’s debt obligation divided by that person’s regular income).
The system calculates debt ratios in the Ratios section on the Summary sub screen
(Applicants link) using the data in the Incomes and Liabilities sections. Information in the
Incomes section comes from the Employments sub screen and the Other Incomes sub screen
during application entry. The information in the Liabilities section comes from the Address sub
screen, the Liabilities sub screen during application entry, and the credit bureau pull.

An underwriter may also add information to the Incomes and Liabilities sections on the
Summary sub screen during the underwriting process.

The debt-to-income ratios in the Ratios section can be recalculated by including or excluding
information from the Incomes section, Liabilities section and Financials sub screen.

To calculate debt ratios
1. Open the Underwriting screen and load the application you want to work with.
2. In the Underwriting link bar, click Applicants.

3. On the Applicants Details screen, select the applicant you want to work with and click
Show in the Details column.

4. Click Summary sub tab.

On the Summary sub screen, view the display only data in the Totals section.

Field: View this:

Monthly Income (Stated) | The stated monthly income.

Monthly Income (Actual) | The actual monthly income.

Monthly Debt (Stated) The stated monthly liability.

Monthly Debt (Actual) The actual monthly liability.

Assets The assets.

Liabilities The liabilities.
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7.5.4.1

Field: View this:

Net-Worth The net-worth.

6.

In the What if Pmt Amt field, enter the payment amount you want to use in the ratios.
Once the payment amount is approved in Decision screen, it will be copied in the What if
Payment field and the ratios are updated accordingly.

Whenever you modify the ‘What If pmt Amt’ field, system automatically calculates the
below ratio's:

— Stated Before DTI - if liabilities, stated income or applicant financials are updated.

— Stated After DTI - if decision payment amount, liabilities, stated income or applicant
financials are updated.

— Actual Before DTI - if liabilities, actual income or applicant financials are updated.

— Actual After DTI - if decision payment amount, liabilities, actual income or applicant
financials are updated.

— Stated PTI - if decision payment amount, stated income or applicant financials are
updated.

— Actual PTI - if decision payment amount, liabilities, actual income or applicant
financials are updated.

Financials Sub Tab

The Financials sub screen only needs to be completed if financial assets exist on the
application. If not, this sub screen can be left blank.

To complete the Financials sub tab

The Financials sub screen only needs to be completed if financial assets exist on the
application. If not, this sub screen can be left blank.

1.

Click Financials sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Type Select financial type from the drop-down list. For example, liquid

assets, retirement assets, and so on.

Source Specify source; for example, stocks, 401K, rent received, and so on.
Account # Specify the account number.
Currency Select the currency code from the drop-down list.

Line of credit | View the Line of credit currency amount.

Currency

Amount

Amount Specify amount.

Include Check this box to indicate that the Asset is included.
Comment Specify comment, if any.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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7.5.4.2 Liabilities Sub Tab

All the liabilities of the applicant that are entered during application entry are displayed in this
tab. For example: Rent. In addition, if you need to record additional liabilities for an applicant
the same can be done in this tab. Also any liability information of the applicant received
through credit pull will be displayed under 'Credit Bureau Data' in Liabilities sub tab.

To complete the Liabilities sub tab
1. Click Liabilities sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Include Check this box to indicate that the liability is included.
Liability Type Select the liability type from the adjoining drop-down list.
Currency Select the currency code from the adjoining drop-down list.
Amount Specify the liability amount.

Line of credit Cur-
rency Amount

View the Line of credit currency amount.

Frequency

Select the frequency from the adjoining drop-down list.

Account Type

Specify the account type.

Account Balance

Specify the account balance.

Line of credit

View the Line of credit currency amount.

Comment

Specify a comment, if any.

Credit Bureau Data

Bureau View the name of credit Bureau.

Open Dt View the opening date of credit account.
Pmt Manner View the mode of payment.

Account # View the account number.

Status View the current status of credit account.
Account Type View the type of account maintained.

Creditor's Name

View the name of the Creditor.

Subscriber # View the Subscriber number.

ECOA View the ECOA (Equal Credit Opportunity Act) code.
Term View the term of credit.

Credit Limit View the total credit limit amount.
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Field Do this

High Balance View the high balance amount if any.
Past Due Amt View the total past due amount if any.
30 View the number of delinquency days.
60 View the number of delinquency days.
90 View the number of delinquency days.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. The Dedupe Liabilities button removes duplicate (“de-dupes”) liabilities that may be
present from subsequent (manual) credit bureau pulls for nonspousal joint applications

7.5.4.3 Other Incomes Sub Tab

The Other Incomes sub tab only needs to be completed if other incomes exist on the
application. If not, this sub screen can be left blank.

To complete the Other Incomes sub tab
1. Click the Other Incomes sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Type Select the income type from the adjoining drop-down list.

Note: In case, the other income of the applicant is from Employment,
then the details of Actual Amount specified in the Employments
Sub Tab is auto populated. Also if the income is verified in the
Employments Sub Tab, then Verified By and Verified Dt details are
auto populated. You can also verify the details here using the current
system date.

Currency Select the currency from the adjoining drop-down list.

Stated Amount Specify the monthly stated income.

Frequency Select the income frequency from the adjoining drop-down list.

Line of credit View the Line of credit currency amount stated.

Currency

Amount Stated

Comment Specify a comment, if any.

Include By default the include check box is selected indicating that the other
income details are included. You can deselect the same if not
required.

When Include check box is selected system automatically adds the
‘Loan Currency Amount Stated’ and ‘Loan Currency Amount Actual’
details to Applicant > Summary Tab. Also system calculates the DTI
and PTI ratio's based on ‘Actual Amount’ specified.
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Field

Do this

Actual Amount Specify the actual monthly income amount.

Line of credit View the actual Line of credit currency amount.
Currency
Amount Actual

Verified By The Verified By field is auto populated with the logged in user name
only after the record has been verified and saved.
Verified Dt You can verify the record by selecting the current system date from

the adjoining calendar icon.

selected apart from current system date.

Note: System displays an error message if any other dates is

3. Perform any of the Basic Actions mentioned in Navigation chapter.

7.5.4.4 Rescoring a Credit Bureau Report Manually

7.5.5

Any manually pulled credit bureau reports can be used to rescore an application.

To manually rescore a credit bureau report

1. Open Underwriting screen and load the underwriting application you want to work with.
2. Click Applicants.

3. On the Applicants Details screen, select the applicant you want to work with and click

View.

4. Click the Credit Scores sub tab.

5. In the Rescore Applicant section, select in the Credit Report ID field, the bureau report
you want to use to rescore the applicant.

6. Click Rescore.

The system displays the new information in the Credit Scores and Parameters sections.
This new score automatically appears in the System Recommendation section on the
Decision link.

Credit Score Sub Tab

You can view the credit score based on the system’s internal scoring models in Credit Scores

sub tab.

To View Credit Scores sub tab
1. Click the Credit Scores sub tab.

You can view the following details:

e Credit Score

Model

Bureau

Credit Report ID
Credit Grade
Score

Current
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e Parameters
— Parameters
— Value
— Score

Note

If you select No Bureau in the Credit Bureau Report ID field and click Rescore, the best
match internal scoring is used for rescoring the applicant without credit bureau report.

7.5.6 Duplicate Applicant Sub Tab

Click De-dupe Applicants to display the existing customer details of the applicant. While
reviewing the de-dupe results, if the current applicant's credentials are exactly matching with
an existing customer record, you can attach the current application to the existing customer.
The same can be done by just keying in the customer ID in the applicants tab and clicking
save.

In case a particular customer has more than one account, on clicking De-dupe Applicants the
system displays only one account in ‘Duplicate’ sub tab. However, you can view all the
accounts held by customer in 'Existing accounts' sub tab.

To View duplicate applicant’s details, click Duplicate Applicant sub tab. In this section you
can view the duplicate applicant’s details.

A brief description of the fields is given below:

Field Do this

Source Type View the source type of the duplicate applicant

Applicant Id/ Cus Id View the applicant ID if the source type is applicant and the
customer ID if the source type is customer.

Application # View the application number of the existing applicant details
for the respective records.

Days since last appli- View the total number of days elapsed since the last applica-
cation tion date. System auto calculates this value as ‘Current sys-
tem date (minus) Last application date’.

ID View the applicant ID

First Name View the first name of the duplicate applicant

Middle Name View the middle name of the duplicate applicant

Last Name View the last name of the duplicate applicant

Date of Birth View the date of birth of the duplicate applicant

CIF View the CIF no of the duplicate applicant

SSN # / National ID View the national ID or SSN number of the duplicate appli-
cant

Driving License # View the driving license number of the duplicate applicant
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7.5.7

7.5.8

Field Do this

City View the city of the duplicate applicant
State View the state of the duplicate applicant
Zip View the zip of the duplicate applicant

Existing Account Sub Tab

The Existing Account Sub Tab displays the applicant's details, if it has been previously
maintained in the system. Also along with the applicant's details, the account number of the
applicant is displayed as a hyperlink. Clicking on the hyperlink will display the respective
account details through the Customer Service screen of Servicing module.

In case you do not see a hyperlink associated with the account number, then you might have
restricted access to the Servicing module. You can request your system administrator to
navigate to Setup > User > Access screen, and enable the ‘ACCESS TO SERCOLL UCS
CUSTOMER SERVICE TAB’ option in Security Access Definition section available in the
'Screen' tab. For more information, on defining user privileges, refer to ‘3.3.2 Screen’ section

in Setup guide.

View the following details:

Field: View this:

Account # The account number.

Title The account title.
Relation The customer relationship.
Product The Line of credit product.
Payoff Amount The payoff amount.

Amount Due

The delinquent amount due.

Oldest Due Dt

The due date.

Status The account status.
Company The company.
Branch The branch.

Total Pay Off Amt

The payoff amount.

Total Amt Due

The total due amount.

Tracking Attributes Sub Tab

You can add tracking attribute information to an application at any time in the underwriting
process by using the Tracking Attribute tab.

The Tracking tab enables you to record further information associated with the application.
What items you choose to track are setup during implementation.
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To track attributes
1. Click Tracking Attributes sub tab.
2. Select the item you want to track.

3. Click Edit to edit the following information:

Field Do this

Sub-Parameter | View the sub-parameter

Parameter View the parameter.

Value Specify the information about the corresponding Value field.

4. Save changes you made to the account.

7.5.8.1 Create Tracking

1. Click Create Tracking, the system loads the tracking parameters.

e If you want to reduce the list of parameters, select a sub-attribute in the Sub Attribute
box.

e If your system has been configured to use the Sub Code field, only attributes in a
particular group appear in the Parameter display.

2. Specify the requested parameter in the Value field and click Save.

7.5.9 Customer Search Tab

While creating an application for an existing customer, you can retrieve and copy the
customer details into the new application by using the Customer Search section of the
Simple Application Entry screen.

You can modify only the address, employment, financial details and not the demographic and
identification details.

To copy the Customer Details
1. On the Underwriting screen, click Applicants tab.
2. Click Customer Search tab.

3. Inthe Search Criteria screen, use the Comparison Operator and Values columns to
create the search criteria you want to use to find a customer.

4. Click the Search button.

The system locates and displays all the customer details that meet your search criteria
in the Search Results section.

Select Reset Criteria at any time to clear the Comparison Operator and Values columns
on the Criteria screen.

5. Inthe Search Results section, select a customer you want to load.

6. Select the relation type and click Copy Customer Details.

7.6 Business Tab

Oracle Financial Services Lending and Leasing can record SME business related financial
information and business partners on the Business section to assist in approving the Line of
credit application during underwriting. The Business Applicant screen is available and
contains the following sub screens:
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e Address

e Telecoms

e Financials

e Liabilities

e Partners

e Affiliates

e Other details

If there are no business information associated with the application, the Business Applicant

tab is unavailable.

To complete the Business tab

1. If SME business information is included on the application, select SMALL BUSINESS in
the Class field on the Applications section and click Save.

The Business tab appears on the Underwriting screen.

2. Click BusinessTab.
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3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Organization Type

Select the organization type.

Business Type

Select the type of the business.

Business Name

Specify the name of the business.

Legal Name

Specify the legal name of the business.

Tax ID

Specify the tax identification.

Start Date

Specify the business start date.

# of Employees (Cur)

Specify the current number of employees at the business.
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7.6.1

Field:

Do this:

# of Employees

Specify the number of employees at the business after
financing.

Contact Person

Specify the contact person at the business.

Business Checking
Bank

Specify the bank name of the business’s checking account.

Bank Acc #

Specify the bank account number.

Avg Checking Balance

Specify the average checking balance.

# of Locations

Specify the number of locations of the business.

Management Since

Specify the year the current management was established.

Existing Business

Check this box if it is an existing Business.

Existing Business
Name

Specify the name of Business entity. If this is not an existing
Business, the field is displayed as UNDEFINED.

Payment Hierarchy

Select the required Hierarchy Definition to be used for pay-
ment appropriation from the drop-down list. The list is popu-
lated with all the pre-defined and enabled hierarchy
definitions maintained Setup > Administration > Users >
Payment Hierarchy screen.

The Hierarchy Definition selected here is propagated to Ser-
vicing > Customer/Business details. If an existing hierarchy

is modified and the ‘Update Customer/Business info’ option

is enabled, then the Payment Hierarchy in Servicing > Cus-

tomer / Business details are also updated.

4. Perform any of the Basic Actions mentioned in Navigation chapter

Address Sub Tab

You can enter more than one address for the business.

To complete the Address Sub Tab
1. Click Address Sub Tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Current

Check this box if this is a current address.

The mailing address must be marked as current.
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Field:

Do this:

Permission to Call

Check this box if customer has provided permission to
contact through the specified phone number.

Atleast one phone number per application should have
the permission to call (flagged as 'Y') for the successful
pre-qualification of the application. Else, an error mes-
sage is displayed.

Permission to Text

Check this box if customer has provided permission to
contact through text message.

Mailing Check this box if this is the mailing address. Only one
address entry can be marked as the mailing address.

Address Type Select the address type.

Country Select the country.

Address # Specify the building number.

Own /Line of credit

Select the ownership type.

Comment Specify a comment.
Postal Type Select the address type.
Street Pre Select the street prefix (directional).

Street Name

Specify street name

Street Type

Select the street type.

Street Post

Select the street postfix (directional).

Apt #

Specify the apartment number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.

Zip Select the zip code.
For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
City Specify the city.
State Select the state.
Phone Specify the phone number.

3. Perform any of the Basic Actions mentioned in Navigation chapter

4.

If there are more than one addresses associated with business, click Save And Add and

add the address details.
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7.6.2 Telecoms Sub Tab

The Business tab’s Telecoms sub tab needs to be completed, if additional phone numbers for
the business exist. If not, this sub tab can be ignored.

To complete the Telecoms sub tab

1. Click Telecoms sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Permission | Check this box if customer has provided permission to

to Call contact through the specified phone number.
Atleast one phone number per application should
have the permission to call (flagged as 'Y') for the suc-
cessful pre-qualification of the application. Else, an
error message is displayed.

Permission | Check this box if customer has provided permission to

to Text contact through text message.

Type Select the telecommunication type.

Phone Specify the phone number.

Extn Specify the phone extension.

Current If selected, indicates that this is a current telecom.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

7.6.3 Financials Sub Tab

The Business tab’s Financials sub screen only needs to be completed if financial assets exist
on the application for the business. If not, this sub screen can be left blank.

To complete the Financials sub tab

1. Click the Financials sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Type Select financial type; for example, liquid assets, retirement assets,
and so on.

Source Specify source; for example, stocks, 401K, rent received, and so
on.

Currency Select the currency of the asset.

Amount Specify amount.
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7.6.4

7.6.5

Field: Do this:

Line of credit

The system displays the Line of credit currency amount

Currency

Amount

Comment Specify comment, if any.

Include Check this box to include this record in calculations on the Other

Details sub section.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Liabilities Sub Tab

The Business Applicant link’s Liabilities sub screen only needs to be completed if financial
liabilities exist on the application for the business. If not, this sub screen can be left blank.

To complete the Liabilities sub tab

1. Click Liabilities sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
Type Select the liability type.
Currency Select the currency.

Line of credit Currency
Amount

The system displays the Line of credit currency amount

Amount Specify the liability amount.
Frequency Select the frequency.
Account Type Specify the account type.

Line of credit Currency
Account Balances

The system displays available Line of credit currency

account balance.

Account Balance

Specify the account balance.

Comment

Specify comments, if any.

Include

Check this box to include this record in calculations on
the Other Details sub screen.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Partners Sub Tab

You can enter more than one partner for the business.

To complete the Partners sub tab

1. Click Partners sub tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field:

Do this:

Permission to
Call

Check this box if customer has provided permission to contact
through the specified phone number.

Atleast one phone number per application should have the permis-
sion to call (flagged as "Y') for the successful pre-qualification of the
application. Else, an error message is displayed.

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

First Name Specify the partner’s first name.

Mi Select the partner’s middle name.

Last Name Specify the partner’s last name.

Suffix Specify the partner’s suffix.

SSN # Specify the partner’s social security number.
Birth Dt Specify the partner’s birth date.

Birth Place Specify the partner’s birth place.

Title Select the partner’s title.

Ownership (%)

Specify the percentage of ownership held by the customer.

Net worth

Specify the partner’s net worth.

Gross Income

Specify the partner’s gross income.

Language Specify the partner’s language.
Nationality Specify the partner’s nationality.
Country Select the partner’s country code.
Address # Specify the partner’s address number.

Address Line 1

Specify the partner’s first address.

Address Line 2

Specify the partner’s second address line.

Zip Select the partner’s zip code.
For non-US country, you have to enter zip code.
Zip Extn Specify the partner’s zip extension.
City Specify the partner’s city.
State Select the partner’s state.
Phone Specify the partner’s phone number.
Extn Specify the partner’s phone extension.
Email Specify the partner’s email.
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7.6.6

7.6.7

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Affiliates Sub Tab

You can enter more than one affiliate for the business.

To complete the Affiliates sub tab
1. Choose Affiliates sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Organization
Type

Select the affiliate’s organization type

Legal Name

Specify the affiliate’s legal name

Business Name

Specify the affiliate’s business name

Tax ID

Specify the affiliate’s tax identification

Ownership (%)

Specify the affiliate’s percentage of ownership

# of Employees

Specify the affiliate’s number of employees

NAICS CODE Specify the affiliate’s North American Industry Classification
System code.

Country Select the affiliate’s country code.

Address # Specify the affiliate’s address number.

Address Line 1

Specify the affiliate’s first address line.

Address Line 2

Specify the affiliate’s second address line.

Zip

Select the affiliate’s zip code.

For non US country, you have to enter zip code.

Zip Extension

Specify the affiliate’s zip extension.

City

Specify the affiliate’s city.

State

Select the affiliate’s state.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Other Details Sub Tab

The Other Details sub screen records information regarding monetary amounts associated
with the business such as profits, sales, and expenses.

To complete the Other Details sub tab
1. Click Other Details sub tab.

2. Click Edit.

3. Verify financial details as well as assets and liabilities linked to the business.
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A brief description of the fields is given below:

Field:

Do this:

Other Details section

Currency

Select the currency.

Business Type

Select the type of business.

Analysis Frequency

Select the analysis frequency.

Line of credit Currency
Gross Margin Factor

The system displays the Line of credit currency business’s
gross margin factor

Gross Margin Factor

Specify the business’s gross margin.

Organization Type

Select the type of organization.

Line of credit Currency
Income

The system displays the Line of credit currency business
income amount.

Income

Specify the business’s income amount.

Line of Credit Currency
Collection Average

Specify the Line of Credit currency collection average.

Collection Average

Specify the collection average.

Line of CreditCurrency
Proj Coll Avg Annual

Specify the Line of Creditcurrency annual projected collec-
tion average.

Proj. Coll.Avg.Annual

Specify the annual projected collection average.

Line of CreditCurrency
Book List

Specify the Line of Creditcurrency business booklist.

Book List

Specify the business booklist.

Line of CreditCurrency
Turn Over

Specify the Line of Creditcurrency turnover amount.

Turn Over

Specify the turnover amount.

Line of CreditCurrency
Capital Amount

Specify the Line of Creditcurrency capital amount.

Capital Amt

Specify the capital amount.

Line of CreditCurrency
Earned Surplus

Specify the Line of Creditcurrency earned surplus amount.

Earned Surplus

Specify the earned surplus amount.

Line of CreditCurrency
Gross Profit

Specify the Line of Creditcurrency gross profit amount.

Gross Profit

Specify the gross profit amount.

Line of CreditCurrency
Net Profit

Specify the Line of Creditcurrency net profit amount.
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Field:

Do this:

Net Profit

Specify the net profit amount.

Line of CreditCurrency
Working Capital

Specify the Line of Creditcurrency working capital amount.

Working Capital

Specify the working capital amount.

Line of CreditCurrency
Annual Sales

Specify the Line of Creditcurrency annual sales amount.

Annual Sales

Specify the annual sales amount.

Line of CreditCurrency
Projected Sales

Specify the Line of Creditcurrency projected sales amount.

Projected Sales

Specify the projected sales amount.

Line of CreditCurrency
Equity

Specify the Line of Creditcurrency equity amount.

Equity

Specify the equity amount.

Open Delq

Specify the open delinquency amount.

Line of CreditCurrency
Business Expenses

Specify the Line of Creditcurrency business expenses
amount.

Business Expenses

Specify the business expenses amount.

Line of CreditCurrency
Personal Expenses

Specify the Line of Creditcurrency personal expenses
amount.

Personal Expenses

Specify the personal expenses amount.

Line of CreditCurrency
Total Expenses

View the Line of Creditcurrency total expenses amount.

Total Expenses

View the total expenses amount.

Line of CreditCurrency
Annual Proj Sales Amt

View the Line of Creditcurrency annual projected collection
amount.

Annual Proj Sales Amt

View the annual projected collection amount.

Line of CreditAnnual
Proj Exp Amt

View the Line of Credit annual projected expenses amount.

Annual Proj Exp Amt

View the annual projected expenses amount.

Line of CreditCurrency
Current Assets

Line of Creditcurrency current assets.

Current Assets/Liability
ratio

View the current asset to liability ratio.

Line of CreditCurrency
Fixed Assets

View the Line of Creditcurrency fixed assets.

Fixed Assets

View the fixed assets.
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7.7

Field:

Do this:

Line of CreditCurrency
Intangible Assets

View the Line of Creditcurrency intangible assets.

Intangible Assets

View the intangible assets.

Line of Credit

View the Line of Credit

Current Liabilities

View the current liabilities.

Line of Credit

View the Line of Credit

Long Term Liabilities

View the long term liabilities.

Line of Credit

View the Line of Credit

Total Assets

View the total asset amount.

Line of Credit

View the Line of Credit total net worth amount.

Total Net worth

View the total net worth amount.

Line of Credit

Line of Credit

Total Liability

View the total liability amount.

Debt Net worth Ratio

View the debt to net worth ratio.

Current Assets/Liability
ratio

View the current asset to liability ratio.

Signatures

Title 1-4

Specify the title.

Signature1-4

Specify the signature.

Request Tab

In the Request tab you can define the required Line of credit parameters. By default, system
calculates for monthly repayment term basis. The payment frequency can be changed only in
the Underwriting tab during decisioning.
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7.71

To complete Request section:

1. On the Application Entry tab, click Request tab.
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2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields are given below:

Field Do this

Credit Limit Specify the value of the credit limit.

Advance Specify the value of advance amount paid.
Promotion Select the promotion type from the drop-down list.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Itemization Sub Tab

The Itemizations sub tab enables you to add or verify any itemized amounts associated with
the application. The list of itemizations is determined by the product you select in the master
screen during the application entry process. The Itemizations sub screen displays an
itemization record of the amount financed, such as the cash price, cash down payment, trade-
in, unpaid cash price balance and so on. Information that was entered on the ltemization sub
screen during the application entry process will appear in the Requested Amt column.
Information that you enter as an underwriter in the Approved Amt column will appear in the
Itemizations sub tab on the Underwriting screen.

Application request details need to be essentially entered in the itemization sub tab for pre-
screening to be successful. Else, the system displays error and application would not proceed
to the next level in work flow. The details of down payment, trade-in, insurance, fees etc. and
the total sale price are recorded under itemization.

To add or view itemizations

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Request > Itemizations sub tab.

Perform any of the Basic Operations mentioned in Navigation chapter.
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7.7.2

A brief description of the fields is given below:

Field: Do this:

ltemization View the itemization.

+/- View whether the itemized amount is added or subtracted
from the Line of credit amount.

Requested Amt Specify the requested amount.

Comment Specify a comment.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Trade-In Sub Tab

The Trade-In sub screen enables you to add or verify any trade-ins associated with the
application. If there is any information regarding an itemized trade-in, use the Trade-In sub
screen to enter the details in the system. (This sub screen might already contain information
supplied during the application entry process.)

To complete the Trade-In sub screen

1. Open the Underwriting screen and load the underwriting application you want to work

with.

2. Click Request > Trade-In.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Trade-In

Asset Type Select the asset type.

Asset Sub Type Select the asset sub-type.
Year Specify the year of the asset.
Make Specify the make of the asset.
Model Specify the model of the asset.
Body Specify the body of the asset.

Identification #

Specify the identification number.

Description

View the asset description.

Valuation

Wholesale Amt

Specify the wholesale value.

Base Retail Amt

Specify the retail value.

Addons Amt (+)

Specify the add ons value.

Pay Off Amt (-)

Specify the payoff amount.
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7.7.3

7.8

Field: Do this:

Total Amt = View the total value.
Valuation Dt Specify the valuation date.
Source Select the valuation source.

Valuation Supplement | Specify the valuation supplement.

Edition Specify the valuation edition.

4. Perform any of the Basic Actions mentioned in Navigation chapter

Subvention Sub Tab

With the Subvention sub tab, available only for Line of credit, you can review the subvention
information from the application entry and calculate the subvention amount, as well as
override the calculated subvention amount. The participant’s information is automatically
populated based on the selected subvention plan.

To complete the Subvention sub screen

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Request > Subvention sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Subvention Plan section:

Plan Select the subvention plan.

Description View the subvention plan description.

Sub Plan Select the sub plan.

Sub Plan Description View the subvention sub plan description.

Subvention Type View the subvention type.

Include Check this box to include this record in calculations on the

Other Details sub section

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Decision Tab

If the application was initially approved automatically, the system displays its
recommendations on the Decision tab’s Approved section.

If the application was initially rejected automatically, the system displays its reasons on
the Decision link’s Stipulation sub tab.
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If you choose to approve or reject the Line of credit manually, you must manually select
the pricing (rule) set by the portfolio company for a specific product. The system validates this
pricing against the information in the System Recommendation sections. The information in
the Requested section comes from the application entry process and can be edited.

o If the data meets your approval, change the status of the application to either
APPROVED or REJECTED and enter any stipulations.

e If you reject the application, change the status to REJECTED and enter the reasons for
the adverse action on the Stipulations sub screen.

To verify the application decision data

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision tab.
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3. Perform any of the Basic Operations mentioned in Navigation chapter.
— A brief description of the fields is given below:

Field: Do this:

Pricing section

Current Check this box to indicate that this is the current deci-
sion.

Pricing View the pricing.

Decision Dt View the decision date.

Underwriter View the underwriter id.

Status View the application status.

Sub Status View the application sub-status.
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Field: Do this:

Approved section

Index Specify the index type.

Approved Index Rate | Specify the approved index rate.

Approved Margin Specify the approved margin rate.
Rate

Approved Rate Specify the approved rate.

Maturity Index Select the approved maturity index.

Maturity Margin Rt Specify the maturity margin rate.

Credit Limit Specify the credit limit.
Promotion Select the promotion.
Grade Select the credit grade.
Score Specify the credit score.
Draw Term Specify the draw term.
Repmt Term Specify the repayment term.
Bureau 1 Specify the Bureau 1.
Bureau 2 Specify the Bureau 2.
Bureau 3 Specify the Bureau 3.
Comments Specify comments, if any.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. Click Select Pricing.

The system determines the best pricing match of all enabled Line of credit pricing strings
in the Setup menu and displays the results in the Pricing and Approved sections.

6. Re-Score

A 'Re-Score' button is available next to 'Calculate’. Whenever any sensitive Financial or
Collateral information is amended in the Application, OFSLL displays a warning
message 'Scoring sensitive information is changed. Re-score the application’. You need
to click on Re-Score to re-validate the grade and pricing accordingly.

The display of the warning message to Re-score the application can be controlled using
the respective System parameter. If the defined System Parameter is flagged 'Y', only
then the message is displayed.

If you are underwriting a Line of credit, record the following information on the Decision
tab:

7. If you are approving the application, complete the Approved section with the values you
want to approve as an underwriter. You can update the default values that appeared
when you selected the pricing string in step 3. (The system calculator may be of use when
completing this section. For more information, refer the Tools chapter).
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7.8.1

7.8.2

System Recommendation

The System Recommendation sub screen displays the system generated Score, Decision
and Grade. You will also be able to view the request details of the application under
'Requested' section itself.

A brief description of the fields in System Recommendation section are given below:

Field: Do this:
Score View the system recommended score.
Decision View the system recommended decision.
Grade View the system recommended grade.
A brief description of the fields in Requested section are given below:
Field Do this
Requested Advance Amt View the requested advance amount
Pmt Amt View the requested payment amount.
Term View the requested term (number of payments).
Requested Rate View the requested rate of interest.
Down Pmt% View the down payment percentage
Down Pmt View the down payment amount
Approx Prc View the approximate cash price
Promotion View the promotion type from the drop-down list.
Balloon Amt View the balloon amount.
Signing Dt View the signing date
Probable Delivery Dt View the probable delivery date.

Stipulations Sub Tab

The Stipulations sub screen allows to add any stipulations or reasons for adverse action you
want to attach to the application. Stipulations are items that need to be addressed before the
Line of credit can be funded.

If the application was automatically rejected during the application entry edits, the system
displays the automatically generated adverse action codes in this sub screen. If the
application is manually rejected by the Underwriter due to adverse action reasons received
from bureau or otherwise, the same can be recorded for each of the applicant.

In addition, you can enter comments against specific stipulations as required. Whenever a

Stipulation is marked as 'Not Applicable' it becomes mandatory to specify the reason in
comments field. Else, system prompts for the reason while processing the application.
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7.8.2.1

7.8.2.2

To add or view stipulations or reasons for adverse action

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Stipulations sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below.

Field: Do this:

Type Select the reason type. Type can be Stipulation Reasons or Adverse
Action Reasons and Adverse Action Reasons can also be those
received from Bureau.

Name The system displays all applicant’'s name in the drop down list. You

can select the name of the applicant for whom adverse action reason
needs to be recorded. In case the stipulation reason is at the appli-

cation level, then select ALL.

Code Select the reason.

Description Specify the required description.

Stips Satisfied Use the Yes/No/NA buttons to indicate if you verified the stipula-
tion(s) in the Type field

Comment Specify the comment.

Verified By The system updates the user ID of the person who verified the
details

Verified Dt The system updates the date when the details are verified.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

If your system is set up to manually load predefined stipulations, click the Load Stipulations
button (For more information, refer the following section, Loading Stipulations.)

Add Multiple

The system enables you to add multiple records to stipulations using the 'Add Multiple' option.
To add multiple stipulations
1. Click the drop down list adjacent to the 'Add Multiple' button.

2. Select the check box against to the required stipulations. You can also select ’All’ to load
all the available stipulations.

Click Add Multiple.

4. If required, you can perform any of the Basic Actions mentioned in Navigation chapter.

Copying Stipulations

The system enables you to automatically transfer stipulations from previous decisions on the
Stipulations sub screen with the Copy Stipulations button. This is particularly useful when you
are rehashing an application and want to use the same stipulations as those in place for the
previous decision.
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7.8.2.3

7.8.3

Loading Stipulations

The system supports the automatic generation of default stipulations on the Underwriting
screen’s Stipulations sub screen. The default stipulations can be maintained by company,
branch, product, state, application status and application sub-status. When the application
status changes (either manually and automatically), the system populates the maintained
stipulations with a Stips Satisfied indicator of ‘No’. You can review and update the stipulations
accordingly.

You have the option to manually load predefined stipulations by clicking the Load Stipulations
button on the Stipulation screen.

To load predefined stipulations

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Stipulations.

3. Click Load Stipulations. The system loads the default stipulations on the Stipulations
sub screen.

4. Use the Yes/No/NA buttons in the Stips Satisfied column to indicate if you verified the
stipulation(s) in the Type field.

5. Click Save on the Stipulations sub screen.

Itemization Sub Tab

The Itemizations sub screen enables you to add or verify any itemized amounts associated
with the application. The list of itemizations is determined by the product you selected in the
master screen during the application entry process. The Itemizations sub screen displays an
itemization record of the amount financed, such as the cash price, cash down payment, trade-
in, unpaid cash price balance and so on. Information that was entered on the Itemization sub
screen during the application entry process will appear in the Requested Amt column.
Information that you enter as an underwriter in the Approved Amt column will appear in the
Itemizations sub screen on the Underwriting screen.

To add or view itemizations

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Itemizations sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
Iltemization View the itemization.
+/- View whether the itemized amount is added or subtracted

from the Line of credit amount.

Requested Amt Specify the requested amount.
Approved Amt Specify the approved amount.
Discount Rate Specify the discount rate.
Comment Specify a comment.
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7.8.4

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Trade-In Sub Tab

The Trade-In sub screen enables you to add or verify any trade-ins associated with the
application. If there is any information regarding an itemized trade-in, use the Trade-In sub
screen to enter the details in the system. (This sub screen might already contain information
supplied during the application entry process.)

To complete the Trade-In sub screen

1. Open the Underwriting screen and load the underwriting application you want to work

with.

2. Click Decision > Trade-In sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Trade-in section

Asset Type

Select the asset type.

Asset Sub Type

Select the asset sub-type.

Year Specify the year of the asset.
Make Specify the make of the asset.
Model Specify the model of the asset.

Identification #

Specify the identification number.

Body

Specify the body of the asset.

Description

View the asset description.

Valuation section

Wholesale Amt

Specify the wholesale value.

Base Retail Amt

Specify the retail value.

Addons Amt (+)

Specify the add ons value.

Payoff Amt (-)

Specify the payoff amount.

Total Amt = View the total value.
Valuation Dt Specify the valuation date.
Source Select the valuation source.

Valuation Supple-
ment

Specify the valuation supplement.

Edition

Specify the valuation edition.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
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7.8.5

7.8.6

Rate Schedule Sub Tab

The Rate Schedule sub screen is only available for variable rate Line of credit and displays
the rate adjustment frequency information based on product setup.

To view the Rate Schedule sub screen

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Rate Schedule sub tab. Click View.

A brief description of the fields is given below:

Field: View this:

Seq The rate adjustment sequence number.

Adjustment Frequency Type The rate adjustment frequency type.

Period The rate adjustment period for the frequency.

# of Adjustments The number of rate adjustments for the frequency.

Subvention Sub Tab

With the Subvention sub tab, available only for Line of credit, you can review the subvention
information from the application entry and calculate the subvention amount, as well as
override the calculated subvention amount. The participant’s information is automatically
populated based on the selected subvention plan.

To complete the Subvention sub tab

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Subvention sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Plan Select the subvention plan.

Description View the subvention plan description.

Sub Plan Select the sub plan.

Sub Plan Description View the subvention sub plan description.

Subvention Type View the subvention type.

Include Check this box to include this record in calculations on the
Other Details sub section

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In Subvention Detail section, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below.

Subvention Detail section:

Participant View the participant.

Participant Type View the participant type.

Collection Method View the collection method.

Rate View the subvention rate.

Rent Factor View the rent factor

Calculation Method View the subvention calculation method.
Factor View the factor.

Calculated Amount View the calculated subvention amount.
Subvention Amount Specify the subvention amount.

Include View if the subvention is included in the application or not.
Total Subvention Rate View the total subvention rate.

Total Subvention Amt View the total subvention amount.

6. Perform any of the Basic Actions mentioned in Navigation chapter.
7. Select the Initialize button to reset the subvention amount to zero.

8. Select the Calculate button to calculate the subvention amount.

Customer Credit Limit tab

This tab is available only if the selected product has the ‘Customer Credit Limit’ check box in
selected in Products setup screen (Setup > Products > Products).

Customer Credit limit in general refers to the maximum amount of credit that a financial
institution can extend to a prospective customer which can then be leveraged by an
underwriter while funding an application.

In Oracle Financial Services Lending and Leasing, you can define the Customer Credit Limit
during underwriting stage based on the customer credit worthiness or historical customer
data. Using this limit, applications can be funded up to the credit limit amount allowed.
However, application funding with or without customer credit limit is controlled based on the
setup and applications can still be funded with the normal process when a particular customer
is not allocated with any credit limit.

A customer credit limit facilitates for quick decisioning by an underwriter and also facilitates
for auto approval of accounts on-boarded from external system with basic validations. While
approving, underwriter has to ensure that the sum of utilizations should always be equal to
the financed amount which can be distributed within applicants primary / secondary or
business categories.

A minimum of one application has to be funded to define customer credit limit for funding
subsequent applications and the defined information is updated into credit limit details. A
credit limit once defined can further be increased from servicing module by posting the

required transaction which is referenced in origination module during application funding.
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On receiving a payment, the amount is reinstated to the credit limit balance which can be re-
used while funding next application. Similarly, the credit limit balance is also updated when
account is moved to VOID status. On reversing a payment, the Total Utilization of credit limit
is increased by the principal portion of the payment and decreased with the Available Amt
field. Also, the Suspended and Hold amount fields are increased and decrease based on the
respective transactions posted.

When two applications are being funded simultaneously (i.e. moving application to ‘Approved
Funded’ status), the utilization amount will be considered for first application while the second
one will be on HOLD since there could be a difference in the available credit limit after funding.
In such a case, you need to re-hash the application, fetch the details in Origination > Decision
tab, (if required) increase credit limit from servicing module, and then proceed for funding.

While processing applications using Customer Credit Limit, the ‘Update Customer Info’ (check
box in applicant tab) and ‘Link to Existing Customer’ (check box in contract tab) are selected
by default for all the existing customers. This is to ensure the application details are
propagated to customer accounts.

On funding a new application for an existing customer using customer credit limit, the details
are updated into the existing customer details in the Servicing module. Also, while posting any
monetary transaction that results in increase of account maturity date, system auto validates
if the same is within the 'Customer Credit Limit Expiry date' of any one or all of the customer(s)
who contributed for funding the Account. In case it is greater, system displays an error
indicating that the resulting Maturity date is greater than 'Customer Credit Limit Expiry date'
and does not allow to post the transaction.

To define Credit Limit Details

1. Open Underwriting screen and load the underwriting application you want to work with.
2. Click ‘Customer Credit Limit’ tab.

oORACLE % Welcome, ABSHEKAR + g signout
Financial Services Lending and Leasing

Origination

usiness | Request Dedson  Customer Credit Limit Bureau Collatersl Comments Tracking Document Verification —Correspondence  Tools

Credit Limit Details

view v Formatv [P
Customer #
Business *

0000000000

Relation Type Name Max Limit. % of Utilization Utiization Amt  Total Utlized Amt Available Amt Suspended Amt Grade

PRIMARY PRITAM APP CRDE 0.00 0.00 0.00 0.00 0.00 0.00

BUSINESS 0000000000

Credit Limit Details
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* o of Utiization | 0.00
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Name PRITAM APP CROETT LIMIT
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[
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3. Perform any of the Basic Operations mentioned in Navigation chapter. A brief description

of the fields are given below:

Field:

Do this:

Relation Type

View the relationship type. This field is pre-populated with
details from Applicant tab.

Customer # / Busi-
ness #

This field is displayed blank for new customer/business and
for an existing customer/business, the details are populated
from Servicing > Customer Service > Customer details.
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Field: Do this:

Name View the customer name. This field is pre-populated with
details from Applicant tab.

Max Limit Specify the value of maximum credit limit amount that can be
provided to the customer.

For new customer/business, the amount is pre-populated
based on selected pricing in Decision tab for new applicant/
business. However, you can override the amount by entering
the required value.

Total Utilized Amt View the total credit limit amount utilized for previously
funded applications.

Available Amt View the available credit limit amount on the account which
is the difference of Max Limit - (Hold + Total Utilized + Sus-
pended) amount.

Hold Amt View the credit limit amount on hold which is based on the
Hold transaction posted in servicing.

Suspended Amt View the credit limit amount suspended which is based on
suspended transaction posted in servicing.

Grade Select the required grade from the drop-down list. There is
no validation performed on the selected grade and can be
selected based on customer credit worthiness.

Max Late Charge Specify the maximum late charge amount.

Limit Expiry Select the credit limit expiry date from the adjoining calendar.
The expiry date is validated if application is being funded
based on customer credit limit.

Limit Next Renewal | Select the date on which the credit limit has to be renewed
from the adjoining calendar.

Application Utilization section - This section allows you to define the portion
(either percentage or amount) of credit limit utilization against the financed amount.

For example,

if the amount financed it 10,000 $ and percentage of Utilization for Primary is 80%
then Utilized amount should be 10,000*0.8 = 8000 $.

Similarly, if the percentage of Utilization for Spouse is 20% the Utilized amount
should be 10,000*0.2 = 2000 $.

Note: On specifying either percentage or amount of utilization, the other field is auto
calculated based on financed amount.

% of Utilization Specify the percentage of credit limit utilization allowed
against each applicant (Customer and business) added to
the application.

Utilization Amt Specify the amount of credit limit utilization allowed against
each applicant (Customer and business) added to the appli-
cation.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
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7.10

Master Account tab

The Master Account tab in Origination screen facilitates to categorize the current application
to be considered as ‘Master Account’ or link the current application to another existing master
account in the system after funding. If the current application is considered as ‘Master

Account’, you can also define Payment Hierarchy for payment appropriation during servicing.

Master account here refers an account which has similar type of accounts of the same
customer grouped under one head. When there are multiple accounts of the same customer,
marking one of them as Master Account and grouping all the associated loan/line/lease
accounts under an Individual customer/Business in the system helps to generate
consolidated statement, make payments, manage ACH, generate payoff quote, post due date
change and extension transitions.

For example, grouping of all loan accounts under one master account of a customer, or
grouping of lease accounts funded with same contract terms during the current financial year.
To define Master Account Details

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click ‘Master Account’ tab.

In the Master Account Details, click ‘Edit’. You can also perform any of the Basic
Operations mentioned in Navigation chapter.

ORACLE’
Financial Services Lending and Leasing
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View v Formatv Ep Freeze  Ef Detach Wrap @ OverideOK ¥ WamingOK ¥  MANUAL Contract
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Bxisting Customer oLt Contact Sales Agent Bran

01/01/2019 0000001017 UNDEFINED APPROVED - REH... REVIEW NY-00002 : SUNRL.. (631)-589-0047 Y e DEMOSUPR USR
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Origination Stage
Dt App # Sub Unit Status o

Producer Name  Producer Contact
Numl

Summary = Applicant | Request Decision Bureau = Contract Master Account | Comments Tracking Document Verification = Correspondence Tools

Master Account Details # Edit View Audit
View > Format~ [ Freeze [t Detach Wrap o)

Link to Master
Account
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Master Account Linked Account Payment Hierarchy

Master Account Details
[} saveand stay | [ Save and Retun | (3 Retun

* Master Account []
Link to Existing Master Account UNDEFINED M
Linked Account UNDEFINED
Payment Hierarchy OUTSTANDING BALANCE -

4. Do one of the following:

e Master Account - Check this box to mark the current Application as Master Account.
After funding the application, system populate the Master Account number same as
Account number under the customer to be identified as Master Account in Servicing.

If the Account details are received from external system through Onboarding process
and the application is already marked as Master Account, then the same Account # is
populated in Master Account # field once the application is funded.

e Link to Existing Master Account - If there is already an existing Master Account
defined for the customer, select the same from drop-down list to associate the current
application to be a part of that account after funding. The list is populated with values in
the format: ‘Relationship Type - Title - Master Account #'.
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e Linked Account - If there is an account to be linked to the current application to have
one-to-one mapping, select the same from drop-down list. The accounts are listed in
format ‘Customer ID - Title - Account #'.

— Thellist is populated with those Accounts which are associated with Customer (i.e.
added as an applicant) and the ‘Link to Existing Customer’ option is checked.

— However, this list does not include Master Accounts and accounts which are already
associated with other Accounts (i.e. already linked to some other account).

On funding the application, both the accounts (newly created and existing) are
interlinked and system updates the ‘Linked Account’ field with Account # respectively.

Note

If account is created using ‘Account Onboarding Service’, the ‘LinkedAccountXrefNumber’
element available under ‘ApplicationData’ parent element, can be used to indicate Linked
Account Xref number to link to Associated Account if both Master and Associated Ac-
counts are in a single payload.

System performs the following edits before linking the accounts:

— Ensure that the Billing Cycle and Due day of current application is same as the
Linked Account Billing Cycle and Due Day. However this is not validated if both
accounts are of ‘Same Billing Cycle’.

— If the current application is to be linked to a Master Account, ensure that the
‘Product/Funding Type’ of both current application and Master Account are same
and also belongs to same ‘Company’.

— The Current and Linked Account belongs to same Company.

e Payment Hierarchy - The field is enabled only on selecting the above ‘Master Account’
check box. Select the required Hierarchy Definition to be used for payment
appropriation from the drop-down list. The list is populated with all the pre-defined and
enabled hierarchy definitions maintained Setup > Administration > Users > Payment
Hierarchy screen. The Hierarchy Definition selected here is propagated to Customer
Service > Account Details > Additional Details section.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Bureau Tab

The Bureau tab displays the credit report (if pulled) for an applicant. If there is a need for
another pull for any applicant, it can be done here manually using the New Request section.

If there are any adverse comments received from the Bureau, system displays them under
'Exceptions/ Comments' section against the specific Bureau record to alert the User.
Following are some of the reasons:

1. Application Indicates Potential Fraud

Bureau Indicates Social Security Number Variance
Duplicate Application Exists

Bureau Indicates a Possible Current Delinquency
Bureau Indicates Bankruptcy

Bureau Indicates Consumer Statement

Bureau Indicates a Possible Repossession

Bureau Reports OFAC hit

© © N o o b~ w0 D

Bureau Reports Applicant as Deceased
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10. Potential Delinquencies for Auto Loans in Past 12 Months
11. Customer Rate (APR) Exceeds the State Usury Rate

12. Open Consumer Credit Counselling

The reasons will also be displayed in the Summary tab in 'Bureau' details under 'Exceptions

/Comments' section.

To verify the credit bureau data using the Bureau tab

1. Open the Underwriting screen and load the underwriting application you want to work

with.
2. Click Bureau.
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In the Bureau Details section, view the following information:

Field:

View:

Type

The credit bureau request type.

Bureau

The credit bureau.

#

The credit bureau request number.

Status

The status of credit bureau request.

Dt

The credit bureau request date.

Report

The credit bureau report type.

Credit Bureau
Reorder#

The credit bureau reorder number.

App Ind

If selected, indicates that a bureau was pulled for an application.
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4. In the Applicant/Customer Detail section, view the following information:

Field: Do this:

Type View the relation type.

First Name Specify the first name.

Mi Specify the middle name.

Last Name Specify the last name.

Status View the credit bureau request status.

Birth Dt Specify the date of birth.

SSN Specify the social security number.
Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is set to Y, this appears as a masked number; for example,
XXX-XX-1234.

Suffix Select the generation.

Include Debt | Select to include credit bureau information in the Liabilities section of
the Summary sub screen.

Populate Select to load debt information from the credit bureau in the Liabili-

Debt ties section of the Summary sub screen.

Address Type | Select the address type.

Country Select the country.

Address # Specify the building number.

City Specify the city.

State Select the state code.

Street Pre Select the street pre type.

Street Name

Specify the street name.

Street Type

Select the street type.

Street Post

Select the street post type.

Apt #

Specify the apartment number.

Address Line
2

Specify the address line 2.

Zip Select the zip code.

For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
Phone Specify the phone number.
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5. In the Report Header section, view the following information:

Field: View:

Bureau The bureau.

First Name The first name.

Mi The middle initial.

Last Name The last name.

SSN The social security number.
Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is set to Y, this appears as a masked number; for example,
XXX-XX-1234.

Birth Dt The birth date.

Note: The SSN and Birth Dt fields in Report Header section are displayed in red if
there is a mismatch in the respective data present in the above Applicant/Customer
Details section.

Report Dt The report date.

Onfile Dt The on file date.

Credit Report | The credit report id.
Id

Best Match The best match.

6. Click Bureau Report.

The system parcels out the details from the credit bureau report in the Bureau screen’s
sub tabs (Summary 1, Summary 2, Tradelines, Public Records, Collections, Fraud
Messages, Inquiries, Also Known As, Consumer Statements, and Credit Scores).

7. Click Summary 1 sub tab.

8. You can view the following information:

Field: View:

Trades Records of extended installment payments, mortgage and revolving
credit, as detailed in the credit bureau report.

Bankruptcy | The total number of times the applicant has applied for Chapter 7,
Chapter 11 and Chapter 13 bankruptcies, recently and throughout life.

Past Due The total number of times the applicant has been past due on pay-
ments by 30, 60, or 90 days in the last year, two years, and throughout
life.

Public Number of legal actions, including liens, public records, and judgments

Records over the course of the applicant’s life, as well as any that are currently
open.

Collection Trades referred to an outside vendor for collection.

Credit View the FICO and bankruptcy scores.

Scores
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Field: View:

Statistical Ages of the oldest and newest trades, as well as the average age of
Trade Ages | the open and total trades.

Derogatory | Tradelines that an action other than being late was reported; this
Trades includes collections, repossessions, charge offs, and bankruptcies.

9. Click Summary 2 sub tab

10. You can view the following information:

In this .

. View:

section:

Trades Records of extended credit for auto, bank, credit card, retail, Line of
creditfinance, and sales finance Line of credit, as detailed in the credit
bureau report.

Inquiries Requests for a credit report regarding Line of credit in the Trades sec-
tion over the last six months, as well as total requests over 6, 12, and
24-month periods, as well as the newest and oldest request.

Balance The total balance of retail and bank trades, as well as the high balance
of each.

Open The following information for all of the customer’s open trade lines: the

Derogatory | shortest and longest period of time (in months) since the customer’s
most recent minor derogatory (30-60 days late), major derogatory (90-
180 days late), and derogatory (bankruptcy, repossession, or charge
off).

Derogatory | The following information for all of the customer’s total trade lines
(open and closed): the shortest and longest period of time (in months)
since the customer’s most recent minor derogatory (30-60 days late),
major derogatory (90-180 days late), and derogatory (bankruptcy,
repossession, or charge off).

11. Click Tradelines sub tab to view information about trade lines, such as the creditor’s
name, trade’s status, type and code and balance information

12. View the following details:

Field: View:

Creditors The creditors name.

Name

Status The status of the tradeline.

Type The type of tradeline, such as bank, first mortgage, travel card, and
SO on.

Type Code The code for the type of tradeline.

Past Due Amt | The past due amount

Balance The balance of the tradeline.

Balance Dt The balance date.
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Field:

View:

Open Dt The date the tradeline was opened.

History Dt The trade line’s history date.

History Data The trade line’s history data.

30 The number of times the tradeline was 30 days past due.
60 The number of times the tradeline was 60 days past due.
20 The number of times the tradeline was 90 days past due.
Creditors The creditor’s subscriber number.

Subscriber #

Mop The method of payment.

Account # The account number.

Credit Limit The credit limit.

Term Pmt Amt

The term payment amount.

High Balance | The high balance of the tradeline.
Reported Dt The reported date.
Duplicate If selected, the tradeline is a duplicate.

Special Exclu-
sion

If selected, the tradeline is a special exclusion.

13. Click the Public Records sub tab to view information about public records, including each
one’s type, status, and amount, as well as the date the record was filed and resolved

14. View the following details:

Field: View:

Record The record type.
Type

Status The status.
Amount The amount.
Filed Dt The filed date.
Satisfied Dt | The satisfied date.

15. Click the Fraud Messages sub screen to view information about fraudulent attempts to
use the applicant’s credit.

16. Click the Inquiries sub screen to view all the credit reports for the applicant in reverse
chronological order
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17. View the following details:

Field: View:

Inquirer Name The inquirer’s name.

Inquirer Subscriber | The inquirer’s subscriber number.

#

Inquirer Industry The inquirer’s industry code.

Code

Inquiry Dt The inquiry date.

Rate Shopping If selected, the inquiry concerned rate shopping.
Duplicate If selected, if the inquiry was a duplicate.

18. Click the Also Known As sub screen to view other names used by the applicant.

19. Click the Consumer Statements sub screen to view statements that the applicant has
issued to the credit bureau.

20. Click the Credit Scores sub screen to view the score model, the score factor, and the
score returned from the credit bureau report.

Printing the Credit Bureau Data as a Text/PDF Report

To print the credit bureau data as a text or PDF report

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. In the Underwriting screen, click Bureau.

3. Inthe Bureau Report tab, the system displays the report in text format. You can also view
the report in PDF format by selecting ‘PDF’ option as View Report.

Note

Google Chrome does not support search functionality in the PDF format of the report.
Hence you have to enable the ad-hoc plug-in in chrome to use the search facility.

4. In the Print Report section, click Print Report to send the information to the default
printer.

Requesting a Credit Bureau Report Manually

The Credit Bureau Summary screen enables you to manually request a credit pull.
Information from a manual credit pull can be used to validate an application.

To manually request a credit bureau report

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Bureau tab.

In the Bureau Details section click Add.
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4. Specify the following information:

Field: Do this:

Applicant Select the applicant.

Spouse Select the applicant’s spouse (if applicable).
Bureau Select the credit bureau.
Report Select the credit bureau report type.

5. Click Create Request.
The system displays this information in the Bureau Details section.

Note

If you are requesting a report from Experian Credit Bureau for Premier Attribute Consumer
report, you can do so without impacting the consumer FICO score. To facilitate the same,
the ‘Soft Pull’ check box is to be selected in Bureau Details section. This option is available
only when the system parameter ‘EXP_PA_SOFT_PULL_IND’ is enabled in the System
Parameters screen and Bureau is selected as ‘EXP’ with Report as ‘PREMIER ATTRIB-
UTE’ in the Bureau Details section.

6. Select Include Debt and Populate Debt in the Applicant/Customer Detail section to
populate the Liability section on the Applicants link’'s Summary sub screen with data from
the credit bureau pull.

7. If you want to receive a copy of a previously pulled credit bureau report, enter the credit
bureau reorder number in the Credit Bureau Reorder # field on the Bureau Details
section. This enables you to receive a previously pulled credit report.

8. In the New Request section, click Submit Request.
The system displays the latest status of the currently requested bureau report in the Bureau

Details section. When the report pull process is complete, the Status field in the Bureau
Details section changes from PENDING to COMPLETED.

Collateral Tab

Having selected and loaded an application, you can view the information about the collateral
of the Line of credit.

The Collateral link opens screens with information regarding any collateral associated with an
application. Depending on the type of Line of credit, collateral can be a vehicle, home or
something such as major household appliances. The Collateral tab is unavailable if this is an
unsecured Line of credit.

To verify information about the collateral
1. Open the Underwriting screen and load the application you want to verify.

2. Click the Collateral tab.

Depending on the type of collateral, information about the vehicle, home, or other type
of collateral appears.

If you are entering an unsecured Line of credit, the Collateral link is present but inactive;
in which case, skip this step.
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3.

In the Collateral Details section (This is information that was recorded during the

application entry process or gathered during the credit pull.)

To enter collateral information

1.

On the Underwriting screen, click Collateral. If the collateral is a vehicle, the Collateral

link displays information about the vehicle.
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2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Existing Asset

Check this box to indicate that the vehicle is an existing asset.

Existing Asset ID

View the existing asset identification number.

Primary

Check this box if this is the main asset on the application.

Asset Class

Select the asset class.

Asset Type

Select the asset type.

Sub Type

Select the asset sub type.

Status

Select the asset status.

Type and Description

Select Make and
Model

Select the make and model of the vehicle from drop-down list.

Year

Specify the year of the vehicle.

Age

View the age of the vehicle

Make

Specify the make of the vehicle.

Model

Specify the model of the vehicle.

Body

Specify the body of the vehicle.
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Field:

Do this:

Registration #

Specify the vehicle registration number.

Identification #

Specify the vehicle identification number.

Description View the vehicle description.
Condition Select the vehicle condition.
Address

Country Select the country.

Address # Specify the apartment number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.

Zip Select the zip code.
For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
City Specify the city.
State Select the state.
County Select the county.

Usage Details

The details maintained in this section is used to calculate ‘EXCESS USAGE FEE’ in pay-

off quote and termination transactions.

Start View/specify the start unit of asset usage.
Base View/specify the base units.

Extra View/specify the extra usage units.

Total View/specify the total usage units.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Interface with VINTEK (If interface is installed)

Using the Vintek interface, the system retrieves the year, make, model and body of the vehicle
when you choose Vehicle Details. This time saving feature reduces data entry errors. Using
the VIN entered in the Identification Number field, the system populates following fields in the
Type & Description section:

e Year
e Make
° Model
e Body

If the Vintek interface is unable to retrieve information based on the VIN entered in the
Identification Number field, the system displays an error message.
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If the collateral is a home, the Collateral link displays information about the home.
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1. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Existing Asset

Indicates that the vehicle is an existing asset.

Existing Asset ID

View the existing asset identification number.

Primary

Select if this is the main asset on the application.

Asset Class

Select the asset class.

Asset Type

Select the asset type.

Sub Type

Select the asset sub type.

Occupancy

Select owner occupancy type.

Identification #

Specify the vehicle identification number.

Address section

Country

Select the country.

Address #

Specify the home number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.

State

Specify the state.

County

Select the county.

Zip

Select the zip code.

For non US country, you have to enter zip code.
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Field:

Do this:

Zip Extn

Specify the zip extension.

City

Specify the city.

Type and Description

Census Tract/BNA | Specify census tract/BNA (block numbering area) code.
Code

MSA Code Specify the metropolitan statistical area (MSA) code.
GEO Code Specify the geographical code for the property.
Condition Select the condition of the home.

Description Specify a description of the home.

Select Make and
Model

Select the make and model from the drop-down list

Year Specify the year when the property was built.
Age View the age of the home.

Make Specify the make of the home.

Model Specify the model of the home.

Width Specify the asset width.

Length Specify the asset length.

Area Specify the area of the collateral

PO# Specify the asset purchase order number.

Legal Description

Specify the legal description.

Lot Specify the asset lot.
Sub Division Specify the asset sub division.
Parcel ID Specify the parcel id of the home.

Metes-Bounds

Check this box to indicate the home is considered Metes-Bounds.

Flood Zone

Check this box to indicate the home is in a flood zone.

1098 Not Required

Check this box to indicate that the home does not require 1098

Deed Details

Construction per-
mit Dt

Specify the date on when the construction is permitted.

Deed Dt

Specify the date on when the deed is issued

Deed Place Of
Issue

Specify the place where the deed is issued.
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Field: Do this:

Properties Bound- | Specify the boundary of the property from the east side.
ary from East

North Specify the boundary of the property from the north side.
West Specify the boundary of the property from the west side.
South Specify the boundary of the property from the south side.

Vacation Ownership Details

Billling Check this box to indicate if the asset is considered for billing.

Due Amt Account | Select one of the following account type from the drop-down list to
Type indicate on which account this asset is to be considered for billing.

- Current Account
- Linked Account
- Master Account

Note: If ‘Billing’ option is checked and the Due Amt Account Type
is selected as Current/Linked/Master Account, then the billing
batch job posts the transactions based on Asset Billing Rate setup
in Current account / Linked Account of current Account / Master
Account of current Account respectively.

Trade Eligible This check box is selected by default and indicates that the asset
is eligible for trade.

If checked (Trade Eligible = Y) then Asset Status is marked as
INACTIVE during Trade. If unchecked (Trade Eligible = N) Asset
status is marked as ACTIVE.

Consolidate Points | Check this box to indicate that point can be consolidated at mas-
at Master ter account level. Refer to ‘Consolidate Points at Master’ section
for more details.

Points Consolida- Select the type of points consolidation option from drop-down list.
tion Type This field is used to identify the assets at Associated accounts to
consolidate the points.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Consolidate Points at Master

If ‘Consolidate Points at Master’ option is checked, system consolidates the asset level points
at Master Account of the associated account provided the following conditions are satisfied:

e The same ‘Points Consolidation Type’ is selected for associated account.
e The status of asset is ACTIVE.

e The status of account is available and enabled in ACC_STATUS_ POINT_CONS_CD
lookup type.

e The asset expiry date is greater than GL date (asset is not expired).

Points consolidation is done in following scenarios:
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e When new account is added under a Master Account by Ul, Funding process, API,
Onboarding, Multi Account onboarding, and/or Master Account Maintenance
Transaction.

e Account Status Change
e During Current Account Level Asset Maintenance updates.
— Collateral POST/PUT/GET Web Services
— Collateral Create/Update File uploads
— Collateral Maintenance from Ul
— Add New Asset Transaction
— Substitution of asset Transaction

To ‘Consolidate Points at Master’, following validations and update options are provided:

e Lookup code ‘Account Statuses for Points Consolidation’ determines which Accounts
with which status are to be considered for point's consolidation.

e Batch job which updates the consolidated points at Master Account level only if the
‘Expiration Date of Asset’ of Actual Asset at associated account is less than the GL date.
This batch job is scheduled to run before the billing batch job to update the actual points
that needs to be considered for Billing.

e ‘Points’ are maintained at actual asset level and any changes done at Master account
level asset points does not flow down to the Actual Asset.

e In case of an update at Master Account level Asset Point's and subsequently any
change in actual asset at current account, system recalculates the points and overrides
the points at master account.

If the collateral is any other, the Collateral link displays information about that collateral.
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3. Perform any of the Basic Operations mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field:

Do this:

Existing Asset

Check this box to indicate that the vehicle is an existing asset.

Existing Asset ID

View the existing asset identification number.

Primary Check this box if this is the main asset on the application.
Asset Class Select the asset class.

Asset Type Select the asset type.

Sub Type Select the asset sub type.

Status Select the asset status.

Select Make and
Model

Select the make and model of the vehicle from drop-down list.

Year Specify the year of the vehicle.
Age View the age of the vehicle
Make Specify the make of the vehicle.
Model Specify the model of the vehicle.
Body Specify the body of the vehicle.

Registration #

Specify the vehicle registration number.

Identification #

Specify the vehicle identification number.

Description View the vehicle description.
Condition Select the vehicle condition.
Address

Country Select the country.

Address # Specify the apartment number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.

State Select the state.
Zip Select the zip code.
For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
City Specify the city.
County Select the county.
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Field: Do this:

Usage Details

The details maintained in this section is used to calculate ‘EXCESS USAGE FEE’ in pay-
off quote and termination transactions.

Start View/specify the start unit of asset usage.
Base View/specify the base units.

Extra View/specify the extra usage units.

Total View/specify the total usage units.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Valuations Sub Tab

The Valuation sub tab contains information about the value of the asset. The Values section
enables you specify the value of the asset. The Addons section records information about any
add ons associated with the collateral.

To complete the Valuations sub tab
1. Click the Valuations sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Value section

Current Select if this is the current valuation.

Valuation Dt Specify the valuation date.

Source Select the valuation source.

Currency Select the currency based on which the valuation is to be done.

Edition Specify the valuation edition.

Supplement Specify the valuation supplement.

Whole Sale

Line of Credit Specify the Line of Credit currency wholesale value.

Currency

Wholesale

Base Amt

Wholesale- Specify the wholesale value.

Base Amt

Usage Specify the usage value; that is, the monetary effect that the current
mileage has on the value of the vehicle.

Retail
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Field: Do this:

Retail Base Specify the retail value.
Amt

Addons Amt (+) | View the add-ons value.

Usage Value Specify the usage. This pertains to Line of credit and usually is
Amt (+) entered as the current mileage on the vehicle.

Total Value Amt | View the total value.

=)

Line of Credit- View the Line of Creditcurrency retail value.
Currency Retail
Base Amt

Line of Credit- View the Line of Credit addons.
Addons Amt(+)

Line of Credit View the Line of Credit currency usage value.
Currency
Usage Value
Amt (+)

Line of Credit View the Line of Credit total value.
Currency Total
Value Amt (=)

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Addons Section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Description Select the description for the attribute.
Value Specify the value of the attribute.
Amount Specify the add-on amount.

Line of Credit Cur- Specify Line of Credit currency amount.
rency Amount

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Complete the Addons/Attributes, Value, and Amt fields for each of the asset’s add-ons
and attributes on the application.

7.12.2 Tracking Sub Tab

The Tracking sub screen enables you to record further information associated with the
collateral. What items you choose to track are setup during implementation.

To track attributes for the collateral
1. Click Tracking sub tab

2. On the Tracking sub screen, click Load Details.
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3. Inthe Tracking Items section, select the item you want to track.

4. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Tracking Item View the tracking type

Disposition Select the disposition.

Start Dt Specify the tracking start date.

End Dt Specify the tracking end date.

Follow up Dt Specify the next follow-up date.

Enabled Select to track the information from the start date in the Start Dt
field.

Comment Specify any comments regarding the tracking item.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Complete the Tracking Item Details section by entering information about a parameter
in the corresponding the Value field.

Vacation Ownership tab

In the Vacation Ownership sub tab you can capture and maintain ‘Timeshare’ specific
collateral details of an account. This tab is displayed only for ‘Home’ collateral and allows to
maintain only one record for the selected account.

In Vacation Ownership or Timeshare industry, ‘points’ represent monetary equivalent value
and in a points-based timeshare ownership system, members/owners use the allotted points
to exchange/trade collaterals. OFSLL uses these points for Asst Billing calculations while
deriving the transaction amount as detailed in Setup > Asset Billing Rate screen.

Also in Vacation Ownership or Timeshare industry, ‘Tiers’ are used to classify a membership
into different levels based on total points at Master Accounts. Each level of membership offers
more perks than previous level. OFSLL supports points-based ‘Tier Calculation’ at Master
Account level using the Formula parameters in Setup > User Defined Parameters screen.

Data in Vacation Ownership tab can also be populated from the following options:
e Create and Update Collateral Upload files
e Application Update Service

To maintain Vacation Ownership Elements for an account
1. Click Vacation Ownership sub tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

3. Inthe Vacation Ownership Elements section, view or edit the following information:

In this field: View this:
Club Name Select the Club Name from the drop-down list.
Points Specify the points up to two decimal digit.
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In this field:

View this:

Billing Points

View the auto populated billing points.

If the Asset Usage Type Sub Code is selected as FULL, this
field is populated with total Points available in Points field.

If the Asset Usage Type Sub Code is selected as HALF, this
field is populated with total Points/2 available in Points field.

First Year Proration

Select the check box for first year proration.

Resort Identifier

Select the Resort Identifier from the drop-down list.

Association Id

Select the Association Id from the drop-down list.

Building

Select the Building from the drop-down list.

Room/Unit Type

Select the Room/Unit Type from the drop-down list.

Unit

Select the Unit from the drop-down list.

Week

Select the Week from the drop-down list.

Site of Inventory

Select the Site of Inventory from the drop-down list.

Phase Number

Select the Phase Number from the drop-down list.

Usage Type

Select the Usage Type from the drop-down list.

Usage Start Date

Select the Usage Start Date from adjoining calendar.

Plus Membership
Type

Check this box to indicate Plus Membership Type.

PR Marking

Check this box to indicate PR Marking.

Signature Grand
Father

Check this box to indicate Signature Grand Father.

Club Indicator

Check this box to indicate Club Indicator.

Expiration Date of
Asset

Select the Expiration Date of Asset from adjoining calendar.

This date is used for ‘Tier Calculation’ and Point Consolida-
tion in the system.

Asset Travel Date

Select the Asset Travel Date from adjoining calendar.

Resale Indicator

Check this box to indicate Resale.

On disabling this check box system considers Asset Billing
Points and Grand Father Points for ‘Tier Calculation’ using
formula Parameters.

Grand Father Points

Specify the Grand Father Points.

These points are used for ‘Tier Calculation’ in the system
using formula parameters.
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In this field: View this:

Additional Attributes - This section consists of additional 15 configurable fields as
indicated below

5 check boxes - Membership 1-5 Opt
5 drop-down lists - Other Attribute 1-5
5 Calendar fields - Other Attribute 5-10

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Tier Calculation

Based on the value defined for Expiration Date of Asset, Resale Indicator, and Grand Father
Points, OFSLL supports the following types of ‘Tier’ calculations at Master Account level using
pre-defined formula parameters in Setup > User defined Parameters screen.

Type Formula Parameter Calculation

Total Tier points at | $ASE_TIER_POINTS Sum of Asset Billing Points where

the Master ‘Resale Indicator’ is ‘N’ and ‘Expiration
account Date of Asset’ is ‘greater than’ GL Date.
Total Grand Father | $ASE_GRAND_FA- Sum of Grandfather Points where
Points at the Mas- | THER _POINTS ‘Resale Indicator’ is ‘N’ and ‘Expiration
ter Account Date of Asset’ is ‘greater than’ GL Date.

Note: For a non Master Account, system uses Master Account # to pick-up all Associated
Accounts.

Tracking Attributes sub tab

The Tracking Attributes screen enables you to link information to collateral that is not tracked
by default in the system. These attributes are loaded when user loads the tracking attributes
from Collateral > Collateral (Home) >Tracking tab.

To maintain the Tracking Attributes
1. Click Tracking Attributes sub tab

Perform any of the Basic Operations mentioned in Navigation chapter.

2.
3. Complete Tracking section by entering the requested parameter in the Value field.
4,

Save the changes.
Seller Tab

The Collateral link’s Seller Details tab enables you to enter the seller details of the collateral
of the Line of credit.

To enter the Seller details
1. Click the Seller Details tab.
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2. Perform any of the Basic Operations mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field:

Do this

Seller Information section

Seller Type

Select the seller type.

Seller Name

Specify the seller name

Nationality

Select the seller’s nationality.

National 1D/
Reg #

Specify the national identification number or registration number.

Authorized
Signatory

Specify the authorized signatory of the seller.

Seller Addres

s section

Mailing

Select if this is the mailing address. Only one address entry can be
marked as the mailing address.

Current

Select if this is a current address. The mailing address must be marked
as current.

Country

Select the country code.

Address #

Specify the address number.

Address Line
1

Specify the first address line.
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Field:

Do this

AddressLine | Specify the second address line.
2
State Select the state.
Zip Select the zip code.
For non US country, you have to enter zip code.
Zip Extn Select the zip extension.
City Specify the city.
Phone Specify the telephone number.
Extn Select the telephone extension.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Comments Tab

When using the Underwriting screen, you can add/delete comments to an application at any
time in the underwriting process by using the Comments screen.

Whenever an application is decisioned by a proxy user, a system generated comment with
timestamp is inserted in the comments tab in the format ‘<User 1> actioned as proxy for
Underwriter <User2>’. Here, User 1 refers to the logged in user who has acted on behalf of
User2, who is the concerned Underwriter. The concerned Underwriter's name will also be
selected in Application section > 'Proxy for Underwriter' field.

To add comments

1. Click Comments tab.
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2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Alert Check this box to make the comment appear on the Customer
Service screen Alert section

Type Select the type of comment you are adding.
Sub Type Select the sub type of comment you are adding.
Comment Specify your comment.

Comment By The system displays your user ID.

Comment Dt The system displays commented date and time stamp.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

7.13.0.1 Deleting Comment(s)

You can delete ‘REGULAR’ type comments displayed in the Comments sub tab.

To delete a comment
1. Select the row which consists of the comment and click Delete from the actions.

2. Click “Yes’ to confirm delete in the warning message displayed.

7.14 Tracking Tab

When using the Underwriting screen, you can add tracking attribute information to an
application at any time in the underwriting process by using the Tracking Attributes screen.
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To enter the tracking attributes
1. Click Tracking tab.
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2. On the Tracking Attributes screen, click Load Tracking to load the tracking attributes.
3. Select the item you want to track.

4. Click Edit to edit the following information:

Field Do this

Sub-Parameter | View the sub-parameter

Parameter View the parameter.

Value Specify the information about the corresponding Value field.

5. Save changes you made to the account.

7.14.1 Field Investigation Sub Tab

The Field Investigation link enables lending institutions to perform field investigations and
verify an applicant’s contact points (address and employment information, for example) and
credentials (such as asset details). Clients can chose the details to be verified (address,
employment, asset or any combination of the three), as well as the verifying agency.

With the Underwriting screen’s Field Investigation screen, you can select which details from
application entry are to be verified. The verifying agency performs a field investigation of the
details and responds to the lending institution with either XML or a text file. The details are
entered in the system for an underwriter to review when making a decision.

1. Click Field Investigation sub tab.

2. In Field Investigation section, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

Field

Applicant

Select the applicant from the adjoining drop-down list

Verification Type

Select the verification type from the adjoining drop-down list.

Verification Agency

Select the verification agency from the adjoining drop-down list.

Status Select the status from the adjoining drop-down list.
Spoke to Specify the name of the person applicant spoke to
Call Dt Specify the call date

# of Attempts Specify the number of attempts made.

Result Select the result from the adjoining drop-down list

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In Verification Details section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field

Verification Match

Check the box if the verification has matched.

Remarks

Specify remarks, if any

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Document Tab

The Document tab allows you to view documents attached to the application in the form of
GIF files, PDF files, DOC files, XLS files and TXT files and add comments regarding a

selected.

For more information, see the chapter Document Management in this User Guide.
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To view a document attached
1. Click Document tab.
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2. Inthe Application Document section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below.

Field:

Do this:

Document Type

View the document type.

Comment

Specify any comments regarding the document.

Field:

View this:

Document Sub
Type

The document sub type.

Version

The version. (Version numbers will be incremental by batch job, first
version will start with 1.0.)

Page #

The page number.

Document File
Type

The document file type.

Tracking #

The tracking number of the document.

Docket #

The docket number of the document.

Location

The location of the of the document.

Received Dt

The effective date of the document.
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Field:

View this:

Effective Dt The effective date of the document.
Expiry Dt The expiration date of the document.
Comment Any comments regarding the document.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click View Document.

The system opens a browser to display the actual document (which browser appears
depends on what type of document you selected and what browsers are set up to work
in conjunction with your system).

Checklist Sub Tab

The Checklist sub tab enables you to view tasks performed during the underwriting process.

To view the underwriting Checklist screen

1.

o M 0D

Click Document > Checklist.
If the Checklist section is empty, click Load Checklist in the Checklist section.

In the Checklist Actions section, click Regular sub tab.

In Checklist Actions section, complete the tasks listed in the Checklist Action column.

Use the Yes/No/NA buttons in the Yes No NA column to indicate whether you completed
the task or not.

Use the Comment field to add remarks regarding any of the tasks, if you choose.

When you are finished completing the tasks, choose Complete in the Checklist section.

= © ® N o

Click Save.

In the Checklist Actions section, click the Documents sub tab

0. In the Documents section, select the record you want to work with and click View in the
Details column.

11. In the Documents section, view the following information:

Field:

Do this:

Action

View the action to be performed.

Document Type

View the document type.

Document Sub
Type

View the document sub type.

Status Select the status of the action.

Response Use the Yes/No/NA buttons to indicate whether or not
you completed the task.

Comment Specify comment.

7-76 ORACLE



7.16

7.16.1

Verification Tab

The system can be configured to automatically validate portions of an application when you
attempt to change its status. The results of this data check appear on the Verification link’s
Edit screen as an Error, a Warning, or an Override.

If it is an Error, the system will not allow you change the application’s status and approve the
Line of credit until you fix all the errors.

If itis a Warning, the system enables you to change an application’s status without correcting
the matter. While you should still investigate the problem, Warning messages are of a lesser
importance than Error messages.

Ifitis an Override, the system displays a dialog box informing you that an override is needed;
your responsibility level does not have the authority required to process this step. (Choose
Yes on the dialog box to move the application to the queue of the user with the required
authority.)

The system can be configured to verify different sets of information; for example, the system
could check one set of data when checking application entries for completeness and another
when approving auto Line of credit. Each one of these ‘edit types’ has its own set of ‘edit
details’.

Note

The Edit Details section’s errors and warnings are created during the setup process.

Edit Sub Tab

To complete the Edits section
1. Open the Underwriting screen and load the application you want to work with.
2. Click Verification > Edits.
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3. Inthe Edits screen’s Edit Type section, select the type of edit you want to verify.

4. Click Check Edits.

The system checks the data for the verification process selected in the Edit Type section
and displays the results in the Edit Details section.

The Edit Details section contains the following display only information:

Field: View this:

Edit Name The edit.

Result The result.

Expected Value The expected value.

Actual Value The actual value.

Override Responsibility The override responsibility, if an override is required.

5. Inthe Edit Details section, view the verification results and begin making corrections on
the Underwriting screen. Remember, edits resulting in ERROR must be corrected. Edits
resulting in WARNING can be by passed.

The system begins processing the credit application.

7.16.2 Audits Sub Tab

The Audits screen is a display only screen that enables you track changes to the contents of
predetermined fields (which fields are determined during set up). For example, the Audits
screen can be configured to monitor when the contents of the Status and Sub Status is
changed. The Audits screen lists the field that was changed, who made the change, when the
change was made, and the old and new values in the field.

To view the Audits
1. Open the Underwriting screen and load the application you want to work with.
2. Click Verification > Audits.

3. Inthe Audit Details section, view the following display only information:

Field: View:

Record Id The record identifier for the record changed.
Field The field which was changed.

Old Value The old value of the column which was changed.

New Value The new value of the column which was changed.

Changed By | The user code who made the change.

Changed The date and time when the change was made.
Date

7.16.3 History Sub Tab

You can track the time it took a user to complete each stage of the application process with
the History section. It displays:

e The date and time when an application changed status / sub status
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e The user who changed the status / sub status
e The elapsed time of how long an application was in a particular status / sub status.

1. To view the History Open the Underwriting screen and load the application you want to
work with.

2. Click Verification > Historyln the Application Status History section, view the following
display only information:

Field: View this:

Status The application status.

Sub Status The application sub status.

User The user name.

Start Dt The date and time when the application moved fo that status.

End Dt The date and time when the application moved from that sta-
tus.

Elapsed The elapsed time between the status change.

Time

7.17 Correspondence Tab

Ad-hoc correspondence enables you to include information from applications in document
templates you create yourself without manually transferring the data. Ad-hoc documents can
be generated as either Microsoft Word or PDF files.

Ad-hoc correspondence can be viewed on the Correspondence link’s Correspondence

screen when you have opened an account. The screen enables you to generate a new letter
or view a previously generated letter.

7.17.1 Correspondence Sub Tab

To generate an ad hoc correspondence

1. Open the Underwriting screen and load the application you want to work with.
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2. Click Correspondence > Correspondence.
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3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Correspondence

Select the correspondence you want to generated.

ID

System displays the correspondence ID.

Date

System displays the correspondence generation date.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

The Documents section displays all the types of documents available for the type of
correspondence you selected.

5. In the Documents section, view the following information for each document:

Field:

View this:

Document ID

The document ID.

Document

The document description.

Recipient

The recipient description.

E-Form Source

The e-form source.

Source Type

The source type.

Selected

If selected, indicates that this document is selected to be included
in the correspondence.

Generated

If selected, indicates that the system generated the document.

6. In the Documents section, select the correspondence you want to view.
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7. The Document Elements section displays the elements the system used to generate the
correspondence. You view the following information:

Field: Do this:

Element Type View the element type.

Element View the element description.

Content Specify/view the value of the element.

e Click All to view all elements in the correspondence.
- Or -
e Click User Defined, to view user-defined elements in the correspondence.

8. Inthe Document Elements section, click User Defined and complete the Content fields
for the Document Element fields you want to include in the correspondence.

9. In the Document Elements section, click Save.

10. In the Documents section, click Generate.

The system ‘locks’ the information included in the correspondence and prevents it from
being changed.

11. In the Document Elements section, click View.
The system displays a PDF of the ad hoc correspondence.

7.17.1.1 Recipient Details Sub Tab

The recipient details sub tab facilitates you to send ad-hoc correspondence to Applicants,
Customers, Producers, and Others as either Fax or Email.

To add recipient details

1. Open the Underwriting screen and load the application you want to work with.
2. Click Correspondence > Recipient Details.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Recipient Select the recipient from the drop-down list. The list displays the
following options:

- Applicant
- Customer
- Producer
- Others

Note: Based on the type of recipient selected the other corre-
spondence options are displayed for selection.
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Field: Do this:

Mode Select the mode of correspondence from the drop-down list. The
list displays the following options:

- Fax
- Email

Note: When the recipient is selected as ‘Applicant’, the Mode is
defaulted to Email.

Type Based on the recipient selected, the following type of correspond-
ence is listed for selection:

- When the recipient is selected as Applicant, you can select the
‘Applicant Type’ from the drop-down list and ‘Type’ as either
EMAIL/ADHOC. The ‘Mode’ is defaulted as ‘Email’.

- When the recipient is selected as Customer / Producer, you
can select the ‘Mode’ as either FAX/EMAIL and ‘Type’ as FAX/
ADHOC or EMAIL/ADHOC respectively.

- When the recipient is selected as Others, you can select the
‘Mode’ as either FAX/EMAIL and ‘Type’ as ADHOC only.

FAX/Email Specify the FAX/Email details for correspondence.

Comments Specify additional information as comments.

4. In the Recipient Details section, click Save.

5. Click Send to FAX/Email the correspondence details to the specified recipients.

System validates the correspondence details and generates a PDF document through
Bl Publisher with the Correspondence details. The same is emailed to the specified
recipient as an attachment and a system generated comment is updated in ‘Comments’
Tab. The correspondence consists of following header details::

Alert Type & Comment Comment Comment Date
Subtype By
N System <Type> <Correspondence Logged in | Current System
Generated type> sent to <Recipient Type> | user date with time
through < Mode> to <'Email' id> stamp

7.17.2 Letters Sub Tab

The Letters link enables you to generate letters using predefined letter templates for Line of
credit.

Letters can be sent in hard copy or Email / Fax. Among the two options provided for each of
these options, you can select the required mode for sending letters.

e When 'Letters' option is selected the correspondences generated are displayed in a
table below with a button 'View Letter'.

e When 'Fax' radio button is selected, the correspondence table displays all
correspondence including those in Fax or email formats in the table below.

In addition to the above, a section for recording 'Recipient details' opens below. On clicking
'Add' you can specify recipient details, Mode, Type, provide comments and Save the same.
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Comments captured will be appended to Fax / Email sent to recipient. You will then need to
click on the 'Send' in the action block for email / fax to be sent from OFSLL. In case the
correspondence generation is dependent on any job run, then on click of 'Send' system
displays an error message "Fax / Letter not generated. Please try sending later”; else event
successful message is displayed.

On the Underwriting screen, these predefined correspondences are as follows:

e Decision Letter
e Adverse Action Letter
e Adverse Conditional Letter

To generate letters on the Underwriting screen
1. Open the Underwriting screen and load the application you want to work with.
2. Click Correspondence > Letters.

3. Inthe Letters screen, select the type of letter you want to generate, and click View Letter.
UNDERWRITING:
— Ifyou select Decision Fax, and click View Letter, the system displays the decision
letter.

The predefined Decision letter is automatically sent after an application receives a
status of APPROVED, REJECTED, or CONDITIONED on the Underwriting screen.

The Decision fax/e-mail is available for Line of credit(fixed and variable rate).

— Ifyou click Adverse Action, and click View Letter, the system displays the adverse
action letter.

The predefined Line of creditAdverse Action letter is automatically sent to the producer
after a configurable number of days when an application receives a status of REJECTED
on the Underwriting screen.

The Adverse Action letter is available for Line of credit(fixed and variable rate).

— If you click Conditional Adverse Action, and click View Letter, the system
displays the adverse conditional letter.

The predefined Conditional Adverse Action letter is automatically sent to the producer
a configurable number of days after an application receives a status of CONDITIONED
on the Underwriting screen.

The Conditional Adverse Action letter is available for Line of credit(fixed and variable
rate).

4. In the Recipient Details section, you can send the ad-hoc correspondence. You can
specify the following details:

Field: Do this:

Recipient Select the recipient from the drop-down list. The list displays the
following options:

- Applicant
- Customer
- Producer
- Others

Note: Based on the type of recipient selected the other corre-
spondence options are displayed for selection.
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Field: Do this:

Mode Select the mode of correspondence from the drop-down list. The
list displays the following options:

- Fax
- Email

Note: When the recipient is selected as ‘Applicant’, the Mode is
defaulted to Email.

Type Based on the recipient selected, the following type of correspond-
ence is listed for selection:

- When the recipient is selected as Applicant, you can select the
‘Applicant Type’ from the drop-down list and ‘Type’ as either
EMAIL/ADHOC. The ‘Mode’ is defaulted as ‘Email’.

- When the recipient is selected as Customer / Producer, you
can select the ‘Mode’ as either FAX/EMAIL and ‘Type’ as FAX/
ADHOC or EMAIL/ADHOC respectively.

- When the recipient is selected as Others, you can select the
‘Mode’ as either FAX/EMAIL and ‘Type’ as ADHOC only.

FAX/Email Specify the FAX/Email details for correspondence.

Comments Specify additional information as comments.

5. In the Recipient Details section, click Save.

6. Click Send to FAX/Email the correspondence details to the specified recipients.

System validates the correspondence details and generates a PDF document through
Bl Publisher with the Correspondence details. The same is emailed to the specified
recipient as an attachment and a system generated comment is updated in ‘Comments’
Tab. The correspondence consists of following header details:

Alert Type & Comment Comment Comment Date
Subtype By
N System <Type> <Correspondence Logged in | Current System
Generated type> sent to <Recipient Type> | user date with time
through < Mode> to <'Email' id> stamp

7.18 Tools Tab

The Tools tab calculates the payment amount, term, interest rate, Line of credit amount,
amortization schedule and allows for the printing of a report.

For detailed information on using the tools, refer “Tools” chapter in the document.

7.19 Review Request

The Review Requests screen is primarily a work flow tool used to flag an Application for the
attention of another Oracle Financial Services Lending and Leasing user and ask for review /
feedback. It allows the system users to send and receive requests (including e-mail)
commenting on a specific Application. The Review Request tab supports iterative review of
selected Application and also to process the review with multiple reviewers.
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In this chapter, you will learn how to compete the following tasks:

e Filter and View Review Requests
e Create and Send Review Request
e Reviewing a Request

e Responding to Review Request

e Reassign Review Request

e E-mailing Review Request

e Closing Review Request

e Complete Review Request

Note

To complete the above mentioned tasks for an Application Review Request, use Review
Request tab available in the Origination (Application Entry, Underwriting and Funding)
screens.

Filter and View Review Requests

The Review Requests tab contains the following sections:
e Query Section
e Action Section
e Email Section
e Comment History Section

Query Section

The Query section enables you to filter records based on User and type of review requests
using any of the following options:

The ‘User’ drop-down lists your User ID along with your Supervisor ID if the same has been
defined in User Definition screen (Setup > Administration > User > Users). If you are the
supervisor, you can view all your subordinates User ID’s along with yours for selection.

On selecting a particular User ID from the list, system displays all the requests which are
created, reviewed, closed and completed by that user.

You can further filter the review request based on the following:

Query .

Options Descriptions

Originator Displays the records of all the active review requests created by the
selected User.

Receiver Displays the records of all the active review requests received by the
selected User.

Both Displays all the review requests records created as well as reviewed by
the selected User with the status other than ‘CLOSED’ and ‘COM-
PLETED'.
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Query .

Options Descriptions

View All Displays all the review requests records created as well as reviewed by
the selected User with all the statuses.

Forwarded Displays all the review requests records which are forwarded by the

Only selected User to another user for review.

Action Section

The Action section enables you to Send (create), Respond, Close, or Complete the review

request.

Action Options

Descriptions

Open Applica-
tion

Displays the Application Entry screen with the Application details
assigned for review.

Send Request

Sends a review request to another Oracle Financial Services Lend-
ing and Leasing user.

Send Response

Sends a response to a review request received from another Ora-
cle Financial Services Lending and Leasing user.

Close Request

Changes the status of review request to CLOSED and can be
viewed by selecting ‘View All’ option in the ‘Query’ section.

Complete
Request

Changes the status of review request to COMPLETED and can be
viewed by selecting ‘View All’ option in the ‘Query’ section.

Remove Filter

Removes the selected filters applied to narrow the view of review
request. The option is available when a review request is accessed
from DashBoard > My Pending Review Requests section.

Email Section

The Email section

enables you to send an email to either originator or receiver of the review

request if an email setup is configured. However, note that a review request cannot be
responded or replied back from email recipient.

Email Descriptions

Options P

Originator Sends an email of review request information to the person listed in the
Originator column on Review Request page.

Receiver Sends an email of review request to the person listed in the Receiver
column on Review Request page.

The ‘Review Requests’ section in Origination screen displays the following information for

each record:

Fields

Descriptions

Request #

View the system generated review request number. The same
can be used to query and track the review requests.
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Fields

Descriptions

Originator The user id of the review request originator.
Priority The request priority: HIGH, NORMAL, or LOW.
Receiver The recipient of the review request.
Application # The Application number which needs review.

Application Status

The Application status of the request being reviewed.

Applicant Applicant’s name in the review request.

Phone Applicant’s phone number in the review request.

Address Applicant’s address in the review request.

Email Applicant’s email in the review request.

Reason Stated reason in the review request.

Status The current status of review request. Following status are
tracked in this column:
WAITING FOR RESPONSE - when request is sent to reviewer
RETURN TO ORIGINATOR - when reviewer has responded to
request
CLOSED - when the request is closed
COMPLETED - when the request is completed

Date The date and time when the review request was created.

Comment History

The ‘Comment History’ section displays the log of comments or additional information added
by originator or receiver while creating or reviewing a request.

During an iterative review, where there are multiple trails of communication exchanged
between originator and receiver, the ‘Comment History’ section tracks all the updates as
individual records for reference.

The Comment History section also allows you to know the actually reviewer when an
Application review request is forwarded to multiple reviewers and is reviewed or completed
by second or third person other than the one assigned by originator.

In the Comment History section, you can view the following details of the selected review

request:

Comments From

Descriptions

Type

View the type of request and is indicated as REVIEW REQUEST by
default as maintained in ‘COMMENT_TYPE_CD’ lookup code.
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Comments From | Descriptions

Sub Type View the sub type of request which can be ORIGINATOR,
RECEIVER, or SYSTEM GENERATED as maintained in COM-
MENT_SUB_TYPE_CD lookup code.

Note: The sub type ‘SYSTEM GENERATED’ is automatically posted
by the system when the review request is forwarded to another user
by the assigned reviewer. The same is also updated with a com-
ment in the next column.

Comment View the Originator’s or Reviewer’s comment.

SYSTEM GENERATED comments are posted in the format -
REVIEW REQUEST: <Request #> FORWADED FROM <first
assigned user id> TO <next assigned user id>.

Comment By View the user who has posted the comment.
SYSTEM GENERATED comments are marked as ‘INTERNAL'.

Comment Dt View the Date and time when the comment was posted.

Create and Send Review Request

The review request tab primarily allows you to flag an Application for the attention of another
OFSLL user through a request asking for review / feedback. While doing so, you can either
choose to send it to the reviewer immediately on creating the request or only create the
request and later send for review.

To Create and Send Review Request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen

and select ‘Review Requests’ tab.

ORACLE’
Financial Services Lending and Leasing

Origination y [dose

Review Requests

Request # 12002 Sender Application Status NEW - BLANK
Originator * Application # 0000001029 Ad Applicant CRACLE MADHAN / MADHAN
*Pririty HIGH [~ *Resson REVIEW APPLICATION = Rl dae
Address  NORMAL ADDRESS - 745
/NEWYORK,MASSACHUSETTS, 34038
Status Email EDW.SIRSI@GMAIL.COM
Comment REQUEST TO REVIEW THE FUNDED CALCULATIONS. Date 09/18/2017 12:12:23 AM

*Receiver | ANAND SHEKAR ~

SendRequest [¥]

Comment History
vews Fomatw | [Ep | [[]|Freeze [HfiDetach e @
Type Sub Type Commen t Comment it By Comment tDt

No data to display.

2. In the Review Requests section, select ‘Originator’.

3. Click ‘ADD’. You can also perform any of the Basic Operations mentioned in Navigation
chapter. A brief description of the fields are given below:

In this field: View this:

Request # View the system generated request number.
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In this field: View this:

Originator View the requester’s user ID auto generated by system upon
creating the request.

Priority Select the priority of review request as High, Normal, or Low
from the drop-down list. This helps the reviewer to prioritize
the request while responding but does not affect the order in
which messages are sent or received.

Receiver Select the user ID of the reviewer from the drop-down list.

Comment Specify additional details for review (if any) which can be sent
to the reviewer along with the review request.

Sender View the user ID of previous reviewer, if a request has been
forwarded to another reviewer.

Note: A forwarded review request can only be viewed in the
review request tab by filtering user ID of previous reviewer
and selecting ‘Forwarded only’ check box.

Application # Select the Application to be reviewed from the drop-down list.
The following fields are auto-populated based on selection:

Application Status
Applicant

Phone

Address

Email

Reason Select the purpose for request from drop-down list.

Status View the status of review request auto updated by system
upon creating the request.

Date View the date and time when the request was created. Sys-
tem appends the current date by default.

Send Request (Optional) Select this check box to send it to reviewer immedi-
ately on creating the request.

However, if the request still need changes, retain the check
box unselected and proceed to create the request. The same
can later be sent for review by selecting ‘Send Request’
option from the action section.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
The review request(s) appear on the recipient’s ‘My Pending Review Request’ window in

DashBoard and also on the ‘Review Request’ tab header with (Pending: <count of unseen
requests>). The status of request is updated as WAITING FOR RESPONSE.

7-89 ORACLE



7.19.3 Reviewing a Request

When you receive a review request, the system notifies you by creating an entry in ‘My
Pending Review Requests By Priority’ section in DashBoard with the number of unseen
messages. Clicking on the Application # link opens the Review Request tab.

ORACLE' : e, ABSHEKAR ~ 1 signout O
Financial Services Lending and Leasing

Customer Service x ~ DashBoard x [®] Glose
Origination Setup Admin
My User Queues | | Product Expiring in Next One Month Critical Batch Job Status
] ] ]
Desaription Count Product End Date Batch Job Status
Mo data to display. o data to display. Mo data ta display.

My Pending Review Requests By Applications

i

App # Briority
0000001044 NORMAL

My Pending Review Requests By Priority

|

Priority Count =

Servicing Producer Vendor
Number of Queues Hard Assigned Producers Count By Status ‘Vendors Count By Status

@ @ @

Queue Desarption Count Status Count Status Count
Ho data to display. acTvE £ ACTIVE 27
Number of Accounts Producers Expiring in Next One Month = Vendors Expiring in Next One Month

® i} G}

Queue Desaription Count | Producer End Date Company Name End Date
No data to display. Mo data to display. No data to display.
My Pending Review Requests By Accounts Producers Count By ACH Status

0 N

To review requests

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen
and select ‘Review Requests’ tab.

ORACLE"
Financial Services Lending and Leasing

Customer Service x| DashBoard ¢ Origination x 3] ose

SesrchfTask  Application Entry | Review Requests (Pending: 1)

Review Requests
dp add || ZEdt || [Fven || of auit

e Email
User - Originator @ Receiver ©) Both view Al [[] Forwarded only [ &4 Originator 3 Receiver
View v Format v [ Freeze i Detach Wrap W 2 Open Applcation SendRequest 3 SendResponse [ CloseRequest [k Complete Request (3] Remove Fiter
Request = orignator Prierty Receiver Applcation * Applcation Status Applcant Phne Addr
11002 HARISH MACHA NORMAL ANAND SHEKAR 0000001044 NEW - BLANK DMOEE DEP 12334 NORI
< i ] v
Comment History Ben
view v Formatv [ Freeze  fiDetach 2 @
Type b Type Comment Comment By Comment Dt
REVIEW REQUEST ORIGINATOR REVIEW PHONE NO HMACHA 05/14/2017 03:59:29 PM

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Click ‘Open Application’. The Application details are displayed in Application Entry >
Summary tab.

4. Review the details in particular to the details specified in the comment (if any).

7.19.4 Responding to Review Request

On completing the review, you can Send Response detailing the feedback of your review. It
is ideally recommended to send a response back to the originator by providing your views on
the review as a comment. The details are recorded in the ‘Comment History’ section as
reference.
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However, system also allows your forward the same request to another reviewer in case of
additional clarifications.

To respond to review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen
and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Inthe Review Request section, select the record that you have reviewed.Click ‘Edit’.

Specify your review response in the ‘Comment’ field. Select the ‘Send Request’ check
box to send the review response immediately to originator. In case of any further changes,
retain the check box unselected and save the details. The response is not sent and the
same can later be sent to originator by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as RETURN
TO ORIGINATOR.

Reassign Review Request

While reviewing a request, system also facilitates you to reassign (i.e. forward) the review
request to another user for review. In such a case, you become the ‘Sender’ and the assigned
user will be the reviewer of the request. The request can further move to other reviewers if
required.

When the request is reassigned or forwarded to another reviewer, the actual originator can
still track the status of request by selecting user ID in Query section. As a ‘Sender’, you can
view the reassigned review requests by selecting the ‘Forwarded Only’ check box in Query
section. Also, on reassigning or forwarding a review request, system automatically posts a
comment in ‘Comment History’ section in the format - REVIEW REQUEST: <Request #>
FORWADED FROM <first assigned user id> TO <next assigned user id> with Sub Type as
‘SYSTEM GENERATED’ and Comment By as INTERNAL'.

Note

It is recommended to limit the reassignment of review request since tracking the request
status becomes difficult.
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To reassign review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen
and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Inthe Review Request section, select the record that you have reviewed and click Edit.

Review Requests
[ save and stay | [ SaveandReturn | CaReturn

Request ¥ 8002 Sender MAVEEN REDDY Days PastDue 0
Originator PRITAM JENA Account # 20000100011820 Total Qutstanding  28,806.94
Priority HIGH Reason REVIEW ACCOUNT Bl
*Receiver HARISH MACHA e Customer ALIVE PRI f DEA SPO
Fhone 9728663378

W Fi
comment Status WAITING FOR RESPONSE S —

Date 09/06/2017 09:32:11 AM MEWYORK,MASSACHUSETTS, 34038
Send Request [T Email EDW.SIRSI@GMAIL.COM

Comment History

view v Format > Fresze  fDetach wrap @R
Type Sub Type Comment CommentBy Comment Dt
REVIEW REQUEST ORIGINATOR TEST FWD PRITAM 09/06/2017 09:32:30 AM
REVIEW REQUEST RECEIVER FWD SURABHL 09/06/2017 09:33:45 AM

RE' QUEST SYSTEM GENERATED REVIEW REQUEST : 8002 FORWADED FROM SURABHI DESAI TO NAVEEN REDDY INTERNAL 09/06/2017 09:33:45 AM
REVIEW REQUEST RECEIVER FWD SURABHL 09/06/2017 09:3%31 AM

4. Select the required reviewer from ‘Receiver’ drop down list.

5. (Optional) Specify the reason for reassignment in the ‘Comment’ field. The same is
tracked in ‘Comment History’ section.

6. Select the ‘Send Request’ check box to reassign review request immediately on update.
In case of any further changes, retain the check box unselected and save the details. The
reassignment can later be completed by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as WAITING
FOR RESPONSE.

E-mailing Review Request

While system updates ‘My Pending Review Requests By Priority ‘section in the DashBoard to
notify you about the new requests, you can also e-mail a review request to both the originator
and a receiver, as applicable. The system will use e-mail address recorded for both the
originator and receiver in Setup > Administration > User > User Definition section.

To e-mail a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen
and select ‘Review Requests’ tab.

2. In‘Email’ section, click ‘Originator’ to send the message to the person listed in Originator
field.

_0 r'_

3. Click ‘Receiver’ to send it to the person listed in the Receiver field.

The system emails the details of selected record to e-mail address recorded in user setup.
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7.19.8

Closing Review Request

You can close a review request you created at anytime, regardless of status. However, you
can only close review requests that have your user id in the Originator field. When you close
a review request, the system removes it from Review Request tab.

To close a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen
and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Close Request’.
The system assigns the request as CLOSED and removes it from your Review Request

record. The closed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.

Complete Review Request

When a particular review request has completed the review process from reviewer with
required changes and confirmation, the same can be marked as ‘COMPLETE’ in the Review
Request tab. However, you can complete a request only if you are the originator of the
request. When you complete a review request, system removes it from Review Request tab.

To complete a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen
and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Complete Request’.
The system assigns the request as ‘COMPLETED’ and removes it from your Review Request

record. The completed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.
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8.2

8. Funding

Introduction

At this stage of the Line of credit origination process, the application has been entered into
Oracle Financial Services Lending and Leasing and approved manually by an underwriter or
by the system. The next step is to view and complete the contract information and make a
funding decision to finance or reject the application. This is accomplished by using the
Funding screen.

This chapter explains how to:

e Load an application on the Funding screen

e Change the status of the application to begin funding process
e Verify the applicant information

e View the credit pull and underwriting information

e Verify the collateral

e Add comments and tracking attributes

e Complete the Contract screens

e View an application’s contract edits

e Audit changed fields and status history

e Change the status at the end of the funding process.

Funding (an overview)

In Oracle Financial Services Lending and Leasing, the funding process follows these basic
steps:

1. Open the Funding screen and load the application you want to work with.

2. Inthe Funding screen’s Applications master screen, Change the status of the application
to APPROVED - VERIFYING.

3. Using the Funding screen’s Applicants link, view and verify information about the
applicant (data recorded from the Application Entry screen). This includes verifying the
applicant’s actual address and employment information.

4. Using the Funding screen’s Decision link, view and verify information supplied during the
credit bureau pull and underwriting process. This is display only information and cannot
be edited.

5. Using the Funding screen’s Collateral link, view and verify information regarding the
collateral for the application.

6. Using the Funding screen’s Contract link, complete the truth-in-lending information.

7. Inthe Funding screen’s the Applications master screen, change the status to FINAL
DOCUMENT CHECK.

8. Using the Funding screen’s Verification link, view any errors and warnings that prevent
the status change.

9. Make changes to the application data that correct the errors until you can change the
status.

When the system changes the status of the application to FINAL DOCUMENT CHECK, it
sends the application to a supervisor or Line of credit officer queue where it is viewed and
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verified. After this, the application’s status is changed to APPROVED - VERIFIED. If the
supervisor/ Line of credit officer decides to fund the Line of credit, he or she will change status
of the application to APPROVED - FUNDED.

Loading an Application on the Funding screen

The first step in the funding process is to open the Applications form and manually or
automatically load the application you want to work with. You can manually select an
application using the Search tab’s Criteria and Results screens. If your system is configured
to load applications based on work queues, use the Queue field in the Quick Search section.

Refer the chapter Searching for Application for more information on the following:

e Using Search Criteria screen
e Using Quick Search section
e Using Result screen

e Loading an application

Funding Screen’s Master Screen

The Funding screen’s master screen displays information from the Application Entry and
Underwriting screens, such as the application number, product and producer. It also contains
the Status field that allows you to change the status/sub status of the application and begin
the funding process.

For details on this screen refer Applications section in Underwriting chapter.

After opening the Funding screen and loading the application you want to work with, you must
change its status to APPROVED - VERIFYING before you can begin the funding process. This
allows you to begin working with the application.

To change the status and begin work on the application on the Funding screen
1. Open the Funding screen and load application you want to verify.

2. In the Funding screen’s Applications master screen, use the Status field to select
APPROVED - VERIFYING.

3. Click Save on the Funding screen.
You can now begin making changes to the application.

Funding an Application

After you have verified the application, entered the contract information and completed the
contract edits, the application is ready to be funded. Applications can be approved
automatically or manually. To manually fund an application, change the status to APPROVED
- FUNDED.

After an application is funded, the Line of credit origination cycle is over. The system moves
the application to the Line of credit servicing module (Customer Service form) where it
receives an account number. The system also automatically creates a check requisition for
the funded account.

Funding tasks
1. Load the application on the Funding form
2. Change the status and initiate Funding process

3. Verify the applicant information
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8.5

Complete Contract (5) details

Verify the documents

Generate letters

Attempt to change the application status

Verify edits

© ©®© N o o &

Complete Funding

After you approve the application, the information on the Decision tab is unavailable. The
application remains in this status of Approved - Verified until a user (usually a supervisor)
changes the status to Approved - Funded. When the status is changed to Approved - Funded,
the account is created.

Summary Tab

The summary screen provides a unified view of the application details without navigating to
the respective screens/ sub-tabs.

Using this screen, the user can view the applicant details, asset details, ratios (only for
Primary Applicant), trade-In, requested details, approved details, itemization, decision history,
alerts, comments, and checklist details in the respective section.

To view the Summary

1. Open the Funding screen and load the application you want to work with.

2. Click Summary.

ORACLE 2 Welcome, PRAKRRAO o
Financial Services Lending and Leasing

o Close
DashBoard Origination x —

Origination Search/Task | Funding: 0000001536 | Review Requests (Pending: 0)
Origin:
Sales Lead
Simple Applicatiol
Application Entry

Application: 0000001536: RODRIGUEZ MILDRE El view || 2 aude
View v Format~ [y Fresze [ Detach + wrap B Override OK v Waming OK v

e - Origination 802 producer Name  Producer Contact ing Customer  Duplicate E
ot App = Sub Unit Stat O Producer N i Existing Cust e Contact
0/05/2015 0000001536 APPROVED - FUN..  FUNDED CA0D003: ACEH.. (818)761-2277 ¥ ¥
< >
Summary || Applicant || Business | Request || Decision | Gontract || Collateral || Comments || Tracking || Document || Verification | Correspondence
Applicant
Applicant
Relation Type First Name Last Name Birth Dt Qv / Rented
1 PRIMARY MILDRED. RODRIGUEZ ©1/03/1965 apT
q Ratios
“
Ratios
Grade Score. What If Pt Amt Assets Amt Lisbilities () Net-Worth Amt
> D GRADE 0 1,302.31 4,350.00 0.00 4,350.00

Bureau

Bureau

Status

Name FICO Score Tradelines # Auto Tradelines =
] s COMPLETED

BKP Notices (LIFE)  Type
REPORT... DAWN 4 1

DawN 4 ° ° compLeTED ~
DawN 3 ° ° compLeTED
REPORT..  DAWN a4 ° ° compLeTED v
= S REPORT...  DAWN 4 ° ° NTIAL coMPpLETED
> Servicing < >
> Collections
> wrp Checklist
> Tools i
x Checklist ©
> Setup Checkiist Checkiist Description Compiete Comment

For details on this screen refer Summary Tab section in Underwriting chapter.

Applicants Tab

Having selected and loaded an application, you can use the Applicants link to view
information about the applicant (s). This is information that was recorded on the Application
Entry screen or gathered during the credit pull. You can edit the data from the Application
Entry screen at anytime in the following steps. Remember to save your work with each
change. Information from the credit bureau pull is available to view only.
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To verify information about an applicant
1. Open the Funding screen and load the application you want to work with.
2. In the Funding tab, click Applicants.

3. Inthe Applicants Details section, select the applicant you want to verify and click Edit.

For details on this screen refer Applicant Tab section in Underwriting chapter.

Business tab

If this application is an SME Line of credit (defined in the Applications section Class field as
SMALL BUSINESS), the Business Applicant link appears on the Funding link bar. This link
displays the small business information recorded on the application entry process. You can
edit the Funding screen at anytime in the following steps. Remember to save your work with
each change.

If there is no business information associated with the application, the Business Applicant link
is unavailable.

For more information about the individual fields in this section, see the Application Entry
chapter.

To verify business information from the Business Applicant link
1. Open the Funding screen and load the application you want to work with.

2. Click Business Applicant.

ORACLE : 5 p Bsignedinas  DEMOSALES v 28 Signout O
Financial Services Lending and Leasing

> DashBoand Origination 3] Close

Origination Summary Applcant. Business Request Dedsion Bureau Collateral Comments Tracking Document Verification Correspondence » ||*

v Origination
Sales Lead Business Details dpadd | FEde | [S]vew | o Audt
simple Applicatio view =] Format v | B Freeze [ Detach wen | @
Application Entry T I I I | | | | | Business Chec
T Organizatin Type |Busness Type | Business Name Legal Name [rax0# |startt |# of Enployees(Cu)| % of Enployees|  Contact Person)
Funding [l s core SERVICE MARKLLP MARKLLP 8998 01/01/2013 7 7 TEST i
Application Retri <

. v
Scenario Analysit
Application Docu

5 Business Details
Image Maintenar

R save And Return | {3 Return
Producers L
G Bl oankation [5 corp =] =start Ot [01/01/2003 B = BankAcc # | 89898989
*zof[7 * Avg Checking [
* Business Type | SERVICE [=] Employees(Cur) Balance
* Business Name [ MARKLLP * # of Employees [ 7 * £ of Locations | 1
* Legal Name | MARK LLP Contact Person | TEST * Management Since | 0
*Tax 1D # 8998 * Business | ¢rrr
q Checking Bank
Address Telecoms Financials Linbiities Partners Affiiates Other Detais
Address Information b add | it | [ vew | o audt
View - Format~ | B Freeze fi Detach Wrap o)
| [nddress Type |country | address = [y |state | ovinjLease | comment. |Postal Type |street Pre [street name |
[ work UNITEDSTATES 8998 ALPHARETTA GEORGIA BUYING HOME NORMAL ADDRESS  NORTH
«

L ’
Colunms Hidden 1

< [t b
| Servicing

>/ Collections

r WFP

>/ Tools

| Setup

For details on this screen refer Business Tab section in Underwriting chapter.

Request Tab

System displays the calculated Payment, Interest Rate, Term and Line of credit Amount in the
Request tab.
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8.8

For details on this screen refer Request Tab section in Underwriting chapter.

Decision Tab

With the Decision tab, the system displays information gathered during the underwriting
process. Depending on the type of application you are working with, system displays Line of
credit information. On Clicking Calculate, the user can calculate the Line of credit amount,
rate, term, and payment.

The fields on the Decision screens and sub screens are described in detail in the Underwriting

chapter.

ORACLE’

Financial Services Lending and Leasing

DashBoard
Origination
Origination
Sales Lead
Simple Application Entry
Application Entry
Underwriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
> Collections
> WFP

> Tools

> Setup

Origination .

Application: 0000001533: SIGG MARK

SearchTask || Funding: 0000001533 || Review Requests (Pending: 0)

Warning OK v/

Origination Stage
Code

Viewv Fomaty B Freeze (gt Detach Wrap M owerideok v
Dt App # Sub Unit Status
0/05/2015 0000001533 REJECTED - AUTO REJEC... NEW
<

Summary || Applicant | Business | Request

Decision Information

View v Format~ [ Freeze

Current Grade

¥ D GRADE
N D GRADE
N D GRADE
N D GRADE
N D GRADE

<

Decision Information

Pricing
Fricing VEHICLE
Current ¥
Approved

Decision Term 15
PmtAmE 1,302.31

Decision  Bursau

i Detach

Score

cocoe

LOAN FRICING-FR

Index FLAT RATE

Index Rate 0.0000
rgin Rate 4.3500
Rats 4.9200
Buy Rate 2.9900
d Buy Rate 2.9900

Collateral || Comments

Max Advance Amt

18,900.00
18,900.00
18,900.00
18,900.00
18,900.00

Producer Name

CA-D0003 : AC

Tracking | Document | Verification || Comrespondence | Tooks

Wrap W £ select Pricing

LTVL  Max Financed Amt

95,50
95,50
95,50
95.50
95.50

Status REJECTED

Sub Status AUTO REJECTED

Max Financed % 0.0000
Max Financed Amt 18,800.00
Maturity Index FLAT RATE
Maturity Margin Rt .5500
EBalloon Amt 0.00

18,900.00
18,900.00
18,900.00
18,900.00
18,900.00

(38 Close
~
it || Hvew || o suit
Fot e Duplicat= £
g g CUsOmEr application
EHEADQUA... (.. N N
>
Fedt | Eview | 2 audit
[ [ calevate ¥ Re-Score
L2 Decision Term: Decision
95.50 15 4.
95.50 15 EXla]
95.50 15 4
95.50 15 4404 l
95.50 15 S
>
{2 Retum
t 02/01/2016
iter INTERNAL
Bureau 1 EXP
Bureau 2
Bureau 3
Grade D GRADE
Score O
Collateral Value 19,790.00
LTVl 95.50
LTv2 95.50 ¥

For details on this screen refer Decision Tab section in Underwriting chapter.
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8.10

Customer Credit Limit tab

This tab displays the customer credit limit details captured during the underwriting process
and is validated during application funding. Depending on the type of application you are
working with, system displays Line of credit information.

ORACLE ABSHEKAR v i signout O
Financial Services Lending and Leasing

Origination »

[3€] Close
Summary | Applicant | Busiess | Request Decsion  CustomerCreditLimit Buresu | Colateral  Comments Tracking | Document | Verification = Correspondence  Tools ‘
Credit Limit Details
# Edit 5] vie o Audit
View = Formatw [Ep Freeze i Detach Wrap ot}
Customer # / o . . . -

Relation Type SR Name Max Limit % of Utiization Utiization Amt  Total Utiized Amt Avallable Amt  Suspended Amt Grade

PRIMARY 0000000000 PRITAM APP CRDE 0.00 0.00 0.00 0.00 0.00 0.00

BUSINESS 0000000000 DD 10,000,000.00 100.00 0.00 0.00 10,000,000.00 0.00 A GRADE

&

(i

Credit Limit Details

n

[ save and stay || [ Ssve andRetumn || {5 Return
Relation Type  PRIMARY Total Utilized Amt 0.00 Grade E|
Customer # 0000000000

Available Amt 0.00
Name PRITAM APP CRDEIT LIMIT Hold Amt 0.00

* Max Limit 0,00 Suspended Amt 0,00 = Limit Expiry | 12/31/4000

*Max Late Charge 0.0000

& &

* Limit Next Renewal  12/31/4000
Application Utilization

* o of Utlization 0.00 * Utiization Amt | 0.00

For details on this tab, refer Customer Credit Limit tab section in Underwriting chapter.

Master Account tab

The Master Account tab in Origination screen facilitates to categorize the current application

to be considered as ‘Master Account’ after funding or link the current application to another
existing master account in the system.

To define Master Account Details

1. Open the Underwriting screen and load the underwriting application you want to work

with.

2. Click ‘Master Account’ tab.

ORACLE’ # Welcome ABSHEKAR ~  ETIOHIRE ©
Financial Services Lending and Leasing

[3] Close

~

Customer Service ~ Origination

Search/Task  Underwriting: 0000001017  Review Requests (Pending: 0)

Application: 0000001017: YADAV_3 VIK

A Edt | [ View | 2 Audit
Viewv Formatv [ Freeze i Detach Wrap W@ OverideOK ¥ WamingOK ¥ MANUAL Contract
. Origination Stage Producer Contact .- Duplicate
Dt App # Sub Unit Status s Producer Name  ocLee Bxisting Customer LR S Contact Sales Agent Bran
01/01/2019 0000001017 UNDEFINED APPROVED - REH... REVIEW NY-00002 : SUNRL.. (631)-589-0047 Y Y DEMOSUPR USR
< >
Summary Applicant  Request Decision Bureau Contract Master Account ~Comments ' Tracking Document ~Verification ~Correspondence Tools
Master Account Details  Edit View | o7 Audit
View > Format~ [ Freeze |t Detach Wrap W
» .
Master Account Lokt ikl Linked Account  Payment Hierarchy
N

UNDEFINED UNDEFINED

Master Account Details

[ saveand stay || [ Save and Retun | {3 Retum
* Master Account
Link to Existing Master Account UNDEFINED
Linked Account UNDEFINED v
Payment Hierarchy OUTSTANDING BALANCE -

For details on this screen refer Master Account tab section in Underwriting chapter.

8-6 ORACLE



8.1

8.12

Bureau Tab

The Bureau tab displays the credit report (if pulled) for an applicant. If there is a need for
another pull for any applicant, it can be done here manually using the New Request section.

To verify the credit bureau data using the Bureau tab
1. Open the Funding screen and load the underwriting application you want to work with.
2. Click Bureau

ORACLE , ; # Welcome, VAVAIDYA + (€D
Financial Services Lending and Leasing
omnati Close
S Origination x £l
Origination searchyTask | Funding | Review Requests (Pending: 0) ~
Origination
Sales Lead Application Aedt | Elvew || o audit
Simple Application Entry
Application Entry View v Formatw [Fp Freeze i Detach Wrap @) oOverideOK  WamingOK__
Undenwriting TR Prc
Funding ot App # Sub Unit Status Qrigination 1292 producer Name GEom T E;:"“:;; Cor
Applcotion Bt No data to display.
Scenario Analysis < >
Application Documents
Image Maintenance
Reports
Producers Summary || Applicant | Request | Decision | Bureau | Contract| Comments | Tracking | Document | Verification | Correspondence
Vendors
Consumer
& add
g agency systems 4 users and only for permissible purpases. Unauthorized access is prohibited under the Fai
r in Faderal prison
View~ Format~ [ ze i Detach B [ submit Request
¥ Credit Bureau
5 Type Burezu # Status ot Report )
No data to display. ¥
< >
Bureau Details
AP Qreate Request | | (3 Retum
New Request
= applicant [ v] = Report | [v]
= Bureau [~]
Applicant/Customer Details
View v Format+ Ep Freezze B Detach ¢l Wrap 5]
2 ennouig Type First Name ML Last Mame Status Birth Dt SsN Suffie Include
> Collections No data to display.
- < >
> WFP
> Tools
D in Report Header V.

For details on this screen refer Bureau Tab section in Underwriting chapter.

Contract Tab

The screens associated with the Contract link are the core of the funding process. They allow
you to perform the important task of completing the truth-in-lending details. These screens
include information mandated by Regulation Z; information about the financed amount, the
payment schedule, the total of these payments, the finance charge, the resulting annual
percentage rate (calculated according to Federal/Central bank guidelines; that is, within 125%
of the Treasury OCC calculated APR) for the conventional Line of credit, and internal rate of
return for Islamic Line of credit. Use the Line of credit packet to supply the required
information.

In completing the truth-in-lending details on the Contract link, you will enter Line of credit
information. The truth-in-lending details must be completed before a Line of credit can be
funded.

The tabs opened from the Contract link share the following sub tabs:

e Contract (2)
e Repayment
e Itemizations
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e Trade-In

e Subvention

e Insurances

e ESC

e Escrow

e Compensation
e Proceeds

e Disbursement

e Fees
e ACH
e Coupons
e PDC

e References
e Real Estate

While working with the Contract tab for Line of Credit applications, you can either enter the
contract details manually or make use of the ‘Suggest’ option which auto populates the
contract details.
On clicking the ‘Suggest’ option,

e System loads the details of 1st instrument available in Instrument drop-down list.

e Populates decision level contract parameters and ‘Verified By’ field with User Code.

Since in one click all the required contract information is populated to fund the application, this
option helps to improve operational efficiency. But however, this option is not available if the
contact instrument is already loaded.

To enter the contract details
1. Open the Funding screen and load the application you want to work with.

2. On the Funding screen, click the Contract tab.

e If the application you opened is for a Islamic Line of credit, the Line of credit screen
appears.
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3. Using the information in the contract packet, complete the Contract section.

ORACLE’

Financial Services Lending and Leasing

DashBoard
Origination
Origination
Sales Lead
simple Application Entry
Application Entry
Underwriting
Funding
Application Retrieval
Stenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
> Collections
> WEP

> Tools

> Setup

Origination x (2 Clos=
Search/Task  Funding: 0000001536  Review Requests (Pending: 0)
Application: 0000001536: RODRIGUEZ MILDRED Eview | o Audit
View > Fomatw [} Freeze &l Detach Wrap @ ovemideok v waming OK v
Pre
ot App = Sub Unit Status gggg‘m’" SIS producer Name Col Existing Customer Z;ﬂ':;; Contac
Ny
03/05/2015 0000001536 APPROVED - FUNDED FUNDED CA-00003 : ACE HEADQUA... (.Y ¥
< >
Summary | Applicant  Business | Request Decision  Contract | Collatersl | Comments Tracking | Document  Verfication  Comespondence
Contract Information Elview | o audit
Vieww Formatv [P Fresze  ff Detach wap | @ [ Suogest
Contract Dt Term 1st Pmt Dt Instrument Credit Limit Draw Term Repmt Term Maturity D Index
0/05/2015 24 10/01/2015 LINE INS WEEKLY. 18,900.00 24 09/01/2017 PRIME RATE
< >
Pl
Pl
Contract (2) | Itemizations | Tradeldn | Procseds | Disbursements | Fees | ACH | References || Real Estate | POC
Other Details Elview || o sudit
View~ Format~ [ Frezze Bl Detach I Wrap 50
Servicing Branch Collector Lien Status HOEPA Rate Spread
USHQ. DEMO COLLECTOR ORIGINATED OR PURCHASED- NOT HO. 0:0000

(The system calculator may used when completing this section. For more information, see
the Tools chapter.)

4. In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter.

A brief description of the fields is given below:

Field:

Do this:

Contract section

Contract Dt

Specify the contract date.

Credit Limit

Specify the credit limit.

Draw Term Enter the draw term. This is the period of time during which you
can receive advances.

Repmt Term Enter the repayment term. This is the period of time during which
you must pay the outstanding balance of your account, with
accrued interest, but may not request further advances. The
repayment period begins at the end of the draw period.

Term Enter the term.

Maturity Dt

Enter the maturity date.

Index

Select the index.

Index Rate

View the index rate.

Margin Rate

Specify the margin rate.
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Field: Do this:

Rate View the interest rate.

1st Pmt Dt Specify the first payment date.

Due Day Specify the due day.

Rcevd Dt Enter the contract received date.

Verified Dt Enter the contract verification date.

Verified By View the user id who verified the contract.

PDC Ind If selected, indicates that the customer has opted for PDC.

Instrument Details — An instrument is a contract with specific rules tied to it. An instru-
ment associated with the application indicates OFSLL of the type of contract being
used for the approved loan. Items defined in the contract are “locked in” when you
select the instrument from drop down list and click on "Load Instrument Details". These
values cannot be changed on the funding screen.

Any changes to the instrument in account will be handled by monetary/non-monetary
transactions.

The system loads all the rules established by the company that are required at the time
of funding; for example, the accrual method, billing method, type of billing, tolerance,
due dates, extensions and so on.

Start Dt Basis View the accrual start basis.

Accrual Method View the accrual calculation method.
Base Method View the accrual base method.

Start Days View the accrual start days.

Stop Accrual Days | View the accrual stop days.

PDC Security Ind If selected, indicates that the customer has submitted the PDC as
a security.

ACH Fee Ind Indicates that the ACH fee should be applied or not. Depending
on the status of check box, the ACH fee is applied based follow-
ing conditions

- When the check box is selected and the fee amount is ZERO,
system will not apply the ACH fee.

- When the check box is selected and the fee amount is BLANK,
system will apply the ACH fee from Contract setup.

- When the check box is selected and the fee amount is specified,
system will apply the specified amount and overrides the ACH fee
amount mentioned in Contract Setup.

- When the check box is not selected, system will apply the ACH
fee amount mentioned in Contract Setup.

Promotion Details — If applicable, enter information regarding any promotion associ-
ated with the application in the Promotion section

Promotion Select the promotion.
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Field:

Do this:

Type View the promotion type.

Term View the term.

Index View the promotion index (displays only).
Index Rate View the promotion index rate (displays only).
Margin Rate View the promotion margin rate (displays only).
Rate View the promotion rate.

Rate Caps & Adjustments section

Increase Per Year

View the maximum rate increase allowed in a year.

Increase Max Life-
time

View the maximum rate increase allowed in the life of the Line of
credit.

Increase Ceiling

View the rate cap (maximum).

Decrease Per
Year

View the maximum rate decrease allowed in a year.

Decrease Max
Lifetime

View the maximum rate decrease allowed in the life of the Line of
credit.

Decrease Floor

View the rate decrease allowed.

# of Adjs / Year

View the maximum number rate changes allowed in a year.

# of Adjs / Life

View the maximum number of rate changes allowed in the life of
the Line of credit.

Initial Advance

View the minimum initial advance amount.

Min Amt

Initial Advance View the maximum initial advance amount.

Max Amt

Advance Min View the minimum subsequent advance amount.

Advance Max

View the maximum subsequent advance amount.

Billing section

Draw Pre Bill Days

This is the number of days before the first payment is due that
accounts funded with this Loan instrument will be billed for the
first payment. Thereafter, the accounts will be billed on the same
day every month.

If an account has a first payment date of 10/25/2003 and Pre Bill
Days is 21, then first payment due will be on 10/04/2003, and
then 4th of every month.

Draw Period Pay-
ment %

View the percentage of draw period payment allowed.
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Field:

Do this:

Repmt Period Bill-
ing Method

View the repayment period billing method allowed.

Repmt Period
Payment %

View the percentage of repayment period payment allowed.

Min Payment Amt

View the minimum payment amount.

Min Finance
Charge

View the minimum finance charge.

Advance Toler-
ance

View the advance tolerance amount.

Advance Toler-
ance %

View the advance tolerance percentage.

Accural Past
Maturity

View the accural past maturity.

Maturity Index

View the maturity index rate.

Margin Rate View the margin rate.

Multiple Billing Check this box to indicate if multiple asset rates are applicable for

Asset Rate one billing period.
System considers billing period from current due date to the next
due date. Multiple rates are fetched only when rate end date (rate
start date + rate frequency) ends one or more cycle(s) before the
next due date i.e. current rate record does not cover the entire
billing period.

Others

Payment Mode

Select the type of repayment mode to indicate if it is ‘Autopay/
Direct Debit or not’ using any of the following option from the
drop-down list. The list is populated from REPAYMENT_PMT_-
MODE_CD lookup code.

- INSTITUTION DRAFT / CHECK (default)
- AUTOPAY (ACH)

- AUTOPAY (CREDIT CARD)

- AUTOPAY (DEBIT CARD)

- POST DATED CHECKS

For an AUTO PAY type of Payment Mode, ensure that at least
one active ACH record exist and for CHECK type of Payment
Mode, there are NO active ACH records.
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Field: Do this:

Statement section

This section allows to define the preferences for Mock Statement generation at Master
Account level. Generating a Mock Statement helps to mock the asset billing process
with a future date and to get an upfront statement indicating future dues of Master and
Associated Accounts. In ‘Vacation Ownership’ industry, such statements are required to
forecast future dues based on current ‘Timeshare’ holdings.

The default populated preference here are propagated from Setup > Administration >
Products > Contract screen when the instrument is loaded.

Note: These fields are enabled only for Master Account, i.e. only if the ‘Master Account’
check box is selected in Origination > Master Account tab. If the option is unchecked
even at a later point, system refreshes these fields making them as ‘Read-Only’.

Stmt Preference
Mode

Select the account statement preference mode as either Email or
PHYSICAL from the drop-down list.

Select this check box to indicate if the account is to be included in

Mock statement Generation.
Mock Statement

Req Note: Based on this selection, others fields related to Mock
Statement below are enabled and becomes mandatory for
providing details.

Mock Start Select the start month of Mock Statements period from the drop-

Month down list.

Mock Statement
Cycles

Select the total number of billings (between 1-12) that are to be
generated post Mock Statement Start Date.

Mock Pre
Statement Days

Specify the number of Pre bill days for Mock Statements
generation.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

8.12.1 cContractContract (2) Sub Tab

The Contract sub screen records the application’s servicing branch and collector. It also
displays additional information regarding the contract not covered on the Line of credit screen,
such as the tolerance, delinquencies, due dates, billings, and extensions.

To complete the Contract sub tab
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Contract sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Servicing Branch Select the servicing branch for the contract.

Collector Select the collector for the contract.
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Field:

Do this:

Funder

If you are acting as a proxy for a Funder, then you can select
the Funder’s name from the adjoining options list. The list
displays all the associated Funders, Funding Supervisors,
and Funding Managers.

However, this is not mandatory and can be used while auc-
tioning an application on behalf of another Funder.

Misc section

Statement Consolida-
tion

By default this check box is selected indicating that system
generates consolidated billing statement at Master Account
level along with details of all the associated accounts with
same Billing cycle and due day.

You can uncheck this option to generate billing statement to
only current account.

After funding, the option selected here is propagated to Ser-
vicing > Account Details and Contract (2) tabs.

For more information, refer to Master Account tab section.

Link To Existing Cus-
tomer

Select to link the application to the existing customer.

Anniversary Period

View the anniversary term.

Default Pmt Spread

View the spread.

HMDA section
Lien Status Select the lien status.
HOEPA Select the home owner equity protection act (HOEPA) code.

Rate Spread

Specify the rate spread. You can calculate this spread from a
tool on the Home Mortgage Disclosure Act (HMDA) website.

Others section

1st Pmt Deduction

View the first payment deduction indicator. If selected, the
first payment deduction is in use.

Days

View the first payment deduction days.

1st Pmt Refund

View the first payment refund indicator. If selected, the first
payment refund is in use.

Days

View the first payment refund days.

Pre-Pmt Penalty

View the prepayment penalty indicator. If selected, a prepay-
ment penalty can be applied.

% of Term for Penalty

View the prepayment penalty percentage of term.

Pay Off Fee

View the payoff fee indicator. If selected, a payoff fee can be
applied to the Line of credit.
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Field:

Do this:

Rebate section

Rebate Method

View the rebate calculation method.

Rebate Term Method

View the rebate term method.

Rebate Min Fin Chg
Method

View the rebate minimum finance charge calculation
method.

Rebate Min Fin Chg
Value

View the minimum finance charge value.

Acquisition Charge
Amt

View the acquisition charge amount.

Tolerance section - This section displays the tolerance details as defined in Setup >
Products > Contract screen.

Refund Allowed

View the refund allowed indicator. If selected, the refund pol-
icies in this section are in use.

Refund Tolerance

View the refund tolerance amount.

Pmt Tolerance Amt

View the payment tolerance amount.

Pmt Tolerance%

View the payment tolerance percentage.

Promise Tolerance
Amt

View the ‘Promise to Pay’ tolerance amount.

Promise Tolerance %

View the ‘Promise to Pay’ tolerance percentage.

Writeoff Tolerance

View the write-off tolerance amount.

Delinquency section

Late Charge Grace
Days

View the late charge grace days.

Delq Grace Days

View the delinquency grace days.

Delq Category
Method

View the delinquency category method.

Time Bar Years

View the total number of years allowed to contact the
customer starting from the first payment date as defined in
Setup > Products > Contract screen.

Due Date section

Max Due Day Change | View the maximum due days.
Days

Min Due Day View the minimum due day.
Max Due Day View the maximum due day.
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Field: Do this:

Max Due Day Change | View the maximum due day changes allowed (year).
Year

Max Due Day Change | View the maximum due day changes allowed (life).
Life

Extension section

Max Extn Period / View the maximum extension allowed (year).
Year

Max Extn Period / Life | View the maximum extension allowed (life).

Max # Extn / Year View the maximum number of extensions allowed (year).

Max # Extn / Life View the maximum number of extensions allowed (life).

Minimum # Payments | View the minimum number of payments.

Extension Gap in View the extension gap in months.
Months

Usage / Rental Details

Agreement Type View the Agreement Type if the current application belongs
to any of the below category. Else, the same is displayed as
UNDEFINED.

- USAGE
- RENTAL
- USAGE RENTAL

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Repayment Sub Tab

The Repayment sub screen records the application’s advance information, repayment
schedule, and skipped repayment months for variable rate Line of credit.

To complete the Repayment sub tab
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Repayment sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Repayment section:

Flexible Repay- | If this display only check box is selected, then the flexible repay-
ment Allowed ment functionality is set up and allowed for this application's prod-
uct type.
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Field: Do this:

Type Select the flexible repayment schedule you want to use from the
following: SKIP PERIOD, USER DEFINED, UNDEFINED.

If you select the repayment schedule type of SKIP PERIOD, you
then select the months for which borrower won't make any pay-
ments in the Skip Months section.

If you select the repayment schedule type of USER DEFINED, you
then enter the repayment schedule requested by borrower in the
Schedule section; for example, $300.00 for first 12 months,
$350.00 for next 18 months, and so on.

Note: The borrower may not provide a complete repayment sched-
ule with the contract. Provisions are available with the system to
compute the repayment schedule for remaining periods at a later
time, if borrower provides partial repayment schedule.

Skip Months section

Jan If selected, indicates that repayment is skipped for January.
Feb If selected, indicates that repayment is skipped for February.
Mar If selected, indicates that repayment is skipped for March.
Apr If selected, indicates that repayment is skipped for April.

May If selected, indicates that repayment is skipped for May.

Jun If selected, indicates that repayment is skipped for June.

Jul If selected, indicates that repayment is skipped for July.

Aug If selected, indicates that repayment is skipped for August.
Sep If selected, indicates that repayment is skipped for September.
Oct If selected, indicates that repayment is skipped for October.
Nov If selected, indicates that repayment is skipped for November.
Dec If selected, indicates that repayment is skipped for December.

Extendable Balloon section

Max Term Specify maximum number of payments.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
5. In the Repayment Schedule section, click View.

6. View the following information:

Repayment Schedule section

Note: Complete the Schedule section only if you have entered USER DEFINED in the
Repayment section’s Type field. Click Add to make new entries.

Seq Specify the sequence number of the repayment schedule.
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Pmt Amt

Specify the repayment amount borrower agreed to pay during the
schedule.

# of Pmts Specify the number of payments borrower agreed to pay for stated
repayment amount during this schedule.

Generated If selected, indicates that the schedule is system generated.

Enabled If selected, indicates that the schedule is enabled.

7. Inthe Payment Change Schedule section, click View.

8. View the following information:

Payment Change Schedule section

Seq Specify the payment sequence number.
Option Type Select the option type.

Frequency Specify the payment change frequency.
Period Specify the period.

# of Adj Specify the number of adjustments.
Value Specify the adjustment value.

Itemizations Sub Tab

The system lists the distribution of the Line of credit proceeds on the Itemizations sub screen
when you choose Select Instrument on the Contract link. It lists amounts paid to the borrower
directly, amount paid to the borrower’s account, and amount’s given on the borrower’ behalf
to third parties. Itemizations are categorized according to advances, finance fees, prepaid
fees, producers or escrows. If you have entered itemization amounts during application entry
or underwriting, you will see these values in the Amount or Approved Amt columns.

The Itemizations sub screen offers the option of computing the values for itemization
according to a itemization formula associated with the selected instrument based on system
setup.

If you require any new itemizations, you can add them using the Setup menu Products
command. (For more information, see the Products chapter in the Setup Guide.)

To complete the Itemizations
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Itemizations sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:
Iltemization View the itemization.
+/- View whether the itemization is added or subtracted.
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Field: Do this:

Amount View the amount.

Approved Amt | View the approved amount. This is information recorded on the
Underwriting screen.

Discount Rate | Specify the discount rate.

Tax View whether the itemization is taxable (Sales) if box is selected.

Sir View the seller payment.

Itemization View the itemization type.

Formula

[temization View the itemization type.

Type

Prefunding View the prefunding status.

Status

Pmt Dt View the payment date.

Pmt Ref # View the payment reference number.

Comment Specify additional comments, if any.

4. Choose the option button for the type of itemization you want to use: Advance, Financed
Fees, Pre-Paid Fees, Producer or Escrow.

5. Inthe Amount column, enter the amount corresponding with what is listed in the
Itemization column.

6. If the Itemization Formula field contains an entry other than UNDEFINED, you can
choose Compute to auto-compute the value in the Amount field using a predefined
itemization formula.

Itemization formulas are created on the Product Setup screen’s Origination Fees
screens. (For more information, see the Org. Fees tab section of the Products chapter
in the Setup Guide.)

To ensure you create the correct computed value, choose Compute after entering
values for all base itemizations; that is, values of all such itemizations with an
Iltemization Formula of UNDEFINED.

You can also manually enter amounts for auto-computed itemizations.

If you click Initialize, the system sets the values of auto-computed itemizations to 0
(zero).

7. If you choose, use the Comment field to add remarks.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

8.12.4 Trade-In Sub Tab

If there is any information regarding an itemized trade-in, use the Trade-In sub screen to enter
the details in the system (This sub screen might already contain information supplied during
the underwriting process.)

To complete the Trade-In sub screen

1. Open the Funding screen and load the application you want to work with.
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2. Click the Contract > Trade-In sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter.

A brief description of the fields is given below:

Field:

Do this:

Trade In section

Asset Type Select the asset type.

Asset Sub Type Select the asset sub-type.
Year Specify the year of the asset.
Make Specify the make of the asset.
Model Specify the model of the asset.

Identification #

Specify the identification number.

Body

Specify the body of the asset.

Description

View the asset description.

Valuations section

Wholesale Amt

Specify the wholesale amount.

Base Retail Amt

Specify the retail amount.

Addons Amt (+)

Specify the add ons amount.

Payoff Amt (-)

Specify the payoff amount.

Total Amt = View the total amount.
Valuation Dt Specify the valuation date.
Source Select the valuation source.

Valuation Supple-
ment

Specify the valuation supplement.

Edition

Specify the valuation edition.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

8.12.5 Subvention Sub Tab

With the Subvention sub screen, you can enter the subvention information and calculate the
subvention amount, as well as override the calculated subvention amount. The participant’s
information is automatically populated based on the selected subvention plan.

To use the Subventions sub screen
1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > Subventions sub tab.
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3. In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter.

4. A brief description of the fields is given below:

Field:

Do this:

Subvention section:

Plan Select the subvention plan code.
Description View the subvention plan description
Sub Plan Select the sub plan.

Sub Plan Description

Select the subvention sub plan.

Subvention Type

View the subvention type

Subvention Amount

View the subvention amount for the plan.

Include

If selected, indicates that the subvention is included.

5. Click View in the Subvention Details section.

View the following:

Participants section:

Participant

View the participant.

Participant Type

View the participant type

Collection Method

View the collection method.

Rate

View the subvention rate.

Rent Factor

View the subvention rent factor.

Calculation Method

View the subvention calculation method.

Factor

View the factor.

Calculated Amount

View the calculated subvention amount.

Subvention Amount

Specify the subvention amount.

Total Subvention Rate

View the total subvention rate.

Total Subvention
Amount

View the total subvention amount.

Include

If selected, indicates that the subvention is included.

6. Click Initialize to reset the subvention amount to zero.

7. Click Calculate to calculate the subvention amount.

8. Perform any of the Basic Actions mentioned in Navigation chapter.
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8.12.6

Insurance Sub Tab

If there is any information regarding an itemized insurance amount, enter the details on the

Insurance sub screen. The Insurance sub screen also enables you to calculate the
commission if there is a commission rule defined during Contract setup.

To complete the Insurance sub tab

1.
2.
3.

chapter.

Open the Funding screen and load the application you want to work with.
Click the Contract > Insurance sub tab.

In this section, you can perform any of the Basic Operations mentioned in Navigation

A brief description of the fields is given below:

Field:

Do this:

Insurance Plan

Select the insurance plan associated with the financed insurance

product.

Insurance Type

View the insurance type associated with the insurance plan.

Sub Type

Select the insurance sub type offered under the insurance plan.

Insurance Com-
pany

Specify the insurance company associated with the insurance
plan. The system populates the default insurance plan defined
during product setup.

Policy # Specify the insurance policy number.
Effective Dt Specify the insurance effective date.
Term Specify the insurance term.

Expiry Dt Specify the insurance expiry date.

Commission Rule

View the insurance premium amount.

Premium Amt

Specify the insurance premium amount.

Commission Amt

View the insurance commission amount.

Phone Specify the insurance company’s primary phone number.
Extn Specify the insurance company’s primary phone extension.
Phone Specify the insurance company’s alternate phone number.
Extn Specify the insurance company’s alternate phone extension.

Beneficiary sectio

=

Primary

Specify the primary beneficiary of the insurance.

Secondary

Specify the secondary beneficiary of the insurance.

Cancellation/Refund section
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8.12.7

Field:

Do this:

Cancellation
Refund Allowed

If selected, a refund is allowed. A selected box indicates that the
insurance premium can be rebated to the customer in case of
early payoff.

Grace Days View the number of grace days allowed for cancellation without
charging a cancellation fee.

Calculation View the insurance premium refund/rebate calculation method to

Method be used when insurance is cancelled.

Grace Days Can- | If selected, indicates that cancellation fees during grace is

cellation Fee allowed.

Allowed

Cancellation Fee

View the amount of the cancellation fee to be charged when the
insurance is cancelled.

Deduct Fee From

View the option defined in setup screen (Setup > Administration >
Products > Insurances) to deduct the cancellation fee.

‘Premium Amount’ indicates fee is deducted upfront before
computation and ‘Rebate Amount’ indicates fee is deducted after
computation.

4. If you click the

Calculate button, the system computes the commission based on the

commission method in the Cancellation/Refund section.

The commission appears in the Commission Rule and Commission Amt fields of the
Policy Information section.

It also appears on the Itemizations sub screen.

You can overwrite the suggested value if you choose.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

ESC Sub Tab

If there is information regarding an itemized extended service contract or warranty amount,
enter the details on the ESC sub screen.

To complete the ESC (extended service contracts) sub tab

1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > ESC sub tab.

3. In this section,
chapter.

you can perform any of the Basic Operations mentioned in Navigation

4. A brief description of the fields is given below:

Field:

Do this:

Warranty Information section

Service Con- View the extended service contract type.
tract
Policy # Specify the ESC number.

Effective Date

Specify the ESC effective date.
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Field: Do this:

Term Specify the ESC term.

Expiration Dt Specify the ESC expiry date.

Premium Amt | View the ESC premium amount

Commission View the commission amount.

Amt

Commission View the commission rule.

Rule

Warranty Specify the ESC company’s name.

Company

Comment Specify comment if any.

Phone No Specify the ESC company’s primary phone number.
Extn Specify the ESC company’s primary phone extension.
Phone No Specify the ESC company’s alternate phone number.
Extn Specify the ESC company’s alternate phone extension.

Cancellation/Refund

Allowed Check this box to allow cancellation/refund.

Method Specify the method of cancellation/refund.

5. In the Cancellation/Refund section, view the following information.

— Ifthe Allowed box is selected, a refund is allowed. A selected box indicates that the
ESC premium can be rebated to the customer in case of early payoff.

— The Method field displays the refund method.

6. If you click the Calculate button, the system computes the commission based on the
commission method in the Cancellation/Refund section.

The commission appears in the Commission Rule and Commission Amt fields of the
Warranty Information section.

It also appears on the Itemizations sub screen.
You can overwrite the suggested value if you choose.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

8.12.8 Escrow Sub Tab

If there is escrow information selected on the Itemization sub screen, enter information about
it on the Escrow sub screen. The Escrow sub screen records escrow details regarding
disbursement, insurance, and property tax -- information that is parsed to the Customer
Service screen on the Customer Service (2) master tab, where it is available for maintenance.

This sub tab is available if escrow is allowed for the instrument selected on the Line of credit
screen.

The Escrow Analysis screen enables you to view and perform the initial escrow analysis. You
can perform multiple analyses; however, the system records only the most recent analysis.
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To complete the Escrow sub screen

1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > Escrow sub tab.

3. The Escrow Information section displays information regarding the escrow recorded on
the Itemization sub screen. In this section, you can perform any of the Basic Operations

mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field:

View:

Escrow

The escrow itemization code and description.

Escrow Type

The escrow type.

Escrow Sub Type | The escrow sub type.

Advance Amt

The amount that’s been approved for the Item in the itemiza-
tion screen under the escrow.

Required Escrow If selected, indicates that this is mandatory itemization and

customer can not opt out of this escrow item.

Cushion Allowed If selected, indicates that cushion is allowed.

4. Select the Opt Out box only if you want to ignore this particular escrow.

5. In the Disbursement section, enter the following information:

Field: Do this:

Rule Select disbursement rule.

Yearly Amt Specify yearly disbursement amount.

Account # Specify reference account number for vendor.
Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is set to Y, this appears as a masked number; for example,
XXXXX1234.

Vendor Specify the vendor name.

Maturity Dt Specify the maturity date, if one exists.

6. If this escrow involves an insurance, use the Insurance section to enter the following
information:
Field: Do this:
Coverage Type Specify the coverage type.

Coverage Term

Specify the coverage term.

Policy #

Specify the policy number.

Coverage Amt

Specify the coverage amount.

Effective Dt

Specify the effective date.
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8.12.10

Field: Do this:

Expiration Dt Specify the expiration date.

7. If this escrow involves a tax, use the Tax section to enter the following information:

Field: Do this:

Property Tax Type Specify property tax code.

Comment Specify a comment.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

Proceeds Sub Tab

The Proceeds sub screen displays the payment amount due to the dealer, based on the
Compensation and ltemization sub screens. It is a view only sub screen, though you can
record comments.

To use the Proceeds
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Proceeds sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:
Itemization View the proceed itemization.
+/- View whether the itemization is added to or subtracted from the

total proceeds.

Amount Specify the amount.
Currency Specify the currency of the proceed.
Comment Specify a comment.

Total Amount View the total amount.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Disbursement Sub Tab

The Disbursement sub screen records how the Line of credit payment is disbursed and
records payments to third parties such as the Department of Motor Vehicles. This sub screen
needs to be completed if there is an itemized disbursement.

To complete the Disbursement sub screen
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Disbursement sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.
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A brief description of the fields is given below:

Field:

Do this:

Disbursement section

Validate Payee

Check this box to validate payee.

Description

View the disbursement description.

Number

Specify the disbursement party’s number.

Payment Mode

Select the payment mode.

Name Specify the company name.

Account # Specify the account number.
Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is set to Y, this appears as a masked number; for example,
XXXXX1234.

Amount View the payment amount.

Currency Specify the currency.

ACH Account
Type

Specify the account type.

Account # Specify the ACH account number.
Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is setto Y, this appears as a masked number; for example,
XXXXX1234.

ACH Bank Specify the bank number.

ACH Routing #

Specify the routing number.

BIC

Select the Business ldentifier Code from the drop-down list. The
list displays the BIC codes defined in the system.

IBAN

Specify the IBAN (International Bank Account Number). IBAN is
used for identifying bank accounts across national borders with a
minimal of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation
based on modulo 97. On save, system automatically validates
the IBAN number length based on country code, characters,
white spaces, and checksum. Validation is also done during
posting non-monetary transaction (ACH Maintenance).

You can maintain the IBAN length and other details required as
per the country code in the user defined table (Setup > Adminis-
tration > System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is
defined by default with length of IBAN as 18.

Comment

Specify a comment.

Country

Select the country.
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Field: Do this:
Address Line 1 Specify the address line 1.
Address Line 2 Specify the address line 2.
Zip Specify the zip code.

For non US country, you have to enter zip code.
City Specify the city.
State Select the state.
Phone 1 Specify the primary phone number.
Extn Specify the primary phone extension.
Phone 2 Specify the alternate phone number.
Extn Specify the alternate phone extension.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Disbursement tab will display the records only if a third party itemization is maintained
during contract setup.

8.12.11 Fee Sub Tab

The Fee sub screen is a view-only table displaying what fees on the Line of credit instrument
are in use, based on the contract.

To view the Fee

1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Fee sub tab.

3. Inthe Fee sub screen, view the following display only information:

Field:

Do this:

Fee

View the fee type.

Fee Calc Method

View the fee calculation method.

Txn Amt From

View the minimum transaction amount.

Credit Limit From

View the minimum value of credit limit for the pricing.

Percent View the maximum percentage.
Min Amt View the minimum fee amount.
Max Amt View the maximum fee amount.
Enabled If selected, the fee rule is enabled.
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8.12.12 ACH Sub Tab

The ACH sub screen records details about automatic clearing house, if this is a direct deposit
payment account; otherwise, it remains empty. This information is used to receive payments,

primarily when working with the Payments screen.

To complete the ACH

1.
2.
3.

chapter.

Open the Funding screen and load the application you want to work with.
On the Funding screen, click the Contract tab, then choose the ACH sub tab.

In this section, you can perform any of the Basic Operations mentioned in Navigation

A brief description of the fields is given below:

Field: Do this:

Bank Name Specify the bank name.

Routing # Specify the routing number.

Payment For an active Recurring ACH record, the payment mode selected in

Mode Contract tab is automatically populated. If not, select the type of
repayment mode to indicate the type of ‘Autopay/Direct Debit’ using
any of the following option from the drop-down list. The list is popu-
lated from REPAYMENT_PMT_MODE_CD lookup code.

- AUTOPAY (ACH)

- AUTOPAY (CREDIT CARD)

- AUTOPAY (DEBIT CARD)

For an AUTO PAY type of Payment Mode, ensure that at least one
active ACH record exist and for CHECK type of Payment Mode,
there are NO active ACH records.

Status Select the required ACH status from the drop down list. By default,
the ACTIVE status is selected.

Default By default, this check box is selected indicating that the current
ACH is the default one. If not, you need to uncheck the same.

Start Dt Specify the ACH start date. By default the first payment date of the
contract is auto populated and can be edited.

End Dt Specify the ACH end date.

Account Type Select the account type.

Account # Specify the account number. Note: If the organizational parameter
UIX _HIDE RESTRICTED DATA is set toY, this appears as a
masked number; for example, XXXXX1234.

BIC Select the Business Identifier Code from the drop-down list. The list
displays the BIC codes defined in the system.
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Field: Do this:

IBAN Specify the IBAN (International Bank Account Number). IBAN is
used for identifying bank accounts across national borders with a
minimal of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation based
on modulo 97. On save, system automatically validates the IBAN
number length based on country code, characters, white spaces,
and checksum. Validation is also done during posting non-monetary
transaction (ACH Maintenance).

You can maintain the IBAN length and other details required as per
the country code in the user defined table (Setup > Administration >
System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is defined
by default with length of IBAN as 18.

Pmt Day Specify the payment day. By default the payment due day specified
for the contract is auto populated and can be edited.

Pmt Amt Specify the payment amount. By default the payment amount
decided for the contract is auto populated and can be edited.

Note: If the payment amount is specified as ZERO, system will
automatically consider the EMI amount.

Pmt Amt Specify the additional payment (if any). This is the additional amount
Excess over and above the regular EMI. Appropriation of this amount is
based on the ‘Spread’ defined in the contract.

Pmt Freq Select the payment frequency. By default the bill cycle frequency
defined for the contract is auto populated and can be edited.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. If there are more than one ACH banks and an optional End Date, click Add and repeat
steps 3 through 5.

8.12.13 Coupon Sub Tab

The Coupon sub screen enables you to order (or re-order) new coupon books. This sub
screen is only available if the bill type for this application is a coupon payment, not a
statement.

To complete the Coupon
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Coupon sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:
Order Select to order coupon book.
Order Dt Specify the coupon book order date.
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Field:

Do this:

Ordered By

Select the user id of the user who ordered the coupon book.

# of Coupons

Specify the number of coupons.

First Pmt Dt

Specify the first payment date.

Coupon Start-
ing #

Specify the starting number of the coupon book.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

8.12.14 References Sub Tab

The References link enables you to enter any number of people as a reference on the

application.

To complete the Reference screen (Contract link)

1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > References link in this section, you can perform any of the Basic

Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Relationship Select the reference type.

Name Specify the reference name.

Status Select the status of the reference from the drop-down list.
Years Specify the number of years.

Months Specify the number of months.

Comment Specify a comment.

Country Select the country.

Address Line
1

Specify the address line 1.

Address Line
2

Specify the address line 2.

State Select the state.
Zip Select the zip code.

For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
City Specify the city.
Phone 1 Specify the reference’s primary phone number.
Extn Specify the reference’s primary phone extension.
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Field: Do this:

Permission to | Check this box if customer has provided permission to contact
call through the specified phone number.

When selected, system auto validates this option against the phone
number specified. Atleast one phone number should have the per-
mission to call for successful pre-qualification of the application.
Else, an error message is displayed.

Permission to | Check this box if customer has provided permission to contact

Text through text message.
Phone 2 Specify the reference’s secondary phone number.
Extn Specify the reference’s secondary phone extension.

Permission to | Check this box if customer has provided permission to contact
call through the specified phone number.

When selected, system auto validates this option against the phone
number specified. Atleast one phone number should have the per-
mission to call for successful pre-qualification of the application.
Else, an error message is displayed.

Permission to | Check this box if customer has provided permission to contact
Text through text message.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
If you want to add another reference, click Add and repeat steps 3 and 4.

8.12.15 Real Estate Sub Tab

The Real Estate Fields screen records additional information regarding manufactured home
Line of credit.

To complete the Real Estate Fields screen
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Real Estate.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Note Transmittal Number Specify the note transmittal number.

Deed Transmittal Number Specify the deeding transmittal number.
Cancel/Cashout Transmittal Specify the deeding cancel/cash out transmittal
Number number.

Deed Input Date Specify the deed input date.

Deed Recording Date Specify the deed recording date.

Deeding Book Number Specify the deeding book number.
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Field:

Do this:

ConDeeding Page Number

Specify the condeeding page number.

Mortgage Recording Date

Specify the mortgage recording date.

Mortgage Book Number

Specify the mortgage book number.

Mortgage Page Number

Specify the mortgage page number.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

8.12.16 PDC Sub Tab

The PDC sub screen displays any post dated checks associated with the contract.

To complete the PDC

1.
2.
3.

chapter.

Open the Funding screen and load the application you want to work with.
Click the Contract > PDC sub tab.

In this section, you can perform any of the Basic Operations mentioned in Navigation

A brief description of the fields is given below:

Field: Do this:

PDC Ind If selected, indicates that this account involves a post dated check as
a method of repayment.

PDC Type Select the post dated check type, SECURITY CHECKS or POST
DATED CHECKS FOR PAYMENT.

Account # Specify the account number, on which the cheque is drawn.

Routing # Specify the routing number of the cheque. It is the number printed on
the cheque, also called MICR number (Magnetic Ink Character Rec-
ognition).

Account Specify the type of the account

Type

Bank Name Specify the bank name of the customers cheque

Branch Specify the Branch name of the customers cheque

Name

Docket # Specify the docket number where post dated checks are supposed
to be stored.

Check # Specify the starting cheque number.
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Field: Do this:

Check Dt Select the check date. In case there are multiple checks being
deposited that have sequential serial numbers, the date of the first
cheque in the series would be entered in the date field. The remain-
ing cheque dates would be anniversary dates based on the fre-
quency set up.

For example, the cheque range could be from 111 to 180. If the date
on the first cheque-111 is October 12, 2003 and the frequency is set
to Monthly, the next cheque would be picked up for processing on
November 12, 2003.

Check Amt Specify the appropriate cheque amount.

No of Specify the total number of checks in the range.

Checks

Billing Cycle | Select the frequency at which the checks are to be sent for collec-
tion.

Comments Specify any remarks for the details.

4. Click Generate.

5. Inthe PDC Table section, select the record you want to work with and enter, view or edit
the following information:

Field: View this:

Select If selected, indicates that this is the current record.

PDC Type The type of post dated check in use.

Account # The account number of the post dated check.

Bank Name The bank name of the post dated check.

Check # The check number of the post dated check.
Status The status of the post dated check.
Check Dt The check date of the post dated check.

Check Amt The check amount of the post dated check.

Account The account type of the post dated check.
Type

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Collateral tab

Having selected and loaded an application, you can view the information about the collateral
of the Line of credit.

The Collateral link opens screens with information regarding any collateral associated with an
account. Depending on the type of Line of credit, collateral can be a vehicle, home, or
something else, such as major household appliances. The Collateral link is unavailable if this
is an unsecured Line of credit.
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A detailed explanation of the fields found on the Collateral link’s screens and sub screens can
be found in the Application Entry chapter.

To verify information about the collateral

1. Open the Funding screen and load the application you want to work with.

2. Click the Collateral link.
Depending on the type of collateral, information about the vehicle, home or other type

of collateral appears.

3. Verify the information regarding the collateral and its sub screens. (This is information that
was recorded during the application entry process or gathered during the credit pull.)

If the collateral is a vehicle, the Collateral link displays information about the vehicle.
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If the collateral is a home, the Collateral link displays information about the home.

Financial Services Lending and Leasing
.
Origination [ Close
Search/Tas< Underwriting: 0000001051  Revew Requests (Pendng: 0) @
Application: 0000001051: PERALTA JAKE AEic | FVven | o auic
View = Formet~ (5 Freeze [ Detach wp @) Oveide OK v Waming OK ¥ MANUAL Cortract
G A
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11372018 0000001051 UNDEFINED APPROVED - ELANK  DECISIONED LN00001 : SGPR... (0002000000 N N DEMOLEAD SGHQ VOLOA
< >
Surmery Appicant Request Decscn Contract MasterAccoutt  Collateral Comments Trackng Docment Verifcetion | Corfesponderce  Toos
Collateral | Sele
Home dpAdd | Edt E|VE«.-/ o hude
Vews Fometv & | Freere [ Detach W @) Bxstng AsserId ¥ o Load Detais
> i
E:s‘:trg Existing Asset1d  Primery Asset Clss Asset Type Sub Type Occupancy Identfcation # Country Address # Ciy Stete County
N B NEW HOME VACATION_OWNE... HOA SINGAPORE 123 SINGAPORE DELAWARE
& >
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‘
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View v Formetv 5 Freere  Eff Detach wee @
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< >
Tracking Attributes JEdt || o hud
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Paramezer Valee
VACATION OWNERSHIP ATTRIBUTE 008 UNDEFINED A v

If the collateral is anything other than a vehicle or home, the Collateral link displays
information about the other type of collateral.

ORACLE’

Financial Services Lending and Leasing

DashBoard
Origination
Origination
Sales Lead
Simple Application Entry
Application Entry
Underwriting
Funding
Application Retrieval
Scenaria Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
> Collections
> WFP

> Tools

> Setup
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Application: 0000001533: SIGG MARK At || B vew || o audt
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>
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N # ]
N oY NEWVEHICLE  VEHICLE [ NOT DEFINED 2015 0 AUDI a4
< > i
Other Collateral
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Existing Assedt_ Body Zp ]
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ficron State [v]
At Tye \REUSEHOND GonDS [v] Condition GOOD CONDITIONED [v] i =
" unt v
* Sub Type GENERAL HOUSEHOLD GOODS / E[~]
= Status NOT DEFINED [v] Address - Usaqe Details
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Select Make and Model 5 Start 0
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Mok Gl *Total 0
Model * Charge Amt 0.00
Valuation  Tracking v

For details on this screen refer Collateral Tab section in Underwriting chapter.
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8.14

8.15

Comments Tab

When using the Underwriting screen, you can add comments to an application at any time in
the underwriting process by using the Comments screen.

Whenever an application is funded by a proxy user, a system generated comment with
timestamp is inserted in the comments tab in the format ‘<User 1> actioned as proxy for
Funder <User2>’. Here, User 1 refers to the logged in user who has acted on behalf of User2,
who is the concerned Funder. The concerned Funder’s name will also be selected in Contract
Tab > 'Funder field.

To add comments to an application
1. Open the Funding screen and load the application you want to work with.

2. Click Comments.

ORACLE
Financial Services Lending and Leasing

Origination (30 s

Application o || Sl || P nude
View « rormare | B =p W o =
ey Cuplicats
ot pe seat Producer Mam o Eeting Cumomer  SUBICHE Contac
o data o dizplay.
< >
Summary || Applicant | mequest | Gaciion || Surssu | Contrsct || Comments | Trading || Socument || Varficstion || Carrsspondance
comments
<o R
View ~ Farmat~ | B rrssze Ef] Detach wa
i 1ype sub iypa Commant
(m} ReGULAR ~| | LoAn oRIGmNATION |~ VAvAIDYA 02/03/2016 12:09:56 AM

> sarvicing
> Collections
> wrp

> Tools
> Setup

For details on this screen refer Comments Tab section in Underwriting chapter.

Tracking Tab

When using the Funding screen, you can add tracking attribute information to an application
at any time in the underwriting process by using the Tracking Attributes screen.

To enter the tracking attributes for an application
1. Open the Funding screen and load the application you want to work with.
2. Click the Tracking tab.

ORACLE

& Welcome, DEMOSUPR ~ 13 signout O
Financial Services Lending and Leasing

= Glose
»| DashBoard Origination (3l
Origination Result/Task Funding Search Review Requests (Pending: 0) 2
"/ Origination o
Sales Lezd Application Aedt | Elven | o audt
Simpie Appication Entry: view - Format - | B Frecze | fefiDetach P T overrideok [1 warningok [
T T T -
Application Entry [ [ Producer |
i |Grignation Stage | |Existing
| | | I |Mumber |
Funding
No data to display.
Application Retrieval o - .
Scenario Analysis
Application Decuments
Image Maintenance
G erne Summary Applicant Request Dedsion Bureau Contract Comments Tracking Document Verification Correspondence
Producers Tracking Attributes Field Investigation
Vendors .
Tracking Attrubutes
Eseveandstay | [ sove andRetun | Garewm |
view v Format v | B Freeze  iff Detach Wrap =)
_ |sub-parameter  |Parameter [value
o data to display.
4
4

For details on this screen refer Tracking Tab section in Underwriting chapter.
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8.16

8.17

Document tab

The Document Maintenance link allows you to view documents attached to an application in
the form of GIF files, PDF files, DOC files, XLS files, and TXT files and add comments
regarding a selected document.

For more information, see the chapter Document Management in this User Guide.

To view a document attached with an application
1. Open the Funding screen and load the application you want to work with.

2. Click Document.

ORACLE’
Financial Services Lending and Leasing

PR — [=)

T Close
e Origination 5 =d

Origination Search/Tesk | Funding | Review Requests (Pending: 0)

Origination
Sales Lead
Simple Applicatiol
Application Entry
Underwiting ot
Funding

Application A Edit
View v Fomat- B 2= & Detach W override oK __ waming OK __

Origination Stage

Code

B view || o Audit

Producer Contact Duplicate

App % Sub Unit Status s Bxisting Customer SRS

Producer Name Contact sa
No data to display.

>

Summary || Applicant || Request || Decision || Bureau || Contract | Comments | Tracking | Document || Verfication | Comrespondence

Checklist  Document

Checklist

View v Formatw [ Freeze i Detach Wirap @ o Load Checkist
Checklist Type Checklist Comment
No data to display.

Zedt | [Eyew || o audt
485 Complete
Complete

Regular | Document

Checklist Actions # Edit
View v Formatv | [E Fresze Efi Detach Wrap (5]

Action Comment.
No data to display.

Elview || o audit

Respanse

< >
> Servicing

> Collections
> WFP

> Tools

> Setup

For details on this screen refer Document Tab section in Underwriting chapter.

Verification Tab

The system can be configured to automatically validate portions of an application when you
attempt to change its status. The results of this data check appear on the Verification link’s
Edit screen as an Error, a Warning or an Override.

If it is an Error, the system will not allow you change the application’s status and approve the
Line of credit until you fix all the errors.

If itis a Warning, the system enables you to change an application’s status without correcting
the matter. While you should still investigate the problem, Warning messages are of a lesser
importance than Error messages.

Ifitis an Override, the system displays a dialog box informing you that an override is needed;
your responsibility level does not have the authority required to process this step. (Choose
Yes on the dialog box to move the application to the queue of the user with the required
authority.)
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The system can be configured to verify different sets of information; for example, the system
could check one set of data when checking application entries for completeness and another
when approving auto Line of credit. Each one of these “edit types” has its own set of “edit
details.”

Note

The Edit Details section’s errors and warnings are created during the setup process.

To complete the Verification tab
1. Open the Funding screen and load the application you want to work with.

2. In the Edit Type drop-down list, select 'Application Approval Edits' and click on 'Check
Edits' button.

Edit details are displayed in the table below along with the result, expected value, actual
value and the override responsibility. This is based on the product and contract set up
details that is done initially.

For more information, refer to Configuring Lending and Leasing setup guides.

3. Specify all the information associated with the application on the Funding screen.

ORACLE’
Financial Services Lending and Leasing

& Welcome, PRAKRRAO - [ EETOIRE O

T Origination 3§ Clos=

Origination Search/Task | Funding | Review Requests (Pending: 0)
Origination
Sales Lead

Application A et || [Eview || o audit
Simple Applicatiol -
Application Entry View v Fomate [ Frezze (i Detach Wrap T Override OK__ Waring OK _
Underwriting Origination Stage Producer Contact i Duplicate
ik Dt App # Sub Unit Status Code Producer Name Number Buasting Customer Application Contact sa
fa t
Application Retrie || M© d(” ok >
Scenario Analysis
Application Docur
Image Maintenan
Reports Summary Applicant Request | Decision Bureau Contract Comments = Tracking Document Verification Correspondence
Producers
Vendors Edits | | Audits || History
Edit Types
View = Fomatw Ep Freeze {4 Detach Wirap W Edit Type [V] 8 check Edits
Date Edit Type
No data to display
“
‘
Edit Details
View w Formatw [ Fresze EfiDetach | ¢ Wrap (%]

Edit Name Result Expected Value Actual Value Override Responsibility
No data to display.

< >
> Servicing

> Collections
> WFP

> Tools

> Setup

e If there are edits with 'Error' entries, verify and correct the data in the respective tabs
and repeat step 2 until the 'Error' entries are cleared.

e When there are only 'Warnings' left you can choose to change the status of the
application to the next stage in the Origination cycle.

4. When you are finished entering data, on the Funding link bar, click Verification.

For details on this screen refer Verification Tab section in Underwriting chapter.
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8.18

8.19

Correspondence Tab

Ad-hoc correspondence enables you to include information from applications in document
templates you create yourself without manually transferring the data. Ad-hoc documents can
be generated as either Microsoft Word or PDF files.

Ad-hoc correspondence can be viewed on the Correspondence link’s Correspondence
screen when you have opened an account. The screen enables you to generate a new letter
or view a previously generated letter.

To generate an ad hoc correspondence
1. Open the Funding screen and load the application you want to work with.

2. Click Correspondence.

ORACLE
Financial Services Lending and Leasing
iginatic Clos:
R origination ». (=
Origination Search/Task | Funding | Review Requests (Pending: 0) .
Qrigination
Sales Lead Application A Edt | Elvew | o audit
Simple Application Entry
application Entry View w Formatw [ Freeze i Detach Wrap W Overideok _ WamingOK __
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Funding Dt App # Sub Unit Status Pk Producer Name Corexiting Customer e Cor
Appiication Retrieval o data 5 diplay.
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Application Documents
Image Maintenance
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Producers Summary || Applicart || Request || Decision | Bureau | Contract || Comments | Tracking | Document | Verfication | Correspondence
Vandors
Correspondence  Letiers
Correspondence & dd | View || o audit
View~ Formatv [ Fresze  Ef Detach Wrap 50
ID Correspondence Date
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4
Correspondence u
[ save and add Save and Stay || [ save and Retun || 3 Return
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Documents
View~ Formaty [ Fresze EfiDetach | «f Wrap @
Document Id Document Recipient EFormSource  Source Type Selects(
No data to display.
< >
Document Elements A Edit | B View || 2 audit
View v Format~  [E} Freeze ) Detach Wrap 51
> Servicing Element Type Element Content
No data to display.
> Collections
> WEP
Recipient Details add | Edit View | o Audit
> Toals L Had | A ] v u
View~ Formatv [ Fresze  fi Detach 0 Wrap W send v
> Setup
Recinient t Made Tune FAXIFmail Sent Tndicator Cammen he

For details on this screen refer Correspondence Tab section in Underwriting chapter.

Escrow Analysis Tab

If escrow is allowed for the selected instrument, the Escrow Analysis link is available on the
Contract drop-down link. This screen enables you to view and perform the initial escrow
analysis. When you are satisfied with the analysis, complete the Approval Dt field in the
Approval section and save your entry.

The escrow payment for the Line of credit account starts on the 1st date of the Line of credit
payment month. The disbursement happens on the 10th of the month (as per the
disbursement rules). The escrow analysis lasts for a year (12 months) irrespective of the Line
of credit term.

You can perform multiple analysis; however, the Escrow Analysis screen only records the last
analysis performed. No record of any earlier analysis is currently available.
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To complete the Escrow Analysis screen

1. Open the Funding screen and load the application you want to work with.

2. On the Funding screen, Click Escrow Analysis tab.

%riginatioll %

Search/Task  Funding: 0000000245 ~ Review Requests (Pending: 0)

Application: 0000000245: EEVERGREEN SADIE / ROSS

View= Format~ [ Freeze & Detach
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12/09/2015
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A
E] view | o udt
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Status Code Producer Name: EaEwstmg[u,tnmer Applcaton Contact Sales Agent Branch Proi
APPROVED - FUNDED FUNDED MN-00001 : TN HOUSE (DIR. N [} NLHQ o8
13
Summary ~Applicant = Request = Decision = Contract Collateral Comments Tracking Document | Verification = Correspondence —Escrow Analysis  Tools
=] view || o udit
dwar R
Disbursement Rule Yearly Amt
JANUARY MONTHLY 120000 A
JANUARY MONTHLY 120000
JANUARY MONTHLY 120000 7
<aReturn
Escrow  COUNTY TAX
Disbursement Rule JANUARY MONTHLY
Vearly At 1,200.00
QM\M o hudit
dwe @
Opening Bal (Act)  Opening Bal (Est.) Cushion Type Cushion Value Cushion Amt. Std PmtAmt  Escrow Pmt Amt Spread PmtAmt () Other Pmt Amt (+
0.00 800.20 MONTHS 00 B00.00 4173 66.68 0.0
b
-

3. Inthe Escrow Analysis section, view or enter the following information:

Field:

View:

Escrow

The escrow item.

Disbursement Rule

The escrow disbursement rule.

Yearly Amt

The escrow disbursement yearly amount.

4. Click Analyze.

5. Information on the Analysis Details screen is based on expected cash flow from contract
and escrow disbursement setup. Payments received appear before escrow disbursement
in any given month. Click View in Escrow Analysis section.

6. In the following section, enter, view, or edit the following information:

Field: View:

Parameters section

Date The date.

From Dt The FROM date for the escrow activity.
To Dt The TO date for the escrow activity.

Opening Bal (Act)

The opening balance actual amount.
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Field:

View:

Opening Bal (Est)

The opening balance estimated amount.

Calculation: cushion amount + low required balance

Cushion Type

The cushion type.

Cushion Value

The cushion value.

Cushion Amt

The cushion amount.

Calculation: as per the shortage /cushion Rule maintenance

Results section

Std Pmt Amt

The standard payment amount.

Escrow Pmt Amt (+)

The escrow payment amount.

Calculation: Yearly Amount/12.

Spread Pmt Amt (+)

The spread payment amount.

Calculation: Surplus amount / 12

Other Pmt Amt (+)

The other payment amount.

New Pmt Amt =

The new payment amount.

Calculation: standard payment amount + escrow payment
amount + spread payment amount + other payment amount

Surplus section

Surplus /<Shortage The surplus shortage amount.

Amt> . .
Calculation: escrow account balance - opening balance

Refund Amt The refund amount.

7. Click View in the Analysis Details section.

8. On the Analysis Details sub screen, view the following information:

Field: View:

Txn Dt The transaction date.

Transaction The escrow transaction.

Vendor The vendor name.

Txn Amt The amount of the transaction.
Balance Amt (Est) The estimated amount of balance.
Balance Amt (Act) The actual amount of balance.

Information on the Analysis Details sub screen is based on expected cash flow from
contract and escrow disbursement setup. Payments received appear before escrow
disbursement in any given month.
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8.20

8.21

9. If you want to re-analyze the escrow analysis, change the escrow information on the
Contract link’s screen and sub screens.

If you want to approve the escrow analysis, complete the following information fields on
the Approval section:

Field: View:

Approval section

Approval Dt The approval date.

Approved By | The person who approved the Line of credit.

10. Click Save on the Funding screen.
Tool Tab

The Tools tab calculates the payment amount, term, interest rate, Line of credit amount,
amortization schedule and allows for the printing of a report.

For detailed information on using the tools, refer “Tools” chapter in the document.

Review Request

The Review Request tab facilitates to flag an Application for the attention of another Oracle
Financial Services Lending and Leasing user and ask for review / feedback. It allows the
system users to send and receive requests (including e-mail) commenting on a specific
account or application. The Review Request tab supports iterative review of selected
Application and also to process the review with multiple reviewers.

For detailed information on using this feature, refer to ‘Review Request’ section in
Underwriting chapter of the document.
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9.1

9. Tools

Depending on the type of product you are working with during origination, the Tools screens
enable you to calculate Vehicle value details.

Tools in the main menu are standalone and information calculated using them can only be
viewed. They cannot be copied to the application / contract.

Whereas, Tools that appear as a sub-tab in Underwriting and Funding Tabs, allows you to

import the contract values, do necessary calculations and copy the calculated values to the
respective Contract / Decision tabs.

Vehicle Evaluator

The Vehicle Evaluator screen allows you to calculate the value of a vehicle. You can use the
Vehicle Evaluator screen to calculate the value of either a vehicle you are entering as the new
collateral or vehicle currently listed as the application’s collateral.

The Vehicle Evaluator screen can be cleared or refreshed at any time by clicking Clear.

To calculate a vehicle value

1. On the Oracle Financial Services Lending and Leasing home screen, click Tools > Tools
> Vehicle Evaluator

oORACLE
Financial Services Lending and Leasing

oard

Valuation

> setup < >

2. In the Vehicle Evaluator section, use Asset field to select the vehicle you want to
appraise. This can be either NEW COLLATERAL or a vehicle entered on the Collateral
link.

3. Inthe Vehicle Evaluator section, click Initialize. The system completes Valuation
Source, Period and Region fields.

4. |If needed, you can change the default contents of the fields in Vehicle Evaluator.

If you selected a vehicle from the Collateral link in step 3, information from the Vehicle
section appears in Vehicle section in Vehicle Evaluator screen.

6. If you selected NEW COLLATERAL in step 3, complete the Identification #
-Or-
Complete the fields in the Vehicle section.

7. In the Vehicle Evaluator section, click Evaluate.

9-1 ORACLE



— If you have specified the vehicle identification number, system searches for the
value of that vehicle with that identification number, then completes Vehicle
Evaluator screen with information about that exact match.

— If you completed the Vehicle section, system searches for the value of a vehicle
matching that description.

— In either case, the system displays following information about the vehicle:

— In the Vehicle section, view the returned information:

Field: View this:

Year The asset year.

Make The asset make.

Model The asset model.

Body The asset body style.

Usage The asset usage or current mileage.
Weight The asset weight.

In the Valuation (Total Value) block, view the returned information:

Field: View this:

MSRP Manufacturer’s suggested retail price value of the asset.
Total Total value of the asset.

Usage Adjusted usage value of the asset.

In the Base and Attribute Value section, view the returned information:

Field: View this:

Base Retail Total retail value of the asset.

Base Loan Base loan value of the asset.

Base Trade Base trade value of the asset.

Retail Retail value of the asset attributes.
Loan Loan value of the asset attributes.
Trade Base trade value of the asset attributes.

Attributes Tab

In the Attributes section, view the following information:

Field: View this:
Attribute Asset attribute.
Retail Attribute retail value.

ORACLE



Field: View this:

Loan Attribute loan value.

Trade Attribute trade value.

Standard Standard indicator. If selected, indicates that the attribute is a standard.
Package If selected, indicates that the attribute is inclusive.

Incl

Selected If selected, indicates that the attribute is selected.

If you want to re-calculate the values using other data in Total Value and Base and Attribute
Value section, do the following:

e Make the required changes to the desired parameters fields in Vehicle Evaluator and
Vehicle sections.

e In the Vehicle Evaluator section, click Recalculate.
The system updates the values in Total Value and Base and Attribute Value sections.

If you choose, use Attributes section to select or clear the Selected box for attributes of the
vehicle. This automatically updates the values in Total Value and Base and Attribute Value
sections. (Note: Attribute amounts within brackets reduce the amount in Totals field in the
Total Value section.)

To copy the calculated value to the Collateral link

You can copy the calculated value to Collateral link only if you have accessed the tools tab
either from Underwriting or Funding Tab. Accessing Tools from the main menu does not
support this option.

1. Complete the following steps in the section To calculate a vehicle value.

2. In the Vehicle Evaluator screen, click Copy to Asset.

The system uses calculations on the Vehicle Evaluator screen to complete Valuation sub
screen on Collateral link. Any pre-existing collateral is no longer the primary collateral.
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10.1

10.2

10. Application Retrieval

Introduction

The Oracle Financial Services Lending and Leasing system includes archiving and retrieving
feature that provides you with the capability to archive old data and store it in a different table.

Archiving / Purging

The system batch process runs the purge / archive feature based on the system parameter
setup. The system archives the following items:

e Applications and related data
e General ledger data

e Securitization related data

e Producers

e Producer transactions

e Account statements

e Vendor assignments

e Vendor invoices.

The system purges the following items:

e Job request data
e Userlogins
e Output data dump related data.

In the system, archiving is a two-way process:

1. All the archived data is moved and stored in O tables.

2. The archived data in the O tables is then moved and stored into OO tables.

You may set the “default days” for the archive feature by setting the following system

parameters on the Administration screen. The parameters marked with _O are the items
moved from O to OO tables. The other parameters are the items moved to O tables.

Parameter Default Description
Days

PAP_ARCHIVE_DAYS 999 PURGE DAYS FOR APPLICATIONS
LEVEL 1: PUR_APP_STATUS_CD IS USED
TO DECIDE APPLICATIONS WITH WHAT
STATUS ARE PURGED

PAP_OARCHIVE_DAYS 999 PURGE DAYS FOR APPLICATIONS
LEVEL 2

PGL_ARCHIVE_DAYS 999 PURGE DAYS FOR GL LEVEL 1: NO OF
DAYS AFTER THE GL TXN WAS CRE-
ATED

PGL_OARCHIVE DAYS 999 PURGE DAYS FOR GL LEVEL 2
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Default

Parameter Description
Days

PJR_ PURGE DAYS 999 PURGE DAYS FOR JOB REQUEST LEVEL
1: NO OF DAYS AFTER JOB REQUEST
COMPLETION DATE

POD_PURGE DAYS 999 PURGE DAYS FOR OUTPUT DATA DUMP
LEVEL 1: NO OF DAYS AFTER PROCESS
RUN DATE

PPR_ARCHIVE DAYS 999 PURGE DAYS FOR PRODUCERS LEVEL

1: NO OF DAYS AFTER THE PRODUCER
STATUS IS SET TO ACTIVE AND THERE
EXISTS NO “NOT PURGED” ACCOUNT

WITH THIS PRODUCER NAME.

PPR_OARCHIVE DAYS 999 PURGE DAYS FOR PRODUCERS LEVEL
2:

PPX_ARCHIVE DAYS 999 PURGE DAYS FOR PRODUCER TXNS
LEVEL 1: NO OF DAYS AFTER THE PRO-
DUCER TXN WAS CREATED

PPX OARCHIVE DAYS 999 PURGE DAYS FOR PRODUCER TXNS
LEVEL 2:

PUL PURGE DAYS 999 PURGE DAYS FOR USER LOGINS LEVEL
1: NO OF DAYS AFTER THE LOGIN END
DATE

PVA_ARCHIVE _DAYS 999 PURGE DAYS FOR VENDOR ASSIGN-

MENTS LEVEL 1: NO OF DAYS AFTER
THE ASSIGNMENT DATE AND ASSIGN-
MENT CODE IN COMPLETED, VOID,

CLOSE

PVA_OARCHIVE DAYS 999 PURGE DAYS FOR VENDOR ASSIGN-
MENTS LEVEL 2:

PVI_ARCHIVE DAYS 999 PURGE DAYS FOR VENDOR INVOICE

LEVEL 1: NO OF DAYS AFTER THE
ASSIGNMENT DATE AND ASSIGNMENT
CODE IN VOID, CLOSE

PVI_OARCHIVE DAYS 999 PURGE DAYS FOR VENDOR INVOICE
LEVEL 2:

10.3 Retrieving an Archived Application

You can retrieve archived applications using the Application Retrieve screen. You can retrieve
only archived applications.

To retrieve an archived application

1. On the Oracle Financial Services Lending and Leasing Application home screen, click
the Origination master tab.

2. Click Application Retrieval link.

10-2 ORACLE



The system opens Application retrieval Search screen.
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View v Formatv [ fiDetach Wirap
Branch App £ Date

Company
Mo data to display.

]

1) Retrieve

Comparison Operator

LIKE

GREATER THAN OR EQUAL

LIKE
LIKE
LIKE
LIKE
LKE

EQUAL

LIKE

EQUAL

LIKE
LIKE
LIKE
LIKE
LIKE

Product

HHPHHOEHOERER DD E]

[ Close:
& Reset Criteria | §) Search
Value
£)
b=l
[

Status Sub Status Producer

5. Select the application you want to work with and click Retrieve.
The system loads the application in the Applications screen.

You are now ready to begin work on the application.

10-3

Use the Comparison Operator and Values fields to create the search criteria you want

3.
to use to find an application.
For more information about creating search criteria, see Searching for an Application
chapter of this User Guide.
4. Click Search.
The system locates and displays all the applications that meet your search criteria on
the Results screen.
Applications are sorted by priority and application number.
Field: View this:
Company The company of the application.
Branch The branch of the application.
App# The application number.
Date The date of the application.
Title The title (applicant name) of the application.
Product The product of the application.
Status The status of the application.
Sub Status The sub status of the application.
Producer The producer of the application.
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11.1

11.2

11. Application Documents

Introduction

The Documents Maintenance screen allow for paperless storage of documents within Oracle
Financial Services Lending and Leasing system. Initially with the applications during the Line
of credit origination cycle and later with accounts during customer service.

This chapter explains how to use the Application Document screen to:
e View an image
e Search for an image
e Split an image to more than one screen
e Change the status of an image
e Combine two images into a multiple screen image
e Attach an image to an existing application
e Print an image
e Attach documents to applications and then view these documents in a browser.

It also explains how to use the Account Document Tracking screen to attach documents to
accounts and then view these documents in a browser.

Application Document screen

The Application Document screen consists of “Document Maintenance” and “Document
Details” sections.

Credit applications are often sent or faxed to financial institutions from producers (or ‘dealers’)
on behalf of the customer. These credit applications, if received as fax, can be stored in the
system as images. Frequently, more than one application is received in a single fax or a single
application is received across multiple faxes. In such cases, the Application Document
Tracking screen can help you organize and maintain your image collection.

The Application Document screen’s Document Maintenance screen allows you to upload
documents to an application in the form of GIF files, PDF files, DOC files, XLS files, and TXT
files. The Document Maintenance screen’s Document Details section allows you to view
these documents.

Application Document screen

Oracle Financial Services Lending and Leasing supports the online attachment of document
images to an application using the Application Documents screen’s Document Maintenance
section. You can attach the documents from either a client machine or server. A defaultimage
directory can be maintained in the system using the system parameter:

UIX DEFAULT IMAGE PATH.

When you choose List File in the Select Document sub section in the Document
Maintenance section, the system displays all available files in the selected directory in the
Document Details section. You can use the Document Maintenance sub-section and
Action sub-section to attach selected documents to a particular account.
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11.2.1 Attaching a Document to an Application from a server

To attach a document to an Application from a server

1. On the Oracle Financial Services Lending and Leasing Application home screen, click
the Origination > Origination > Application Documents link.

ORACLE & Wekome, VEROUTHU » [=)
Financial Services Lending and Leasing

a

i % Close
DashBoard Application Documents D
Origination o
Document Maintenance
Qrigination
Sales Lead Action
Simple Applcation Entry
Appleation Entry None () Copy Document(”) Move Document () Attach Document (Server) (@) Attach Document (Clent)
Underwritng
Funding Select Document
Applcation Retrieval
Scenario Analysis Fietoupoad | Browse. | No & Upl
Applcation Documents
Image Maintenance
Reports Document Details
Producers b [ saveand stay | [ Saveand Retum <@ Retumn
Vendors -
View= Fomat~ [ Freeze £ Detach Wrap W
Fie Name Document Type Document Sub Type Applcation # Aftach Status Tracking # Docket # Location Received
No data to display.
‘ m )
Servicing
Collections
WFP
Tools
Setup

2. In the Action sub-section, click Attach Document (Server).

3. Inthe Select Document sub-section, use the default image directory in the Directory
Path field. (The default path is the value for the system parameter
UIX_DEFAULT IMAGE_PATH). -or-

4. In the Directory Path field, specify the full path name to the document on the server that
you want to attach to an account.

You can click Reset Path at any time to return to the default image directory.

5. In the Select Document section, click List File.
The system displays the files from the entry in the Select Document section Directory
Path in the Document Maintenance record.

6. Inthe Document Details record, select the record you want to work with and click Edit
in the Details column.

7. In the Document Details record, specify, view or edit the following information:

Field: Do this:

File Name View the file name for the document.

Document Type | Select the type for the document.

Document Sub Select the sub type for the document.

Type

Application # Select the application number to attach/copy/move the docu-
ment image.

Attach Attach the document.

Status View the status of the document.
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11.2.2

Field:

Do this:

Tracking # Specify the tracking number of the document.
Docket # Specify the docket number of the document.
Location Specify the location of the document.
Received Dt View the document image received date.

Effective Dt

Specify the effective date of the document.

Expiry Dt

Specify the expiration date of the document.

Comment

Specify any comments regarding the document.

8. Select the Attach check box to attach the file to the account.
9. Click Save And Return.

10. In the Action sub-section, click Post.
The system attaches the document to the application.

You can view the document in a browser by clicking View Document in the Document
Details section.

Attaching a Document to an Application from a Client Machine

To attach a document to an application from a client machine

1.

7.
8.
9.

On the Oracle Financial Services Lending and Leasing Application home screen, click

the Origination master tab.

Click the Application Documents link.

In the Action sub-section, click Attach Document (Client).

In the Select Document section, click Browse in File to upload field.

The system opens a Choose File to Upload dialog box.

In the Choose File to Upload dialog box, locate the document you want to attach to the

account. You can select multiple files by holding the Ctrl or Shift key on your keyboard.

When you have located the document you want to attach to the account in the Open

dialog box’s File name: field, click Open.

The selected files appear in the Select Document sub-section’s File to Upload field.
In the Select Document sub-section, click Upload.

In the Document Details record, select the file uploaded from your server and click Edit.

10. In the Document Details section, enter, view or edit the following information:

Field:

Do this:

File Name

View the file name for the document.

Document Type

Select the type for the document.

Document Sub Type | Select the sub type for the document.

Application #

Select the application number to attach/copy/move the docu-
ment image.
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11.2.4

Field: Do this:

Status View the status of the document.

Comment Specify any comments regarding the document.
Tracking # Specify the tracking number of the document.
Docket # Specify the docket number of the document.
Location Specify the location of the document.

Received Dt Specify the received date of the document.
Effective Dt Specify the effective date of the document.
Expiry Dt Specify the expiration date of the document.
Comments Specify any comments regarding the document.

11. Select the Attach check box to attach the file to the account.
12. Click Save And Return.

13. In the Action sub-section, click Post.
The system attaches the document to the application.

You can view the document in a browser by choosing View Document in the Action section.

Copying a Document

The Action section’s Copy Document command copies the document image from one
application to another application. This command has no impact on the source application or
the source application’s document image.

To copy a document to an application from another application

1. On the Oracle Financial Services Lending and Leasing Application home screen, click
the origination master tab.

2. Click the Application Documents link.
In the Action sub-section, click Copy Document.

4. In the Document Maintenance sub-section, use the Application # field to specify the
application with the image you want to copy.

5. In the Document Maintenance sub-section, click Search. The system displays the files
attached to that application in the Document Details section.

6. Inthe Document Details section, select the document you want to copy and click Edit.

7. Inthe Copy/Move App # field, specify the application number of the application to which
you want to copy the document.

8. Click Save And Return.

9. In the Action sub-section, click Post.

Moving a Document

The Action section’s Move Document command moves an existing document image from one
application to another application. This command detaches the document image from the
source application and attach to second application.
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11.2.5

To move a document to an application from another application

1.

8.
9.

On the Oracle Financial Services Lending and Leasing Application home screen, click

the Origination master tab.

Click the Application Documents link.

In the Action sub-section, click Move Document.

In the Document Maintenance sub-section, use the Application # field to specify the

application with the image you want to move.

In the Document Maintenance sub-section, click Search.

The system displays the files attached to that application in the Document Details

sections.

In the Document Details section, select the document you want to move and click Edit.

In the Copy/Move App # field, specify the application number of the application to which

you want to move the document.

Click Save And Return.

In the Action sub-section, click Post.

You can view the documents attached to a particular account by loading the application on
the Customer Service screen, then clicking the Customer Service tab and then clicking on the
Document Tracking sub tab.

Viewing a Document Attached to an Application

To view a document attached to an application

1.
2.

Using above method, load the application with the document you want to view.

In the Application Document section, click Edit.

3. View/edit the following display only information:

Field:

Do this:

Document Type

View the document type.

Comment

Specify any comments regarding the image.

4.

5.

information:

In the Application Document Details section, select the record you want to work with
and click Edit.

In the Application Document Details section, view the following display only

Field:

View this:

Document Sub
Type

The document sub type.

Version The version number. (version numbers will be incremental by batch
job, first version will start with 1.0).
Page # The page number.

Document File
Type

The document file type.

Status

The status.
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Field: View this:

Tracking # The tracking number of the image.
Docket # The docket number of the image.
Location The location of the of the image.
Received Dt The effective date of the image.
Effective Dt The effective date of the image.
Expiry Dt The expiration date of the image.
Comment Any comments regarding the image.

6. Use the Application Document and Application Document Details sections to select
the document you want to view.

— In multiple paged documents, choose 1 in Page # field on Application Document
Details section to view all the pages in the document.

_Or_
— Choose a specific page number to view only that page.

7. Click View Document.
The system opens a browser to display the actual document (which browser appears
depends on what type of document you selected and what browsers are set up to work in
conjunction with your Oracle Financial Services Lending and Leasing system).

8. You can add comments to the Comments field in the Application Document and
Application Document Details sections.

9. Click Save And Return.

11.3 Document Tracking section

You can view the documents attached to a particular application by loading the application on
the Underwriting/Funding screen and then clicking on Document tab.

11.3.1 Locating an Application Document

To locate an account document

1. On the Oracle Financial Services Lending and Leasing Application home screen, click
the Origination master tab.

2. Click the Underwriting/Funding link.
Select and open the application you want to work with.

4. Click Document sub tab.
The Account Document screen appears.

Information about the documents attached to the Application appears in the
Application Documents and Application Document Details sections.

11.3.2 Viewing a Document Attached to an Application

To view a document attached to an account
1. Using the above method, load the account with the document you want to view.

2. In the Application Document section, click Edit.
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3. View/edit the following display only information:

Field:

Do this:

Document Type

View the document type.

Comment

Specify any comments regarding the image.

4. Inthe Application Document Details section, select the record you want to work with

and click Edit.
5. Inthe Application Document Details section, view the following display only

information:

Field: View this:

Document Sub Type The document sub type.

Version The version number (version numbers will be incremental by

batch job, first version will start with 1.0).
Page # The page number.

Document File Type

The document file type.

Status The status.

Tracking # The tracking number of the image.
Docket # The docket number of the image.
Location The location of the of the image.
Received Dt The effective date of the image.
Effective Dt The effective date of the image.
Expiry Dt The expiration date of the image.
Comment Any comments regarding the image.

6. Use the Application Document and Application Document Details section to select

the document you want to view.

— In multiple paged documents, choose 1 in Page # field on Application Document

Details section to view all the pages in the document.

-0r-

— Choose a specific page number to view only that page.

7. Choose View Document.

The system opens a browser to display the actual document (which browser appears
depends on what type of document you selected and what browsers are set up to work
in conjunction with your system).

8. You can add comments to the Comments field in the Application Document and
Application Document Details sections.

9. Click Save And Return.
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12. Image Maintenance

You can view any image in the Oracle Financial Services Lending and Leasing system in the
upper list box of the Image Maintenance link.

To view an image

1. On the Oracle Financial Services Lending and Leasing home screen, click Origination
> Origination > Image Maintenance.

ORACLE’

Financial Services Lending and Leasing

PRT— o

DashBoard

Origination

Simple: Applicatiof
Application Entry
Underwriting
Funding
Application Retrie
Scenario Analysis
Application Docur
Image Maintenan)
Reports
Producers
Vendors

< >
> Servicing

> Collections
> WFP

> Tools

> Setup

Image Maintenance x

Image Maintenance

Image Header
View » Fomat~ [ Frezze  Hfi Detach
Image Id Fax Header
No data to display.

Pages

View = Format~  [5 Freeze & Detach
No data to display.
Image
LD
=
Application
View v Fomatw | [ Fresze i Detach
App# Title:

No data to display.
Action

@® None
) Split Image.
D) Change Status
O attach to an Image
© astach to an Application

B View All Images []

Status

Company

i Cose

Branch Pages

Select Page(s)

[E] review

2. The Image Header section displays the images in the Oracle Financial Services Lending
and Leasing system.

3. Inthe Image Header section, select the image you want to work with.

The Image Header section displays the following information for each image:

Branch Branch

Select If selected, indicates that this is the current record.
Image Id The image identification number.

Fax Header | The fax header.

Status The image status.

Pages The total number of pages of the image.

Company The company the image came from.

Branch The branch the image came from.

4. If an image is more than one page long, select the page you want to view in the Pages

section and click on the page number to preview the image.

5. Select the required transpose type to change the appearance of the image.
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Splitting an Image

If an image is more than one page long, you can split it into two separate images using the

Split Image button in the Action section. This option button is only available when an image
contains more than one page. Also, you cannot splitimages with a status of “PROCESSED” or
“SKIP.”

To split an image

1. On the Image Maintenance section Image Header section, select the multiple page
image you want to split.
2. In the Action section, select Split Image.
The Pages and New Image Id fields appear in the Action block.
3. Inthe Pages block, select the page where you want to split the image.
The selected pages appear in the Pages field on the Action section.
You can select more than one page; however, you cannot select page # 1.
4. In the Action section, click Post.

Oracle Financial Services Lending and Leasing removes the selected pages and
completes the New Image Id field with the image id of the new image.

The new image does not appear in the Image Header section after you click Post.
However, if you refresh the Image Maintenance screen by closing and opening the
screen, the new image id appears in the Image Header section and the change of page
length in the original image is displayed.

Changing the Status of an Image

The Action section on the Image Maintenance screen allows you to change the status of the

image.

The Image Maintenance screen uses the following statuses:

Status: What is does:

RUSH Moves the image to the front of the queue of images to be pro-
cessed.

NEW Places an image in a queue in the order of which it was received
and allows you to process it as an application.

SKIP Makes the image unavailable for processing until the status is
changed.

BAD Notes that the image is illegible and should be deleted.

PROCESSED | Notes that the information on the image has been entered and is
attached to an application or account.

Only images with a status of Rush or New can be attached to an application or account.

To change the status of an image

1. On the Image Maintenance screen’s Image Header section, select the image whose

status you want to change.

2. Inthe Action section, select Change Status.The Status field appears.

3. In the Status field, select the new status for the image.
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4. In the Action section, click Post.
Oracle Financial Services Lending and Leasing changes the status of the image.

Attaching an Image to an Existing Image

You can combine two images to make one image. This is the reverse of splitting an image.

To combine images

1. On the Image Maintenance screen’s Image Header section, select the image to which
you want to attach an existing image.

2. In the Action section, select Attach to an Image.
The Image Id field appears.

3. Inthe Image Id field, select the image id of the image to which you want to attach the
selected image.

4. In the Action section, click Post.

Oracle Financial Services Lending and Leasing joins the two images: the Id of the image
you selected in step 3 remains on the Image Header section. The image you selected
in step 1 now appear as part of the remaining image.

Attaching an Image to an Existing Credit Application

You can attach one or more images to an existing credit application. To attach specific pages
from a multiple page image to an application or account you have to split the image to isolate
the pages you want to attach. You can then attach those pages and, if necessary, link pages
of the original image back together.

To attach an image to an existing application image

1. On the Image Maintenance screen’s Image Header section, select the image you want
to attach to an existing application.

2. Inthe Action section, select Attach to an Application. The App# field appears.

3. Inthe App # field, select the application number of the application to which you want to
attach the image.

4. In the Action section, click Post.

Oracle Financial Services Lending and Leasing attaches the image to the application.
You can view the image in the Image (8) master tab on the Underwriting and Funding
forms.

Printing an Image

The Print Image button sends the selected image to a predefined printer.
To print an image

1. On the Image Maintenance screen’s Image Header section, select the image you want
to print.

2. In the Action section, click Print Image.
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13. Oracle Financial Services Lending and Leasing
Reports

During the day, or at the end of day, you may want to retrieve information on any of the several
operations that were performed during the day in your financial institution. You can generate
this information in the form of reports in Oracle Financial Services Lending and Leasing. You
can specify the values in the Report Parameters section and generate a report using that
information.

Navigation to Reports
On the Oracle Financial Services Lending and Leasing home page, click Origination >
Origination > Reports.

ORACLE’ : T [=]
Financial Services Lending and Leasing

DashBoard Revatax
Origination
Reports
View~ Formate | Freeze i Detach weo | @

Module
ORIGINATION
ORIGINATION

Description
ACCOUNT PAYABLE(ORIGINATION)
COLLATERAL TRACKING LOG
FUNDED CONTRACTS LEASE
FUNDED CONTRACTS LINE

ORIGINATION
GRIGINATION
ORIGINATION
ORIGINATION
ORIGINATION
ORIGINATION
ORIGINATION v
ORIGINATION

Report Parameters
View ~ Format- [ Freeze  f: Detach J Wrap B %5 Run Report
Description value
FROM MM/DO/YYYY o)
TO MM/DD/YYYY N
REPORT FORMAT POF [~]

B

»> Servicing
> Collections
> WFP

> Tools

> Setup

13.1 Number of Credit Applications Entered by User

This application entry report lists the amount of credit applications entered by user.

Parameters:
e Company/Branch

e User Name

e From MM/DD/YYYY
e To MM/DD/YYYY

e Report Format
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Example of the Number of Credit Applications Entered by User report

Report: Number of Credit Applications Entered

Date: 10/14/2013 10:16 AM

NLO2
NLR1

ORACLE"

Financial Services Lending and Leasing

Entered By

Date Entered

# of Applications

ARNATH 07/09/2013 2

Total: 2

Branch Total: 2

Company Total: 2
uUso01
USHQ

Entered By Date Entered # of Applications

ARNATH 05/16/2013 1

ARNATH 06/25/2013 2

ARNATH 06/26/2013 1

ARNATH 07/03/2013 2

Total: 6

Branch Total: 6

Company Total: 3

Grand Total: 8

13.2 Collateral Tracking Log

This servicing report lists collateral tracking details.

Parameters:

e Company/Branch
e Tracking Type
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13.3

13.4

Example of the Collateral Tracking Log report

eral Tracking Log oRACLE"
& 1:17 AM Financial Services Lending and Leasing
NLD2
NLHQ
Type Asset state Focount § Follow Op Start DE Disposition
cmments Date

SEARROW JACK / MARYY M 20120200010081

12/12/20185

2/12/2015 NOT DEFINED

3

SEARROW JACK / MARYY i 201202000100%1

1z/12/z2005

2/12/2016  NOT DEFINED

1
SPARROW JACK / MARYY M 20120200010091  12/12/2015 12/12/2015  WOT DEFINED
1
3
CTustomer State Zccount # Follow Up Start DL Disposition
Date
¢« SMITH JOHN an 20150600011323  12/12/2015 12/13/2015 NOT DEFINED
3
BHANDARI ARBAN PR 20151200012977 01/06/2016 01/06/2016 NWOT DEFINED
SIGG MARK MR 20150900014267 01/30/2016 01/30/2016 NOT DEFINED
RODRIGUEZ MILDRED M 20150900014275 01/30/2016 01/30/2016 NOT DEFINED
RODRIGUEZ ROBINSON Ma 20150900014283  01/30/2016 01/30/2016  ROT DEFINED
RODRICUEZ ROBINSON M 20150900014283  01/30/2016 01/30/2016 WOT DEF:
£ sam R 20160200014338  02/02/2016 02/02/2016 NOT DEF:
®F EF ca 20160200014346 02/02/2016 02/02/2016 NOT DEFINED
§  SMITH JOHN an 20150600011323  12/12/2015 12/12/2015 NWOT DEFPINED
T
= 71

Con 21

24

Credit Bureau Report

This report lists the credit bureau details.
Parameters:

e Credit Request ID
e Credit Request Detail
e Report Format

Example for Credit Bureau report

Report: Credit Bureau Report ORACLE’
Financial Services Lending and Leasing

Date: 9/13/2013 16:37 PM

Account Payable (Origination)

This report lists the payable accounts.
Parameters:

e From MM/DD/YYYY
e To MM/DD/YYYY
e Report Format

13-3

ORACLE



Example for Origination Account payable report

(Onigination) ORACLE

Financial Services Lending and Leasing

13.5 Number of Credit Application Images by Status

This report lists the number of credit application images by status.

Parameters:

e Company/Branch
e From MM/DD/YYYY
e To MM/DD/YYYY
e Report Format
Report: Number of Credit Applications Images By Status

Month/Year From: 01/01/1800 To: 01/01/2048
Date: 10/15/2013 12:04 PM

ORACLE’

Financial Services Lending and Leasing

usol

USHQ
Image Status Date Entered # of Applications
BAD 07/23/2013 i1
BAD 07/28/2013 i
BAD 08/23/2013 1
BAD 08/26/2013 1
NEW 07/23/2013 4
NEW 07/26/2013 1
NEW 08/19/2013 1
NEW 08/26/2013 3
NEW 09/24/2013 2
PROCESSED 09/24/2013 E
RUSH 08/26/2013 1
RUSH 09/24/2013 9
Total: 26
Branch Total: 26
CompanyTotal : 26
Grand Total: 26
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13.6 Dealer Reserve Report

This report lists the reserve amount balance of producers.
Parameters:

e Company/Branch

e Producer

e From MM/DD/YYYY
e To MM/DD/YYYY

e Report Format

Report : Dealer Reserve Report ORACLE" ) )
Date: 2/29/2016 11:27 AM Financial Services Lending and Leasing
uso1l
USHQ
Producer # Producer Name Incr Due To New Loans Adj Due Payoff/ Chgoff adj Due To Cr Adj Due To Dr Reserve Amt
CA-00004 VOLKSWAGEN OF 0.00 0.00 0.00 0.00 0.00
WOODLAND HIL
CR-00005 RUTO JUNGLE 0.00 0.00 0.00 0.00 991.00
GA-00002 ADVANCE 0.00 0.00 0.00 0.00 0.00
LEASING
(MARIETA)
Branch Total: 0.00 0.00 0.00 0.00 991.00
Company Total: 0.00 0.00 0.00 0.00 991.00
Grand Total: 0.00 0.00 0.00 0.00 991.00

13.7 Batch Job Report

This report lists the batch jobs scheduled and status of execution for the selected period.
Parameters:

e From MM/DD/YYYY
e To MM/DD/YYYY
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13.8

13.9

Report Format

Report : Batch Job Report
Date: 2/22/2016 11:53 AM
Job Bet Job Code

SET-AAL ARTDRC_BJ_100_01
SET-AAT TXNACT BJ_100_01
SET-ACR TABACC BJ_100_01
SET-ACR TXNACE_BJ_100_01
SET-ACR TENACR_BJ_100_02
SET-ACR TXNACRE_BJ_100_03
SET-ACR TXNACRE_BJ_100_04
SET-ADT ADTPRC_EJ_100_01
SET-ACE ACAAPP_EJ_100_01
SET-AGE ACCCON_EJ_100_01
SET-AGS AGSSAL BJ_100_01

Job Description
APPLICATION TO
ACCOUNT INTERFACE

ACCOUNT ACTIVATICOH

ILY TRIAL BALANCE
GENERATION

INTEREST ACCRUAL
AND DELINQUENCY
PROCESEING

PREPARE BATCH DATA
FOR INTEREST
ACCRUAL END
DELINQUENCY
PROCESSING

P INTEREST
ACCRUAL PROCESSING

RE-START INTEREST
ACCRUAL

ATE ROWID IN
IT TABLE (RUN
JOB AFTER
EXPORT-IMPORT OF
TRABLES)
APPLICATION AGING
PROCESS

CONTRACT RCING
PROCESS

SRLE LEAD AGING

Start Date
02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

End Date
02/25/2016

02/25/2016

02/25/2016

02/25/2016

0Z/25/2016

0z/25/2016

0z/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

ORACLE’
Financial Services Lending and Leasing

Btatus
COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

User Report and Access by Responsibility

Result

This report lists the users with their name, code, responsibility and active status for the
selected period.

Parameters:

Report Format

Report : User REporthUSER REPORT & ACCESS BY RESPONSIBILITY)

Date: 2/29/2016 11:52 AM

ORACLE'

Financial Services Lending and Leasing

Taer Code TUser Rame Responsibility Active Stact Date End Date
(¥/N}

AJITHA M YES /11/1800 12/31/4000

BATCH EATCH USER YES /11715982 12/31/9959

DEMOCOLL DEMO COLLECTOR COLLECTOR YES /11/1992 12/31/9559

DEMOEUNDER DEMO FUNDER FUNDING SPECIALIST YES /11/1g992 12/31/9559

DEMOSALES DEMOD ALES LEADER YES /1171592 12/31/9559

DEMOSUER DEMO YES /11/15892 12/31/95539

DEMOUNDW DEMO UNDERWRITER T YES 11/1992 12/31/9559

EVENT EATCH USER ONDEF INED YES /11/1592 12/31/9559%

INTERNAL INTERNAL INTERNAL SUPERUSER YES /11/1800 11/11/4000

TAYANTA JAYANTA C SUPERUSER wES /1171800 12/31/4000

NAVEEN REDDY ERUSER vES /11/1800 12/31/4000

SUPERUSER vES /11/1800 12/31/4000

SUPERUSER YES 02/18/2018 12/31/4000

SUPERD. YES 02/18/2016 12/31/4000

TRITAM JENA SUPERUSER YES 11/11/1800 12/13/4000

SHASHANK S YES /11/1800 12/31/4000

vES /11/1800 12/31/4000

YES /12/1B00 12/31/4000

Transactional Access by Responsibility

This report lists the transactional access to users with their Transaction Code, Transaction
Description and access permission.

Parameters:

User Responsibility
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e Report Format

Report : Transactional Access by Responsibility ORACLE’
Date: 3/9/2016 11:54 AM Financial Services Lending and Leasing
}Lesponsibiliiy Code \ Responsibility Description |
COLLECTOR | COLLECTOR |
Transaction Code Transaction Description Allowed

ACCOUNT CLOSE ACCOUNT CLOSE Y

ACCOUNT CLOSE REV REVERSE ACCOUNT CLOSE Y

ACCRUAL START START ACCRUAL Y

ACCRUAL_STOP STOP ACCRUAL Y

ACCRUAL_STOP_REV REVERSE STOP ACCRUAL Y

ACC_ACH_FEE_MAINT ACH FEE MAINTENANCE Y

ACC_ACH_MAINT ACH MAINTENANCE Y

ACC_ACH NEW NEW ACH MAINTENANCE Y

ACC_CASA_PHP_BATCH ONE TIME INCOMING CASA BATCH Y

PAYMENT
ACC_CASA_PHP_REAL ONE TIME INCOMING CASA REAL TIME Y
PAYMENT
ACC_CHANGE_PMT_DEFAULT_SPREA | CHANGE DEFAULT PAYMENT SPREAD Y
D
ACC_COMP_ADJ_MINUS ADJUSTMENT TO COMPENSATION Y
AMOUNT - SUBTRACT

ACC_COMP_ADJ_PLUS ADJUSTMENT TO COMPENSATION Y
AMOUNT - ADD

ACC_CPN_MAINT COUPON BOOK MAINTENANCE Y

ACC_CRB_PMT_RATING_MAINT MAINTAIN CREDIT BUREAU PAYMENT Y

RATING

ACC_ESC_MAINT WARRANTY MAINTENANCE Y

ACC_ESC_PMT_MAINT WARRANTY PAYMENT MAINTENANCE Y

ACC_INS_MAINT INSURANCE MAINTENANCE Y

ACC INS PMT MAINT INSURANCE PAYMENT MAINTENANCE Y

ACC_OFF_1098_REQ_NOT_IND SWITCH 1098 NOT REQUIRED Y
INDICATOR OFF

ACC_ON_1098_REQ_NOT_IND SWITCH 1098 NOT REQUIRED Y
INDICATOR ON

ACC_PDC_CHK VOID VOID OPEN PDC CHECKS Y

13.10 Front End Access by Responsibility

This report lists the front end screen access permissions depending on the user responsibility.
Parameters:

e User Responsibility
e Report Format

Report : Front End Access by Responsibility ORACLE

Date: 3/9/2016 13:02 PM Financial Services Lending and Leasing
[ Responsibility Code [ Responsibility Description |
| coLLECTOR | COLLECTOR |

[Entity: | COLLECTIONS |

Menu / Screen Menu / Screen / Tab / Sub Tab Item
CUSTOMER SERVICE BANKRUPTCY MENU

CUSTOMER SERVICE COLLECTIONS MENU
CUSTOMER SERVICE DEFICIENCY MENU

CUSTOMER SERVICE RESPOSSESSICN MENU

Entity: | COMMON

Menu / Screen Menu / Screen / Tab / Sub Tab Item
REVIEW REQUEST REVIEWREQUEST ADD BUTTON
REVIEW REQUEST REVIEWREQUEST AUDIT BUTTON
REVIEW REQUEST REVIEWREQUEST EDIT BUTTON
REVIEW REQUEST REVIEWREQUEST VIEW BUTTON
CALCULATOR AMORTIZATIONSCH TAB
CALCULATOR CALCULATORLEASE TAB
CALCULATOR CATCULATORLOAN TAB
CALCULATOR FLLSUITE LEASECALCULATOR MENU
CALCULATOR LOANCALCULATOR MENU
CALCULATOR RATESCH TAB
UNDERWRITING FLLSUITE VEHICLEEVALUATOR MENU
USER PRODUCTIVITY DASHBOARDUSERSPRODUCTIVITY MENU

USER PRODUCTT
USER _PRODUCTIVIT
USER PRODUCTIV.

USERPRODUCTIVITYAPPLICATIONENTRY TAB
USERPRODUCTIVITYCOLLECTORUSER TAB
USERPRODUCTIVITYFUNDING TAB

USER PRODUCTIVIT USERPRODUCTIVITYORGQUEUESTATUS TAB
USER PRODUCTIVITY USERPRODUCTIVITYSERCOLQUEUE TAB
USER PRODUCTIVITY USERPRODUCTIVITYUNDERWRITING TAB
PRODUCER PRODUCERCOMMENT TAB
PRODUCER PRODUCERCOMMENT VIEW BUTTON
PRODUCER PRODUCERCOMMENT EDIT BUTTON
PRODUCER PRODUCERCCMMENT AUDIT BUTTON
PRODUCER RCOMMENT ADD BUTTON
PRODUCER COMPENSATIONBALANCE TAB
PRODUCER PRODUCERCOMPENS ONDETAIL VIEW BUTTON
PRODUCER PRODUCERCO] CT AUDIT BUTTON
PRODUCER PRODUCERCONTACT TAB
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13.11 Underwriting Status by Month and Producer (Line)

This underwriting report lists application status by month and producer for lines of credit.
Parameters:

e Company/Branch

e Producer

e From MM/DD/YYYY
e To MM/DD/YYYY

e Report Format

Example of the Underwrltlng Status by Month and Producer (Ilne) report

ORACLE
Report: Un. us by month & producer (line) ervices Lending and Leasing

Date: 10#30/2013 12 50 M

0.000%

13.12 Underwriting Status By Month and Underwriter (Line)

This underwriting report lists application status by month and underwriter for lines of credit.
Parameters:

e Company/Branch

e From MM/DD/YYYY
e To MM/DD/YYYY

e Report Format

Example of the Underwriting Status By Month and Underwriter (Line) report

Rep derwriting tus by Month & Underwriter (line oOoRrRACLE"
Date: 10/15/2013 16:37 pM Financial Services Lending and Leasing
= n vso
Month Approvea Conditioned Rejected Total Funded % Tot apps Funded
2 & & 2
2013-08 SENTHIL EUMAR = 100.000% 2 2.000% 2 2.000% 2 z 2.000%
Menthly Tetal: 2 100.000% 2 100.000% 2  100.000% 2 2 100.000%
Branch Total: 2 100.000% 2 100.000% 2 100.000% 2 2 100.000%
company Total: z 100.000% 2 100.000% z  100.000% 2 2 100.000%
erand Total: 2z 100.000% 2 100.000% z  100.000% 2 2 100.000%

13.13 Underwriting Status By Month (Line)

This underwriting report lists application status by the month for lines of credit.

Parameters:
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e Company/Branch

e From MM/DD/YYYY
e To MM/DD/YYYY

e Report Format

Example of the Underwriting Status By Month (Line) report

Report: Underwriting Status by Month (line)
Month/ Year From: 01/2000 To: 01/2048
Date: 10/18/2013 9:27 AM

ORACLE"
Financial Services Lending and Leasing

Wido
Month e iSEoE Apps Approvals Conditioned Rejected Funded Volume Average Loan Average Rate
sooea 1 1 7 E] 3 8, 00000 800.00 5.000%
o 2 & 4 B 2.00 800.00 £.000%
~ 2 E) ] 1 1.00 200.00 1.000%
Branch Total 5 5 16 12 L] B,O oo 2,500.00 11.000%
Company Total H 5 18 12 9 B,0 oo 2,500.00 11.000%
13.14 Funded Contracts Line
This funding report lists applications funded for line.
Parameters:
e Company/Branch
e From MM/DD/YYYY
e To MM/DD/YYYY
e Producer
e Report Format
Example of the Funded Contracts Line report
ORACLE'
Report: Funded Contracts (Line) Financial Services Lending and Leasing
Date: 10/29/2013 16:53 PM
Month  Year From: 012000 To: 012048
a1
USH)
ALL AMOUNT 2RE IN USD
Producer Name product Collateral  Underwriter Application # contract Dt Amount Rate Term
MN-00001  PARTNER L0c NOHANA 0000001500 01/01/2013 100,000.00  12.930% 999
HER BLOCK  FRANCHISE RAJARAY
MN-00001  PARTNER Loc NOHRNA 0000001507 03/14/2013 100,000.00 52508 999
HLR BLOCK  FRANCHISE RAJARAY
Comnt: 2 Total: 200, 000.00
Branch Comnt: 2 Branch Total: 200,000.00
Company Count: 2 Company Total: 200,000.00
Total Count: 2 CGrand Total: 200, 000.00

13.15 Pre Funding Contracts Line

This funding report lists applications verified for line.
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Parameters:

e Company/Branch

e From MM/DD/YYYY
e To MM/DD/YYYY

e Producer

e Report Format

Example of the Pre Funding Contracts Line report

Report: Pre-funding Contracts (Line)
Date: 10/30/2013 14:53 PM

ORACLE

Financial Services Lending and Leasing

Month/Year From: 01/2000 To: 01/2048
Us01
USHQ
ALL AMOUNT ARE IN USD
Producer Name Product Collateral Underwriter Application# Contract Dt Amount Rate Term
CA-D0007 NARAYAN SREERAM LINE- RAMAC 2013 SREERAM NARAYAN 0000001548 08/29/2013 0.00 6.500% 18
RE WHEELS DRODUCT
Count: 1 Total 0.00
Branch Count 1 Branch Total 0.00
Company Count 1 Company Total 0.00
Total Count: 1 Grand Total 0.00
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14. Producer

Oracle Financial Services Lending and Leasing is capable to create and service direct as well
as indirect Line of credit. Indirect Line of credit are generated through Producer Entities like
Dealerships and Agents. It is essential to create and maintain such entities to enable incentive
tracking and business development achieved through each entity.

Applications are sent to financial institutions indirectly through producer entities like dealers
or agents on behalf of a customer. Specifying Producer details is mandatory while creating a
application since the system associates a credit application with the producer entity which
sent it, on the Application Entry, Underwriting, and Funding screens. When the credit
application is approved and funded, the system associates the account with the producer
entity.

When the credit application is approved and funded, system associates account with the
producer.

The following three different status are defined for Producer Entities in OFSLL:

e Active: Only if Producer Status is Active, the application sourced through that Producer
Entity can be funded.

e Inactive: If the Producer Status is Inactive, the application sourced through that
Producer Entity cannot be funded.

e Temporary: If the Producer Status is Temporary, the application sourced through that

Producer Entity can only be reviewed. However it cannot be funded.
The producers are paid for their participation, either:

e Up front during funding
-or-

e Up front on a monthly basis
-or-

e When the interest is earned
-or-

e When the payment is received from customer based on the set up compensation plans.

The Producer screen contains pages that enable you to maintain and administer producer
compensation, compensation payments, charge back plans, and chargeback parameters.

While setting up Producer entities it is also essential to setup the Producer Cycles under
'Setup' in main menu. For more details, refer to Configuring Lending and Leasing guides.
While working with the Producer screen, you will primarily use the following sub tabs:

1. Payment Details

Tracking Attributes

Contracts

Comments

o M 0D

Summary

The Producers screen completed during setup, can be used to view and maintain producer
details.
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14.1

14.1.1

The ‘Producers’ screen consists of the following tabs:

e Producer Details tab
e Search tab

Producer Details tab

The Producer details screen allows you to record or edit basic information about the producer.
You can set up dealers or producers for a company and branch. You can also set up a default
underwriter and a default collector for a producer. The system uses this information in the
origination work flow to select a queue.

The producer number, name, contact information, company and branch to which the producer

is associated with, federal tax number, status, and license information can be stored in this
screen.

Producer Details tab Extensibility

The Producer Details tab is a customizable tab in OFSLL in which you can enable new user
defined fields (UDFs), disable /rename existing fields, allow or restrict access to UDFs, non-
mandatory fields and also set the field as mandatory/non-mandatory for user input.

To facilitate such customizations, during product installation/upgrade there are additional 20
‘Custom’ user defined fields provided by default along with ‘Base’ fields with the below
combination in main Producer Details tab and its sub tabs.

e 10 free text fields - ‘User Defined Field Char’
e 5 numeric fields - ‘User Defined Field Num’
e 5 date fields - ‘User Defined Field Date’

The above user defined fields, also referred to as ‘User Defined Fields’ are to be basically
enabled in Setup > Administration > User > Access > ‘Field Access Definition’ tab and access
is to be provided in ‘Security User Access Definition Details’ sub tab for the field(s) to appear
in Producer Details tab. The enabled fields can customized in the ‘Label Configuration’ tab
available in Setup > Administration > System > Label Configuration screen.

For detailed information, refer to appropriate sections in Setup Guides.

Navigating to Producer Details

1. On the Oracle Financial Services Lending and Leasing home screen, click Origination >
Origination > Producers > Producer Details.
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2. The system displays the Producers screen.

ORACLE
Financial Services Lending and Leasing

Producers . (3 Close

Producer Details  Search

PRODUCER DETAILS CUSTOM dhadd | Sedt | [Hview | o audt
View v Fomat~ B} Freeze  ifiDetach Wrap @

Producer # Old Producer # Name Company Branch Start Dt End Dt Status Enabled Contact Group Type

CA-D0005 CA-DD0D5 AUTO JUNGLE uso1 UsHQ 05/27/1934 12/31/4000 ACTIVE ¥ JACK NOT DEFINED DEALER -
Ca-00006 Ca-00006 SIMI VALLEY CHRY... USO1 usHQ 05/27/1994 12/31/4000 ACTIVE v nck NOT DEFINED DEALER

CO-00001 CO-00001 PHILLONG MITSU... US01 UsHQ 05/27/1994 12/31/3000 ACTIVE Y JACK NOT DEFINED DEALER

FL-00002 FL-00002 VICAR MOTOR OF ... USO1 usHQ 05/27/1994 12/31/4000 ACTIVE Y JACK NOT DEFINED DEALER

FL-00003 FL-00003 TADDEI AUTO SAL... US01 UsHQ 05/27/1994 12/31/4000 ACTIVE Y JACK NOT DEFINED DEALER ke

« 0 r
Columns Hidden 32
PRODUCER DETAILS CUSTOM

m

Save and Stay Save andRetumn || (@ Retum

Producer # CA-00005 Address Line 1 12800 ROSCOR BLVD. Max Float 99,999
Old Producer # CA-00005

Address Line 2 Remaining Float 99939
= Fl
Name | AUTO JUNGLE + Country | UNITED STATES B Enabled [7]
* Company | USO1 - i
R &l Zp{ 31552 z Subvention Participation
*Branch | USHQ [=] ZpExin
StartDt 05/27/1994 [y ety [EERRAIEY * Subvention Participant [
EndDt 123174000 *State CALIFORNIA = Oolectin Tipe ST =
) Contact | JACK + permission to Call [F] Collection Frequency MONTHLY [=]
* Group | NOT DEFINED = *Permission to Text [ Refund Disbursement Method NONE [=]
Grade = Phone 1 (818)-763-2100 Region ALL [=]
*Type DEALER = Extn1 5 Territory ALL [=]
+ Status [ AGTVE = * Permission to Call [
atus -
*Permission to Text [ License Details
Sales Agent | DEMO LEAD [=] e .
- z ﬁ = vaid From 01/01/1800 E!
Underwriter | DEMO UNDERWRITER [+ e Jo1/ P@
valid To  12/31/4000 E:
i = * Fax Prefixt | 11DIGIT = s o
= User Defined Field Char 10
Collector | DEMO COLLECTOR [+ Fax 1 (818)-767-8329
* Fed Tax # [755705902 W B User Defined Field Num 1
User Defined Field Date 1 62
Address Details fax2
Email
Address = *Loss Reserve Amount 0
Payment Details | Compensation | Subvention | Transactions | Holdback/Loss Reserve | Tracking Atfributes || Statements | Contacts | Comments | Summary | Title Status Summary i

To set up the Producer

1. In the Producer Details section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Note

Field names in the Producer Details section may vary depending on the customization and
additional fields introduced. Populate the field details accordingly.

Field: Do this:

Producer # Based on the system setup, either:
Specify the producer number

-or-

The system generates producer number.

Producer will be activated on the next system date (current system
date + 1) and not on the start date.

Old Producer # Specify the old producer number.

Name Specify the producer name.

Company Select the company from the drop-down list.

Branch Select the branch from the drop-down list.

Start Dt Select the producer start date by clicking on the adjoining Calendar
icon.
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Field:

Do this:

End Dt Select the producer end date by clicking on the adjoining Calendar
icon.

Contact Specify the producer contact.

Group Select the producer contact group from the drop-down list.

Grade Select the producer grade as per business processes from the drop-
down list. The list consist of values which are used only for
categorizing at the producer level and can be changed periodically
as per business requirement.

Type* Select the producer type from the drop-down list. The Group and
Type fields help in setting up the pricing schemes on Pricing screen.

Status Select the appropriate status from the drop-down list. The contents
of this field can be linked to edits in Line of credit origination cycle so
that only applications from Producers whose status is 'Active’' can be
funded.

Sales Agent Select the sales agent associated with this producer from the drop-

down list.

Underwriter

Select the default underwriter assigned to this producer from the
drop-down list. Only users with a responsibility for an
UNDERWRITER can be designated as underwriters for producers.

Funder

Select the users with responsibility as Funding Specialist, from the
drop-down list.

Collector

Select the default collector or agent assigned to this producer from
the drop-down list. (This will appear in the Collector field in
Delinquency Information section of Account Details screen on
the Customer Service screen).

Fed Tax #

Specify the federal tax identification number. If the organizational
parameter UIX HIDE RESTRICTED_ DATA is set to Y, this appears
as a masked number; for example, XXXXX1234.

Address section

Country

Select the country code from the drop-down list.

Address Line 1

Specify address line 1

Address Line 2

Specify address line 2

Zip Select the zip code from the drop-down list.
Zip Extn Specify the extension of the zip code.

City Specify the city.

State Select the state from the drop-down list.

Permission to
call

Check this box if customer has provided permission to contact
through the specified phone number. When selected, system auto
validates this option against the phone number specified.
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Field:

Do this:

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

Phone 1

Specify phone number 1.

Exnt 1

Specify phone number 1 extension.

Permission to
call

Check this box if customer has provided permission to contact
through the specified phone number. When selected, system auto
validates this option against the phone number specified.

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

Phone 2 Specify phone number 2.

Extn2 Specify phone number 2 extension.

Fax Prefix1 Select fax prefix number 1 from the drop-down list.

Fax1 Specify fax number 1.

Fax Prefix2 Select fax prefix number 2 from the drop-down list.

Fax2 Specify fax number 2.

E-Mail Specify the producer mail address.

Loss Reserve Specify the loss reserve amount

Amount

Max Float Specify the value of maximum float allowed for the Producer.

A Float represents the application sourced by the producer that is
Funded and awaiting 'Title perfection' from the concerned authorities
for marking lien. If you do not know the exact value but want to
provide a maximum float, then specify the value as 99999.

Remaining Float

System automatically displays the available number of floats by
calculating the remaining float value based on 'Max Float' and Title
perfections under processing.

Enabled

Check this box to enable the product.

Subvention Partici

pation Details

Subvention
Participant

Check this box to maintain the producer as subvention participant

Collection Type

Select the collection type from the drop-down list.

Collection Select the collection frequency from the drop-down list.
Frequency

Refund Select the refund disbursement method from the drop-down list.
Disbursement

Method

Region Select the region of producer from the drop-down list.
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Field: Do this:

Territory Select the territory of producer from the drop-down list.

License Details

Valid From Specify the date from when the producer’s license is valid.

Valid To Specify the date till when the producer’s license is valid.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

Oracle Financial Services Software recommends that you double-check the fax numbers
(especially the 10 digit number) and email addresses you enter on this screen, since the
system uses this information to send its system-generated underwriting decisions.

14.1.2 Payment Details

You can setup ACH as the payment mode for a dealer or producer on Payment Details sub
screen. The Payment Details sub screen stores information regarding the payment mode,
currency and producer’s bank details, such as bank’s name, routing number, account type,
account number, BIC and IBAN. Once the details are updated the same has to be verified and
approved in the payment details section before processing.

The dashboard of Oracle Financial Services Lending and Leasing displays all the producers
whose payment details are either APPROVED or WAITING FOR APPROVAL in the
‘Producers Count By ACH Status’ section. You can click on the respective links to view the
details in ‘Producers’ screen.

To complete the Payment Details
1. Click Origination > Origination > Producers > Payment Details.

2. In the Payment Details section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Pmt Mode Select the payment mode from the drop-down list.

Bank Specify the ACH bank name.

Start Dt Select ACH start date if payment mode is ACH. You can even
select the date from adjoining Calendar icon.

Routing # Specify the ACH bank routing number.

Account Type Select the ACH bank account type from the drop-down list.

Account # Specify the ACH bank account number.

Currency View the currency of the Producer. System defaults the

currency depending on the Company or Branch selected for
the Producer.
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Field: Do this:

BIC Select the Business Identifier Code from the drop-down list.
The list displays the BIC codes defined in the system.

IBAN Specify the IBAN (International Bank Account Number). IBAN
is used for identifying bank accounts across national borders
with a minimal of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation
based on modulo 97. On save, system automatically validates
the IBAN number length based on country code, characters,
white spaces, and checksum. Validation is also done during
posting non-monetary transaction (ACH Maintenance).

You can maintain the IBAN length and other details required
as per the country code in the user defined table (Setup >
Administration > System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is
defined by default with length of IBAN as 18.

Disbursement Select the disbursement currency from the drop-down list.
Currency System defaults the currency depending on the Company or
Branch selected for the Producer.

Approval Detail section - When the payment details are approved, system
automatically populates the following fields with the approver details along with the
status as ‘Approved’. However on subsequent update, the details are reset till
further approval and status is changed to ‘Waiting for approval’.

Approved By View the user who has approved the payment details.

Approved Dt View the date and time when the payment details were
approved.

Status View the status of producer payment details.

Perform any of the Basic Actions mentioned in Navigation chapter.

To Approve Payment Details

You can verify and approve the producer payment details defined by another user in the
Producers > Payment Details section. You can either directly select the required record in the
‘Producers’ screen or sort the list of payment details awaiting approval using the Dashboard.

Before you proceed, ensure that you have approval rights assigned to your login. Else,
contact your system administrator.

1. To access the payment details to be approved, do one of the following:
e Click Origination > Origination > Producers.

e Click Dashboard and navigate to ‘Producer’ section. In the ‘Producers Count By ACH
Status’ sub section, click WAITING FOR APPROVAL. The payment details are sorted
accordingly and displayed in ‘Producers’ screen.

2. Inthe Producer Details section, select the required Producer. The payment details
associated with the producer are displayed in the ‘Payment Details’ section.

3. Inthe ‘Payment Details’ section, click Approve Payment Detail.
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14.1.3

The payment details are approved and approver information is captured in Approval Detail
section. Also on approval, the Dashboard counters in ‘Producers Count By ACH Status’
section are updated.

Tracking Attributes

The Tracking Attributes sub screen allows you to link information to a producer who is not
tracked in the system, by default, however is part of company’s business practices.

To complete the Tracking Attributes
1. Click Origination > Origination > Producers > Tracking Attributes.
2. In the Tracking section, you can edit the parameter and Value details.

3. A brief description of the fields is given below:

Field: View this:

Sub-Parameter View the sub-parameter details.

Parameter View the parameter details.

Value Enter the required value for the selected parameter.

4. In the Statements Transactions section, view the following information:

Field: View this:

Effective Dt | The statement transaction date.

Transaction | The statement transaction.

Account The statement account number.

Debit Amt The statement debit amount.

Credit Amt The statement credit amount.

14.1.4 Contacts

The Contacts sub screen allows you to record information regarding contacts associated with
a producer, such as employees at a dealership.

To complete the Contacts
1. Click Origination > Origination > Producers > Contacts sub tab.

2. On the Contacts sub screen, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Contact Type Select the producer contact type from the drop-down list.
Name Specify the producer contact name.

Phone Specify producer contact phone number.

Extn Enter phone number extension.
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14.1.5

14.1.6

Field: Do this:

Fax Enter producer contact fax number.

Enabled Check this box to indicate this is a current contact.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Comments

The Comments sub screen allows you to view and enter comments regarding the producer.

To enter a comment on the Comments
1. Click Origination > Origination > Producers > Comments sub tab.

2. Inthe Comments section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Comment Enter comment.
Comment By Displays user id.
Comment Dt Displays comment date.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Summary

The display only Summary sub screen allows you to view summary information regarding the
producer.

To view summary on the Summary
1. Click Origination > Origination > Producers > Summary sub tab.

2. In the Summary section, view the following information.

A brief description of the fields is given below:

Field: View this:

Year Month | The year and month.

Total Apps The application total status count.

Approved The application approved status count.

Conditioned | The application conditioned status count.

Rejected The application rejected status count.

Withdrawn The application rejected status count.

Funded The application withdrawn status count.
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141.7

14.2

Field:

View this:

Amount

The application funded status total amount.

Title Status Summary

The Title Status Summary screen displays the various stages of titles of assets for
applications sourced by the producer. The details are available for specific periods based on
elapsed days like last 1 Day / 1 Week / 1 Month or by a specific date range.

To view Title Status Summary on the Summary

1.

Click Origination > Origination > Producers > Title Status Summary sub tab.

2. Sortthe list of statuses to be displayed based on elapsed days by selecting the ‘View Last’
option as 1 Day /1 Week / 1 Month / By Date. When ‘By Date’ is selected, you can specify
a date range (within 3 months) in ‘Start Dt’ and ‘End Dt’ fields using the adjoining calendar
and click ‘Search’. View the following field details.
Field: View this:
New Status Displays lien status as 'New'
Perfection Displays lien status as either Sent for Perfection/ Sent for Re-

Processing Status

perfection

Perfected Status

Displays if lien status has 'Perfected Title'

Release
Processing Status

Displays lien status as either Sent for Title Release/Re-sent for
Title Release

Released Status

Displays lien status as either Service Requested/Pending Delete

Hold Release

Displays lien Hold Release status

To be Released

Displays lien status if ‘To be released’

Closed Status

Displays lien status if ‘Deleted’

Exception Status

Displays lien status as either Pending Lien Holder/ Pending DMV

Lien Event Date

Displays lien Event Date attached against each status.

Search Tab

A Search tab is available on the Producers screen to help locate producer information such
as producer number, name, status, group, type, grade, and zip code maintained in the
system. This is the information that is used on the Producer Details screen.
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To search for a producer

1. On the Oracle Financial Services Lending and Leasing home screen, click Origination >
Origination > Producers > Search tab.

ORACLE’ ABSHEKAR ¥ 1 Snout O
Financial Services Lending and Leasing

Producers x (3 Close
Producer Detals | Search Z
Search Criteria
G rsetcena | @sewch
Vew~ Fomatv B | [[Freee BfiDetach | Jwrep | @
Ciiteria Comperison Operator Value
PRODUCER # LikE [+ %
PRODUCER NAVE e =
PRODUCER STATUS LI [+l [l
PRODUCER GROUP LIKE [+ [+l
PRODUCER TYPE LIKE [+ [E2)
PRODUCER GRADE LKE [~] [=] 3
PRODUCER ZIP CODE LIKE [+
N
L1 gpen
Search Results
View > Formatv B eze  EfiDetach ap @

Producer # OldProducer 5 Neme Company Branch StartDt EndDt Status Contact Group Type Grade
FL00004 FL-00004 USA AUTO CENTE... Us01 usHQ 05/27/1994 12/31/4000 ACTIVE IncK NOT DEFINED DEALER B
FL0000S FL-00005 TEXAS AUTO MAR... USO1 usHQ 05/27/1994 12/31/4000 ACTIVE ek NOT DEFINED DEALER
A-00001 GA-00001 ALTO SOURCE OF... US01 usHQ 05/27/1994 12/31/4000 ACTIVE ek NOT DEFINED DEALER
GA-00002 GA-00002 ADVANCELEASIN... US01 usHQ 05/27/1994 13/31/4000 ACTIVE ek NOT DEFINED DEALER
A-00003 GA-00003 DAUGHTRY AUTO .. US01 usHQ 05/27/1994 13/31/4000 ACTIVE ek NOT DEFINED DEALER
GA-00004 GA-00004 ADVANCELEASIN... US01 usHQ 05/27/1994 12/31/4000 ACTIVE MK NOT DEFINED DEALER
A-00005 GA-00005 CARRIAGE NISSAN  US01 UsHQ 05/27/1994 12/31/4000 ACTIVE ek NOT DEFINED DEALER
1A-00001 1A-00001 DAN DEERY TOYOTA NLO2 NLRL 05/27/1994 ACTIVE K NOT DEFINED DEALER
1a-00002 1A-00002 REEDER MOTOR .. NLOZ LR 05/27/1994 ACTIVE MK NOT DEFINED DEALER
1A-00003 1A-00003 CAROUSEL MOTORS NLOZ NLRL 05/27/1994 ACTIVE MK NOT DEFINED DEALER

2. In the Search Criteria section, use Comparison Operator and Value columns to enter
search criteria you want to use to locate a producer.

3. Click Search.

System displays the result in the ‘Search Results’ section at the bottom of the screen with the
following details:

e Producer #
e Old Producer #
e Name

e Company
e Branch

e Start Dt

° End Dt

e Status

e Contact

e Group

e Type

e Grade

4. Select the required record and click ‘Open’. The details of only that particular Producer is
displayed in ‘Producer Details’ tab. However, system displays the producer details only
for authorized users based on access/permissions defined in setup.

Note

When a single producer record is opened from Search tab, the ‘Producer Details’ tab en-
ables a ‘Remove Filter’ option. Clicking on the same removes the filter criteria and displays
all the producer records maintained in the system.
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You can click Reset Criteria at any time to clear Comparison Operator and Values columns
on the Search Criteria section.
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15.1

15. Vendors

During the life of an account, a financial institution might require the use of specialized
services of a vendor for various purposes; for example, repossessing a vehicle, retaining an
attorney for bankruptcy court proceedings or making field calls. With the system’s Vendors
screen, you can:

e Maintain vendor information

e Maintain services offered by the vendor

e Assign tasks to the vendors and subsequently track and process those tasks
e Charge vendor expenses to customers

e Enter and update invoices raised by the vendors

e Post vendor transactions

e Process vendor payments

Once an invoice has been presented for a service performed by a vendor, you can enter
information on Vendor Management form and create a monetary transaction. You can then
choose if the customer should pay any particular expense or not.

The Vendors screen allows you to set up vendor information. You can also use the copy
feature to quickly create new vendors with the existing details. By default it will show current
address but if the vendor receives escrow disbursement at an address which is different from
current business address the information can be entered in Payment Details sub screen. Also,
the Payment Details sub screen allows you to enter number of days prior to the due date by
which payment to vendor must be processed.

Navigating to Vendor Detail Screen

1. On the Oracle Financial Services Lending and Leasing home screen, click Origination >
Origination > Vendors.

2. The system displays the Vendor screen. The details are grouped under four tabs:
e Vendors
e Assignment Allocation
e Work Orders
e Follow-up
e Invoices
e Search

Vendors tab

1. Click Origination > Origination > Vendors > Vendors. The details in the screen are
grouped into the following tabs:

e Payment Details
e Vendor Groups
e Tracking Attributes

e Comments
2. In the Origination > Origination > Vendors > Vendors > Vendor Details section, you
can create or edit vendor details. While creating new, you can also use the copy feature

to copy the existing details to new vendor. The copy option in the Vendor Details screen
is controlled by the system defined parameter (UVN_VEN_NBR_SYS_GENERATED).
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Based on the valued defined for the parameter in Setup > Administration > System >
System Parameter screen, you can copy the existing vendor details in the following ways:

e If the value of the parameter is set to ‘Y’ (default), specify a new name in ‘New Vendor
Name’ field and click ‘Create Copy’.

e If the value of the parameter is set to ‘N’, specify a vendor number in ‘New Vendor #
field and click ‘Create Copy’.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

ORACLE’
Financial Services Lending and Leasing
Vendors y, (& Close
Vendors | Assignment Alocation | Work Orders || Invoices | Search 2
Vendor Details Fadd | Sk U o Aux
View v Format v [E5 Freeze  [fiDetach rap o) New Vendor Name } Create Copy
& ca-vno1 Y [
Vendor = Channel Old vendor = Name Status Company Branch Start Dt EndDt ContactPerson  FedTax = Email E
CA-02001 INTERNAL PHANINDRA VEND... ACTIVE KEY EQUIPMENTF... KEFC_BR 03/28/2016 12/31/9999 PHANINDRA 9090 ¥
« i = vollE
Columns Hidden 14
Vendor Details
B B saveandstay | | saveandRenm || GaRewn
*Enabled [ Fed Tax = 908030 Fax2
Vendar ¥ CA-02001 * CreditDays 2 * Country | UNITED STATES [=]
Sheroel [HOEEA = Permission to Cal [¥] Address # 9090
Old Vendor i @
sneer femiesan b Text * address Line 1 LINE 1
#MName PHANINDRA VENDOR Phone 1 (008)-289-8998
Address Line 2 LINE 2
Status ACTIVE [=] Bl o B
* Company KEF-CA = permisson to Call [ e
. permission to Text [1]
Branch KEFC_CA_BR =] *City SANDIEGO
. oG Phone 2
startDt 03/28/2016 | B o *Siste CALIFORMIA =
*EndDt 12310308 B i -

A brief description of the fields is given below:

Field: Do this:

Enabled Check this box to enable the vendor.

Vendor # The vendor number is either editable (default) or auto generated
depending on the system parameter defined at setup screen.
System auto generates the vendor number when the following sys-
tem parameter is set to ‘Yes’ in Setup > Administration > System >
System Parameter screen.
- Parameter: UVYN_VEN_NBR_SYS_GENERATED
- Description: VENDOR NUMBER IS SYSTEM GENERATED

Channel Select the vendor channel from the drop-down list.

Old Vendor # Displays the old vendor number if exists.

Name Specify the vendor name.

Status Select the vendor status from the drop-down list.

Company Select the vendor portfolio company from the drop-down list.

Branch Select the vendor portfolio branch from the drop-down list.

Start Dt Specify the vendor start date. You can select data even from the
adjacent Calendar icon.

End Dt Specify the vendor end date. You can select data even from the

adjacent Calendar icon.

Contact Person

Specify the vendor contact name.
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15.1.1

Field:

Do this:

Fed Tax # If available, enter the vendor federal tax identification number. If the
organizational parameter UIX HIDE RESTRICTED DATA is set to
Y, this appears as a masked number; for example, XXXXX1234.

Credit Days Specify the credit days for the vendor invoice. This number is used

to check that Invoice Due Date is not more than the credit days from
Invoice Date.

Permission to
Call

Check this box if customer has provided permission to contact
through the specified phone number. When selected, system auto
validates this option against the phone number specified.

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

Phone 1

Specify primary phone number.

Extn 1

Specify the primary phone extension.

Permission to
Call

Check this box if customer has provided permission to contact
through the specified phone number. When selected, system auto
validates this option against the phone number specified.

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

Phone 2 Specify alternate phone number.

Extn 2 Specify the alternate phone’s extension.

Fax Specify the fax number.

Fax 2 Specify the fax number 2.

Country Select the country code from the drop-down list.
Address # Specify the vendor address.

Address Line 1

Specify address line 1.

Address Line 2

Specify address line 2.

Zip Select the zip code from the drop-down list.
Zip Extn Specify the extension of the Zip code.

City Specify the city.

State Select the state from the drop-down list.
Email Specify the email address.

Payment Details

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Click Origination > Origination > Vendors > Vendors > Vendor Details > Payment
Details. The Payment Details sub tab allows you to set up automatic clearing house
information for vendors.
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On the Payment Details sub tab, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Remittance section

Country

Select the country code from the drop-down list.

Address Line 1

Specify address line 1.

Address Line 2

Specify address line 2.

Zip Specify zip code from the drop-down list.
Zip Extn Specify extension of the zip code.

City Specify city.

State Select state from the drop-down list.

Pre-Process Days

Specify the remittance pre-process days. This is the number of
days prior to due date by which payment to the vendor must be
processed.

Currency

View the currency attached to vendor.

Payment Details section

Mode Select the mode of payment from the drop-down list.

Bank Specify the ACH bank.

Start Dt View ACH start date.

Routing # Specify the bank routing number.

Account Type Select the account type from the drop-down list.

Account # Specify the account number. If the organizational parameter UIX-
_HIDE RESTRICTED DATA is set to “Y’, this appears as a
masked number; for example, XXXXX1234.

BIC Select the Business Identifier Code from the drop-down list. The

list displays the BIC codes defined in the system.
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15.1.2

15.1.3

Field: Do this:

IBAN Specify the IBAN (International Bank Account Number). IBAN is
used for identifying bank accounts across national borders with a
minimal of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation
based on modulo 97. On save, system automatically validates
the IBAN number length based on country code, characters,
white spaces, and checksum. Validation is also done during post-
ing non-monetary transaction (ACH Maintenance).

You can maintain the IBAN length and other details required as
per the country code in the user defined table (Setup > Adminis-
tration > System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is
defined by default with length of IBAN as 18.

Disbursement Select the disbursement currency for vendor payment from the
Currency drop-down list. The list displays all the available currencies appli-
cable to the vendor.

Perform any of the Basic Actions mentioned in Navigation chapter.

Vendor Groups

Click Origination > Origination > Vendors > Vendors > Vendor Details > Vendor Groups.
The Vendors Groups allows you to set up vendor groups.

On the Vendor Groups section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:
Sort Specify sort sequence.
Group Select the vendor type to which the vendor belongs from drop-down list,

based on services provided by the vendor.

Enabled Check this box to enable the vendor service.

Perform any of the Basic Actions mentioned in Navigation chapter.

Tracking Attributes

Click Origination > Origination > Vendors > Vendors > Vendor Details > Tracking
Attributes. The Tracking Attributes allows you to load tracking attributes and define the
parameter value for various parameters listed.

On the Tracking Attributes sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.
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15.1.4

15.2

15.2.1

A brief description of the fields is given below:

Field: Do this:

Sub-Param- | View the Sub-Parameter.
eter

Parameter View the listed Parameter.

Value Specify the required parameter value. By default, NA is displayed.

Perform any of the Basic Actions mentioned in Navigation chapter.

Comments

Click Origination > Origination > Vendors > Vendors > Vendor Details > Comments. The
Comments sub tab allows you to add comments and also view comments posted through AP

interface.

On the Comments sub tab, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Comment View or add the required comment.

Comment System automatically selects the logged in user details.
By

Comment System automatically displays the current date.

Dt

Perform any of the Basic Actions mentioned in Navigation chapter.

Assignment Allocation

The Assignment Allocation tab allows you to define criteria for selecting a specific vendor to
execute a work order. A criteria here refers to a combination of a Channel, Work Order Type,
Company and Branch associated to a vendor. If the same combination or criteria is selected
during work order creation, system selects a specific vendor or highest weighted vendor in the
list by default for the work order.

Click Origination > Origination > Vendors > Assignment Allocation. The details are
grouped under two sections:

e Vendor Assignment Criteria
e Vendor Assignment Allocation

Vendor Assignment Criteria

In the Vendor Assignment Criteria section, you can define the criteria used for vendor
selection.
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1. In the Origination > Origination > Vendors > Work Order > Assignment Allocation,

perform any of the Basic Operations mentioned in Navigation chapter.

ORACLE’
Financial Services Lending and Leasing

Vendors x [ Close:

Vendors  Assignment Allocation  \Work Orders  Follow-up  Invoices

Vendor Assignment Criteria
View v Format~ [Er Freeze i Detach Wrap i)

apadd | AEdt | [5 Yew

Channel Work Order Type Company Branch Enabled State Country
GENERIC AUCTIO... RE SALE DEMO BANK U... US HEAD QUA. ¥ FLORIDA UNITED STATES
INTERNAL BANKRUPTCY DEMO BANK U... US HEAD QUA. ¥

DEMO BANK U... US HEAD QUA... Y

DEMO BANK U... US HEAD QUA. ¥ ALASKA
DEMO BANK U... US HEAD QUA. ¥

DEMO BANK ... US HEAD QUA... ¥

DEMO BANK JP  JP HEAD QUA

GENERIC RECOVE... DOCR KNOCK {GRI)
GENERIC AUCTIO... RE SALE
GENERIC RECOVE... REPOSSESSION

UNITED STATES

GENERIC RECOVE... IMPOUND INVOLUNTARY REFOSSESSION (GRI)
GENERIC RECOVE... BANKRUPTCY

Vendor Assignment Allocation AEit | Evew | o audt
vewv Formatw g Fresze i Detach frap )
Vendor = Name Assigned Cases % Alocation Assignment %
V04814 SAND CASTLE INVESTMENTS LLC o
GA-03001 PRITAM o

V05329 RDN DEMO FLORIDA o ||=

A brief description of the fields is given below:

Field: Do this:

Channel Select the OFSLL interfaced channel from the drop-down list.
If the channel is selected as ‘GENERIC RECOVERY INTERFACE’,
the work order is processed through an external system. For more
information, refer to Appendix chapter - ‘Generic Recovery Interface
(GRIy.

Work Order Select the work order type from the drop-down list.

Type

Repo Storage This field is available only if the channel is selected as ‘GENERIC

Country AUCTION INTERFACE'. Select the Country where the repossessed
asset is currently stored from the drop-down list.

Repo Storage This field is available only if the channel is selected as ‘GENERIC

State AUCTION INTERFACE'. Select the State where the repossessed
asset is currently stored from the drop-down list.

Company Select the Company from the drop-down list.

Branch Select the company’s Branch from the drop-down list.

Enabled Check this box to enable the vendor assignment criteria.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

15.2.2 Vendor Assignment Allocation

In the Vendor Assignment Allocation section, system fetches the list of vendors qualifying the
combination of channel, work order, company and branch selected and allows you to define
the weightage for each vendor in percentage.

By default, the allocated assignment percentage for each vendor is ‘0’. During subsequent
update, the total of assignment percentage allocation for all vendors should be equal to “100’.
A vendor with the highest weightage is selected by default during work order creation.

For ‘GENERIC AUCTION INTERFACE' related Vendor Assignment Criteria, you can add
vendors to the defined criteria from ‘Vendor Assignment Allocation’ section. For more
information, refer to ‘Remarketing’ chapter in Collections User Guide.
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1.

In the Origination > Origination > Vendors > Work Order > Assignment Allocation,

perform any of the Basic Operations mentioned in Navigation chapter.

Field: Do this:

Vendor # View the Vendor number. The same is either specified manually or
system generated in the Vendors tab.

Name View the name of the vendor.

Assigned Cases

View the total number of cases assigned to the vendor.

% Allocation

View the percentage of total cases assigned to the vendor.

Assignment %

Specify the percentage allocation value (out of 100) for each vendor.
However, ensure that the total of all assignment % is equal to “100’.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

15.3 Work Orders Tab

The Work Orders link allows you to assign an account to a vendor for a service that the vendor
provides, view the history of work order changes and define tracking attributes.

3.

under three tabs:
e Services

e Work Order History
e Tracking Attributes

Click Origination > Origination > Vendors > Work Order. The details are grouped

In the Origination > Origination > Vendors > Work Order > Work Order, sort the list

of work orders based on status using the ‘View Options’ drop down list. You can further
sort the list of work orders based on elapsed days by selecting the ‘View Last’ option as
1 Day /1 Week / 1 Month / By Date. When ‘By Date’ is selected you can specify a date
range (within 3 months) in ‘Start Dt and ‘End DY’ fields using the adjoining calendar and

clicking ‘Search’.

ORACLE"

Financial Services Lending and Leasing

Perform any of the Basic Operations mentioned in Navigation chapter.

ESHEKAR * g Sign Out
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Work Order

View Options

view v Format~ [ Freeze i Detach
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UNDEFINED

N WO:0002001
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«

UNDEFINED
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Work Order
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View Last
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m

1Day @ 1Week® 1Month
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Qverride

Vendor
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Company
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Work Order Details
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A brief description of the fields is given below:

Field: Do this:

Work Order # Displays the work order number.

Case # Displays the case number received from third party vendor interface.

Channel Select the OFSLL interfaced channel from the drop-down list.
If the channel is selected as ‘GENERIC RECOVERY INTERFACE’,
the work order is processed through an external system. For more
information, refer to Appendix chapter - ‘Generic Recovery Interface
(GRIy.

Work Order Select the work order type from the drop-down list.

Type

Account Select account number for the work order from the drop-down list.

Company Displays the company name based on the account selected.

Branch Displays the branch based on the account selected.

Vendor Select vendor who will service the work order from the drop-down

list. The list of vendors are displayed based on the selected Chan-
nel, Work Order Type, and Account.

Override Rea-
son

In case of vendor re-assignment, select the appropriate override
reason for the selected Vendor.

Status Select the work order status from the drop-down list.

If the status is selected as ‘SEND TO GRUI’, the work order is pro-
cessed through an external system. For more information, refer to
Appendix chapter - ‘Generic Recovery Interface (GRI)'.

Reason This field is enabled only if the status of work order is selected as
PENDING ON HOLD, RLRELEASED, or PENDING CLOSE. You
can select the appropriate reason from the drop-down list.

Collector Select the Collector from the drop-down list. The list displays all the
users defined with ‘Collector’ responsibility.

Work Order Details section

Dt Displays the date when work order was created.

Status Dt Displays the last work order status-change date.

Currency Displays the vendor company currency based on the vendor
selected.

Estimated Displays the estimated amount, which is the sum of all the services
added to the work order.

Billed Displays amount billed by the vendor for the work order.

Paid Displays amount paid to the vendor for the work order.

Reference #

Specify vendor reference details if any.
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Field:

Do this:

Assigned By

Displays the user who created/assigned the work order to vendor.

Followup Dt

Select the subsequent follow-up date from adjoining calendar.

Account Information section - System displays the following information depending on
the account selected for the work order in ‘Work Order’ section.

Account Status

Displays the status of the account.

Charged off Dt

Displays the date when the account was charged off.

Due Amt

Displays the due amount to be paid to the account.

Total Outstand-

Displays either ‘Account outstanding principal balance’ for active

ing Balance accounts, or ‘Deficiency balance’ for charge-off accounts.
Total Due Displays the total of all dues pending on the account.
Due Dt Displays the last elapsed due date on the account.

Days Past Due

Displays the total number of days elapsed past due date.

Service
Address

Displays the combined details of Customer/Business, Address Type
and Address based on the account selected. For Business account
only business address is populated. You can also select the required
service address from the drop-down list only while creating work
order details (i.e. when status = New).

Note: When selecting the service address for an external interfaced
channel (i.e. changing primary address), ensure to select the sec-
ondary address only. Else, system displays an error message.

Collateral Details

section - This section displays the asset details associated with the

work order.
Collateral System displays the primary collateral associated with the account
Description by default. You can also select the collateral from the drop-down list.

The list displays all the assets associated with the account.

Identification #

Displays the identification number of the asset.

Year Displays the manufacturing year of the asset.
Make Displays the asset’s manufacturing company.
Model Displays the asset’s model.

Vendor Information section

Contact Specify the vendor contact for the work order.

Phone Specify the vendor contact phone for the work order.

Extn Specify the vendor contact phone extension for the work order.
Fax Specify the vendor contact fax for the work order.

Comment Specify any comments regarding the work order.
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Field: Do this:

Vendor Messages section - This section is displayed only when the selected channel is
‘GENERIC RECOVERY INTERFACE’ and allows you to add specific communication or
instructions as a message to the vendor.

Vendor Msg Select the type of vendor message from the drop-down list.

Type

Vendor Msg Specify additional information that is to be communicated to the
external interface.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

15.3.1 Services

In the Origination > Origination > Vendors > Work Order > Services, perform any of the
Basic Operations mentioned in Navigation chapter.

Click ‘Load Services’ button in the Services section header to load all the services associated
with the selected combination of ‘Work Order Type’ and ‘vendor (Vendor Group)'.

A brief description of the fields is given below:

Field: Do this:

Service # Specify an unique service number for the work order.

Service Select the service type from the drop-down list (required).

Currency System defaults the currency defined in work order which is the vendor
currency.

Estimated System defaults the Estimated cost of the service offered by the vendor

as defined in vendor administration setup screen (Setup > Administra-
tion > System > Vendors > Vendor Fees > Vendor Service Fee Defini-
tion).

However, you can also modify the estimated value to the required
amount.

Billed Amt Displays amount billed by the vendor for the service.

Paid Amt Displays amount paid to the vendor for the service.
Status Select the status from the drop-down list.
Status Dt Displays the last service status change date.

Perform any of the Basic Actions mentioned in Navigation chapter.

15.3.2 Work Order History

The Work Order History sub tab displays the details of the selected work orders in the
sequence of the changes done i.e. last change details appear as the first record.
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In the Work Order History section, select the required work order and click View.
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15.3.3 Tracking Attributes

15.4

Click Origination > Origination > Vendors > Work Order > Tracking Attributes. The
Tracking Attributes allows you to load tracking attributes and define the parameter value for
various parameters listed.

On the Tracking Attributes sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Sub-Param-
eter

View the Sub-Parameter.

Parameter

View the listed Parameter.

Value

Specify the required parameter value. By default, NA is displayed.

Perform any of the Basic Actions mentioned in Navigation chapter.

Follow-up Tab

The Work Orders link lists the work orders that are not complete and hence require follow-up.

1. Click Origination > Origination > Vendors > Follow-up tab. The details are grouped

into two:

e Work Order Follow-up

e Assigned Services

15-12

ORACLE



2. In the Origination > Origination > Vendors > Follow-up > Work Order Follow-up,
perform any of the Basic Operations mentioned in Navigation chapter except for creating
a new record.

vendors ; [ Close
Vendors | WorkOrders  Follow-up | Invoices
Work Order Follow-up AEit | Eview | o audit
Views Formatv B3 Freeze ffiDetach  Jwap @)
Company  Branch FolowupDt  WorkOrders Dt Assignment Type  Account Vendor Status Dt Assigned By Estin
ust uskQ 1122015 WO:0001001 13122015  COLECTION  20150100011170ROBERTEOREN PR-D1001-PINNACLE PARTS & SERVICE Ljp0ls  VEROUTHU 000
uso1 UsHQ 1142015 WO:0001003 /142015 BANKRUPTCY 20120100010406:LEWIS LESLIE JOHN  1L-00005- MICHAEL D, CLARK 1142015 VINOARUM 124
uso1 usHQ 12/29/2015 jisPNs  SERVICING 2015120001 1333:ER00K BROOK CA-D2001-ANDREWS TOWING 1152015 VAVAIDYA 1020
uso1 usHQ j19PNs  SERVICING 20151200011317:CHODA PHANINDRA ... CA-04001-PHANINDRAL 12192015 PHACHODA 1004
uso1 usHQ 1W/19Ns  BANKRUPTCY 2015060001 1323:5MITH IOHN 11-00005- MICHAEL D. CLARK 5 PHACHODA 1004
uso1 usHQ 1142015 COLLECTION 20120100010373:ANDRE PETER [ VICT... L-00002-GRTR QUAD CITY AUTO AUC 5 VANKAYA 000
uso1 usHQ Wj1pNs  SERVICING 20150100010023:BABU MADHU 1L-00001-DECATUR AUTO AUCTION /42015 VIBRRTA 000
uso1 usHQ 12/19/2015 20120100010373:ANDRE PETER | VICT... CA-04002-HARRY RECOVER 1192015 VEROUTHU 0.0
uso1 usHQ WO:0004001 0/PNs BANKRUPTCY 20120100010373:ANDRE PETER | VIC... CA-02001-ANDREWS TOWING 122015 VINOARUM 0.0
uso1 UsHQ WO:0005001 10205 BANKRUPTCY 20120100010406:LEWIS LESLIE / JOH  CA-04004-STAR SERVICES 12/22/2015  VINOARUM 000 T
»
4
Work Order Follow-up
[ saveand stay | [ saveand Retum | GaRetum
Vendor PR-01001-PINNACLE PARTS & SERVICE Paid 0.00
Work Order Follow-up * Status  NEW b
. o Vendor Information
Company UL Status Dt 12/12/2015
5 ;
Branch USHQ & N— Contact ?R_E?URv
Followup Dt 12/12/2015 B Phone (973}539-4539
Work Order # WO:0001001 Curtency US DOLLAR )
Dt 12/1202015 Estimated 0.00 Comment
Account 20150100011170:ROBERT BOREN Billed Amt 0.00
A
Assigned Services A Eit | Elyien | o audit
Viewv Formatv [ Freeze f Detach w @ &

A brief description of the fields is given below:

Field: Do this:

Company Displays the vendor company.

Branch Displays the vendor branch.

Followup Dt Specify the next follow-up date. You can even select the date from

adjoining Calendar icon.

Work Order # Displays the work order number.

Dt

Displays the work order date.

Account

Displays the account associated with the work order.

Vendor

Displays the vendor associated with the work order.

Status

Select the work order status from the drop-down list.

Status Dt

Displays the last work order status change date.

Work Order section

Currency

Displays the currency for the work order.

Estimated

Displays the estimated amount, which is the sum of all the services
added to the work order.

Billed Amt

Displays amount billed by the vendor for the work order.

Paid

Displays amount paid to the vendor for the work order.
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15.4.1

15.5

Field: Do this:

Vendor Information section

Contact Displays the vendor contact name.

Phone Displays the vendor contact phone number.

Extn Displays the vendor contact phone number’s extension.
Comment Specify a comment.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Assigned Services

In the Origination > Origination > Vendors > Follow-up > Assigned Service, perform any
of the Basic Operations mentioned in Navigation chapter except for creating a new record. A
brief description of the fields is given below:

Field: Do this:

Services Displays the service provided by the vendor.
Currency Select currency for the vendor from the drop-down list.
Estimated Specify the estimated amount for the service.

Billed Amt Specify amount billed by the vendor for the service.

Paid Specify amount paid to the vendor for the service.
Status Select the service status from the drop-down list.
Status Dt Specify the last service status change date. You can even select the

date from the adjoining Calendar icon.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Invoices Tab

In the invoice tab of vendors screen, you can define invoices and process them along with
internally generated and externally received invoices. Invoice processing involves validating
the invoice information either manually or through an automated process.

Manual validation involves verifying the invoice information, accepting or rejecting the details,
updating the invoice status and indicating if the invoiced amount is Collectible.

Auto validation is supported for invoices which are in ‘OPEN’ status and generated internally
(i.e. channel = Internal). During auto validation, the invoice details are verified against specific
business rules defined in the system and corresponding status update and collectible
indicator is updated accordingly.

However, other invoices received from externally interfaced channel would get auto validated

with specific business rules when they are received and corresponding status is appended to
the invoice while listing in the Invoice Information section.
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Post the validation, invoices may still have difference in estimated and invoiced amount. Such
invoices are marked with status ‘FOR APPROVAL” and requires to be manually approved.

Further in the Invoices tab, you can define Tracking Attributes, Payment Schedules and view
the Related Invoice/Work Orders (if any) in the system.

1. Click Origination > Origination > Vendors > Invoices tab. The details are grouped into

following sections:
e Details
— Payment Schedules sub tab
— Related Invoice/Work Orders sub tab
e Tracking Attributes

2. Inthe Origination > Origination > Vendors > Invoices > Invoice Information, sort the
list of invoice based on status using the ‘View Options’ drop down list. You can further sort
the list of invoice based on elapsed days by selecting the ‘View Last’ option as 1 Day / 1
Week /1 Month / By Date. When ‘By Date’ is selected you can specify a date range (within
3 months) in ‘Start Dt and ‘End Dt’ fields using the adjoining calendar and clicking

‘Search’.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

ORACLE
Financial Services Lending and Leasing
Vendors y,
Vendors  Assignment Allocation ~ Work Orders ~ Follow-up  Invoices
Invoice Information
View Options ViewLast © 1Day @) 1 Week© 1Month@ ByDate startDt 07/01/2017 (BpEndDt 09022017 o @B
view v Formstv [ Freeze  EffiDetach Wrap ® Validate Invoice
vendor Company Branch Invoice = ExternalRef=  InvoiceDt
IN-0000 1-DYER ALITO AUCTION uso1 UsHQ 33453462 4143252465 08/20/2017
Invoice Information
»
External Ref # 41432524965
Invoice
*Invoice Dt 0920/2017 [y
* Invoice Type  PAYABLE [=] “DueDt 09/20/2017 (B
*Vendor IN-0D001-DYER AUTO AUCTION i ¢ * Status | APPROVED E‘
Company US01
Branch USHQ Detalls
* Invoice # 33453462
Status Dt 09/20/2017
Details  Tracking Attributes
Invoice Details
View = Format~ 2 Freeze RliDetach Wrap @

Due Dt stats Channel
os/20/2017 AFPROVED INTERNAL

[ save andstay || [ save andReturn || {aRetum

Address P OBOX 115 DYER, IN 46311
Currency
Estimated
Invoice Amt 0.00
Agreed Amt 0.00
Paid Amt 0.00
Channel INTERNAL

A brief description of the fields is given below:

Field: Do this:

Vendor Select the vendor name for whom the invoice is to be created.
Company Displays the vendor portfolio company.

Branch Displays the vendor portfolio branch.

Invoice # Specify the invoice number.

The invoice number should be unique for every vendor. In case the
Invoice # already exists for Vendor, system displays a warning message.

External Ref
#

Specify the reference number which can be used for invoice tracking.

For invoice received from external system, this field is auto populated
with the reference number generated in external interfaced system.

Invoice Dt

Specify the invoice date. You can even select the date from the adjoining

Calendar icon.
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15.5.2

Field: Do this:

Due Date Select the due date. You can even select the date from the adjoining
Calendar icon.

Status Select the invoice status from the drop-down list.

Details section

Status Dt Displays the last invoice status change date.

Address Displays the vendor address.

Currency Select the currency from the drop-down list.

Estimated Displays the total estimated amount of all the invoices defined in ‘Invoice

Details’ sub tab.

Invoice Amt | Displays the total invoice amount.

Agreed Amt | Displays the total agreed amount.

Paid Amt Displays the total paid amount.

Channel Displays the Channel as ‘Internal’ for manually defined or internally gen-
erated invoice and ‘Generic Recovery Interface (GRI)’ for externally gen-
erated invoice.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Auto Validate Invoice

You can auto validate the invoice details in the Invoice Information section for those invoice
which are in ‘OPEN’ status. Auto validation with system defined business rules ensure that
every approved invoice comply to required processing standards and helps to quickly proceed
with further action.

1. Inthe Origination > Origination > Vendors > Invoices > Invoice Information, sort the
list of invoice with status as ‘OPEN’ from the ‘View Options’ drop down list.

2. Select the required invoice form the list and click ‘Validate Invoice’ button on the Invoice
Information section header.

The invoice details are validated and the status of the invoice is updated based on validation.
For more information on validations, refer to ‘Business Rules’ section.

Invoice Details sub tab

1. Inthe Origination > Origination > Vendors > Invoices > Invoice Details, perform any
of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Work Order | Select the work order from the drop-down list. This list displays the gen-
erated work orders. Each work order name is defined in the format which
consists of work order number, account number, service number and
service name.
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Field: Do this:

Case # System displays the Case number only if there is a Case number is
associated for the selected work order.

Estimated Displays the estimated cost of selected work order as defined in Vendors
> Work Order > Services section.

Invoice Amt | Specify the invoice amount.

Agreed Amt | Specify the agreed amount.

Paid Amt Displays the paid amount.

Txn Post Dt | Specify transaction effective date. You can even select the date from the
adjoining Calendar icon.

Status Select the status from the drop-down list.

Status Dt Displays the last status change date. On edit, system updates the cur-
rent date by default.

Authorized Displays the name of the user who verified (accepted/rejected) the
By invoice details.

Authorized Displays the date when the invoice details were verified.
Dt

Collectible Check this box to indicate if the agreed amount is collectible from the
customer. When checked, the collectible amount is posted as an
expense on the customer account.

During auto invoice validation, this check box is automatically selected if
the same combination of a service and work order status matches with
the state specific rule defined in Setup > Administration > System > Ven-
dors > Invoice Rules tab.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

15.5.3 Accept/Reject Invoice details

In the Invoice Details sub section, you can accept or reject the details of those invoices which
are in ‘FOR APPROVAL'’ status. This status is updated during invoice processing and when
there is difference in estimated and invoiced amount which needs manual approval.

1. In the Origination > Origination > Vendors > Invoices > Invoice Details, select the
required invoice record.

2. Click ‘Accept’ or ‘Reject’ in the Invoice Details section header and click ‘Yes’ to confirm
the action.

3. Click Refresh button to view the status update.
On Accepting or Rejecting the invoice details, the ‘Authorized By’ and ‘Authorized Dt fields
are auto updated with user name and current date. Also the status of Invoice information and

Payment Schedules are updated as either ‘CLOSE’ or ‘REJECTED’ respectively. However,
auto update of status is controlled by the ‘Current/Next’ status defined in Cycle Setup screen.

If the status of a particular invoice is updated from ‘APPROVED’ to ‘CLOSE’, system
generates a payment requisition record for payment processing.
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15.5.4 Payment Schedules sub tab

1. In the Origination > Origination > Vendors > Invoices > Invoice Details > Payment
Schedules, you can maintain the payment schedules information. Perform any of the
Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Currency System displays the vendor currency.

Payment Specify the actual payment amount for the invoice.

Amt

Status Select the payment status from the drop-down list.

Payment Dt | Select the payment date from the adjoining calendar.

Payment (Optional) Specify reference details for the payment if any.

Reference

Payable Id View the auto-generated payable ID which is the requisition ID in the AP
Transaction screen.

Payment Id | View the Requisition ID generated during AP transaction.

Disburse- View the vendor disbursement currency. However, you can select the

ment Cur- vendor payment disbursement currency from the drop-down list.

rency

Account View the currency of the account selected at in ‘Invoice Details’ sub tab.

Currency

Amount in View the Invoice Currency amount equivalent of the Account Currency.

Account System displays the ‘Amount in Account Currency’ by converting Vendor

Currency Currency value to Account Currency and considering the exchange rate
as per the scheduled payment date.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

15.5.5 Related Invoice/Work Order Details sub tab

1. In the Origination > Origination > Vendors > Invoices > Invoice Details > Related
Invoice/Work Order Details, view the following details.

A brief description of the fields is given below:

Field: Do this:

Invoice # View the invoice number for the work order.

Invoice Sta- | View the status of invoice generated for the work order.
tus

Status Dt View the date on which the status of invoice is recorded.
Currency View the currency in which the invoice is generated.
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Field: Do this:

WO Esti- View the estimated amount for the work order.
mated Amt

WO Agreed | View the vendor agreed amount for the work order.
Amt

WO Paid View the amount paid for the work order.
Amt

15.5.6 Tracking Attributes sub tab

1. In the Origination > Origination > Vendors > Invoices > Tracking Attributes. The
Tracking Attributes allows you to load tracking attributes and define the parameter value
for various parameters listed.

On the Tracking Attributes sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Sub-Param- | View the Sub-Parameter.
eter

Parameter View the listed Parameter.

Value Specify the required parameter value. By default, NA is displayed.

Perform any of the Basic Actions mentioned in Navigation chapter.

15.5.7 Business Rules

Business rules facilitate to auto validate invoices and approve only those which comply to the
invoice processing requirements in OFSLL. Business Rules are always validated on Invoice
information, Invoice details and payment schedules which are in ‘OPEN’ status.

Business rule validation for Invoices created or generated internally can be performed in the
Vendors > Invoices tab and external invoices are auto validated before listing in Invoices tab.

For invoices received from external system, following pre-validation checks are also
performed before validating with the business rules.

e A duplicity check is performed based on External Reference number to ensure that
there are no two invoices with same details. In case the external reference number of
new and existing invoice in the system are same, the status is auto updated as
‘Rejected’ and invoice is not processed further.

e When the payment for a ‘Service’ in work order is already paid and the same work order
is again received with a new external reference number, system validates the ‘Paid’
status and if “Yes’, would auto update the invoice status as ‘Rejected’.

Following business rules are defined in the system for invoice validation. During the process,

if any of the business rule validation fails, system stops the validation process and updates
the status of Invoice as ‘Rejected’.
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Rule 1

Every work order should have a specific closure status corresponding to the type of work
order defined. Accordingly, an invoice generated for that work order should comply with any
of the following combination of ‘Work order Type’ and ‘Work Order status’.

Work Order Type Work Order Status
Door Knock Completed
Involuntary Repossession Repossessed
Voluntary Repossession Repossessed
Impound Involuntary Repossessed
Impound Voluntary Repossessed
Involuntary Repossession Closed
Voluntary Repossession Closed
Impound Involuntary Closed
Impound Voluntary Closed
Skip Investigation Repossessed
Skip Investigation Closed
Rule 2

Validate invoice for the status of ‘Collectible’ check box in Vendors > Invoice tab > Invoice
Details section.

During invoice processing, if the combination of Service, Work Order Status and State
matches with any of the state specific rule defined in Setup > Administration > System >
Vendors > Invoice Rules tab, the ‘Collectible’ check box is selected and invoice is allowed to
process the next business rule.

In case the above combination does not exist in Invoice Rules tab, the ‘Collectible’ check box
is NOT selected and the invoice is still allowed to process the next business rule.

Rule 3

Validate invoice based on Estimated and Invoiced amount and updated the corresponding
status in Invoice Information, Invoice Details and Payment Schedules sections of Vendors
screen.

e If the Invoice Amount is ‘Less than or equal’ to Estimated amount, the invoice is
approved and the status of Invoice Details and Payment Schedules is updated to
‘APPROVED’.

e If the Invoice Amount is ‘greater than’ the Estimated amount, then the invoice needs
manual approval and the status of Invoice Details and Payment Schedules is updated
to 'FOR APPROVAL'.

An invoice status in Invoice Information section is auto updated to “APPROVED’ if both
Invoice Details and Payment Schedules have the same status. Else, if status is rejected in
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either of the sections, the status of invoice is also updated as ‘REJECTED’ in Invoice
Information section without allowing further edits on the same.

Search tab

A Search tab is available on the Vendors screen to help locate the details of a Vendor,
Workorder, and/or an Invoice information maintained in the system. This is the information
that is used in the respective tabs of Vendors screen.

To search for a Vendor/Workorder/Invoice

1. On the Oracle Financial Services Lending and Leasing home screen, click Origination >
Origination > Vendors > Search tab.

ORACLE’ ABSHEKAR + g signout &
Financial Services Lending and Leasing

Vendors [ Close
Vendors | Assignment Allocation | Work Orders  Invoices  Search Z
Search Options: @ Vendor () Workorder © Invoice
Search Criteria
& ResetCritera | @ Search
View ¥ Format~ [ Freeze i Detach vrap ®
Criteria Comparison Operator value
VENDOR # LIKE [=] %
VENDOR NAME LIKE =)
STATUS LIE [=] [
CHANNEL LIKE [+ =]
PHONE 1% e [=] 3
¥ COUNTRY e [=] =
il e [=]
L Open
Search Results
View v Fomat~ Freeze [ Detach wep @
Vendor = Charnel 0ld Vendor & Name Status Company Branch Start Dt End Dt Zp
1L-00001 INTERNAL DECATUR AUTO AUCTION ACTIVE DEMOBANKUSA  US HEAD QUARTERS 06/14/1334 12/31/4000 60440 =
1L-00002 INTERNAL GRTR QUAD CITY AUTO AUCTION ACTIVE DEMOBANKUSA  US HEAD QUARTERS 06/14/1394 12/31/4000 61244
1L-00003 INTERNAL CRAIG PHELPS, TRUSTEE ACTIVE DEMOBANKUSA  US HEAD QUARTERS 06/14/1334 12/31/4000 60603 =
1L-00004 INTERNAL JAY A STEINBERG, ESQ ACTIVE DEMOBANKUSA  US HEAD QUARTERS 06/14/1334 12/31/4000 60602
1L-00005 INTERNAL MICHAEL D, CLARK ACTIVE DEMOBANKUSA  US HEAD QUARTERS 06/14/1594 1231/4000 61602
1L-00005 INTERNAL B AND K TOWING ACTIVE DEMOBANKUSA  US HEAD QUARTERS 06/14/1394 1231/4000 61701
1L-00007 INTERNAL ILLINOIS AUTO RECOVERY ACTIVE DEMOBANKUSA  US HEAD QUARTERS 06/14/1594 1231/4000 s25%8 -

2. Inthe ‘Search Options’, select the option against Vendor or Workorder or Invoice.

In the ‘Search Criteria’ section, use ‘Comparison Operator’ and ‘Value’ columns to enter
search criteria you want to use to locate a producer.

4. Click ‘Search’.
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System displays the result in the ‘Search Results’ section at the bottom of the screen
with the following details:

Vendor Details

Workorder details

Invoice details

Vendor #
Channel

Old Vendor #
Name

Status
Company
Branch

Start Dt

End Dt

Zip

Work order #
Case #
Channel
Account
Collateral Desc
Vendor

work order Dt
Company
Branch
Status
Reason

Workorder Type

Vendor
Company
Branch
Invoice #
External Ref #
Invoice Dt
Due Dt

Status

Channel

5. Select the required record and click ‘Open’. The details of only that particular Vendor /
Workorder / Invoice is displayed in the respective tab of Vendors screen. However,
system displays the selected record details only for authorized users based on access/
permissions defined in setup.

Note

When a single producer record is opened from Search tab, the Vendors / Work Orders /
Invoices tab enables a ‘Remove Filter’ option. Clicking on the same removes the filter cri-
teria and displays all the corresponding records maintained in the system.

You can click ‘Reset Criteria’ at any time to clear ‘Comparison Operator’ and ‘Values’ columns
on the Search Criteria section.
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Appendix A:Rounding Amounts and Rate Attributes

Rounding Amounts

Generally in the lending industry, computed amounts (interest, fees, costs and so on) are
rounded to the second decimal place. However, there are occasions where the rounding of
the computed amounts has to be carried out using different methods. Oracle Financial
Services Lending and Leasing supports the rounding, raising of or cutting off calculated
amounts.

e Rounding will increase the resulting amount to next number up to the second decimal,
based on values of third decimal.

e Raising will always increase the resulting amount to next number up to the second
decimal.

e Cutting off will always cut the number after the second decimal.

The system only rounds calculated amounts (calculated fees, calculated payment, and
so on) and not user-entered amounts.

You can choose the rounding method you want to use by setting the parameter value for
system parameter CMN_AMOUNT _ROUND_METHOD on the Administration form (Setup
menu > Administration master tab > System drop-down link > System Parameters link >
System tab).

You can choose the rounding factor you want to use by setting the parameter value for system

parameter CMN_AMOUNT _ROUND_FACTOR on the Administration form. Currently, Oracle
Financial Services Lending and Leasing supports rounding up to two decimals only.

Examples of how resulting amounts differ by RAISE, ROUND, and CUTOFF:

Example 1: Amount: 234.136

Method Result
Round 234.14
Raise 234.14
Cut off 234.13

Example 2: Amount: 234.134

Method Result
Round 234.13
Raise 23414
Cut off 234.13

Example 3: Amount: 234.1319999

Method

Result

Round

234.13
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Method Result

Raise 234.14
Cut off 234.13
Rate Attributes

The system supports rounding of index rate to keep the rate calculation as simple as possible
for the customers. The general practice is to round the rate to nearest eighth (1/8th) (to keep
index rate in the multiple of 125) or fourth (1/4th) (to keep index rate in the multiple of 25). The
system rounds only index rate and not the margin or final rate. You can define the index

rounding method on the Product tab’s Product Definition screen for variable rate Line of credit.

Note

Index rounding does not apply to fixed rate Line of credit.

The system currently supports the following rounding of methods.

1. NO ROUNDING TO INDEX RATE
2. INDEX RATE ROUNDED TO NEAREST.25
3. INDEX RATE ROUNDED TO NEAREST.125

NO ROUNDING TO INDEX RATE:

Select this method for no rounding.

INDEX RATE ROUNDED TO NEAREST 0.25:

Select this method to round up to 1/4th (to keep the index rate in the multiple of 0.25).

Examples:

Method Result

Current rate: 5.125

Round of rate: | 5.25

Method Result

Current rate: 5.124

Round of rate: | 5.00

INDEX RATE ROUNDED TO NEAREST 0.125:

Select this method to round up to 1/8th (to keep the index rate in the multiple of 0.125).

Examples:

Method Result
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Current rate: 5.325
Rate rounded 5.375
to:

Method Result
Current rate: 5.312
Rate rounded 5.250

to:
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Appendix B: Payment Amount Conversions

The following table contains the calculations Oracle Financial Services Lending and Leasing
uses to convert different payment frequencies (weekly, biweekly, semi monthly, and so on) to
standard monthly values for instalment accounts.

Payment Frequency:

Scheduled Monthly Income Amount:

D = Deferred

Zero fill

P = Single payment Line of credit

Zero fill

W = Weekly (due every week)

Multiple by 4.33

B = Biweekly (due every two weeks)

Multiple by 2.16

E = Semi-monthly (due twice a month) | Multiple by 2
M = Monthly (due every month) As given

L = Bimonthly (due every two months) | Divide by 2
Q = Quarterly (due every three Divide by 3
months)

T = Triannually (due every four Divide by 4
months)

S = Semi-annually (due twice a year) Divide by 6
Y = Annually (due every year) Divide by 12
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Appendix C:Generic Recovery Interface (GRI)

Introduction

In general, a Generic Recovery Interface (GRI) is a platform to connect Oracle Financial
Services Lending and Leasing (OFSLL) with any third party recovery system. This integration
facilitates auto lending institutions to repossess non-performing assets and recover them
through a network of third party vendor managed systems.

Accordingly, in an integrated system a particular account in OFSLL can be assigned to a
vendor (third party) through GRI for recovery services. Depending on each stage of the
process, OFSLL triggers appropriate web service requests to create and update the details
into the third party system. Subsequently, the acknowledged details and case updates are
retrieved into the corresponding work order(s) and account(s) in OFSLL.

Also the system parameter ‘GRI_WEBSERVICE_LOG_IND’ when enabled, logs all the GRI
related web service communications between OFSLL and external interfaced system. The
same can be viewed in Dashboard > System Monitor > Database Server Log Files tab by
selecting ‘Interfaces’ view option.

Following type of web service requests are supported:

e Create Case

e Update Case

e Case Comments

e Hold Case

e Reopen Case

e Reassign Case

e Close Case

e Case Updates Received via FireHose WebService
e Case Repossession

e Case Invoice

Pre-requisites

Following are the pre-requisites while working with third party integrated system:

e Ensure that 'Cycle’ setup (Setup > Vendors> Cycles tab) is defined for the Work Order,
where channel is selected as 'Generic Recovery Interface'. Also if the system is defined
to automatically post any specific conditions on account, you need to maintain the
Action and Result Code.

e Ensure that Vendor Fees (Setup > Vendors > Vendor Fees tab) defaults the 'Estimated
Amount'.

e Ensure that the Work Order Types are mapped consistently and are in sync between
OFSLL and third party system. The following table lists the Work Order Types
maintained in the system.

Work Order Type | Description

DRK DOOR KNOCK (GRI)

IR IMPOUND INVOLUNTARY REPOSSESSION (GRI)
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Work Order Type | Description

VRP VOLUNTARY REPOSSESSION (GRI)

IVR IMPOUND VOLUNTARY REPOSSESSION (GRI)
SKP SKIP TRACE (GRI)

IRP INVOLUNTARY REPOSSESSION (GRI)

e Ensure that the details of Vendors, Collectors and Service types are mapped
consistently and are in sync between OFSLL and third party system.

e Define Invoice Rules (Setup > Vendors > Invoice Rules tab) that are applicable to each
Vendor Service with appropriate Work Order Status, Close Reason, and State
combinations. This ensures that the 'Collectible’ flag is set to "Y' for selected invoice
during processing.

Create Case

Once a non-performing account is identified in OFSLL, the details are to be registered in the
third party system for further action. Using the Work Orders tab (Vendors > Work Orders tab),
you can create a work order with the identified account details and selecting the channel as
Generic Recovery Interface (GRI).

Note that, system does not allow to create a work order during the following conditions:

e Ifthere is already a case created with the same work order type which is active on the
account. On updating the details and clicking ‘Save’, system displays an error message
as ‘Active Work Order with same Order Type already exists on account’.

e If a CURE letter is issued on an account and the same is in-force. If the case creation
date is before the cure letter expiry date, then system displays an error message as
‘Cure Letter Issued and Active. Cannot create work order’.

For information on creating a work order, refer to section Vendors > Work Orders tab.

When the 'Channel' is selected as GENERIC RECOVERY INTERFACE, the Work Orders tab
enables 'Vendor Messages' section to specify additional details that are required by the third
party vendors to act upon the case. For more information, refer to ‘Case Comments’ section.

After the work order details are created, the same needs to be registered as a case in third
party system by updating the status. Accordingly, when the Status of Work Order is selected
as 'SEND TO GRI', the 'add Case()' web service is initiated to create a case in third party

system.

ORACLE'
Financial Services Lending and Leasing

@ Vendors x [®Dose
Work Order
Save and Stay. SaveandRetun || {3 Return
> DashBoard
Origination Work Order Work Order Details
Ot 12/26/2016 Collateral Details
Work Order # WO:0021410 Status Dt 12/26/2016
Case # UNDEFINED Currency USDOLLAR Collateral | 2006 CHEVROLET MONTECARLO 20w
nel INTERNAL Estimated 100.00 i)
Work Order MPOUND INVOLUNTARY REPOSSESSION (GRT) Biled Amt 0.00 Lexitibcaton
Type s Year 2006
Account 200:5MITH E Make CHEVROLET

Reference = Model MONTECARLO
Assigned By PRITAM

# 2BAGP4SGIXRITE252

Followup Dt B Vendor Information
Account Information
B Account Status  ACTIVE:DELQ:BKRP:REPO Contact ME

= | Charged off Dt Phone
Due Amt 450.03

= Total Outstanding 20500.36
Balance

Total Due  5050.33 Comment t
DueDt 02/10/2017
DaysPastDue 315
Service Address
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The 'add Case()' web service request consists of the following Case details to be registered
in third party system:

e Primary Customer

e Secondary Customer (Based on the sequence)

e Address Details

e Account Details

e Collateral Details

When the web service request is successful, the response would contain the new case
number created in third party system. The case # is then appended to the work order and the
status is changed from 'SEND TO GRI' to '"ASSIGNED'. Also a comment is posted on the
corresponding account in Customer Service > Comments tab, with the following details:

e Type = SYSTEM GENERATED

e Sub Type = INBOUND FROM INTERFACE

e Comment = [Case No]: "NEW CASE CREATED"
e Comment By = "INTERNAL"

e Comment Dt = Comment Posted date

Search | Customer Service: 20000100015971 | Review Request (Pending: 0) | Queus Assignment

Account(s): 2000 SMITH E] view || « Audit
View = Format= & Freeze EfiDetach Virap W & @ curent@ show Al © Group Follow-up
Company Branch Sub Unit Account ¥ Product Days Past Due Currency Pay Off Amt Amount Due !
uso1 USHQ SUB UNIT1 2000 LOAN WEHICLE (FR) 315 UsD 27,947.17 4,950.33!

4 m r

Summary  Customer Service AccountDetalls = Customer Detalls = Transaction History =~ PmtModes — Bankruptcy — Repo/Foredosure | Defidency  Collateral | Bureau CrossUp Sellac > ™

Call Activities | Maintenance ~Comments | Promises | Cheddists = Tracking Atiributes  Field Investigation | References | Correspondence | Letters | DocumentTracking | Scenario Ar > ¥

Comments dpadd | AEdt | [Evew | o Auit
View v Formatv P Freeze ot Detach Wrap @ 3¢ Delete
Alert Type Sub Type Comment Comment By Comment Dt
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044297557:UPDATED ACCOUNT DETAILS ACCEPTED BY THIR... INTERMAL 12/06/2016 07:45:48 AM -
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044312529:90DEMO-GRI_INTERFACE-CASE GOT REPOSSESS... INTERNAL 12/21/2016 06:55:39 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044312529:90DEMO-GRI_INTERFACE-CASE WAS ACCEFTED  INTERNAL 12/21/2016 06:48:07 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE __2044312529:90DEMO-GRI_INTERFACE-ACCEFTED CASE INTERNAL 12/21/2016 05:48:07 AM
I N SYSTEM GENERATED INBOUMND FROM INTERFACE  2044312529: NEW CASE CREATED INTERNAL 12/21/2016 05:59:15 AM | I
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044297557:90DEMO-GRI_INTERFACE-ACKNOWLEDGED CASE... INTERNAL 12/20/2016 10:08:05 PM
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. {CORRESPONDENCE: C... INTERNAL 12/06/2016 02:03:51PM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044298164:UPDATED ACCOUNT DETAILS ACCEPTED BY THIR... INTERNAL 12/06/2016 07:45:49 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044297557:UPDATED ACCOUNT DETALLS ACCEPTED BY THIR... INTERNAL 12/06/2016 07:45:48 AM

In case of an error in the web service response received from third party system, the status
of work order is changed from 'SEND TO GRI' to 'GRI FAILED' and a comment is posted on
the corresponding account in Customer Service > Comments tab, with the following details:

e Type =SYSTEM GENERATED

e Sub Type = INBOUND FROM INTERFACE
e Comment = "<<Error Message>>"

e Comment By = "INTERNAL"

e Comment Dt = Comment Posted date

Note

Error in web service response can also arise when a work order type is not mapped be-
tween the two systems and a case creation request is sent to third party system.

Update Case

Once the details of a work order has been registered as a case in third party system, there
can be subsequent updates in the details of the mapped account arising due to mismatch in
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account details, change in address, collateral and so on. These changes need to be
incrementally updated into the third party system and are done through the following web
services which are triggered when corresponding details are updated.

Web Service Type of change in mapped account

updateCaseAccountinfo() | When Account details are updated.

updateCaseAddress() When Address details are updated.

updateCaseCollateral() When Collateral details are updated.

updateCaseDebtor() When Primary Customer details are updated.

updateCaseCosigner() When Secondary Customer details are updated.

Secondary Customer can also be the next customer type
defined in the sequence.

The update web service request consists of the modified field details that are to be updated
in third party system.

ORACLE’
Financial Services Lending and Leasing

HEKAR + g signgut &

Customer Service 3 (3 Close

Search  Customer Service: 2000010015971 Review Request (Pending: ) Queue Assignment

Account(s): 20000100015971: EDWIN Elvew | o audt
View v Format~ [ Freeze i Detach Wirap W & @ curent show AlO Group Folow-up
Company Branch Sub Unit Account = Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
uso1 UsHQ SUB UNITL 0000100015871 LOAN VEHICLE (FR) 338 USD 27,9545 5,200.36 [T TRl 02/10/2016

« M » o

Summary = CustomerService | AccountDetsls | Customer Detals | Transaction History ~PmtModes —Barkruptcy | RepofForecosure | Defidency | Collateral | Bureau | CrossiUp Sell Activities  External Interfaces

Call Activities | Maintenance | Comments  Promises | Cheddists | Tracking Attributes || Field Investigation | References | Correspondence || Letters | Document Tracking || Scenario Analysis | Access History

Comments dhadd | FEdt || Evew | o audt

view v Formatv  Ep Freeze  EfiDetach wrap W 38 Delete |
Alert Type Sub Type Comment Comment By Comment Dt
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ ADDRESS UPDATED - ADDRESS NUMBER: OLD VALUE : 745 NEW VALUE : 111ADDRESS UPDATED - ADD INTERNAL 01/13/2017 03:01:58 AM -
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044297557:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 03:01:56 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044312529:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 03:01:54 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ COLLATERAL INFORMATION UPDATED - COLLATERAL TYPE: VEHICLE, PRIMARY IND: Y INTERNAL 11/23/2016 04:50:43 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ CUSTOMER UPDATED - NAME: UPDATE-1 ADD CASE-2, RELATION: PRIMARY, DATE OF BIRTH CHAN... INTERNAL 01/13/2017 03:01:24 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ CUSTOMER URDATED - NAME: COSIGNER DETAILS-1, RELATION: SPOUSE, DATE OF BIRTHCHANGED  INTERNAL 12/06/2016 02:03:51 FM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044258164:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 02:57: 11 AM I
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044287557:UPDATED ACCOUNT DETAILS ACCEFTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 02:57:09 AM =

-B

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312529:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 02:57:07 AM

If the web service request is successful, the modified details are updated into the case in third
party system. Also a comment is posted on the corresponding account in Customer Service
> Comments tab, with the following details:

e Type =SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = “CASE NO: <<UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD
PARTY INTERFACE>>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date and time.

In case of an error in the web service response received from third party system, case details
are not updated and the following details are posted as a comment against the account.

e Type=SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment="“CASE NO: <<UPDATED ACCOUNT DETAILS NOT UPDATED IN THIRD
PARTY INTERFACE>>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date and time.
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Case Comments

Case comments refers to additional details provided in the 'Vendor Messages' section of
Work Orders tab that are required by the third party vendors to act upon the case.

The ‘Vendor Messages’ section can be updated after the case has been created in third party
system and serves as a communication channel between the integrated system.

'Vendor Messages' section is available in the Work Orders tab only when the 'Channel' is
selected as GENERIC RECOVERY INTERFACE and by default, the Vendor Message Type
is selected as ‘CLIENT UPDATE’.

ORACLE
Financial Services Lending and Leasing

@ vendors x [ iose
Work Order Work Order Details =
Dt 12/26/2016 Collateral Details
St Work Order # UNDEFINED StatusDt 12/26/2016
Origination et b currency (e )
* Channel GENERIC RECOVERY INTERFACE [ Estimated 0.00 . n:“‘ﬂ‘” 2
O = * Work Order INTERNAL Biled Amt 0.00 SR
Sales Lead W G-1\eRIC RECOVERY INTERFACE pad 0.00 e
Smple Application Entr Moke
i b * Account - Reference #
Appication Entry Model
ol Company Assigned By ABSHEKAR
Funding Branch Followup Dt EY Vendor Information
Applcation Retrieval Voo = Account Information
Scenario Analysis Ovarride Reasen Account Status Contact
¥
Application Documents *Status NEW [=] Charged off Dt o
Image Maintenance fomen Due Amt i
Reports Total Cutstanding
Producers . Clecix; = Balance Fax
Vendors i Total Due: Comment
Due Dt
Days Past Due
Service Address [=]
Vendor Messages
Vendor Msg Type | CLIENT UPDATE -
= Vendor Msg
> Servicing
* Collections
> WEP
» Tools
> Setup

Accordingly, in the ‘Vendor Messages’ section when the details of Vendor Message Type and
Vendor Message are updated for a work order, system triggers ‘addCaseUpdate()’ to update
the same details in the third party system.

An outbound comment is posted on the corresponding account in Customer Service >
Comments tab, with the following details and the update details are also captured as a record
in Work Order History tab.

e Type =SYSTEM GENERATED

e Sub Type = OUTBOUND TO INTERFACE

e Comment = “[Case No]: <<Vendor Msg Text >>"
e Comment By = “USER”
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e Comment Dt = Comment Posted date

ORACLE’ ¥ SSHEKAR ¥ i Sign out =
Financial Services Lending and Leasing

Vendors 3 Customer Service y [%] Close:

Search | Customer Service: 20160900013226  Review Request (Pending: 0) | Queue Assignment

Account(s): 20160900013226: CHAKS JACY E View || o Audit
view v Format~ [ Freezz i Detach Wrap W & @ curent® show Al @ Group Folow-up
Company Branch Sub Unit Account £ Product Days Past Due Currency Pay Off Amt Amount Due Status =
uso1 usHQ SUB UNIT1 20160800013226  LOAN VEHICLE (FR) 108 USD 51,936.86 17,405.28

Summary || Customer Service AccountDetals | Customer Detals | Transacton History | PmtModes  Bankruptcy | RepofForedosure | Defidency  Colatersl | Bureau  Cross/Up Sell Activities | E > 7

Cal Activiies | Maintenance =~ Comments | Promises | Cheddists Tracking Attributes  Field Investigation =~ References | Correspondence  Letters  DocumentTracking = Scenario Analysis | A > ™

Comments Spadd | Fedt | Fyew | o audt
view v Format» [ Freezz i Detach Wrap W g Deete
Alert Type Sub Type Comment. Comment By Comment Dt
I N SYSTEM GENERATED OUTBOUND TO INTERFACE 2044317321:OTHER:TOYCTA CAMRY - NEW EDITION 2017 MODEL ABSHEKAR 01/27/2017 05:22:59 AM I
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044317321:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/24/2017 01:07:20 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE 204431732 1:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERMNAL 01/13/2017 03:00:07 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044317321:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/13/2017 02:58:09 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044317321:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/13/2017 02 A
N SYSTEM GENERATED INBOUND FROM INTERFACE 204431732 1:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERMNAL 01/13/2017 02:53:59 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044317321:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/13/2017 02:51:26 AM ql.

Hold Case

A particular work order or case which is already scheduled for repossession can undergo a
status change when a payment is received (either full outstanding due or partial) on the non-
performing account associated with the work order.

Also, an automatic case status change can happen on work order for an account based on
Delinquency Days. Whenever the delinquency days falls below certain number of days as
defined in system parameter “GRI_DLQ_DAYS_AUTO_STATUS_CHG” (DELINQUENCY
DAYS FOR AUTOMATIC CASE STATUS CHANGE), system auto updates the case status
as ‘PENDING ON HOLD/ON HOLD’ on running the batch job SET-GRI
(RDNDLQ_BJ_100_01-AUTOMATIC CASE STATUS CHANGE).

Accordingly, when the status of a work order is changed to ‘PENDING ON HOLD’ in Work
Orders screen, system triggers ‘holdCase()’ web service request to update the status of
corresponding mapped case in third party system. This ensures that a work order in hold
status is not processed further with third party vendor managed systems.

For information on updating the work order details, refer to section Vendors > Work Orders
tab.

ORACLE’
Financial Services Lending and Leasing

Vendors 3 (%] Close
view = Format v [ Freeze  fiDetach Wrap 2]
Override
Work Order # Case # Channel Account. Colateral Descripton ~~ Vendor % - Company  Branch Status Reason Work Order Type  Assigned By Reference #
WO:0021105 2044299014 GENERIC RECOVERY INTERFACE  20000... 2006 CHEVROLET MONT... S0DEMO- uso1 UsHQ ONHOLD  JCUSTOMER .. IMPOUIND TNVOLU... HMACHA
WO:0021117 2044296035 GENERIC RECOVERY INTERFACE  20151... 2006 CHEVROLET MONT... S0DEMO- usol UsHQ ONHGLD  CUSTOMER ... IMPOUND INVOLU... VENKAT
WO:0021122 2044299038 GENERIC RECOVERY INTERFACE 20160... 2006 CHEVROLET MONT... S0DEMO-. uso1 usHQ ONHOLD CUSTOMER IMPOUND INVOLU... VENKAT
WO:0021106 2044299023 GENERIC RECOVERY INTERFACE 20000... 2006 CHEVROLET MONT... S0DEMO-. uso1 usHQ ONHOLD CUSTOMER IMPOUND INVOLU... HMACHA
WO:0021067 2044297345 GENERICRECOVERY INTERFACE  20000... 2006 CHEVROLET MONT... 90DEMO-.. uso1 usHQ ONHOLD  CUSTOMER ... DOOR KNOCK (GRI) HMACHA
WO:0021070 2044297557 GENERICRECOVERY INTERFACE  20000... 2006 CHEVROLET MONT... 90DEMO-.. uso1 usHQ ONHOLD  CUSTOMER ... DOOR KNOCK (GRI) HMACHA

« i »

services | Work Order History | Tracking Attributes

m

‘Work Order History 5] view
Vigw * Format + H | Freeze fdiDetach Wrap 5]
¢
Viork Order # Case # Chanel  Account ;Z!‘Z:fp’:ln Vendor R“:;;E:E Company  Branch Status Reason Work Order Type  Assigned By R
W0:0021105 2044299014  GENERICRE... 20000100013892:... 2006 CHEVROLET .. S0DEMO-RON_INT. uso1 usHQ PENDING ONHOLD CUSTOMER .. IMPOUND INVOLU... HMACHA
W0:0021105 2044299014 GENERICRE.. 20000100013892:... 2006 CHEVROLET ... 90DEMO-RDN_INT. usot UsHQ oPEN IMPOUND INVOLU... HMACHA
WO:0021105 2044299014 GEMERIC RE... 20000100013892:... 2006 CHEVROLET .. SODEMO-RDN_INT. uso1 USHQ | ASSIGNED IMPOUND INVOLU... HMACHA T
WO:0021105 UNDEFINED ~ GEMERIC RE... 20000100013892:... 2006 CHEVROLET .. SODEMO-RDN_INT. uso1 USHQ INEW IMPOUND INVOLU... HMACHA
« ] v o

If the web service request is successful, a comment is posted on the corresponding account
in Customer Service > Comments tab, with the following details:

e Type =SYSTEM GENERATED
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e Sub Type = INBOUND FROM INTERFACE

e Comment = “CASE NO: <<CASE HOLD REQUEST ACCEPTED BY THIRD PARTY
INTERFACE (Reference No)>>"

e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date.

ORACLE’
Financial Services Lending and Leasing

Customer Service x (3] Close

Search  Customer Service: 20160300018800 | Review Request (Pending: 0) | Queue Assignment

Account(s): 20160318800: FOSTER RICK [El view || & Audit
View » Formatv Freeze i Detach Wrap @ & © curent® show Al © Group Fallew-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Status Oldest Due Dt
uso1 usHQ SUBUNIT1 2016030018800  LOAN VEHICLE (FR) 50 USD 32,536.20 3,861.52 ACTIVE:DELQ 11/24/2016

Summary ~ Customer Service ~AccountDetails = Customer Detais || Transaction History | PmtModes || Bankruptcy | RepofForedosure | Defidency | Colateral | Bureau Cross/Up Sell Activities | External Interfaces

Call Activities || Maintenance | Comments | Promises | Checists | Trading Attributes | Field Investigation | References | Correspondence || Letters || DocumentTracking || Scenario Analysis || Access History

Comments Hadd | AEit | [Hvew | o Audt
View » Format v [ Freeze i Detach wirap W 9 peete
Alert Type Sub Type Comment Comment By Comment Dt
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR_VR JOB REQUEST ID: 2... INTERNAL 01/12/2017 11:19:27 PM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION1 LETTER GENERATED. (CORRESPOMDENCE: CNLNCE_COL_LTR1_VR JOB REQUEST ID: 21... INTERNAL 12/13/2016 12:47:35 AM

12/06/2016 02:03:51 PM

N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR_VR JOB REQUEST ID: 2... INTERNAL
(CORRESP: :

N SYSTEM GENERATED SYSTEM GENERATED WELCOME LETTER GENERATED. ESPONDENCE: CNLNCE_WEL | TR VR JOB REQUEST ID: 17499)  INTERNAL
| SYSTEM GENERATED INEQUND FROM INTERFACE 2044275575 : CASE HOLD ACCEPTED BY THIRD PARTY INTERFACE : INTERNAL 11/10/2016 03:00:35 AM
N SYSTEM GENERATED TNBOUND FROM INTERFACE _ 2044275575:90DEMO-RDN_INTERFACE-CASE WAS ACCEFTED TNTERNAL T1/10/2016 02:54:45 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044275575:90DEMO-RDN_INTERFACE-ACCEFTED CASE INTERNAL 11/10/2016 02:54:45 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044275575:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 11/10/2016 02:51:43 AM =

In case of an error in the web service response received from third party system, following
details are posted as a comment against the account with an alert flag and the status of Work
Order is not changed.

e Alert=Y
e Type=SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment="“CASE NO: <<CASE HOLD REQUEST NOT UPDATED IN THIRD PARTY
INTERFACE>>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date.

Reopen Case

When the status of a work order is updated from ‘ON HOLD’ to ‘RELEASED’ in Work Orders
screen, system triggers ‘reopenCase()’ web service request to update the status of
corresponding mapped case in third party system.
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This ensures that a work order in hold status is processed further with third party vendor
managed systems.

ORACLE BAR 1 signout O
Financial Services Lending and Leasing

Vendors 5. @ dose

Vendors | Assignment Alocation | Work Orders  Folow-up  Invoices b

‘Work Order
Fradd | FEdt | Evew | o Audt

View v Format~ [ Freeze  {fiDetach Wrap 5]
& woooa1117
Colateral Override Assig

Work Order # Case # Channel Account e Vendor Sl Company  Branch Status Reasor Work Order Type oy Reference Fol |2
WO:0021117 2044298035 GENERIC RE.. 20151100019817:... 2006 CHEVROLET ... S0DEMO-RDN_INT. us1 UsHy ONHOLD CUS... IMPOUND INVOLUNTARY REPOSSE... VE.
« i '
Work Order
Eseveandsay | | saveandreum || (agetm
4 Work Order Work Order Details
Dt 12/01/2016 Collateral Details
Work Order # WO:0021117 StatwsDt 12012016
Case & 2044293035 Currency USDOLLAR Colateral Description 2006 CHEVROLET MONTECARLO 2DR
Channel GENERIC RECOVERY INTERFACE Estimated 0.00 Identification # 284GP45G DR 378252
Wiork Order Type IMPOUND INVOLUNTARY REPOSSESSION (GRI) Biled Amt 0.00 Year 2006
Account 201511000193 17:DON TAMPRI Faid 0.00 gy
Company US01 Reference # Modl MOIGECRRLD
Branch USHQ Assigned By VENKAT Vendor Information
* Vendor  SODEMO-RDN_INTERFACE - Folowup Dt 2 e
Override Rezson Select the work order status R s =
= Status | ON HOLD [5] Account Status CLOSED:ACTIVESTTP Phone
e e — G
s, A Due Amt 1078.8 e
RevEaseD | Total Qutstanding Balance -207.84 Fax
S— Total Due 0 Comment

Due Dt 02/02/2017
Davs Past Nie 22

The processing update of REOPEN case request at the third party system is tracked
separately through a FIREHOSE web service scheduled at specific interval using a batch
process. For more information, refer ‘Case Updates Received via FireHose WebService’
section.

If the web service request is successful, a comment is posted on the corresponding account
in Customer Service > Comments tab, with the following details:

e Type=SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = “CASE NO: <<CASE REOPEN UPDATED IN THIRD PARTY
INTERFACE>>"

e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date

ORACLE' KAR ~  ug Signout
Financial Services Lending and Leasing

Vendors x| Customer Service x [ Close
View v Format= | g7 rreeze g Demn wrap GRS} @ LUENTL SNOW AN LrOUD FOIOW-UP .
Company Branch Sub Unit Account £ Praduct Days Past Due Currency Pay Off Amt Amount Due Status
uso1 usHQ SUB UNITL 0160300021035 LOAN VEHICLE (FR) 264 USD 46,032.86 17,561.52 ACTIVEIDE

Summary ~ Customer Service AccountDetails | Customer Detaiis | Transaction History | PmtModes | Bankruptcy  RepofForedosure  Deficency | Collateral | Bureau | CrossfUp Sell Activiies | E >

Call Activities | Masintenance  Comments | Promises  Checklsts | Tracking Atrbutss | Field Investigation | References | Correspondence  Letters  DocumentTracking | Scenario Analyss A >

Comments Fadd | et | Fyew || o Audt =
View ~ Format ~ [ Freeze g Detach Wrap W 8¢ Delete
» Alert Type Sub Type Comment Comment By Comment Dt

N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044302016:CASE REOPEN UPDATED IN THIRD PARTY INTERFACE INTERNAL 12/06/2016 07:26:30 AM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION2 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL_LTR... INTERNAL 12/13/2016 12:48:39 AM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION1 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL _LTR... INTERNAL 12/13/2016 12:47:35 AM I
N SYSTEM GENERATED SYSTEM GENERATED WELCOME LETTER GEMERATED. (CORRESPOMDEMCE: CNLNCE_WEL_LTR_VR ... INTERNAL 12/06/2016 02:03:15PM
N SYSTEM GENERATED INBOUND FROM INTERFACE 2044302016: NEW CASE CREATED INTERNAL 12/06/2016 07:22:53 AM

In case of an error in the web service response received from third party system, following
details are posted as a comment against the account with an alert flag and the status of Work
Order is not changed.

o Alert=Y
e Type =SYSTEM GENERATED
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e Sub Type = INBOUND FROM INTERFACE

e Comment = “CASE NO: <<CASE REOPEN REQUEST NOT UPDATED IN THIRD
PARTY INTERFACE>>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date

Reassign Case

A particular work order or case which is already scheduled for repossession in third party
system can be reassigned to a different vendor due to delay in action, response, status
updates or any such conditions.

Accordingly, when a case is reassigned to a different vendor, the change is processed for
update in third party system depending on the current case status maintained across systems
as indicated below:

. OFSLL Work | GRI Case .
Scenario Order Status | Status Case Reassignment Update

1 Send to GRI NEW Case is assigned to new Vendor.
FROM
CLIENT
2 Open Open Existing case is closed (i.e. status is updated

as ‘PENDING REASSIGN/CLOSE’) and new
case is created and assigned to new Vendor.

Also, system automatically updates the work order status to ‘PENDING REASSIGN/CLOSE’
based on the days defined in the lookup code ‘VEN_REASSIGN_DAYS_ CD (VENDOR
REASSIGNMENT DAYS CODES). If the case status is OPEN for specific number of days as
maintained in the sub code of the above lookup code, system auto updates the case status
as ‘PENDING REASSIGN/CLOSE’ on running the batch job SET-GRI (RDNVNA_BJ_100_01
- AUTOMATIC VENDOR REASSIGNMENT).

Accordingly, when a case is reassigned, system triggers ‘reassignCase()’ web service
request for reassigning the case to new vendor in third party system. Depending on the case
status, the case is either directly assigned to new vendor, or a new case is created with new
vendor by closing the existing case.

e If Case status is ‘'NEW FROM CLIENT’ in GRI, the case is reassigned to new vendor in
GRI and no New CASE is created in OFSLL.

e If Case status is ‘OPEN’ in GRI, the case is updated to ‘Pending on Close’ status in GRI,
new case is created in OFSLL with New Case # and assigned to new Vendor.

If a new case is created in third party system due to vendor reassignment, then the web
service response will include the new case number. Subsequently, when a close confirmation
is received on the existing case as part of case status update from FIREHOSE web service
response, the work order in OFSLL is closed (status = ‘CLOSE’) and new work order is
created with new case number, new assigned vendor and previous work order account
details.

Note the following:

— New work order is created in OFSLL only if the ‘reassignCase()’ web service
response consists of new case number created in third party system.
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— If the web service response is successful but does not contain a case #, then the
case is directly assigned to new vendor in third party system.

A comment is posted on the corresponding account in Customer Service > Comments tab,
with the following details:

e Type =SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = NEW CASE NO: “<<CASE REASSIGNMENT REQUEST ACCEPTED BY
THIRD PARTY INTERFACE >>"

e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date

ORACLE SHEKAR * i SignQut =
Financial Services Lending and Leasing

Vendors ¢ Customer Service yx (] Clos=

Search  Customer Service: 20160100025071  Review Request (Pending: 0)  Queue Assignment

Account(s): 20160100025071: JENA PRITAM E View || o Audt
View > Format v [Ep Freeze i Detach Vrap W & © curent® show Al © Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Status =
Us01 UsHQ SUB UNIT1 20160100025071  LOAN VEHICLE (FR) 349 USD 15,748.99 5,400.36

« i B

Summary = Customer Service | AccountDetails = Customer Detalls | Transaction History | PmtModes | Bankruptcy | RepojForedosure | Defidency | Colateral | Bureau | Cross/Up Sel Acthities | E > ¥

Call Activities ~ Maintenance = Comments  Promises  Cheddists | Tracking Attrbutes | Field Investigation = References = Correspondence | Letters  DocumentTracking | Scenario Analysis A > 7

Comments dpadd | AEdt | [Fuew | o At
View v Format~  [Ep Fresze i Detach \irap ) 5% Delete
Alert Type Sub Type Comment Comment By Comment Dt
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE. INTERNAL 01/24/2017 01:06:33 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/13/2017 02:59: 12 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE. INTERNAL 01/13/2017 02:50:25 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE. INTERNAL 01/08/2017 09:45:22 PM
N SYSTEM GENERATED INBOUND FROM INTERFACE __ 2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/02/2017 12:23:35 AM
I N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044314205: REASSIGNMENT IN PROGRESS INTERNAL 12/29/2016 04:43: 20 AM I =

——= e = T “

In case of an error in the web service response received from third party system, following
details are posted as a comment against the account and the work status is not updated nor
a new work order is created with new assigned vendor.

e Type =SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = CASE NO: “<<CASE REASSIGNMENT REQUEST NOT UPDATED IN
THIRD PARTY INTERFACE >>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date

C.8 Close Case

A particular work order or case which is already scheduled for repossession can be closed
after validating the preceding status and subsequently a repossession may not be required
on the account mapped to the work order.

Accordingly, when the status of a work order is changed to ‘PENDING CLOSE’ in Work
Orders screen, system triggers ‘closeCase()’ web service request to update the status of
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corresponding mapped case in third party system. This ensures that the work order is not
processed further with third party vendor managed systems.

ORACLE" . . HEKAR = 1 SignOut &
Financial Services Lending and Leasing
Vendors 3 (2] Close
Work Order &
dpadd | ZEdt | Guew | o Audt
View + Format~ [0 Freeze i Detach rap o]
Work Order # Case # channel Account i vendor OV oy Branch Status Reasor Work Order Type  Assigned By Reference
Description Reason
WO:0021175 2044302017 GENERIC RE... 20160300021051:... 2006 CHEVROLET ... SODEMO-RDN_INT. uso1 UsH cLose CUS... IMPOUND INVOLLL... HMACHA
« i v
b Services  Work Order History | Tracking Attributes
Work Order History [E] view
View = Formatv [ Freeze  {fiDetach rap 5]
Work Order # Case = Channel Account &= Vendor O Company  Branch Status Reason Work Order Type  Assigned By R
Desaription Reason
WO:0021175 2044302017  GENERIC RE... 20160300021051:... 2006 CHEVROLET ... S0DEMO-RDN_INT. uso1 USHQ PENDING CLOSE | CUSTOMER .. IMPOUND INVOLLL... HMACHA
WO:0021175 2044302017 GENERICRE... 20160300021051:... 2006 CHEVROLET ... SODEMO-RDN_INT. uso1 USHQ GPEN IMPOUND INVOLU... HMACHA
WO:0021175 2044302017 GENERICRE... 20160300021051:... 2006 CHEVROLET ... SODEMO-RDN_INT. uso1 UsHQ ASSIGNED IMPOUND INVOLUL... HMACHA
WO:0021175 UNDEFINED  GENERIC RE... 20160300021051:... 2006 CHEVROLET ... S0DEMO-RDN_INT. uso1 USHQ NEW IMPOUND INVOLU... HMACHA

q] M »

If the web service request is successful, a comment is posted on the corresponding account
in Customer Service > Comments tab, with the following details:

e Alert=N
e Type = SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE
e Comment = CASE NO: “<<CASE CLOSE REQUEST ACCEPTED BY THIRD PARTY
INTERFACE >>”
e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date
ORACLE’ -
Financial Services Lending and Leasing
‘Customer Service 53] Qo;e

Search | Customer Service: 20160300018545 | Review Request (Pending: 0) | Queue Assignment

Account(s): 20160300018545: FOSTER B view || o Audit
View = Format~ [Ep Freeze  f Detach Wrap M & @ curentO show AlD Group Follow-up
Company Branch Sub Uit Account £ Product Days Past Due Currency Pay OFF Amt Amount Due Status Oldest Due Dt
uso1 UsHQ SUB UNITL 2016030018545  LOAN VEHICLE (FR) 264 USD 46,345.17 17,561.52 ACTIVEDELQ 04/24/2016
d m T =|

Summary | Customer Service || AccountDetails | Customer Details | Transaction History | PmtModes  Bankruptcy | RepojfForecosure | Defidency  Colateral | Buresu  Cross/Up Sell Activities | External Interfaces

Cal Activities | Maintenance =~ Comments | Fromises | Checlists | Tracking Attributes | Field Investigation || References  Corespondence | Letters | DocumentTracking | Scenario Analysis | Access History

Comments dhadd | Fedt | Huew | o audt
View v Format v B Freeze  fiDetach wirap W 3¢ Delet=

Alert. Type Sub Type Comment Comment By Comment Dt

N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE _STM_LTR_VR JOB REQUEST ID: 2... INTERNAL 01/12/2017 11:19:27PM

N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE _STM_LTR_VR JOB REQUEST ID: 2... INTERNAL 12/06/2016 02:03:51PM

N SYSTEM GENERATED SYSTEM GENERATED COLLECTION2 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL LTR2 VR JOB REQUEST ID: 35... INTERNAL 11/23/2016 05:06:53 AM

N SYSTEM GENERATED SYSTEM GENERATED COLLECTION3 LETTER GENERATED. (CORRESPONDENCE: CNLNCE COL LTR3 VR JOB REQUEST ID: 38... INTERNAL 11/23/2016 04:50:43 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE [2044274356 : CASE CLOSE ACCEPTED BY THIRD PARTY INTERFACE mTERNAL 11/08/2016 10:44:48 PM

N SYSTEM GENERATED SYSTEM GENERATED WELCOME LETTER GENERATED. (CORRESPONDENCE: CNLNCE_WEL_LTR VR JOB REQUEST ID: 17330)  INTERNAL 11/09/2016 09:27:10 PM

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044274356: NEW CASE CREATED INTERNAL 11/09/2016 09:13: 10 PM il

In case of an error in the web service response received from third party system, following
details are posted as a comment against the account with an alert flag and the status of Work

Order is not changed.

e Alert=Y

e Type = SYSTEM GENERATED

e Sub Type = INBOUND FROM INTERFACE

e Comment = CASE NO: “<<CASE CLOSE REQUEST NOT UPDATED IN THIRD
PARTY INTERFACE >>"

e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date
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Case Updates Received via FireHose WebService

Retrieving case status updates from the third party system is through a FIREHOSE web
service response received into OFSLL through a pull service. Each response is channelled
through an individual Event ID and Event Type.

A FIREHOSE web service 'getGriFireHose' - scheduled at specific interval using batch
(GRIFRH_BJ_100_01) retrieves the case updates. This response consists of case activities
recorded in third party system between specific intervals (based on Max event ID).

Note that, the FIREHOSE web service response always contains specific Event Type Code
from the third party system which are updated in the database and inturn is validated for
appropriate action in OFSLL. The table below indicates the list of Event Type and the
corresponding action updated in the system.

Event Event Description Action

Type

600 ACCEPTED CASE Change Work order status to “OPEN”

601 DECLINED CASE Change Work order status to “DECLINED”

602 ACKNOWLEDGED Change Work order status to “CLOSE”

CLOSE
603 ACKNOWLEDGED Change Work order status to “ON HOLD”
HOLD

300 CASE WAS REPOED Change Work order status to “REPOSSESSED”
And
Trigger “getRepossessionDetails()” web service to
get repossession details and update in Servicing >
Repo/Foreclosure” tab.

302 CASE COMPLETED Change Work order status to “COMPLETED”

200 FIRST UPDATE ADDED | Post the received update as “Inbound Comment”

CUSTOM from Interface in Servicing >Customer Service
>Comments tab.

201 UPDATE EDITED Post the received update as “Inbound Comment”
from Interface in Servicing >Customer Service
>Comments tab.

203 UPDATE UNHIDDEN Post the received update as “Inbound Comment”
from Interface in Servicing >Customer Service
>Comments tab.

811 INVOICE SENT TO CLI- | Call the “getCaselnvoiceData()” web service and

ENT create the invoices in OFSLL.
1300 CR ADDED Update ‘Condition Report Status =Y’ and Condition

Report Recd Dt = Event Received Date

Based on the web service response received from third party system, the status updates are
posted onto corresponding work order(s) and account(s) in OFSLL.
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For example, if the FIREHOSE web service response consists of the Event Type ‘600’, it
indicates that the case is accepted by the assigned vendor in third party system and status of
the work order is to be updated to ‘OPEN’ in OFSLL. Also a comment is posted on the
corresponding account in Customer Service > Comments tab, with the following details:

e Type =SYSTEM GENERATED

e Sub Type = INBOUND FROM INTERFACE

e Comment = "[Case No]: <<[Vendor] ACCEPTED CASE>>"
e Comment By = "INTERNAL"

e Comment Dt = Comment Posted date and time

Note

Work order status change is permitted only if the previous status matches with the defined
cycle setup (Setup > Products > Cycles). Else, update is not allowed and comment is post-
ed on the account with the message ‘Work Order Status Update failed due to mismatch of
previous status’.

Case Repossession

When a case has been repossessed, the status of the case is updated by the assigned vendor
in third party system. The case status is then retrieved through a FIREHOSE web service
scheduled at specific interval using a batch process.

On receiving the case status update as ‘REPOSSESSED’ (i.e. Event Type 300) from
FIREHOSE web service response, system triggers ‘getRepossessionDetails()’ web service
request to fetch the repossession details and update the status of corresponding mapped
work order and account in OFSLL.

If the web service request is successful and repossession details are received as part of the
response, the status of the work order is updated in Work Orders tab and a comment is posted
on the corresponding account in Customer Service > Comments tab, with the following
details:

e Type=SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = “[Case No]: <<[Vendor]: REPO DETAILS RECEIVED FROM THIRD
PARTY INTERFACE >>"

e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date and time

ORACLE 3 SSHEKAR + 1) Sgnout
Financial Services Lending and Leasing

Customer Service s, Customer Service 5 (3 Close
Search | Customer Service: 2016060001 Review Request (Pending: 0) || Queue Assignment =
Account(s): 2016060001: COSIGNER Elview || o Audit
View ¥ Format~ [y Freeze i Detach Wrap W & @ curent© Show Al Group Follow-up
Company Branch Sub Uit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status OldestDue Dt
uso1 usHQ SUBUNITT 20160600018906  LOAN VEHICLE (FR) 170 USD 102,758.36 51,382.92 ACTIVE:DELQ 07/27/2016

Summary || Customer Service | Account Details | Customer Details | Transaction History | PmtModes | Bankruptcy = RepojForedosure | Defidency | Colateral | Bureau = CrossfUp Sell Activities | External Interfaces

Call Activities | Maintenance | Comments | Promises | Cheddists | Tracking Attributes || Field Investigaion | References | Correspondence || Letters | Document Tracking | Scenario Analysis | Access History

Comments dpadd || ZEdit || [F view || o Audt
View v Fomat~  Ep Freeze i Detach Wrap W 38 ekt

Alert Type Sub Type Comment ‘Comment By Comment Dt
N SYSTEM GEMERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR VR JOB REQUEST ID: 25332) INTERNAL 01/12f2017 11:19:27PM
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR _VR JOB REQUEST ID: 20948) INTERNAL 12/06/2016 02:03:51PM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION2 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL_LTR2_VR JOB REQUEST ID: 18920) INTERNAL 11/23/2016 05:06:53 AM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION3 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL_LTR3_VR JOB REQUEST ID: 18906) INTERNAL 11/23/2016 04:50:43 AM
N SYSTEM GENERATED SYSTEM GENERATED WELCOME LETTER GENERATED. (CORRESPOMNDENCE: CNLNCE_WEL _LTR_VR JOB REQUEST ID: 17499) INTERNAL 11/10/2016 02:02:51PM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044275584: GRI_INTERFACE:REPOSESSION DETAILS FROM GRL UPDATED INTERNAL 11/10/2016 05:02:30 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044275584:90DEMO-RDN_INTERFACE-CASE GOT REPOSSESSED INTERNAL 11/10/2016 05:02:25 AM “
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044275584:90DEMO-RDN_INTERFACE-AGENT UPDATED LICENSE PLATE FROM UNDEFINED TO 123456 INTERNAL 11/10/2016 05:02:25 AM
N SYSTEM GEMERATED INBOUND FROM INTERFACE  2044275584: 90DEMO-RDN_INTERFACE-ACCEPTED CASE INTERNAL 11/10/2016 04:53:19 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044275584:90DEMO-RDN_INTERFACE-CASE WAS ACCEPTED INTERNAL 11/10/2016 04:53:19 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE 2044275584 NEW CASE CREATED INTERNAL 11/10/2016 04:51:00 AM =
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The Repossession details are also updated in Repo/Foreclosure tab of Customer Service

screen.

ORACLE"
Financial Services Lending and Leasing

Customer Service || Customer Service x [ Close
Search | Customer Service: 2016060001 Review Request (Pending: 0) | Queue Assigrment i
Account(s): 2016060001: COSIGNER Ewew o Audit
View = Formatv & Freeze i Detach Wrap W & © Curent© Show Al O Group Folow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Status Cldest Due Dt
uso1 UsHg SUB UNITL 0160600018306 LOAN VEHICLE (FR) 170 USD 102,758.36 51,382.92 ACTVEDELQ 07/27/2016

Summery || Customer Service || Account Details | Customer Detals || Transaction History || Pt Modes | Bankupicy | RepofForeclosure | Deficency || Collateral || Bureau || Cross/Up Sell Activities || External Interfaces

Repossession  Analysis

Repossession Details: 2B4GP45G1XR378254 o add | ZEdit || B Vew | o Audit 3
view v Formatv [ Freeze i Detach Wrap 5]
Current Folowup Dt Work Order Type  Collateral Disposition File Received Dt Repo Dt RepoEndDt  Comment
Y 12/31/4000  INVOLUNTARY 2010 VOLVO AMDO07 NEWLY RECEIVED

Repossession Details

{aRetum
Current ¥ File Received Dt
Followup Dt 12/31/4000 Repo Dt i
Work Order Type INVOLUNTARY Repo End Dt
Collateral 2010 VOLVO AMDOO7 Comment
Disposition  NEWLY RECEIVED
Case Repo Details
Case 2044275584 Is Drivable ¥ Storage Location Space 12123123 Phone (123)-333-4444
Vendor Work IMPOUND VOLUNTARY REPOSSESSION (GRI) Personal Items HGJHG) Fax (333)444-5555
Order Type Storage Days 0 Storage Location
Identification B4GP4SGIR378254 Transport Release Date 11/09/2016 Repo Location
g N Delivered ReleasedTo 0 e e
Vehide C.D|?F ???‘» Conditon Report Status __ Country UNITED STATES Address TEE }jl{sjkﬁfb "‘L“—;fPTlB |

C.11 Case Invoice

When a case has been repossessed, an invoice with the actual cost incurred for repossession
and the details of the asset repossessed are updated in the third party system by the assigned
vendor.

Subsequently, when the case status update is received as ‘REPOSSESSED’ (i.e. Event Type
300) from FIREHOSE web service response, system triggers ‘getCaselnvoiceData()’ web
service request to retrieve the invoice and asset details from the third party system.

ORACLE' v ABSHEKAR ~ 1 Signgut
Financial Services Lending and Leasing

Vendors x [ Close
Work Order o
[ save and stay, saveandRetun || (3 Return
Work Order Work Order Details
Dt 12/22/2016 Collateral Details
Work Order # W0:0021380 StatusDt 12/22/2016
Case # 2044312777 Currency USDOLLAR Collateral Description 2006 CHEVROLET MONTECARLO 2DR.
Channel GENERIC RECOVERY INTERFACE Estimated 0.00 Identification # 2B4GP45G 1XR 378252
Wark Order Type  IMPOUND INVOLUNTARY REPOSSESSION (GRT) Billed Amt 0.00 Year 2006 |
b Account  20160100011187: Paid 0.00 WMake CHEVROLET 3
Company USO1 Reference # Model MONTECARLO
Branch USHQ Assigned By VENKAT
Vendor Information
Wendor 90DEMO_INTERFACE Followup Dt
; Account Information
i RSEZI REPOSSESSED Aczount Status ACTIVEDELQ:BKRP:REPO C::;[E‘ HEHOINIEREAE
e Charged off Dt -
Collector Due Amt 450,03 i
Total Qutstanding Balance  15834.6

Total Due 5625.36 P

DueDt 03/10/2017 <

If the web service request is successful and repossession details are received as part of the
response, the details are updated in Vendors > Invoices tab and a comment is posted on the
corresponding account in Customer Service > Comments tab, with the following details:

e Type =SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = “[Case No]: <<[Vendor]: INVOICE RECEIVED FROM THIRD PARTY
INTERFACE >>"

e Comment By = “INTERNAL”
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e Comment Dt = Comment Posted date and time

ORACLE’
Financial Services Lending and Leasing

Vendors Customer Service 5 (3] Close

Search  Customer Service: 2016010001187 | Review Request (Pending: 0) | Queue Assignment

Account(s): 20160100011187: Elyen | o Audit
view v Format~  [Ep Fresze i Detach Wirap W & © curent® show Al Group Follow-up i
Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status
uso1 UsHQ SUB UNIT1 2016010001187  LOAN VEHICLE (FR) 349 USD 15,809.54

Summary | Customer Service | AccountDetals Customer Detals | Transaction History | PmtModes Bankruptcy RepofForedosure  Defidency | Collateral | Bureau | CrossfUp Sell Activies | E > ¥

Cal Activiies | Maintenance  Comments Promises | Checkists | Tracking Attributes  Field Investigation | References | Correspondence | Letters | DocumentTracking | Scenario Anlyss A > ¥

Comments dpadd | ZEdt | [Jven | o Audt
view v Format~ &y Freeze i Detach Wirap W 3¢ Delete

Alert Type Sub Type Comment Comment By Comment Dt

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312777:90DEMO-GRI_INTERFACE:INVOICE RECEIVED FROM THIRD PA... INTERNAL 12/22/2016 03:37:12 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044312777:90DEMO-GRI_INTERFACE-ORACLE ONE HAS APPROVED THE IN... INTERNAL 12/22/2016 03:37:10 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044312777:90DEMO-GRI_INTERFACE-INVOICE CREATED IN THIRD PARTY ... INTERNAL 12/22/2016 03:37:10 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044312777:90DEMO-GRI_INTERFACE:REPOSESSICN DETAILS FROM GRIUL... INTERNAL 12/22/2016 03:30:53 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312777:0DEMO-GRI_INTERFACE-CASE GOT REPOSSESSED INTERNAL 12/22/2016 03:30:51 AM -

The details of the invoice in the web service response are captured in Vendors > Invoice
Information tab with invoice details and Payment Schedule. By default, the status of the
invoice is ‘OPEN’ to update the payment details.

ORACLE’
Financial Services Lending and Leasing

Vendors x [#]lose

Vendors | Assignment Allocation | Work Orders | Follow-up | Invoices

Invoice Information o Add | ZEdt || [E]Vew || o Audit
View Options AL [=
View = Format v Freeze i Detach Wrap o) Validate Invoice
& ) £
Vendor Company Branch Invoice # ExternalRef=  InveiceDt Due Dt Status Channel
S0DEMO-RDN_INTERFACE uso1 UsHQ 3851 23086216 12/22/2016 12/22/2016 aose GENERIC RECOVE
S0DEMO-RDN_INTERFACE uso1 usHQ £ 23066207 12/21/2016 12/21/2016 OPEN GENERIC RECOVE
Invoice Information
Gagewm | [
Invoice Dt 12/22/2016 Currency USDOLLAR
B Invoice Due Dt 12/22/2016 Estmated 122,00
Status CLOSE Invoice Amt 122,00
Vendor SODEMO-RDN_INTERFACE Agreed Amt 122,00
Company US01 Details Paid Amt 122.00
Branch USHQ Channel GENERIC RECOVERY INTERFACE
Inveice = 3651 Status Dt 12/22/2016
External Ref # 23066216 Address ADD12 ADD13 REDDING, CA 96001
Details | Tracking Attributes
Invoice Details [Elvew || o Auit
view v Formatv [} Freeze gt Detach ] wirap o)
Viork Order # Estimated Tnvoice Amt Agreed Amt Faid Amt Txn Post Dt Status Status Dt Authorized By Authorized Dt Colectble
WO:0021380 2016010001187 2798 10.00 10.00 10.00 10.00 12/22/2016 close 12/22/2016 N
WIO:0021380 2016010001187 2798 100.00 100.00 100.00 100.00 12/22{2016 CLose 12/22[2016 ¥
WQ:0021380 20160 100011187 2798... 12.00 12.00 12.00 12,00 12/22/2016 CLOSE 12/22/2016 N

Payment Schedule  Relsted Tnvoice Work Orders

System auto validates the invoice details which are received from third party system with
specific business rules before creating a record in the Invoice Information tab. Hence the
‘Validate Invoice’ button in the Information tab is disabled for invoice records from external
channel (Generic Recovery Interface) and the details are marked as view only.

For more information on business rules and working with Invoices tab, refer to ‘Vendors’
chapter.
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